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Regulatory Requirement

The Versana Premier/Versana Premier Lotus complies with regulatory requirements of the
following European Regulation 2017/745 EU concerning medical devices.

First CE Marked in 2023.
This User Manual is a reference for the Versana Premier/Versana Premier Lotus. It applies to
Version R3 software for the Versana Premier/Versana Premier Lotus ultrasound system.

GE Healthcare
P.O. Box 414, Milwaukee, Wisconsin 53201 U.S.A.
(Asia, Pacific, Latin America, North America)

GE Healthcare GmbH
Beethovenstrasse 239
Postfach 11 05 60
D-42655 Solingen GERMANY
TEL: 49 212.28.02.208; FAX: 49 212.28.02.380
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Revision History

Table -1 Reason for Change

Revision Date (YYYY-MM-DD) Reason for change

Rev. 1 2023-10-19 Initial release.

Rev. 2 2023-10-30 Add India factory address.

Rev. 3 2024-02-21 • Update frist CE mark year.
• Remove Tricefy Uplink.
• Update graphics and description.

Rev. 4 2024-10-09 Update InSite ExC service content.

Rev. 5 2024-11-20 Update Digital Expert Connect section.

Rev. 6 2025-03-06 Add Full Screen and update Worklist
description.

Please verify that you are using the latest revision of this document. Information pertaining
to this document is maintained on MyWorkshop. If you need to know the latest revision,
contact your distributor, local GE HealthCare Sales Representative or in the USA call the GE
HealthCare Ultrasound Clinical Answer Center at 1 800 682 5327 or 1 262 524 5698.
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Regulatory Requirements

Conformance Standards

The following classifications are in accordance with the IEC/EN 60601-1:6.8.1:

• According to European Medical Device Regulation 2017/745, this is Class IIa Medical
Device.

• According to IEC 60601-1:

Equipment is Class I or Internally Powered equipment, Type BF or Type CF Applied Part
for probes, DEFIBRILLATION-PROOF Type CF Applied Part for ECG.
Not suitable to be used in an OXYGEN RICH ENVIRONMENT.
Continuous Operation.

• According to CISPR 11:

Equipment is Group 1, Class A ISM Equipment.
• According to IEC 60529:

The footswitch rate IPx8 is suitable for use in surgical rooms.
Probe head (immersible portion) and cable are IPX7. Probe connector is not waterproof.

This product complies with the regulatory requirement of the following:

• Council Regulation 2017/745 concerning medical devices: the CE label affixed to the
product testifies compliance to the Regulation.

The location of the CE marking is shown in the Safety chapter of this manual.

Authorized EU Representative
European registered place of business:
GE Medical Systems SCS
283 rue de la Minière
78530 BUC, France

Authorized Swiss Representative
GE Medical Systems (Schweiz) AG
Europa-Strasse 31
8152 Glattbrugg
Switzerland

• International Electrotechnical Commission (IEC).
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• IEC/EN 60601-1 Medical Electrical Equipment - Part 1: General requirements for
basic safety and essential performance.

• IEC/EN 60601-1-2 Medical Electrical Equipment - Part 1-2: General requirements
for basic safety and essential performance - Collateral Standard: Electromagnetic
disturbances- Requirements and tests.

• IEC/EN 60601-1-6 (Usability), EN ISO 20417 (Information supplied with medical
devices).

• IEC/EN 60601-2-37 Medical electrical equipment - Part 2-37: Particular
requirements for the basic safety and essential performance of ultrasonic medical
diagnostic monitoring equipment.

• IEC 62359 Ultrasonics - Field Characterization - Test methods for the determination
of thermal and mechanical indices related to medical diagnostic ultrasound fields.

• International Organization of Standards (ISO)

ISO 10993-1 Biological evaluation of medical devices.
• ANSI/AAMI ES60601-1 Medical Electrical Equipment - Part 1: General requirements for

basic safety and essential performance.
• Canadian Standards Association (CSA).

CAN/CSA-22.2, NO. 60601-1 Medical electrical equipment - Part 1: General
requirements for basic safety and essential performance.

• CSA 22.2, 601.1 Medical Electrical Equipment - Part 1: General requirements for basic
safety and essential performance.

• Medical Device Good Manufacturing Practice Manual issued by the FDA (Food and Drug
Administration, Department of Health, USA).

Certifications

General Electric Medical Systems (China) Co., Ltd. is ISO 9001 and ISO 13485 certified.

Original documentation

• The original document was written in English.

Country-Specific Approval

Brazil
Registro ANVISA N°: 80071260409
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Authorized Representative in Kazakhstan

Authorized representative in Kazakhstan which is responsible for accepting claims is GE
HealthCare Kazakhstan LLP.

Authorized Representative in Ukraine

Importer Information

Turkiye
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Brazil

Versana Premier/Versana Premier Lotus - User Manual vii
5928218-1EN Rev. 6



viii Versana Premier/Versana Premier Lotus - User Manual
5928218-1EN Rev. 6



Table of Contents

Chapter 1 - Getting Started 

Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

Attention . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

Documentation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Principles of Operation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

Contraindication . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

Patient population . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

Clinical Benefit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

Prescription Device . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .15

Intended Use . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .15

Preparing the System for Use . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

Console Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .19

Peripheral/Accessory Connection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20

Battery . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .21

Gel Warmer (Option) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

Wired Footswitch (Option) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

Control Panel Map . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

Indicator Light (For Versana Premier Lotus only) . . . . . . . . . . . . . . . . . . . . . . . . 30

Physical A/N keyboard (Option) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30

Top/Sub Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31

Touch Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

Monitor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

Moving the system . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38

Before moving the system . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38

Wheels . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

Moving the System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40

Transporting the System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41

System Start-Up . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42

Connecting the System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42

Power On . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44

Versana Premier/Versana Premier Lotus - User Manual i
5928218-1EN Rev. 6



Power Off . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47

Log Off . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47

Standby Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .48

Crash Recovery Instructions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48

Probes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .50

Connecting the Probe . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .50

Cable handling . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51

Activating/Deactivating the Probe . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51

Disconnecting the Probe . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51

Transporting Probes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52

Storing the Probe . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52

Preparing for an Exam . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54

Patient Screen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54

Scanning a New Patient . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62

Entering a Patient List . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .64

Starting a new exam on an existing patient . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65

Scanning without entering any patient data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65

Ending a Patient . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65

Changing Current Patient to Existing Patient (with Patient ID) . . . . . . . . . . . . . . 66

Changing Current Patient to Existing Patient (without Patient ID) . . . . . . . . . . . 66

Delete the existing patient/exam/image . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67

Barcode Reader . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68

Chapter 2 - Performing an Exam 

Optimizing the Image . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74

Optimizing B-Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74

Optimizing M-Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .80

Optimizing Color Flow Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83

Optimizing M Color Flow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86

Optimizing Doppler Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86

Other Controls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .90

Split screen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 93

Freezing an image . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 93

Table of Contents

ii Versana Premier/Versana Premier Lotus - User Manual
5928218-1EN Rev. 6



Activating CINE Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .93

Body Patterns . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 93

Annotating an Image . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .94

Measurement and Analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95

Location of Measurement Controls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95

B-Mode Measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 96

M-Mode Measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 100

Doppler Mode Measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102

Application M&A . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108

Wide Dual Screen Measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 145

Viewing and Editing Worksheets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 146

Clinical Measurement Accuracy . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 147

Chapter 3 - After The Exam Is Over 

Preset . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 152

System Presets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .152

Imaging Presets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 153

Storing Images and Cineloops . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 161

Data Transfer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 163

Image/Data Management . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .171

Configuring Connectivity . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .186

Printing Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 189

Electronic Documentation (Not applicable for China) . . . . . . . . . . . . . . . . . . . . . . . 193

Documentation Distribution . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 193

Using Online Help Via Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 193

Electronic media . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 194

System Care and Maintenance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 196

Expected Service Life Description . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 196

Maintenance Schedule . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 196

Cleaning and Disinfecting the system . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 198

Prevention of static electricity interference . . . . . . . . . . . . . . . . . . . . . . . . . . . . 205

Disposal . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 205

Troubleshooting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 206

Table of Contents

Versana Premier/Versana Premier Lotus - User Manual iii
5928218-1EN Rev. 6



InSite ExC . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 207

eDelivery - Software update . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 215

Assistance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .225

Quality Assurance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .233

Typical Tests to Perform . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .233

Baselines . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 234

Periodic Checks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 235

Results . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 235

System Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 235

Test Procedures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 236

Setting up a Record Keeping System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 241

Ultrasound Quality Assurance Checklist . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 242

Probe Check . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 242

Image Quality Check (IQC) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 248

Privacy and Security . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .249

Potential Hazardous Situations Resulting from Failures of the IT Network . . . .249

Warning . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .249

Contact Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 250

Contacting GE HealthCare Ultrasound . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 250

Manufacturer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .254

Factory Sites . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .255

Chapter 4 - Safety 

Owner Responsibility . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 258

Owner requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 258

Notice against user modification . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 258

Bioeffect Disclosure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 259

Training . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 259

ALARA . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 259

Safety Precautions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 260

Precaution Levels . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 260

Hazard Symbols . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 260

Patient Safety Related Hazards . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 262

Table of Contents

iv Versana Premier/Versana Premier Lotus - User Manual
5928218-1EN Rev. 6



Equipment and Personnel Safety . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .264

Electrical safety . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .269

EMC (Electromagnetic Compatibility) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 270

Patient Environmental Devices . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 281

Acoustic Output . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 282

RoHS Hazardous Substances . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 284

WEEE Passport . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 286

Safe Product and Packaging Disposal . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .286

General Caution . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 286

Device Labels . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 287

Label Icon Description . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 287

Label Locations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .292

Probe Label Explanation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 294

Probe Box Label . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 296

Chapter 5 - Probes and Biopsy 

Probe Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 298

Ergonomics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .298

Cable handling . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 298

Probe orientation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 298

Labeling . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 299

E7C8L-RS Probe Composition . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .299

L4-20t-RS Probe Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 299

Probe Usage . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .300

Care and Maintenance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 300

Covering the Transducer using a Sterile, Protective Sheath . . . . . . . . . . . . . . .315

E7C8L-RS Operation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 316

Probe Safety . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 319

Special handling instructions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 322

Probe handling and infection control . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 323

Special Reprocessing Instructions for E7C8L-RS . . . . . . . . . . . . . . . . . . . . . . . 324

Coupling gels . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 327

Probe Discussion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 329

Table of Contents

Versana Premier/Versana Premier Lotus - User Manual v
5928218-1EN Rev. 6



Application . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 329

Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 330

Specifications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 333

Slice Thickness Specification . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 334

Probe Illustration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .335

Biopsy Special Concerns . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 339

Precautions Concerning the Use of Biopsy Procedures . . . . . . . . . . . . . . . . . . 339

Preparing for a Biopsy . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 341

Displaying the Guide zone . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 341

Preparing the Biopsy Guide Attachment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 343

4D Probe Biopsy Needle Path Selection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 351

Biopsy Needle Path Verification . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 351

The Biopsy Procedure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 352

Post Biopsy . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .352

Chapter 6 - Advanced Features 

Whizz Easy Style . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 355

Activating . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 355

Whizz CF . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 356

Using Whizz CF . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 356

B Flow / B Flow Color (Option) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .358

B Flow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 358

B-Flow Color (BFC) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 360

Stress Echo (Option) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 361

Getting started with a stress study . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 361

Image acquisition . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 363

Continuous Capture mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 365

Post Acquisition Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .371

Analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .372

Editing/Creating template . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 374

Wall Motion Segment Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .380

Utility Application Settings for Protocol . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 381

Reports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 381

Table of Contents

vi Versana Premier/Versana Premier Lotus - User Manual
5928218-1EN Rev. 6



ECG Option . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .383

ECG connecting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 384

To activate ECG Option . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 384

Operation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 385

Patient preparation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 386

Cleaning and Disinfection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .386

Troubleshooting - Noisy ECG Signal . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 388

ECG Trace Monitor Display . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 389

ECG menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 389

Using 3D (Option) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 392

Easy 3D . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 392

3D Acquisition Parameter Description . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 396

Advanced 3D . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 400

Movie 3D . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .403

Elastography (Option) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .404

Activating Elastography . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 404

How to Use . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 405

Additional Notes for Elastography . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 406

Contrast Imaging (Option) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 408

Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 409

Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 409

Relationship with other controls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 413

Time Intensity Curve (TIC) Analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .414

Needle Recognition (Option) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 438

Adjusting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 438

Breast Care . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .443

Prepare the patient information and scanning . . . . . . . . . . . . . . . . . . . . . . . . . . 443

Breast Productivity Package . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 446

Breast Lesion M&A . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .446

BI-RADS (ACR) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 447

Worksheet and Summary Worksheets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .450

Breast Measure Assistant (Auto Contour) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 450

Thyroid Productivity Package . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .452

TI-RADS (ACR) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 455

Table of Contents

Versana Premier/Versana Premier Lotus - User Manual vii
5928218-1EN Rev. 6



Worksheet and Summary Worksheets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .458

Measure Assistant Thyroid (Auto Contour) . . . . . . . . . . . . . . . . . . . . . . . . . . . . 459

Scan Assistant . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 460

Scan Assistant Manager . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .460

Activating the Scan Assistant Creator . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 466

Exporting Scan Assistant Programs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .466

My Trainer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .468

Follow-up Tool . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 470

Follow-up tool configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 470

Follow-up Tool Workflow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 472

Worksheet . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .474

Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 474

QAnalysis (Option) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 476

Activating QAnalysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .476

QAnalysis Screen Description . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 477

Selecting QAnalysis Image Range . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .478

Generating a Trace . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .479

Manual tracking of the sample area (dynamic anchored sample area) . . . . . . 479

Delete a trace . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 480

Manipulating the Sample Area . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 480

Disabling/Enabling the frame . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 483

Smoothing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .484

Horizontal Sweep . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 484

Drift Compensation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .484

Statistics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 485

Trace Measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 485

Exporting Traces (Saving the Trace Data) . . . . . . . . . . . . . . . . . . . . . . . . . . . . .485

Annotating the QAnalysis Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 487

Exiting QAnalysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 487

Whizz Label (Not applicable for China) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 488

Using Whizz Label . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 489

Advanced urology procedures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 492

ERB7/ERB Biopsy Attachment for E7C8L-RS . . . . . . . . . . . . . . . . . . . . . . . . . .492

Biopsy Guideline Type Preset Selection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 493

Table of Contents

viii Versana Premier/Versana Premier Lotus - User Manual
5928218-1EN Rev. 6



E7C8L-RS Grid Biopsy Accessories . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 495

Calibration Procedure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .497

Stepper Volume Measurement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .500

Strain Imaging . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .503

Using Strain . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 505

Optimizing Strain . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 505

Strain rate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 506

Using Strain rate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 507

Optimizing Strain rate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 507

Using 4D . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 508

Features supported with 4D . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 508

4D Principles of Operation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 508

4D Operational Controls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 515

4D Presets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 516

Performing a 4D Scan . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 517

Tomographic Ultrasound Imaging (TUI) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .531

Whizz RenderLive . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .533

Whizz Follicle . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 535

Using Whizz Follicle . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 537

Whizz Follicle Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 538

Whizz Note . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 540

VCO for customer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 544

Outside Hospital version . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .544

Inside Hospital version . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 553

Using VCO for Customer - EClient Side . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 557

Digital Expert Connect . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 558

Intensity Ratio . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 559

Purpose . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .559

Probes and presets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .559

Scan Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 559

Activation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 559

IR Calculation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 559

IR Calculation with Follow Up Tool . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .562

Worksheet and Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 563

Table of Contents

Versana Premier/Versana Premier Lotus - User Manual ix
5928218-1EN Rev. 6



US LI-RADS (ACR) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .564

US Category . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 564

US Visualization Score . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 564

User Requirement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .565

Whizz Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 568

Creating a report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .568

Activating the Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 568

Selecting another template . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .569

Factory Templates . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 569

Whizz Report Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 570

Import Report Template to Ultrasound System . . . . . . . . . . . . . . . . . . . . . . . . . 580

Scan Coach . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 582

Scan Coach Manager . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .582

Activating the Scan Coach Creator . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 588

Scan Coach Creator . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 589

Table of Contents

x Versana Premier/Versana Premier Lotus - User Manual
5928218-1EN Rev. 6



Chapter 1
Getting Started
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Overview

Attention

This manual contains information to operate the system safely. Advanced equipment training
may be provided by a factory trained Applications Specialist for the agreed-upon time period.

Read and understand all instructions in this manual before attempting to use the ultrasound
system.

Keep this manual with the equipment at all times. Periodically review the procedures for
operation and safety precautions.

NOTE
The Online Help offers a quick way for the user to access the manual.

Disregarding information on safety is considered abnormal use.

Not all features, products, probes or peripherals described in this document may be available
or cleared for sale in all markets. Please contact your local GE HealthCare Ultrasound
representative to get the latest information.

Table 1-1 Product model configuration

Model 3P
P

4P
P

5P
P

Fixed
arm

Flexible
arm

21.5
inch
LCD

23.8
inch
LCD

Indicator
Light

Strain Strain
Rate

Versana
Premier VS

✓ O X ✓ O ✓ X X X X

Versana
Premier VA

X ✓ X X ✓ X ✓ X X X

Versana
Premier
Lotus 4PP

X ✓ X X ✓ X ✓ ✓ O O

Versana
Premier
Lotus 5PP

X X ✓ X ✓ X ✓ ✓ O O

NOTE

✓: The feature/configuration is available for current model.
X: The feature/configuration is not available for current model.
O: The feature/configuration is optional for current model.

NOTE
Please note that orders are based on the individually agreed upon specifications and
may not contain all features listed in this manual.

Getting Started
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NOTE
All references to standards / regulations and their revisions are valid for the time of
publication of the user manual.

Documentation

CAUTION
Safety instructions must be reviewed before operating the unit.

Versana Premier/Versana Premier Lotus documentation is provided electronically on the
ultrasound system by pressing Help, by viewing the documentation media via the Service
Desktop, or may be ordered on paper (via H-Cat). Additionally, an electronic Instructions For
Use Kit (eIFU Kit) is shipped with the ultrasound system. The eIFU Kit provides all of the
manuals in all languages.

Table 1-2 Documentation

Publication Translated Available via
Help

Available via
Media in the
eIFU Kit

Available on
Paper (if
purchased)

User Manual
Provides information needed
by the user to operate the
system safely.

Yes (all
required
languages)

Yes Yes Yes

Advanced Reference Manual
Provides Acoustic Output
Data and System
Measurement and Analysis
Tables and Formulas.

English and
French

Yes Yes Yes

Basic Service Manual
Supplies block diagrams,
spare parts, adjustments,
instructions to help qualified
technical personnel repair the
system.

No No Yes Yes

Release Notes
Provides precautions and
instructions that supplement
the User Manual.

Yes No Yes Yes

NOTE
An AIUM Booklet is shipped with systems shipped in the United States and Canada.

Chapter 1
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NOTE
The screen graphics in this manual are only for illustrational purposes. Actual screen output
may differ.

Principles of Operation

Medical ultrasound images are created by computer and digital memory from the
transmission and reception of mechanical high-frequency waves applied through a
transducer. The mechanical ultrasound waves spread through the body, producing an echo
where density changes occur. For example, in the case of human tissue, an echo is created
where a signal passes from an adipose tissue (fat) region to a muscular tissue region. The
echoes return to the transducer where they are converted back into electrical signals.
These echo signals are highly amplified and processed by several analog and digital
circuits having filters with many frequency and time response options, transforming the
high-frequency electrical signals into a series of digital image signals which are stored in
memory. Once in memory, the image can be displayed in real-time on the image monitor.
All signal transmission, reception and processing characteristics are controlled by the main
computer. By selection from the system control panel, the user can alter the characteristics
and features of the system, allowing a wide range of uses, from obstetrics to peripheral
vascular examinations.
Transducers are accurate, solid-state devices, providing multiple image formats. The digital
design and use of solid-state components provides highly stable and consistent imaging
performance with minimal required maintenance. Sophisticated design with computer control
offers a system with extensive features and functions which is user-friendly and easy to use.

Contraindication

The ultrasound system is not intended for ophthalmic use or any use causing the acoustic
beam to pass through the eye.

Patient population

• Age: all ages (including embryos and fetuses)
• Location: worldwide
• Sex: male and female
• Weight: all weight categories

NOTE
Extreme obesity may changes the diagnostic information ability of the device.

• Height: no limitations

Getting Started
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Clinical Benefit

The clinical benefit of a diagnostic ultrasound device is to help healthcare professionals
provide accurate diagnostic information (visualize human tissue/internal structure) that
enhances the diagnostic and treatment care pathways of the patient for a variety of diseases
and conditions.

CAUTION
This machine should be used in compliance with law. Some jurisdictions restrict certain
uses, such as gender determination.

Prescription Device

CAUTION: United States law restricts this device to sale or use
by, or on the order of a physician.

Intended Use

The Versana Premier/Versana Premier Lotus is a general-purpose diagnostic ultrasound
system intended for use by qualified and trained healthcare professionals for ultrasound
imaging, measurement, display and analysis of the human body and fluid.

Indications for Use
The Versana Premier/Versana Premier Lotus is a general-purpose diagnostic ultrasound
system intended for use by qualified and trained healthcare professionals for ultrasound
imaging, measurement, display and analysis of the human body and fluid. Versana
Premier/Versana Premier Lotus clinical applications include: Fetal/Obstetrics, Abdominal,
Gynecology, Urology, Pediatric, Small Parts (includes breast, testes, thyroid), Cardiac
Adult, Cardiac Pediatric, Vascular/Peripheral Vascular, Musculoskeletal Conventional,
Musculoskeletal Superficial, Thoracic/Pleural, Transcranial, Transrectal, Transvaginal,
Transesophageal, Interventional guidance (includes tissue biopsy, fluid drainage, vascular
and non-vascular access).
Modes of operation include: B, M, PW Doppler, CW Doppler, Color Doppler, Color M
Doppler, Power Doppler, Harmonic Imaging, Coded Pulse, 3D/4D Imaging mode and
Combined modes: B/M, B/Color, B/PWD, B/Color/PWD, B/Power/PWD.
Versana Premier/Versana Premier Lotus is intended to be used in a hospital or medical clinic.

Frequency of Use
Daily (Typically 8 hours)

Type of use
Multiple patient multiple use.
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Operator Profile
• Qualified and trained Healthcare professionals, including physicians, sonographers and

equivalent/comparable professions, with at least basic ultrasound knowledge.
• The operator must have read and understood the user manual.

NOTE
Only qualified physicians or sonographers should perform ultrasound scanning on human
subjects for medical diagnostic reasons. Request training, if needed.

Preparing the System for Use

Site Requirements
Do not attempt to install the unit alone. General Electric, Affiliate, or Distributor Field
Engineers and Application Specialists will install and setup the system.
The ultrasound system does not contain any operator serviceable internal components.
Ensure that unauthorized personnel do not tamper with the unit.
Perform regular preventive maintenance.
Maintain a clean environment. Turn off, and if possible, disconnect the system before
cleaning the unit.
Never set liquids on the unit to ensure that liquid does not drip into the control panel or unit.

Before the system arrives
The ultrasound unit must operate within the proper environment and in accordance with
the requirements described in this section. Before using the system, ensure that the
requirements are met.

Power Requirements

• A separate power outlet with a 6.5 amp Supply Mains Switch.
• Frequency: 50/60 Hz
• 100 - 240V AC (± 10%)

Fuse Type and Nominal Value

Type: 0215010.HXP

Factory Tag: LITTELFUSE

Nominal Value: 10A, 250VAC

NOTE
For changing the fuse, please contact GE HealthCare Service.

Electromagnetic interferences

This medical equipment is approved, in terms of the prevention of radio wave interference,
to be used in hospitals, clinics and other institutions which are environmentally qualified.

Getting Started
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The use of this equipment in an inappropriate environment may cause some electronic
interference to radios and televisions around the equipment.

Ensure that the following is provided for the new system:

• Take precautions to ensure that the console is protected from electromagnetic
interference.

Precautions include:

• Operate the console at least 15 feet away from motors, typewriters, elevators, and other
sources of strong electromagnetic radiation.

• Operation in an enclosed area (wood, plaster or concrete walls, floors and ceilings) helps
prevent electromagnetic interference.

• Special shielding may be required if the console is to be operated in the vicinity of radio
broadcast equipment.

CAUTION
Do not operate the system in the vicinity of a heat source, of strong electric or magnetic
fields (close to a transformer), or near instruments generating high-frequency signals, such
as HF surgery. These can adversely affect the ultrasound images.

Environmental Requirements
The system should be operated, stored, or transported within the parameters outlined below.
Either its operational environment must be constantly maintained or the unit must be turned
off.

NOTE
You may get an overheating message with regard to fan speed. Ensure adequate system/
room ventilation.

Table 1-3 System Environmental Requirements (including probes)

Element Operational (with probe) Storage Transport

Temperature 3 ~ 40℃ (without battery)
37.4 ~ 104℉ (without battery)
10 ~ 30℃ (with battery)
50 ~ 86℉ (with battery)

-20 ~ 50℃ (without
probes)
-4 ~ 122℉ (without
probes)
-5 ~ 50℃ (with
probes)
23 ~ 122℉ (with
probes)

-20 ~ 50℃ (without
probes)
-4 ~ 122℉ (without
probes)
-5 ~ 50℃ (with
probes)
23 ~ 122℉ (with
probes)

Humidity 30% ~ 85% non-condensing 10% ~ 90%
non-condensing

10% ~ 90%
non-condensing

Pressure 700 ~ 1060hPa 700 ~ 1060hPa 700 ~ 1060hPa

NOTE
The operational temperature should be 18-30 degree while the system is connecting with
RAB2-6-RS.
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CAUTION
The system cannot be used in OXYGEN rich environment.

CAUTION
Ensure that the probe face temperature does not exceed the normal operation temperature
range.

Operating Environment
Ensure that there is sufficient air flow around the ultrasound unit when installed in a fixed
location.

CAUTION
Do not cover the ventilation holes of the ultrasound system.

CAUTION
The ultrasound system and probe connector are NOT waterproof. Do not expose the device
to water or any kind of liquid.

Getting Started
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Console Overview

NOTE
The graphics of the ultrasound system in this manual are for illustration purpose only, real
system may vary with different configuration.

Figure 1-1 Ultrasound system overview - example

1 LCD Monitor
2 Touch Panel
3 Gel Bottle Holder/Gel Warmer
4 Control Panel
5 Probe Holder
6 Flexible Cable Hook/Cable Hook
7 Printer & DVD Box
8 Body Left and Right Cover

9 Probe Connector
10 Speaker
11 Rear Handle
12 Rear Panel
13 Wheel
14 Flexible Arm / Fixed Arm
15 Back side Accessory Tray (Option)
16 Back side Accessory Box (Option)

NOTE
The console graphics in this manual are only for illustrational purposes. Refer to the system
for actual appearance.

Chapter 1
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Peripheral/Accessory Connection

The ultrasound system peripherals and accessories can be properly connected using the rear
connector panel.

CAUTION
For compatibility reasons, use only GE HealthCare approved probes, peripherals or
accessories. DO NOT connect any probes, peripherals or accessories without approval by
GE HealthCare.

CAUTION
The connection of equipment or transmission networks other than as specified in the user
instructions can result in electric shock hazard. Alternate connections will require verification
of compatibility and conformity to IEC/EN 60601-1 by the installer.

CAUTION
DO NOT touch the patient and any of the connectors on the ultrasound unit simultaneously,
including ultrasound probe connectors. DO NOT touch the conducting parts of the USB,
Ethernet, Video, Audio cables when connecting equipment to the unit.

CAUTION
When using peripheral device, observe all warnings and cautions given in Peripheral
manufacture's manuals.

WARNING
Peripheral devices that use their own AC power source can not be attached to system.

Figure 1-2 Peripheral/Accessory Connector Panel
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Table 1-4 Peripheral/Accessory Connector Panel

No. Electronic interface Description (Interface standards / Data rate)

1 Diagnostic LED 1, 2,
3

System Diagnostic LED

2 Ethernet port RJ45 network Connector, IEEE 802.3 10 Base-T, 100 Base-TX
and 1000 Base-T

3 USB port Type A USB port, USB 3.0, Max 5.0 Gbps, DC5V/500mA

4 HDMI port Video/Audio port, HDMI, 1080P

5 Type-C USB port Type-C USB port, USB 3.0, Max 3.0, Max 5.0 Gbps, DC5V/
500mA

6 Equalization
conductor

The terminal to be used for connecting equipotential conductors
when interconnecting (grounding) with other equipment.

7 Supply Mains Switch Supply Mains Switch

8 AC Inlet AC 100-240V, IEC C13 socket

Battery

The lithium ion battery provides power when an AC power source is not available. A battery
in the battery bay is optional for the ultrasound system. Lithium ion batteries last longer than
conventional batteries and do not require replacement as often. You can expect minimum 20
minutes of battery life with a full charged battery in use to supply power to the system.

NOTE
While scanning with the battery supplying power only, the battery life may be shorter. Always
archive the data and keep your attention on the battery status. When the battery power
is low, charge by connecting to the power source immediately so that scanning is not
interrupted as data could be lost due to the automatic shutdown of the system.

The lithium ion technology used in your system's battery is significantly less hazardous to the
environment than the lithium metal technology used in some other batteries (such as watch
batteries). Used batteries should not be placed with common household waste products.
Contact local authorities for the location of a chemical waste collection program nearest you.

NOTE
The battery is designed to work with this ultrasound systems only. Only use GE HealthCare
recognized batteries.

Where the integrity of external protective conductor in the installation or its arrangement is in
doubt, EQUIPMENT shall be operated from its battery.

WARNING
For safety of the battery, do not expose it to temperature over 60℃ (140℉). Keep it away
from fire and other heat sources.
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Versana Premier/Versana Premier Lotus - User Manual 21
5928218-1EN Rev. 6



CAUTION
The battery may not charge properly if the environmental temperature is below 10℃ (50℉) or
above 35℃(95℉) which may disrupt the power supplied to the system.

Failure to read and follow the battery pack safety instructions and warnings below may result
in personal injury, and property damages.

WARNING
The replacement of lithium batteries or fuel cells by inadequately trained personnel could
result in a hazard.

WARNING

• The battery has a safety device. Do not disassemble or modify the battery pack.

• Excessive vibration outside the final product, puncture, contact with metals, or tampering
with the battery can cause it to fail.

• Do not short-circuit the battery pack by directly connecting the negative terminals with
metal objects.

• Do not keep a battery pack in your pocket, purse, or anywhere together with other metal
(conductive)objects.

• Never use force to install(insert) the battery pack.

• If the battery pack is damaged in any way stop using immediately.

• Immediately discontinue use of the battery if, while using, charging, or storing the
battery, the battery emits an unusual smell, feels hot, changes color or shape, or
appears abnormal in any other way.

• Only use GE HealthCare designated battery packs inside a GE HealthCare system and
or GE HealthCare Charger, never use an aftermarket or non-GE HealthCare authorized
battery pack, if you are unsure, contact GE HealthCare for confirmation.

• The battery contains safety and protection devices, which, if damaged, may cause the
battery pack to fail.

• Do not heat the battery or discard it in a fire.

• Do not charge the battery near a heat source, such as a fire or heater.

• Do not leave the battery in direct sunlight.

• Do not pierce the battery with a sharp object, hit it, or step on it.

• Do not solder a battery.

• Do not connect the battery to an electrical power outlet.

Getting Started
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Battery Storage
In order to ensure the capacity of the battery in the fully-charged state is not less than 80% of
the initial fully-charged state. Need to store the battery at low temperature and low humidity,
no dust and no corrosive gas atmosphere.

• Storage time <= 3 months: 0 - 45℃ (32 - 113℉)
• Storage time <= 12 months: 0 - 23℃ (32 - 73.4℉)
• Humidity: < 65%

WARNING

• If the ultrasound system is not being used on a monthly basis, the battery needs to be
removed during the lengthy non-use period.

• Store in a cool, dry place. Never store or charge batteries in extreme temperatures, such
as a hot car; near heat sources or fire; in pressurized or very cold environments.

CAUTION

To avoid the battery bursting, igniting, or fumes from the battery causing equipment damage,
observe the following precautions:

• Exposure to liquids can cause internal corrosion or damage to the cells or to the Battery
Management System (BMS). The BMS protects the battery from overcharging, high self
discharge, or imbalanced charging of the cells, any of which can present the possibility
of hazards during charging or use.

• Do not immerse the battery in water or allow it to get wet.
• Do not put the battery into a microwave oven or pressurized container.
• If the battery leaks or emits an odor, remove it from all possible flammable sources.
• If the battery emits an odor or heat, is deformed or discolored, or in a way appears

abnormal during use, recharging or storage, immediately remove it and stop using
it. If you have any questions about the battery, consult GE HealthCare or your local
representative.

Discharge/Charge Cycle
When the battery is stored for three months or more, the customer should perform one full
discharge/charge cycle.

NOTE
A full discharge/charge cycle means the system is turned on using battery power until the
battery loses its charge completely and the system shuts down. Plug the ultrasound system
in until the battery is fully charged as indicated by a green LCD light.

Upon receipt of the ultrasound system and before first time usage, it is highly recommended
that the customer perform one full discharge/charge cycle.

If the battery has not been used for >2 months, the customer is recommended to perform one
full discharge/charge cycle. It is also recommended to store the battery in a shady and cool
area with FCC (full current capacity).
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One Full Discharge/Charge Cycle Process:

1. Full discharge of battery to let the ultrasound system automatically shut down.
2. Charge the ultrasound system to 100% FCC (full current capacity).
3. Discharge of ultrasound system for complete shut down (takes one hour for discharge).

When storing packs for more than 6 months, charge the pack at least once during the 6
month timeframe to prevent leakage and deterioration in performance.

WARNING

• After the battery is fully discharged, do not leave it fully discharged, charge battery as
soon as possible.

• Only charge battery packs in authorized GE HealthCare devices or chargers, never use
a third-party charger.

• Avoid unattended charging of battery packs, or where objects such as carpet, furniture,
wood, vinyl floors, curtains or other flammable objects are nearby.

Safe Use
Follow below instruction to ensure safe use and adequate maintenance of rechargeable
battery.

1. Regularly check the appearance of the cell to see if there is no abnormal deformation
(bulge) etc.

2. Check the battery interface to see if there is no foreign body and deformation.
3. Regularly charge the battery if the system is not in use.

View current battery status

When the system is running on battery, there is a battery icon  displayed in the system
status bar.
Total battery power remaining is shown on the battery icon. When there is no battery, the AC

plug icon  is displayed in the system status bar.

Getting Started
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Select the battery icon and the following information window appears:

Figure 1-3 Battery Status Message

a -Battery charging: - This field displays the current power source: AC power and Battery.

• When the battery is in use, this field displays the current power remaining capacity.
• When there is no battery, "No Battery" appears.
• When the battery is not in use, this field displays current capacity (charging...).

b -remaining %: - This field displays the current power remaining percentage.
When there is no battery, "0" appears.

If the battery is not in use, the battery icon  appears as being charged in the system
status bar.

Battery power low warning
If the battery is in use and the battery power is lower than 40%, a warning message appears
to warn the user that the battery power is low.

A red warning message "The battery is low, please charge your battery immediately" will
display on the main screen.

When the estimated current power is lower than 30%, a warning will display on the screen to
warn that the system is about to shut down.

NOTE
When the battery power is low and the user cannot charge the battery in time, the system
automatically shuts down. This protects the whole system. You need to charge the battery
by connecting to power source immediately before the system shuts down or you may lose
useful information.
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Gel Warmer (Option)

Gel Warmer is used for heating the gel to provide a comfortable scanning environment. There
are 2 temperature level on the gel warmer.

Figure 1-4 Gel Warmer Temperature Option

When the setting is on Level I, the temperature is 28 degree; When the setting is on Level II,
the temperature is 38 degree. The LED light will be on no matter the gel warmer is set on I or
II.

NOTE
In order to protect patient safety, the highest temperature for gel should be less than 41
degree.

Wired Footswitch (Option)

You can attach the Footswitch to the system by connecting it to one of the USB port on the
rear of the system.

Getting Started
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CAUTION
To avoid damage of the cable, keep the cable away from the wheels. Disconnect the
Footswitch before moving the system.

Figure 1-5 Footswitches

1. 1 Pedal Type Footswitch
2. Footswitch MKF 2-MED USB GP26
You can configure the function of Footswitch from the Utility > Application > Settings >
Footswitch.

NOTE
For single footswitch, please use Middle to do setting.

CAUTION
When using the Footswitch, DO NOT hold down the footswitch pedal. Press and release the
Footswitch pedal. Pushing and holding down the pedal behaves the same way as pushing
and holding down a key on the keyboard.
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Control Panel Map

Controls are grouped together by function for ease of use. See the callout for this figure.

Figure 1-6 Control panel map - example

1. Probe and Gel Holders
2. Touch Panel
3. Power On/Off
4. Menu knobs
5. User Configurable keys
6. Quad, Single, Dual keys
7. Assistant key
8. M Mode/X
9. CW key

10. PW Mode/Y
11. PDI
12. CF Mode/Z
13. 3D/4D
14. B Mode key
15. Depth
16. Ellipse/Zoom key
17. Whizz key

18. Cursor
19. Clear key
20. Measure key
21. Body Pattern key
22. Comment key
23. Print key
24. Freeze key
25. Trackball, Trackball Keys

NOTE
The factory default settings can be modified in Utility > System > User Configurable Key.
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Control panel adjustment
CAUTION
To avoid injury or damage, make sure nothing is within the range of motion before moving
the control panel. This includes both objects and people.

The control panel position can be adjusted for easy viewing and ease of use.

To raise/lower the Control panel

1. Grab and hold the Up/Down lever under the control panel.

Figure 1-7 Up/Down lever

2. Pull up or push down forcefully to adjust the height of control panel.
3. Release the lever at the desired height.

NOTE
If the control panel is adjusted after a long period or for the first time, it may need more
strength and produce some noise. It will become smoothly and easily after several times.

To swivel the Control panel

1. Grab the swiel lever under the control panel and hold it to swivel the control panel.
2. Release the lever at the desired position.
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Indicator Light (For Versana Premier Lotus only)

Figure 1-8 Indicator Light

There is an indicator light on the control panel to indicate the system status.
White - System is in normal working status.
Blue - System is in standby status.
Yellow - System is in low battery status.

Physical A/N keyboard (Option)

Physical A/N keyboard is under the control panel. User can push the keyboard to project
forward.

Figure 1-9 Push the Physical A/N keyboard

The standard alpha-numeric keyboard has some special functions.
Table 1-5 Special Key Function

Keyboard key Function

Esc Exit current display screen.

Help Access Online help/user manual.
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Keyboard key Function

Arrow Annotation Arrow.

Eject Eject media.

Spooler Activates DICOM Job Spooler screen.

Macro Creates a Fast Key.

Macro Plays a Fast Key.

Home Move annotation cursor to home position; shift+key to set current
annotation cursor position as the new home position.

Text Overlay Switch between user text annotation overlays.

Grab Last Activate the last selected data for edit.

Word Delete Erase word associated with comment cursor.

Prt Scr Print Screen.

Fn + Left/Right Keys Adjust audio volume.

Fn + Up/Down Arrow Keys Adjust brightness.

If you encounter a problem and cannot collect the logs immediately:
Table 1-6 Key for Collecting the Log

Keyboard key Function

Alt+1 or Alt+2 Place a marker in the log.

Alt+D Collect the logs.

Once the logs are collected, the service representative would be able to see the marker you
added which will help to troubleshoot the problem.

Top/Sub Menu

The Top/Sub Menu contains exam function and mode/function specific controls.

Figure 1-10 Top/Sub Menu controls

The Top/Sub Menu contains adjustable knobs associated with it. The adjustable knobs are
used to adjust the selected function. For example, to increase or decrease frequency, turn
the knob clockwise or anticlockwise; the paddle switches are used to access and adjust the
menu. The functionality of these controls change depending upon the currently displayed
menu.
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Touch Panel

The touch panel contains exam function, mode/function specific controls, digital keyboard,
Digital TGC and Fifth Column for quick access.

Figure 1-11 Touch Panel

Table 1-7 Touch Panel controls

No Name Description

1 Patient Press to enter new patient information.

2 Probe Press to select appropriate probe.

3 Report Press to generate report.

4 End Exam Press to end current exam.

5 Digital TGC Press to activate digital TGC.

6 Digital Keyboard Press to activate digital keyboard.

7 Brightness Press to adjust Display, Touch Panel, Control Panel
brightness.

8 Sound Adjustment Press to adjust volume.
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No Name Description

9 User Defined Gesture Press to view user defined gesture configuration.
User can configure the gesture by going to Utility >
System > User Defined Gesture.
User can configure Screen Clean Mode under User
Defined Gesture for cleaning the Touch Panel.

10 Utility Press to enter Utility.

11 Fifth Column Swipe the fifth column with one finger from right
to left/left to right to change user configured preset
page (Frequent Presets/Recent Presets/Customized
Presets).

Digital Keyboard
User can use digital keyboard on the Touch Panel.

NOTE
Digital keyboard supports the same key combinations as the physical keyboard.

User can press the icon on the right upper corner of the Touch Panel to activate digital
keyboard.

Figure 1-12 Activate digital keyboard
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User can press the icon on the right bottom to exit digital keyboard.

Figure 1-13 Exit digital keyboard

Digital TGC
User can adjust TGC by activating digital TGC on touch panel, refer to Figure 1-11 Touch
Panel on page 32.
Digital Longitudinal Gain Compensation (Digital TGC) amplifies the returned signal to correct
for the attenuation produced when the beam penetrates tissue. Digital Longitudinal Gain
Compensation (Digital TGC) balances the image so that the density of echoes is evenly
distributed across the image. It enables the user to adjust B-mode gain compensation in the
longitudinal direction.

Figure 1-14 Digital TGC
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Table 1-8 Digital TGC controls

No Name Description

1 Standard Presets Quick access to standard presets.

2 User Defined Presets User can press and hold a button to save current
user defined preset.

3 Touch TGC Touch area for TGC adjustment.

4 Exit Press to exit digital TGC.

Monitor

Monitor Display

Figure 1-15 Monitor Display Tour
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1. Institution/Hospital Name, Date, Time,
Operator Identification

2. Patient Name, Patient Identification
3. Power Output Readout
4. Probe Identifier. Exam Preset
5. Caps Lock: (lit when on), network

connection indicator, system messages
display, InSite status, InSite controls

6. Current date and time
7. Active Images screen
8. Delete Image
9. Save As Menu
10. Slide Show
11. Follow Up
12. Image Preview
13. Trackball Controls and Status

14. Image Clipboard
15. Measurement Window
16. Gray/Color Bar
17. Measurement Results Window
18. Measurement Calipers
19. Region of interest
20. Focal Zone Indicator
21. Imaging Parameters by Mode
22. Body Pattern
23. User Configurable Keys
24. P1, P2, P3 keys
25. Cine Gauge
26. Depth Scale
27. 6Tc-RS Probe temperature display
28. 6Tc-RS Probe angle display

To adjust the Monitor Position
The monitor can be swiveled and tilted.

Hold the bottom of the monitor when you adjust the position of the monitor.

Figure 1-16 Hold the bottom of the monitor
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CAUTION
When flipping up the monitor from the flip down status, you can hold the upper corner of the
monitor.

CAUTION
To avoid injury or damage, make sure nothing is within the range of motion before moving
the monitor. This includes both objects and people.

Adjust Monitor by Software

1. Press Cursor key on the control panel. Move the trackball to position the cursor over the
adjustment icon, then press Set to display the setting menu.

Figure 1-17 Adjust Monitor by Software

2. Adjust the Color Temperature, Contrast and Brightness by moving the trackball and
using Set key.

3. Press Exit to exit the setting menu.

NOTE
Press Reset button can reset the three color temperature settings to default.
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Moving the system

Before moving the system

When moving or transporting the system, follow the precautions below to ensure the
maximum safety for personnel, the system, and other equipment.

CAUTION
When the system is not in use AND/OR before moving/transporting the system, make sure
the monitor is flipped down to prevent system damage.

CAUTION
This product is not to be used on transport vehicles (e.g. ambulances, aircraft).

CAUTION
Handle carefully. A drop of more than 5 cm can cause mechanical damages.

1. Adjust the LCD monitor and control panel to their lowest positions. Flip down the LCD
monitor before moving the system.
WARNING
Avoid injuring hands or fingers when adjusting the arm of monitor and adjusting the
control panel.

WARNING
Avoid pinching hands and fingers during moving the system.

2. Press the Power On/Off switch to power off the system.
3. Unplug the power cord.
4. Wind the power cable around the cord hooks.

NOTE
To prevent damage to the Power Cord, DO NOT pull excessively on the cord or make
sharp bends while wrapping.

5. All cables from off-board peripheral devices and the ethernet connection must be
disconnected from the console.

6. Ensure that no loose items are left on the console.
7. Connect all probes to be used while off site. Ensure that probe cables are out of the

way from the wheels and not protruding beyond the console. Use the probe management
hooks located below the Control Panel to further secure the probe cables.

8. Store all other probes in their original cases or in soft cloth or foam to prevent damage.
9. Store sufficient gel and other essential accessories in the provided space.
10. Disconnect the footswitch from the console.
11. Unlock the wheels.
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Wheels

Examine the wheels frequently for any obvious defects that could cause them to break or
bind.

All the four wheels have independent brake pedals.

Figure 1-18 Wheel lock

1. Locked: Press the ON brake to lock the caster wheels.
2. Unlocked: Press the OFF brake to unlock the caster wheels.

MOVING HAZARD
Never move the system with locked wheels.

CAUTION
When two or more people are releasing the wheel controls with the front and rear wheels,
take extra precaution to prevent unexpected movement which could result in possible toe
injuries.

CAUTION
If you use/park the system on an incline, you MUST use the brakes on the wheel.
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Moving the System

1. Always use the handles to move the system.
NOTE
User can choose front or rear handle to push the system for better sight and safety.

2. Take extra care when moving the system long distances and on inclines. Ask for help if
necessary.

NOTE
Use two or more people to move the system on inclines or long distances. Failure to
follow instructions could lead to possible injury and/or equipment damage.

Avoid ramps that are steeper than ten degrees to avoid tipping over the system. Utilize
additional care and personnel when moving on a steep incline (>5 degrees) or loading
the system into a vehicle for transport.

NOTE
Wheel chair ramps are usually less than five degrees.

CAUTION
DO NOT attempt to move the console using any cables or fixtures, such as the probe
connectors.

3. Use the foot brake (pedal), located on the bottom of the system in the front, when
necessary.

4. Do not let the system strike walls or door frames.
5. Use extra care when crossing door or elevator thresholds.
6. Once the destination is reached, lock the wheels.

CAUTION
The system weighs less than 45 kg (99.2 lbs.), without any probes or peripherals. To avoid
possible injury and equipment damage:

• Be sure the pathway is clear.
• Limit movement to a slow careful walk.
• Use two or more persons to move the system on inclines or long distances.

CAUTION
DO NOT attempt to move the system with the monitor by pulling cables or belts placed
around the monitor and/or monitor arm.

Do not put your whole body weight on the foot-rest holder.
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Transporting the System

Use extra care when transporting the system using vehicles.

In addition to the instructions used when moving the system, also perform the following:

1. Before transporting, place the system in its special storage case.
2. Ensure that the system is firmly secured while inside the vehicle.
3. Secure the system with straps or as directed otherwise to prevent motion during

transport.

CAUTION
Remove all peripherals from the console before transportation.

Load the system onto a vehicle

1. Only use vehicles that are designed for transport of the ultrasound system.
2. Load and unload the system to a vehicle parked on a level surface.
3. Ensure that the transporting vehicles can handle the weight of the system plus the

passengers.
4. Ensure that the load capacity of the lift is capable of handling the weight of the system.
5. Ensure that the lift is in good working order.
6. Secure the system while it is on the lift so that it cannot roll. Use either wood chocks,

restraining straps, or other similar types of constraints. Do not attempt to hold it in place
by hand.

7. Employ two or three persons to load and unload safely from a vehicle.
8. Load the unit aboard the vehicle carefully and over its center of gravity. Keep the unit still

and upright.
NOTE
Do not lay the unit down on its side.

9. Ensure that the system is firmly secured inside the vehicle.
NOTE
DO NOT restrain the Versana Premier/Versana Premier Lotus at the monitor or
the monitor neck using a belt.

10. Prevent vibration damage by driving cautiously. Avoid unpaved roads, excessive speeds
and erratic stops or starts.

Chapter 1

Versana Premier/Versana Premier Lotus - User Manual 41
5928218-1EN Rev. 6



System Start-Up

Connecting the System

To connect the system to the electrical supply:

1. Ensure that the wall outlet is the appropriate type.
2. Ensure that the power switch is turned off.
3. Unwrap the power cable. Make sure to allow sufficient slack in the cable so that the plug

is not pulled out of the wall if the system is moved slightly.
CAUTION
Use the appropriate power cord provided by or designated by GE HealthCare.

4. Attach the power plug to the system, and then install the power cable bracket (b). Ensure
the power plug is placed securely in power cable bracket.

Figure 1-19 Supply Mains Switch and Power Plug

5. Push the power plug securely into the wall outlet.

NOTE
Do not use an extension cord or adapter plug.

6. Switch ON the Supply Mains Switch (a).The On/Off button on the control panel
illuminates blue, indicating that the system is in standby mode.

WARNING

To avoid risk of fire, the system power must be supplied from a separate, properly rated
outlet.
Under no circumstances should the AC power plug be altered, changed, or adapted to a
configuration rated less than specified. Never use an extension cord or adapter plug.
To help assure grounding reliability, connect to a "hospital grade" or "hospital only" grounded
power outlet.

CAUTION
To ensure that the power cable does not disconnect during system use. If the system is
accidentally unplugged, data may be lost.
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WARNING

Failure to provide an adequate earth circuit can cause electrical shock, resulting in serious
injury.
Connection of additional protective earth conductors or potential equalization conductors
is not necessary in most cases and is only recommended for situations involving multiple
equipment in a high-risk patient environment to provide assurance that all equipment is
at the same potential and operates within acceptable leakage current limits. An example
of a high-risk patient would be a special procedure where the patient has an accessible
conductive path to the heart such as exposed cardiac pacing leads.

CAUTION
Only connect ultrasound system and mains-operated accessories to the appropriate wall
outlet. DO NOT connect them to a single or multiple socket outlets, an extension cord, power
strip or an adapter plug.

WARNING
To avoid the risk of electric shock, this equipment must only be connected to a supply mains
with protective earth.

Figure 1-20 Example Plug and Outlet Configurations

1. 100-120 VAC, 10A Plug and Outlet Configuration
2. 220-240 VAC, 10A Plug and Outlet Configuration

NOTE
Country-specific power cords are currently available for Argentina, Australia/New Zealand,
China, Denmark, India/South Africa, Switzerland, United Kingdom, Europe, USA, Israel,
Brazil and Japan.

Voltage level check
Check the rating label on the rear side of the system. Check the voltage range indicated on
the label.

Connecting to the electrical outlet
WARNING
POWER OUTAGE MAY OCCUR. The ultrasound unit requires a dedicated single branch
circuit. To avoid circuit overload and possible loss of critical care equipment, make sure you
DO NOT have other equipment operating on the same circuit.
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CAUTION
Disconnect the power plug from the wall outlet or press the Power On/Off switch to turn the
power off in case an emergency should occur. Ensure easy access to the power plug and
the Power On/Off switch.

Supply Mains Switch
The Supply Mains Switch is located at the rear panel of the system. On supplies main power
to all internal systems. Off removes main power from all internal systems.

Figure 1-21 Supply Mains Switch (located on the rear panel)

The Supply Mains Switch should stay in the On position; DO NOT hold the switch in the On
position. If the Supply Mains Switch remains On, follow the Power On procedure.

1. On position
2. Off position

NOTE
If the Supply Mains Switch does not remain in the On position or trips again:

1. Disconnect the Power Cable.
2. Call Service immediately.

DO NOT attempt to use the system.

Power On

CAUTION
Press the Power On/Off switch to turn the power on. The Supply Mains Switch must also be
in the on position. For Supply Mains Switch location, see Supply Mains Switch on page 44
for more information.

After the Supply Mains Switch is on, the LED light at the bottom of the monitor is lit and the
Power On/Off switch illumination turns to white.
After a successful boot-up process, the Power On/Off switch illumination turns from white to
green, the keyboard backlight is lit.
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To turn on the system

1. Ensure that the unit is properly plugged into an AC outlet of sufficient capacity.
2. Turn on the breaker at the back of the system
3. Momentarily press the On/Off switch. After powered on successfully, the Power On/Off

switch illumination is turned from white to green.
4. The system should now go through its boot-up process with no further user intervention.

Power Up Sequence
The system is initialized. During this time:

• The system boots up and the status is reflected on the monitor.
• Probes are initialized for immediate operation.
• Peripheral devices are activated on power up.

CAUTION
Please check that system date and time are correct after system is powered on.

After initialization is complete, controls on the Control Panel backlight and the default B-Mode
screen is displayed on the monitor (if a probe is connected).

Login
Personal IDs and associated passwords can be preset on the ultrasound system.
If the User Auto Logon preset is blank, you are prompted to login.

Figure 1-22 Operator Login Window
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1. Operator: Select the Operator.
2. Password: Enter Operator's password (optional).
3. Select OK or Cancel.

• OK: Standard logon
• Cancel: Cancel logon

NOTE
This ultrasound system Local Disk is encrypted by default. The user will be notified to
complete encryption process by changing password and saving the recovery keys. If
user did not complete this process, a warning message will appear each time the user
logs in as an administrator (ADM).

Figure 1-23 Warning message for product encryption

Please navigate to Utility > Admin > System Admin > Disk Encryption to complete
this process. For the detail information, please refer to Basic Service Manual.

4. Reset Logon Accounts To Factory Default (Reboot needed): Plug in SSA Dongle to
reset Logon accounts.

If the user wants to skip the Login procedure, please check the Use Auto Logon preset from
Utility > Admin > Logon.

Check System Date and Time
A warning message Please check the system date and time are correct. appears on the
screen when the system is powered on. This warning message appears for the possible
reasons:

• The system is not boot up for over 14 days.
• The system time has been changed by 24 hours earlier than the current system time of

last boot-up.

A warning message pop out to remind the user to check the system date in case the system
date and time is incorrect.
Move the cursor to OK and press Cursor key on the control panel to select OK. The system
enters scanning mode.
Check the system date and time. If it is incorrect, follow below steps to reset the system date
and time.

1. Enter Utility > System > General > Date/Time.
2. Reset the system date and time.
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3. Select Apply and then select OK.
4. Select Save.

Power Off

To power off the system:

1. When you shutdown the system, enter the scan screen and lightly press the Power
On/Off switch on control panel once. The System-Exit window is displayed.
NOTE
DO NOT press and hold down the Power On/Off switch to shutdown the system.

2. Using the Trackball, select Shutdown.

The shutdown process takes a few seconds and is completed when the Power On/Off
switch illumination turns from green to white.

NOTE
DO NOT select Exit for shutdown. Exit is only available to service representative.

NOTE
If the system has not fully shut down in 60 seconds in the power-off sequence, press
and hold down the On/Off switch until the system shuts down.

3. Disconnect the probes.

Clean or disinfect all probes as necessary. Store them in their shipping cases or another
appropriate probe storage system to avoid damage.

NOTE

DO NOT turn off the Supply Mains Switch before the monitor display turns off.
Data may be lost or system software damaged if the Supply Mains Switch is
turned off before the system shuts down.

4. Disconnect the power plug from the power outlet.

Log Off

To Logoff,

1. Press the On/Off switch momentarily and a System Exit window appears.
2. Press the Log Off switch to logoff current user account.

Press the On/Off Switch to fast boot up.

NOTE
If the user logoff the system, system will not save user configuration when log in next time.
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Standby Mode

To activate Standby Mode:

1. Press the Power On/Off switch and select Standby.
2. A warning message display to ask user saving data before entering standby mode.

Select OK to continue or select Cancel to return to system logon status.
3. The system will turn off all backlight and disable all keys (Function Keys, A/N keys,

Trackball) except On/Off switch.
NOTE
The backlight of On/Off switch will flash slowly to indicate that system is in standby
mode.

Press the On/Off Switch to fast boot up.

CAUTION
Low battery can cause system power off during Standby Mode. If the fast boot up failed,
please plug in AC power and try again.

Crash Recovery Instructions

In cases where the system detects an internal error, the system may reboot on its own.
If this happens, the system automatically returns to the start-up screens. All images and
measurements, except for generic reports, are preserved in the system.

The system automatically ends the current exam and permanently store all the images and
measurements. When the system reboots, check that all images and measurements have
been preserved in the system. Then, simply hold down the power switch to initiate a normal
power down sequence.

NOTE
If the image is not updated properly when the system is up, shut down the system again.

NOTE
Generic reports are not saved if the system crashes before you save it.

WARNING
A system crash may cause internal SSD (Solid State Disk) corruption. Avoid using the
internal SSD as a permanent storage device. Backup data on a regular basis.

Database Protection Mechanism
Abnormal shutdown, such as power outage, has the risk to cause database corruption.
Reboot the system after abnormal shutdown. The below dialog box displays when the system
visits damaged database. Press OK, then the system restores the database which have been
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backuped most recently in the normal condition. The data occurred since last time of normal
store and normal shutdown may lost.

Chapter 1

Versana Premier/Versana Premier Lotus - User Manual 49
5928218-1EN Rev. 6



Probes

Connecting the Probe

Only use approved probes.

CAUTION
Inspect the probe before and after each use for damage or degradation to the housing, strain
relief, lens, seal, cable and connector. DO NOT use a transducer which appears damaged
until functional and safe performance is verified. A thorough inspection should be conducted
during the cleaning process.

CAUTION
Remove any dust or foam rests from the probe pins.

CAUTION
Fault conditions can result in electric shock hazard. Do not touch the surface of probe
connectors which are exposed when the probe is removed. DO NOT touch the patient when
connecting or disconnecting a probe.

Probes can be connected at any time, regardless of whether the console is powered on or
off.
To connect a probe:

1. Place the probe's carrying case on a stable surface and open the case.
2. Carefully remove the probe and unwrap the probe cord.
3. Put the probe in the probe holder.

CAUTION
DO NOT allow the probe head to hang free. Impact to the probe head could result in
irreparable damage.

4. Hold the probe connector horizontally with the cable pointing upward.
5. Slide the connector lock to the left (unlocked position).
6. Insert the connector into the probe port and slide the connector lock to the right position

to lock the probe connector.
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NOTE
For the straight connector, please connect to the side port as illustrated on Figure 1-24
Lock the probe connection on page 51.

Figure 1-24 Lock the probe connection

7. Wrap the probe cables around the probe cable hooks under the control panel. Ensure
the probe cables are wrapped properly, not extended beyond sides of console.

Cable handling

Take the following precautions with probe cables:

• Keep free from wheels.
• Do not bend the cable acutely.
• Avoid crossing cables between probes.

Activating/Deactivating the Probe

To activate the probe, select the appropriate probe from the probe indicators in Probe screen.

To deactivate the probe, select another probe or press Freeze key to enter into freeze mode.

The probe's default settings for the mode and selected exam are used automatically.

CAUTION
Make sure that the probe and application names displayed on the screen correspond to the
actual probe and application selection.

Disconnecting the Probe

Probes can be disconnected at any time. However, the probe should not be active when
disconnecting the probe.
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1. Deactivate the probe.
2. Slide the connector lock to the left position to unlock the probe.
3. Pull the probe connector straight out of the probe port carefully
4. Ensure the cable is free.
5. Be sure that the probe head is clean before placing the probe in its storage box.

Transporting Probes

Transport and store the ultrasound probes covered as needed and secured.

When transporting a clean or dirty ultrasound probe, ensure the probe is protected from cross
contamination and possible damage. This can include the use of covers per the appropriate
disinfection/contamination level, and the use of rigid containers or the probe holder on the
ultrasound unit to secure.

NOTE
Do not use cloth or plastic bags to transport probes. This could result in damage to the
probes.

When using a rigid transport case, such as the shipping container or a transport case, ensure
that the probe is clean, and avoid damage to the probe by allowing nothing to protrude
beyond the case when closing the lid, and secure the system connector in place so as not to
damage the transducer head or lens.

• Secure the probe in its holder for moving short distances.
• When transporting a probe a long distance, store it in its carrying case.

WARNING
Placing an uncovered dirty or contaminated probe in a carrying case or shipping carton will
contaminate the foam insert.

CAUTION
Avoid rapid and extreme temperature changes.

Storing the Probe

Prior to storage, it is essential to ensure the probe is completely clean and dry following
disinfection.

If the probe is not immediately reused, store the probe in a manner that will protect and
keep the probe from being re-contaminated. This may be accomplished by placing the probe
lens upward on a wall mounted rack, probe holder on the ultrasound system, or in a storage
cabinet with filtered air flow, using a disposable storage cover placed over the probe when
needed. Avoid dangling the probe to prevent contact damage. For endocavitary probes, the
optional horizontal probe holder mounted on the ultrasound machine can be used.

Do not use the shipping case or any closed container for other than short term transportation
or shipping.
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CAUTION
Avoid lengthy exposure of the probe to direct sunlight or to a strong ultraviolet light source.

It is recommended that all probes be stored in the provided carrying case for probe storage.

When storing a probe in the carrying case:

1. Place the probe connector into the carrying case.
2. Carefully wind the cable into the carrying case.
3. Carefully place the probe head into the carrying case. DO NOT use excessive force or

impact the probe head.

CAUTION
DO NOT store probes in the side tray. To avoid damage, store the probe in its carrying case.
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Preparing for an Exam

Patient Screen

User can go to Utility > System > General > Patient Workflow (restarted needed) to select
Traditional or Simplified patient workflow.
Press the Patient key on the control panel to display the Patient Screen on the monitor.

• Enter Patient Data with the alphanumeric keyboard.
• To navigate through the Patient Entry menu, use the Tab key or Trackball and Set to

move and fix the cursor.

Patient Screen - Traditional

Figure 1-25 Patient Screen - Traditional

Table 1-9 Patient Screen - Traditional

No. Function Description

1. Image Management • Patient - Provides a search and creation of patient.
(currently selected).

• Image History - Provides a list of images per exam for the
currently selected patient.

• Active Images - Provides image preview of the currently
selected exam.

• Data Transfer - Provides an interface to handle patient
data from a remote device.
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No. Function Description

2. Function Selection • New Patient - Used to clear patient entry screen in order to
input a new patient's data into the database.

• Register - Used to enter new patient information into the
database prior to the exam.
NOTE
If you are using the auto-generate Patient ID feature,
do not select Register. It is always a good practice to
Register all patients.

• Details - Select the Details box to activate/deactivate the
exam details. The Exam Description pull-down selection is
used as the DICOM identifier.

3. EZBackup/EZMove • EZBackup - One-step method to backup patient images to
an external media.

• EZMove - Move and delete patient images.

4. Dataflow Selection Select archive and other pre-defined services.
If you use a DVD-R, select DICOM CD Read in Dataflow.
If you place the cursor on the icon, the pop-up menu displays
disk capacity.

5. Scan Used to exit Patient Menu and enter scanning screen.

6. Patient Information • Patient ID Number (User cannot re-edit ID after once
edition.)

• Other ID Number. The system now allows you to enter a
second identification number for the same patient, which
may be required in certain countries.

This is only displayed if enabled on the Utility > Connectivity >
Miscellaneous screen.

• Patient Name-Last, First and Middle
• DOB (Birthdate)
• Age (automatically calculated when birthdate is input)
• Gender

7. Category Selection Select from 10 exam application categories.
When a category is selected, the measurement and category
presets are displayed.

8. Exam Information Shows the Current/Active Exam information. Information
pertinent to the selected exam category appears in the window.
All possible information needs to be entered.

• Clear-Clears existing data.
• Past Exam (only for OB)-Input past exam data (register the

patient before using).

9. Patient View/Exam
View

Display either patient or examination list.
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Patient View

Figure 1-26 Patient View

Table 1-10 Patient View

No. Function Description

1. Patient View List the patients in the database.
When you double-click the patient on the patient list using the
Set key, the Review screen or New Exam entry screen displays
depending on the preset. You set this preset via Select Review
or New Exam in Utility > Connectivity > Miscellaneous > Double
click on patient list to start preset.

2. Search key Select a search criteria.
NOTE
Criteria "Img. Archived" means that the exam was backed up
to external media by EZBackup or Export.

3. String Enter appropriate information for search criteria.
NOTE
If you select Locked (Y, N) or Archived (Y, N) for the Search
key, enter Y (Yes) or N (No).

4. Clear Clears the entered string.

5. Hide Hide the patient view.

6. Review Highlight the patient and press Review. Exam view is
displayed..
NOTE
If the selected patient has a Current Exam or the selected
exam is the Current Exam, the Review button changes to
"Resume Exam" on Patient List.
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No. Function Description

7. New Exam Creates a new exam based on a current or searched patient.

8. Delete Deletes Patient/Exam.
NOTE
"Delete" is only displayed when you login as Administrator.

9. Lock/Unlock Locks the exam/patient. Prevents move and delete functions.
If you select the patient, all exams are locked. If you select one
exam, the selected exam is locked and the lock icon displays in
the patient ID cell.

10. Listing XX of XXX Displays the quantity of patients in the search window and the
quantity of patients in the database.

Exam View

Figure 1-27 Exam View

Table 1-11 Exam View

No. Function Description

1. Exam View The system can display the Detail Mode instead of Exam View
when you double click the patient in the patient list or select the
patient in the patient list and then select Details. If the Detail
Mode preset on Utility > Connectivity > Miscellaneous menu is
selected, the Detail Mode displays.

2. Disk Displays the disk name on which you saved the exam's image
data. If "+" displays behind the disk name, the data is saved on
two or more disks.

3. Delete Exam Delete one or more exams from Exam View.
NOTE
"Delete" is only displayed when you login as Administrator.

4. Send To Send the images to the DICOM Device.
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Patient Screen - Simplified

Figure 1-28 Patient Screen - Simplified

Table 1-12 Patient Screen - Simplified

No. Function Description

1 Patient • New Patient - Provides creation of patient.
• New Exam - Creates a new exam based on a current or

searched patient.
• Detail - Used to check the detail of patient information and

exam information.
• Report - Used to enter report of current exam.

2 Function Selection • Scan - Used to exit Patient Menu and enter scanning
screen.

• End Exam - Used to end current patient.
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No. Function Description

3 Patient Information • Patient ID: (User cannot re-edit ID after once edition.)

• Default ID(Auto ID or Manual ID): It is generated by
system automatically or inputted manually and only
can be re-edited in Patient Info page once.

• Temp ID(Simplified Patient only): It can be re-edited
once only after saving images without patient ID
etc. information, i.e. in emergency. The ID is shown
'xxxTEMP' that differs from Default ID.

• Other ID: The system now allows you to enter a second
identification number for the same patient, which may be
required in certain countries.

This is only displayed if enabled on the Utility > Connectivity >
Miscellaneous screen.

• Patient Name-Last, First and Middle
• DOB (Birthdate)
• Age (automatically calculated when birthdate is input)
• Gender

4 Category Selection Select from 9 exam application categories.
When a category is selected, the measurement and category
presets are displayed.

5 Exam Information Shows the Current/Active Exam information. Information
pertinent to the selected exam category appears in the window.
All possible information needs to be entered.

• Clear-Clears existing data.
• Past Exam (only for OB)-Input past exam data (register the

patient before using).

6 Probe/Preset Display or select probe and preset information.

7 Exam List Display examination list.
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Archive

Figure 1-29 Archive

Table 1-13 Archive

No. Function Description

1. Archive List the patients in the database.
When you double-click the patient on the patient list using the
Set key, the Review screen or New Exam entry screen displays
depending on the preset. You set this preset via Select Review
or New Exam in Utility > Connectivity > Miscellaneous > Double
click on patient list to start preset.

2. Search key Select a search criteria.
NOTE
Criteria "Img. Archived" means that the exam was backed up
to external media by EZBackup or Export.

3. String Enter appropriate information for search criteria.
NOTE
If you select Locked (Y, N) or Archived (Y, N) for the Search
key, enter Y (Yes) or N (No).

4. Clear Clears the entered string.

5. Dataflow Selection Select archive and other pre-defined services.
If you use a DVD-R, select DICOM CD Read in Dataflow.
If you place the cursor on the icon, the pop-up menu displays
disk capacity.

6. Add Exam Creates a new exam based on a current or searched patient.

7. Resume Continues the exam for that patient if you select the last exam
of the day.
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No. Function Description

8. EZBackup/EZMove • EZBackup - One-step method to backup patient images to
an external media.

• EZMove - Move and delete patient images.

9. Printer Print the search list to a standard printer.
Highlight the patient and press Cursor key. Select Print from
the pop-up and press the right Set key.

10. Send To Send one or multiple patients' images to the peripherals in JPG/
AVI, JPG/WMV, DICOM, Raw Dicom or Mpeg Vue format.
DICOM - Digital Imaging and Communications in Medicine is
a standard protocol for the management and transmission of
medical images and related data.
Raw DICOM - Based on DICOM images and related data, Raw
DICOM contains GE proprietary information which can be post-
processed on GE system.

11. Import/Export Select to import or export patient information (including Report,
images and other patient information).

12. Listing XX of XXX Displays the quantity of patients in the search window and the
quantity of patients in the database.

13. Q/R Allows for One Click Q/R (Query/Retrieve) for the current
patient.

14. Delete Delete one or more exams from Exam View.
NOTE
"Delete" is only displayed when you login as Administrator.

Image Review

Figure 1-30 Image Review
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Table 1-14 Image Review

No. Function Description

1. Image Review Select to review all images of the selected patient exam.

2. Active Image Provides preview of the currently selected exam.

3. Image History Provides a list of images per exam for the currently selected
patient.

4. Review Highlight the image and press Review.

5. Compare Enter Follow-up function.

6. Printer Print the search list to a standard printer.
Highlight the patient and press Cursor key. Select Print from
the pop-up and press the right Set key.

7. Send To Send one or multiple patients' images to the peripherals in JPG/
AVI, JPG/WMV, DICOM, Raw DICOM or Mpeg Vue format.
DICOM - Digital Imaging and Communications in Medicine is
a standard protocol for the management and transmission of
medical images and related data.
Raw DICOM - Based on DICOM images and related data, Raw
DICOM contains GE proprietary information which can be post-
processed on GE system.

8. Delete Delete one or more exams from Exam View.
NOTE
"Delete" is only displayed when you login as Administrator.

Scanning a New Patient

Warnings and Cautions
WARNING
Imaging functions may be lost without warning. Develop emergency procedures to prepare
for such an occurrence. Failure to prepare for unexpected loss of functionality could lead to
patient injury.

WARNING
Always ensure you have selected a dataflow. If No Archive is selected, no patient data is
saved and a rescan may be required. A Ø appears next to Dataflow if No Archive is selected.

CAUTION
To avoid patient identification errors, always verify the identification with the patient. Make
sure the correct patient identification appears on all screens and hard copy prints.
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CAUTION
Always use the minimum power required to obtain acceptable images in accordance with
applicable guidelines and policies.

CAUTION
Always use the system on a flat surface in the patient environment.

CAUTION

Ensure that the hands of the patient are away from the system during the exam.
The position of the operator and the patient vary by the anatomy of interest being scanned.
In most cases, the operator sits/stands straight in front of the operator console and the
patient lies on the bed on the right (or left) side of the system.

CAUTION

Before each use of intracavitary probe, or after changing its observation mode/setting,
please check to ensure that the image is a live (not the stored image) and has the correct
image orientation.

CAUTION

The intracavitary probes supported by this product are only expected to contact intact
mucosa.

Creating a new patient record
When starting a new patient's exam, ensure you do the following:

1. Select Patient on the touch panel.
2. Select New Patient on the patient menu.

If there are images on the clipboard, a pop-up menu appears. Specify whether you want
to store images, delete images, or go to active images.

3. Choose the exam category.
4. Verify the dataflow.

NOTE
DO NOT use the removable media Dataflows on the New patient menu.

NOTE
The system will display a warning dialog when the patient is registered to "No Archive".
If the "Warn register to No Archive" preset is selected in the Utility > Connectivity
> Miscellaneous menu, a warning displays. Please select a different dataflow for
permanent storage of patient data.

5. Fill in patient information.
NOTE
You can also select a patient from the patient database at the bottom of the Patient
menu if the patient has a patient ID.
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NOTE
Columns drive the ordering of the patients displayed. The columns that you select drive
the order of the displayed patient database.

NOTE
Do not use the following characters when filling in patient information: " ` / : ; . , * < > | +
= [ ] & !, @, #, $, %, ^, &, *, (, ), ?, /, ~ , [, ], {, }.

6. Select Register. Enter Past OB Exam information, if desired.
7. Select the probe to start scanning (or select Esc, Scan, or Freeze).
8. Perform the exam.

Perform an exam

1. Select the probe, exam category and application.
2. Perform an exam.
3. Store the raw data to the clipboard.

To store the still image, press Freeze and run the cineloop using the Trackball. Select the
frame and press Store.
To store the cineloop, press Freeze and run the cineloop using the Trackball. Select the
start/end frame and run the selected loop. Press Store.

Ending an exam

1. When you have completed the study, press End Exam.
2. The image management screen displays. Select the images (still frame or cineloop) you

want to store or select Select All to store all images. Select Permanent Store to store
the images permanently.

CAUTION
After completing the measurement, verify that the measurement result window is updated
before you send or save the image.

CAUTION
DO NOT use the following special characters when saving images: !, @, #, $, %, ^, &, *, (, ),
|, :, ;, <, >, ?, /, ~, [, ], {, }.

Entering a Patient List

All patient information can be entered before starting an exam.

1. Press Patient to display the Patient Screen.
2. Press New Patient to erase the current patient data.
3. Select Store All if data from previous patient was not saved.
4. Enter the Patient ID.
5. Enter the patient and exam information.
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6. Press Register.
7. Repeat above steps as required.

Select the patient from the Patient List. Select Resume Exam to continue the last exam that
was performed on the selected patient.
Select New Exam to start a new exam on the selected patient.

Starting a new exam on an existing patient

1. Select Patient on the control panel.
2. Select the patient from the Patient List.
3. Select New Exam.
4. A new exam is created. Enter the data and begin the scan.

Scanning without entering any patient data

To scan a patient without entering any patient data until the end of the exam:

1. Scan the patient and save images to clipboard without the patient information, the
system displays a Warning message, "A patient must be selected for permanent storage
of images." Select OK, a warning message is also displayed at the bottom of the image
monitor in red.

2. When the scanning is finished, press Patient to display the Patient Search screen.
3. Enter the Patient ID, patient data and exam information as necessary, select Register.
4. If images or measurements have been stored to the clipboard, the system will display the

following message:
"Unsaved images, measurements or fetus number will be linked to the current
patient information, continue?" Press OK if you want to permanently store the images/
measurements that were just taken.

5. Enter the Active Images Screen, select Permanent Store.
6. Return to patient page, select New Patient.

When the system shuts down during an exam, the unsaved images and data are stored
in temporary buffer. Next time the system starts up, the temporary buffered data is still
available.

Ending a Patient

To end a patient:
Press Patient > New Patient, then select Store All in the pop-up menus to store exam data.
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Changing Current Patient to Existing Patient (with Patient ID)

To change the current patient (with patient ID) to an existing patient, when there are some
unsaved images on the clipboard for the current patient:
Select the existing patient from the patient list, the following dialog displays.

Figure 1-31 Unsaved Exam Data

1. Store All - All the unsaved images will be saved to the current patient.
2. Review Images - Review the unsaved images in Active Images page and select to

permanent store or delete.
3. Delete All - Delete all the unsaved images.

The system will display a confirmation message: "Do you really want to delete all
temporary images?" Select OK to delete the unsave images, select Cancel not to delete
the images.

4. Cancel - Do nothing with the unsaved data, and return to Patient page.

Changing Current Patient to Existing Patient (without Patient ID)

To change the current patient (with patient ID) to an existing patient, when there are some
unsaved images on the clipboard for the current patient:
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Select the existing patient from the patient list, the following dialog displays.

Figure 1-32 Unsaved Exam Data

1. Store All - All the unsaved images will be saved to the current patient. The current
patient does not have Patient ID, the system will indicate to enter patient ID.

• Input manually - Input the Patient ID and other information manually, and then
select Register to register the new patient. And the system will display:
"Unsaved images, measurements or fetus number will be linked to the current
patient information, continue?" Select OK to save the images.

• Auto Generate - The system will generate a new patient ID and the unsaved
images will be saved to this new patient automatically.

2. Review Images - Review the unsaved images in Active Images page and select to
permanent store or delete.

3. Delete All - Delete all the unsaved images.
The system will display a confirmation message: "Do you really want to delete all
temporary images?" Select OK to delete the unsave images, select Cancel not to delete
the images.

4. Cancel - Do nothing with the unsaved data, and return to Patient page.

Delete the existing patient/exam/image

CAUTION
Before deleting a patient or image from the Patient Screen, make sure you have already
saved the data with EZBackup/EZMove, Backup, or Export. Verify the media before deletion.
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Delete the existing patient

1. Search and select the patient in the patient list.
2. Select Delete. The confirmation dialog box displays.

OR
Press the Cursor key. A pop-up menu displays. Select Delete. The confirmation dialog
box displays.

3. Select OK to delete or Cancel.

Delete multiple patients from the patient list

1. Select the multiple patients to be deleted from the patient list by holding down the Control
key and selecting patients one by one or holding down the Shift key to select a group of
patients.

2. Select Delete. The confirmation dialog box displays.
OR
Press the Cursor key. A pop-up menu displays. Select Delete. The confirmation dialog
box displays.

3. Select OK to delete or Cancel.

Delete the existing exam

1. Search and select the patient in the patient list under patient screen.
2. Select Exam View to display patient exam screen.
3. Select the exam to be deleted.
4. Select Delete Exam. The confirmation dialog box displays.
5. Select OK to delete or Cancel.

Delete the existing image

1. Search and select the patient in the patient list under patient screen.
2. Select Exam View. The patient exam screen displays.
3. Select the exam which contains the image to be deleted.
4. Select Active Images to display the image list.
5. Select the image to delete and select Delete. The confirmation dialog box displays.
6. Select Yes to delete or No to cancel.

Barcode Reader

The Barcode Reader supports 1D and 2D encoding symbologies. The protocols supported
are shown as below:
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Table 1-15 Protocols supported by Barcode Reader

Category Protocol

1D Code 128, Code 93, Interleaved 2 of 5

2D PDF417, Data Matrix

Activate Barcode Reader
The barcode reader needs to be activated before the first use.
To activate the barcode reader, follow the steps below:

1. Power on the system and connect the barcode reader to USB port on the ultrasound
system.

NOTE
The following barcodes MUST be printed on paper before being scanned by the
barcode reader.

2. Scan the four barcodes.
First, scan the Remove Custom Defaults barcode (1).
Second, scan the Activate Defaults barcode (2).
Third, scan the To enable 1900 PID code(3).
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Finally, scan the USB Serial barcode (4).

Figure 1-33 Barcode for scanning

Setup Barcode Reader
Before using barcode reader, follow below instruction to complete configuration.
Select Utility > Barcode to enter configuration page.

Input Mode
There are Patient ID, Complexation and Off mode listed under Input Mode.

Off
If Off is selected, user needs to use the keyboard to enter the Patient ID.

Patient ID
If Off is selected, scan the Barcode as the Patient ID or enter the Patient ID using the
keyboard..

Complexation
If Complexation is selected, user can scan the barcode to input the Patient demographics or
use the keyboard to enter the Patient demographics.
To enter the Patient demographics:
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1. Enter a barcode string in the Input Data tab by scanning from a barcode or typing with
the keyboard.
The following items can be included in the barcode:

• Patient ID
• First Name, Last Name, Middle Name
• Birth Year, Birth Month, Birth Day

NOTE
The length of Birth Year contains 4 digits, Birth Month contains 2 digits and
Birth Day contains 2 characters; they should always be provided together.

• Gender
NOTE
Please input F for female and use M for male.

2. Configure the Start and End position for each item.
NOTE
If the barcode does not contain the information of any item, configure the Start
and End position as "0".

For example, if the scanned barcode is
"0102LastNameFirstNameMiddleName20001212F", the configuration and results display
as the following:

Figure 1-34 Barcode Manager
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Table 1-16 Complexation mode Input Data configuration

Item Start Position End Position Input Data Element

Patient ID 1 2 01

Other ID 3 4 02

Last Name 5 12 Last Name

First Name 13 21 First Name

Middle Name 22 31 Middle Name

Birth Year 32 35 2000

Birth Month 36 37 12

Birth Day 38 39 12

Gender 40 40 F

3. Click Save to save the configuration.
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Chapter 2
Performing an Exam
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Optimizing the Image

Optimizing B-Mode

B-Mode is intended to provide two-dimensional images and measurement capabilities
concerning the capabilities of anatomical structures.

Figure 2-1 B-Mode Display -- Representative Example

Typical B-Mode Exam Protocol
A typical examination using B-Mode might proceed as follows:

1. Record exam-related patient information. Verify system setup (probes and presets).
2. Position the patient and the console for optimum operator and patient comfort. Perform

the scan.
3. Complete the study by collecting all the data.

B Mode Controls
Table 2-1 B Mode Controls

Control Bioeffect Description/Benefit

Depth Yes Depth controls the distance over which the B-Mode images
anatomy, and the field of view. To visualize deeper structures,
increase the depth. To visualize the flatter structures, decrease
the depth.

Gain No B-Mode Gain increases or decreases the amount of echo
information displayed in an image. It may have the effect
of brightening or darkening the image if sufficient echo
information is generated.
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Control Bioeffect Description/Benefit

Focus Yes Increases the number of focal zones, moves the focal zone(s)
and change the zone width so that you can tighten up the
beam for a specific area. A graphic caret corresponding to the
focal zone position(s) appears on the right edge of the image.

Whizz No Whizz in B mode (ATO: Auto Tissue Optimization) will
continuously optimize the brightness, contrast and uniformity
of B mode images when scanning on different tissues.
Whizz in PW/CW Doppler Mode (ASO: Auto Spectral
Optimization) optimizes the spectral data. Auto adjusts the
Velocity Scale/PRF (live imaging only), baseline shift, and
invert (if preset). Upon deactivation, the spectrum is still
optimized.
Specify the Whizz Level: Low or High via Utility > Whizz/
Application > Whizz > Whizz Level.

CrossXBeam Yes CrossXBeam is the process of combining three or more frames
from different steering angles into a single frame.
CrossXBeam is available on Convex and Linear probes.
CrossXBeam combines multiple co-planar images from
different view angles into a single image at real-time frame
rates, using bi-cubic interpolation.

Coded Harmonic
Imaging (Phase
Inversion
Harmonic) (CHI)

Yes Harmonic imaging utilizes Digitally Encoded Ultrasound (DEU).
Coded Harmonics enhances near field resolution for improved
small parts imaging as well as far field penetration.

Frequency Yes Adjust Frequency until the desired frequency is selected. Multi
Frequency mode lets you downshift to the probe's next lower
frequency or shift up to a higher frequency.

Steer Yes You can slant the B-Mode or Color Flow acoustic beam without
moving the probe. The steer function only applies to linear
probes.
NOTE: Steer is not available while using CrossXBeam.

Virtual Convex Yes Virtual Convex provides a larger field of view in the far field.
The Virtual Convex feature provides an extra wide field of view
on Linear and sector probes, by introducing an offset, which is
similar to radius of convex, and it defines the FOV of Linear
and Sector probes.
Virtual Convex allows for a wider field of view. Available in
B-Mode, Color Flow Mode, and Doppler Mode. CrossXBeam is
available on Virtual Convex with linear probes.
Activating Virtual Convex may change the TI and/or MI.
Observe the output display for possible effects.
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Control Bioeffect Description/Benefit

TGC No TGC amplifies returning signals to correct for the attenuation
caused by tissues at increasing depths. TGC slide pots are
spaced proportionately to the depth. The area each pot
amplifies varies as well. A TGC curve may appear on the
display (if preset), matching the controls that you have set
(except during zoom). You can choose to deactivate the TGC
curve on the image.

Width Yes You can widen or narrow the size of the sector/convex angle to
maximize the image's region of interest (ROI).

Tilt Yes You can steer the sector angle to get more information without
moving the probe while in B-Mode, M-Mode, Doppler Mode,
and Color Flow Mode.
NOTE
Tilt is not available on linear probe.

NOTE
Tilt is available when CrossXBeam is off.

Revert No Flips the image 180 degrees left/right.

Dynamic Range No Dynamic Range controls how echo intensities are converted
to shades of gray, thereby increasing the adjustable range of
contrast.

Line Density Yes Optimizes B-Mode frame rate or spatial resolution for the best
possible image.

Gray Map No The system supplies B, M, and Doppler Mode system maps.

Frame Average No Temporal filter that averages frames together, thereby using
more pixels to make up one image. This has the effect of
presenting a smoother, softer image.

Colorize No Colorize is the colorization of a conventional B-Mode image or
Doppler Spectrum to enhance the user's ability to discern B,
M, and Doppler Mode intensity valuations. Colorize is NOT a
Doppler Mode.
NOTE
You can colorize real-time or CINE images or Timeline CINE,
but not DVR images.

Colorizes the gray scale image to enhance the eye's
discrimination capability.
The colorize bar displays while Colorize is activated.

Edge Enhance No Edge Enhance brings out subtle tissue differences and
boundaries by enhancing the gray scale differences
corresponding to the edges of structures.
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Control Bioeffect Description/Benefit

LGC No LGC (Lateral Gain Compensation) balances the image so that
the density of echoes is the same throughout the image. It
enables user to adjust B mode gain compensation along lateral
direction.

Speed of Sound No Speed of Sound is available on all probes for all applications.
The Speed of Sound control can be configured via Utility >
Application > Imaging Controls.
With SoS adjustment, user can adjust the SOS close to the
real ultrasound transmission speed in different tissues and
patients, which provides better focusing to optimize the image
quality.
NOTE
Speed of Sound displays on the monitor display as "SoS"
with the speed following, "SoS 1500" (when the speed of
sound is not equal to default value 1540 m/s).

Rotation No You can flip the image 90 degrees/180 degrees/270 degrees.
CAUTION: When reading an rotated image, be careful to
observe the probe orientation to avoid possible confusion over
scan direction or left/right image reversal.

Rejection No Selects a level below which echoes will not be amplified (an
echo must have a certain minimum amplitude before it will be
processed).

Suppression No Suppresses the noise in the image.

SRI-HD No SRI-HD (High Detection Speckle Reduction Imaging) is an
adaptive algorithm to reduce the unwanted effects of speckle
in the ultrasound image. Image speckle usually appears as
a grainy texture in otherwise uniform areas of tissue. Its
appearance is related to image system characteristics, rather
than tissue characteristics, so that changes in system settings,
such as probe type, frequency, depth, and others, can change
the appearance of the speckle. Too much speckle can impair
image quality and make it difficult to see the desired detail in
the image. Likewise, too much filtering of speckle can mask
or obscure desired image detail. Extra care must be taken to
select the optimal SRI-HD level.
Tips and Notes
When selecting the SRI-HD level, observe the effect of SRI-
HD in the desired region of interest and make a real-time
comparison with the original image. The optimal level depends
on the clinical situation. Observing the original and SRI-HD-
processed images together helps to determine whether too
much or too little SRI-HD has been applied.
Dual image mode for SRI-HD can also be activated on a
stored CINE Loop. This allows you to always see the original,
unprocessed or enhanced image by going into the Dual display
mode and to change the SRI-HD settings when reviewing the
CINE Loop.
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Control Bioeffect Description/Benefit

LOGIQView
(Option)

No LOGIQView provides the ability to construct and view a static
2D image which is wider than the field of view of a given
transducer. This feature allows viewing and measurements
of anatomy that is larger than what would fit in a single
image. Examples include scanning of vascular structures and
connective tissues in the arms and legs.
LOGIQView constructs the extended image from individual
image frames as the operator slides the transducer along the
surface of the skin in the direction of the scan plane. The
quality of the resulting image is somewhat user-dependent and
requires some additional skill and practice to develop proper
technique and become fully proficient.
LOGIQView is only available in B mode.

Full Screen No Full Screen button is used to enlarge image and black area on
the monitor. Only Full Screen button and B button can be used
in Full Screen mode.

Digital LGC (Lateral Gain Compensation)
Digital LGC (Lateral Gain Compensation) amplifies returning signals to correct for the
attenuation caused by tissues when the beam penetrates.
Digital LGC (Lateral Gain Compensation) balances the image so that the density of echoes is
the same throughout the image. It enables user to adjust B mode gain compensation along
lateral direction.
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Adjusting LGC
User can activate LGC from the Touch Panel.

Figure 2-2 LGC icon on the Touch Panel

Figure 2-3 LGC ON

To adjust and save User Defined LGC:

Figure 2-4 Adjusting the LGC

See below description for the usage of the icons marked on Figure 2-4:
a. Adjust the slide pots to your prefered value.
b. Press to reset the LGC value to the center position.
c. User Defined LGC settings.
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NOTE
Press and hold a button to save user defined preset.

d. Press to exit LGC.

Optimizing M-Mode

M-Mode is intended to provide a display format and measurement capability that represents
tissue displacement (motion) occurring over time along a single vector.

Typical exam protocol
A typical examination using M-Mode might proceed as follows:

1. Get a good B-Mode image.
2. Press M-Mode. Survey the anatomy and place the area of interest near the center of the

B-Mode image.
3. Move the trackball to position the mode cursor over the area that you want to display in

M-Mode.
4. Adjust the Sweep Speed, TGC, Gain, Power Output, and Focus Position, as needed.
5. Press Freeze to stop the M trace.
6. Record the trace to disk or to the hard copy device.
7. Press Freeze to continue imaging.
8. To exit, press M-Mode.

M-Mode Controls
NOTE
You can set default value of each parameter by probe and application on the Utility >
Imaging page.

Table 2-2 M-Mode Controls

Control Bioeffect Description/Benefit

Sweep Speed No Changes the speed at which the timeline is swept.
Available in M-Mode, Doppler Mode and M Color Flow Mode.

Anatomical M-
Mode (option)

Yes Anatomical M-Mode gives you the ability to manipulate the
cursor at different angles and positions. The M-Mode display
changes according to a motion of the M cursor.

Anatomical M-Mode (AMM) and Anatomical Color M-Mode (ACMM)
Anatomical M-Mode allows manipulation of the cursor at different angles and positions. The
M-Mode display changes according to the position of the cursor.

Anatomical M-Mode displays a distance/time plot from a cursor line, which is independent
from the axial plane. AMM is available in B, Color and TVI.
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NOTE
To set up AMM, go to Utility > Imaging > AMM. Select the specific probe and parameters.

NOTE
Turn off CrossXBeam before activating AMM/CAMM.

Figure 2-5 Anatomical M Mode

Activating
To activate Anatomical M-Mode, while in M-Mode, press the Anatomical M Touch Panel
control.

NOTE
AMM is not available on Linear probes.

NOTE
Anatomical M-Mode can also be used with previously acquired digitally stored 2D images.
More than one heart cycle should be stored if performing M-Mode in post processing.

To activate Anatomical Color M-Mode, after accessing Anatomical M-Mode, activate Color
Flow (CF).

Adjusting
Use Touch Panel Trackball to position the M cursor over the required area of the B-Mode
image.

1. Use the trackball (assigned function: Pos) to position the M cursor over the required area
of the image.
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2. Press the top Trackball key to allow free rotation of the solid arrow line throughout the 2D
image (trackball assigned function: Angle).

NOTE
Rotate the Touch Panel control to angle the M cursor at a given angle.

Benefits
Color Flow Mode and Color M-Mode are Doppler Modes intended to add color-coded
qualitative information concerning the relative velocity and direction of fluid motion within
the B-Mode or M-Mode image.

Bioeffects
Changing the Packet Size, Scale, and ROI size may change the TI and/or MI. Observe the
output display for possible effects.

Curved Anatomical M-Mode (CAMM)
Curved Anatomical M-Mode (CAMM) displays a distance/time plot from a free-drawn cursor
line. CAMM is available in B, CF and TVI.

1. Select Curved AMM on the Touch Panel.
2. Use the Trackball to position the start point of the time motion curve in the B-Mode

image.
3. Press Set to fix the start point.
4. Use the Trackball to position the next point.

The time motion curve is drawn by the green line.
5. Press Set to fix the point.
6. Repeat step 4 and 5 to draw a complete time motion curve.

NOTE
The time motion curve can be edited by following the curve back to the desired point
and redrawn as desired. Following the curve back to the starting point will delete the
time motion curve.

7. Press Set twice to complete.
NOTE
Move the cursor to the desired anchor point and press Set. Move the point to the
desired position and press Set.

8. The arrow cursor appears on the M-Mode image and the red bar appears on the time
motion curve.

The red bar indicates the position of the time motion curve relative to the arrow cursor on
the CAMM image. They move relative to one another.

NOTE
Press Set to clear a cursor line.
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NOTE
Curved Anatomical M-Mode can also be used with previously acquired digitally stored B-
Mode images.

NOTE
CAMM is not available on Linear probes.

Optimizing Color Flow Mode

Color Flow Mode is a Doppler Mode intended to add color-coded qualitative information
concerning the relative velocity and direction of fluid motion within the B-Mode image.

Typical exam protocol
A typical examination using Color Flow Mode.

1. Follow the same procedure as described under B-Mode to locate the anatomical area of
interest.

2. After optimizing the B-Mode image, add Color Flow.
NOTE
Use all noise reduction controls with care. Excessive application may obscure low level
diagnostic information.

3. Move the color flow area of interest as close to the center of the image as possible.
4. Optimize the color flow parameters so that a high frame rate can be achieved and

appropriate flow velocities are visualized.
5. Press Freeze to hold the image in memory.
6. Record color flow images as necessary.
7. If more definitive information is needed about flow, utilize the procedures described

under Doppler Mode.
8. To exit Color Flow, press CF-Mode or B-Mode.

NOTE
Most parameters are user presettable by probe and application in the preset menu
(Utility > Imaging > CF).

Color Flow Mode Controls
Color Flow Mode and Color M-Mode are Doppler Modes intended to add color-coded
qualitative information concerning the relative velocity and direction of fluid motion within
the B-Mode or M-Mode image.
Table 2-3 Flow Mode Controls

Control Bioeffect Description/Benefit

Flow Selection Yes In the Lower Extremity Vein (LEV) and Abdominal applications,
you can quickly select the flow state via a shortcut on the Color
Flow Mode menu.
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Control Bioeffect Description/Benefit

Gain No Gain amplifies the overall strength of echoes processed in the
Color Flow window or spectral Doppler timeline.

Scale (Velocity
Scale)

Yes Increases/decreases the Scale on the color bar.

Wall Filter No Filters out low flow velocity signals. It helps get rid of motion
artifacts caused from breathing and other patient motion.

Size/Position Yes Adjust size and position of the color window.

Invert (Color
Invert)

No Lets you view blood flow from a different perspective, e.g., red
away (negative velocities) and blue toward (positive velocities).
You can invert a real-time or frozen image.
NOTE
Invert reverses the color map, NOT the color PRF.

Baseline No Changes the Color Flow or Doppler spectrum baseline to
accommodate higher velocity blood flow. Minimizes aliasing
by displaying a greater range of forward flow with respect to
reverse flow, or vice versa.
Baseline adjusts the alias point. The default baseline is at the
midpoint of the color display and at the midpoint of the color
bar reference display.

Angle Steer Yes You can slant the ROI of the Color Flow linear image left or
right to get more information without moving the probe. The
Angle Steer function only applies to linear probes.

Accumulation No Time Accumulation of Color Flow.

Color Flow Line
Density

Yes Optimizes the Color Flow frame rate or spatial resolution for
the best possible color image.

Map No Allows you to select a specific color map. After you have made
your selection, the color bar displays the resultant map.

Map Compress No Change the gradation of color map.

Threshold No Limits color flow overlay to low level echoes inside vessel
walls. Helps minimize color `bleeding' outside vessel walls.

Frame Average No Averages color frames.

Transparency
Map

No Brings out the tissue behind the color map.

Spatial Filter No Smooths out the color and reduces over pixelated appearance.

Flash
Suppression

No Activates/deactivates Flash Suppression, a motion artifact
elimination process.

Packet Size Yes Controls the number of samples gathered for a single color
flow vector.
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Control Bioeffect Description/Benefit

Sample Volume Yes Adjusts the size of the color flow doppler transmit wave (or
pulse) and size (or length). Lower setting gives better flow
resolution and a higher setting increases sensitivity.

CF/PDI Auto
Sample Volume

Yes Set the default value at Utility > Imaging > CF Mode.
The transmit frequency and focus position will be changed
automatically with depth.CF/PDI Focus

Depth
Yes

CF/PDI
Frequency

Yes

CF/PDI Auto
Frequency

Yes

CF/PDI Center
Depth

Yes

PDI No Power Doppler Imaging (PDI) is a color flow mapping
technique used to map the strength of the Doppler signal
coming from the tissue rather than the frequency shift of
the signal. Using this technique, the ultrasound system plots
color flow based on the number of reflectors that are moving,
regardless of their velocity. PDI does not map velocity,
therefore it is not subject to aliasing.

Directional PDI No You can select the DP7 Directional Power Doppler maps while
in PDI.
Directional Maps. Directional Power Doppler Maps from PDI.
NOTE

If you store a PDI image and recall it, you can still switch
to the Directional Power Doppler map and vice versa.
However, an image stored as non-directional then switched
to directional just adds direction to a non-directional map and
vice versa.

TVI (Option) Yes Tissue Velocity Imaging (TVI) calculates and color-codes the
velocities in tissue. The tissue velocity information is acquired
by sampling of tissue Doppler velocity values at discrete
points. The information is stored in a combined format with
gray scale imaging during one or several cardiac cycles with
high temporal resolution.

TVD (Option) Yes Tissue Velocity Doppler (TVD): basing on TVI mode, activate
a sample volume of PW ventricular wall to get the spectral
information of the sample section.

TVM (Option) Yes Tissue Velocity M Mode image (TVM): Active M mode while in
TVI. To display myocardium motion velocity and direction.

QAnalysis
(Option)

Yes QAnalysis is available for the image loop acquired in the
following modes: TVI, CF and PDI. All of the QAnalysis modes
operate similarly, with some variation.
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Optimizing M Color Flow

M Color Flow is used for fetal cardiac applications. Color Flow overlays color on the M-Mode
image using velocity and variance color maps. The Color Flow wedge overlays the B-Mode
image and M-Mode timeline.
The Color Flow maps available in M-Mode are the same as in Color Flow Mode. The size and
position of the Color Flow window in B-Mode determines the size and position of the Color
Flow window in M-Mode.
All M-Mode measurements are available with M Color Flow active: depth, distance along a
straight line, % stenosis, volume, trace, circumference, enclosed area, distance, time, slope,
and heart rate.
M Color Flow mode can be activated on the sector probes only.

Activating
To activate M Color Flow Mode, press M (M-Mode), then press CF (Color Flow)- or - press
CF, then press M.
CM tab is displayed.

Benefits
Color Flow Mode and Color M-Mode are Doppler Modes intended to add color-coded
qualitative information concerning the relative velocity and direction of fluid motion within
the B-Mode or M-Mode image.

Bioeffects
Changing the Sweep Speed, Packet Size, Frame Rate/Resolution, Zoom, PRF, and ROI size
may change the TI and/or MI. Observe the output display for possible effects.

Optimizing Doppler Mode

Doppler is intended to provide measurement data concerning the velocity of moving tissues
and fluids. PW Doppler lets you examine blood flow data selectively from a small region
called the sample volume.

Typical Use - PW Doppler
In Pulsed Wave Doppler (PW) Mode, energy is transmitted from the ultrasound probe into the
patient, as in B-Mode. However, the received echoes are processed to extract the difference
in frequency between the transmitted and received signals. Differences in frequencies can be
caused by moving objects in the path of the ultrasound signal, such as moving blood cells.
The resultant signals are presented audibly through the system speakers and graphically on
the system display. The X axis of the graph represents time while the Y axis represents the
shift in frequency. The Y axis can also be calibrated to represent velocity in either a forward
or reverse direction.
PW Doppler is typically used for displaying the speed, direction, and spectral content of blood
flow at selected anatomical sites. PW Doppler operates in two different modes: conventional
PW and High Pulse Repetition Frequency (HPRF).
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PW Doppler can be combined with B-Mode for rapidly selecting the anatomical site for PW
Doppler examination. The site where PW Doppler data is derived appears graphically on the
B-Mode image (Sample Volume Gate). The sample volume gate can be moved anywhere
within the B-Mode image.

Typical exam protocol
A typical examination using PW Doppler Mode might proceed as follows:

1. Locate the anatomy to be examined. Get a good B Mode image. Press CF to help locate
the vessel you wish to examine.

2. Press PW. The PW Doppler spectrum appears and the system operates in combined B
mode, color Doppler and PW Doppler modes. Adjust Volume to adjust Doppler audio.
The Doppler signal is heard through the speakers.
To activate Continuous Wave (CW), press CW.

3. Position the sample volume cursor by moving the Trackball left and right. Position the
sample volume gate by moving the Trackball up and down. Size the gate by clicking SV
Length.

4. Optimize the PW Doppler spectrum, as necessary. Refer to the Doppler Optimization
section of this chapter for more information.

5. Press Set to toggle between real time B-Mode with Doppler Mode (with audio).
6. Sample along the whole length of the vessel. Make sure that the probe is parallel to flow.

Listen, then look, when positioning the sample volume cursor.
7. Press Freeze to hold the trace in memory and stop imaging. Activate CINE Timeline, as

necessary
8. Perform measurements and calculations, as necessary. Refer to the Measurements and

Calculations chapter for more information.
9. Record results by pressing the appropriate print key, depending on the setup of your

recording devices.
10. Press Freeze to resume imaging.
11. Repeat the above procedure until all relevant flow sites have been examined.

Doppler Mode Display Explanations
Table 2-4 Doppler Mode Display Explanations

Doppler Display Description, Format, Values

PRF Pulse repetition frequency, displayed as PRF in kHz.

Wall Filter Wall filter size, displayed as WF in Hz.

Doppler Gain Displays as GN in decibels (dB).

Sample Volume
Depth

Displays (in cm) when Doppler cursor is present.

Doppler Angle
(AC ##)

Indicates angle in degrees between the Doppler mode cursor and
the angle correction indicator. Displays when Doppler cursor is
present. The Doppler Angle displays in red when the angle exceeds
60°. Velocities obtained when the angle is greater than 80° are
displayed as asterisks (***).
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Doppler Display Description, Format, Values

Spectral Invert INVERT appears when the spectral trace is inverted and the plus/
minus signs (+/-) are reversed.

HPRF HPRF mode is used when detected velocities exceed the processing
capabilities of the currently selected PW Doppler scale or when the
selected anatomical site is too deep for the selected PW Doppler
scale.

Time Scale Each selection represents a different sweep time.

Angle Correct Indicates flow direction.

Sample Volume Gate Indicates sample volume box. Each probe defaults to a specific
range gate.

Doppler Velocity
Scale

Flow direction has a positive and negative indicator, noted in
centimeters per second (cm/sec.). When the velocity scale is less
than 10 cm/s, it is displayed to the first decimal point (4.6 rather than
5 cm/s). The Doppler velocity scale adjust as you adjust the PRF.

Doppler Mode Controls
Table 2-5 Doppler Mode Controls

Control Bioeffect Description/Benefit

Auto Spectral
Optimize [ASO]
(Auto)

Yes Auto in Doppler Mode optimizes the spectral data. Auto adjusts
the Velocity Scale/PRF (on live images only), baseline shift
and invert (if preset). The benefit of Auto can be found in
reduced optimization time and a more consistent and accurate
optimization process.

Set Yes Toggles between simultaneous and update presentation while
viewing the timeline.

Doppler sample
volume gate
position

Yes Moves the sample volume gate on the B-Mode's Doppler Mode
cursor. The gate is positioned over a specific position within
the vessel.

Doppler sample
volume length

Yes Sizes the sample volume gate.

Scale (Velocity
Scale)

Yes Adjusts the velocity scale to accommodate faster/slower blood
flow velocities. Velocity scale determines pulse repetition
frequency.
If the sample volume gate range exceeds single gate Scale
capability, the system automatically switches to high PRF
mode. Multiple gates appear, and HPRF is indicated on the
display.
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Control Bioeffect Description/Benefit

Angle Correct No Estimates the flow velocity in a direction at an angle to the
Doppler vector by computing the angle between the Doppler
vector and the flow to be measured.
NOTE
When the Doppler Mode Cursor and angle correct indicator
are aligned (the angle is 0), you cannot see the angle correct
indicator.

Quick Angle No Quickly adjusts the angle by 60 degrees.

Wall Filter No Insulates the Doppler signal from excessive noise caused from
vessel movement.

Baseline No Adjusts the baseline to accommodate faster or slower blood
flows to eliminate aliasing.

Mode Cursor No Displays the Doppler Mode cursor on the B-Mode image.

Steer and Fine
Steer

Yes You can slant the ROI of the Color Flow linear image left or
right to get more information without moving the probe. The
angle steer function only applies to linear probes.

Volume No Controls audio output.

Sample Volume Yes Adjusts the size of the color flow doppler transmit wave (or
pulse) and size (or length). Lower setting gives better flow
resolution and a higher setting increases sensitivity.

Invert No Vertically inverts the spectral trace without affecting the
baseline position.

Compression No Dynamic range controls how echo intensities are converted to
shades of gray, thereby increasing the range of contrast you
can adjust.

Trace Method No Traces the average mean and peak velocities in real-time or
frozen images.

Cycles to
Average

No The average value over a number of cycles (from 1-5).

Trace Sensitivity No Adjust the trace to follow the waveform for signal strength.

Trace Direction No Specifies trace direction.

Display Format No Changes the horizontal/vertical layout between B-Mode and
Doppler-Mode, or timeline only.

Modify Auto
Calcs

No Activates the menu to select which calculations are
automatically calculated.

Auto Calcs No Activates the calculation automatically which you select in the
Modify Auto Calculation when the system is in a state of freeze
or live.
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Control Bioeffect Description/Benefit

Simultaneous
(Duplex/Triplex)

Yes When you select Simultaneous, everything is live.
Simultaneous includes duplex and triplex. For example, it is
duplex if both B-Mode and PW Doppler Modes are active; it is
triplex if B-Mode, PW Doppler Mode, and CF Modes are active.
If Simultaneous is not selected, use Set to toggle between
modes.

Continuous
Wave Doppler
(CWD) (option)

Yes Allows examination of blood flow data all along the Doppler
Mode cursor rather than from any specific depth. Gather
samples along the entire Doppler beam for rapid scanning of
the heart. Range gated CW allows information to be gathered
at higher velocities.

Frequency Yes In CWD and PWD mode, touch the frequency button on the
touch screen to adjust PWD and CWD mode frequency.

Other Controls

Zoom
To zoom an image, rotate / press Zoom knob. A reference image appears in the lower left
corner of the monitor.
To exit zoom, enter B mode or press Zoom knob until the reference zoom image is removed.
Reference Image is the small un-zoomed image displayed next to the zoomed image.

Read Zoom
System will enter Read Zoom by default after press / rotate Zoom knob.
Read Zoom magnifies the display of the data without making any changes to the ultrasound
image data that is acquired.
Available in a live, frozen, cine or recalled raw data image.

Write Zoom
To activate Write Zoom, press the trackball key to enter Write Zoom.

Zooming an image changes the frame rate which tends to change thermal indices. The
position of the focal zones may also change which may cause the peak intensity to occur at a
different location in the acoustic field. As a result, the MI (TI) may change.

ACOUSTIC OUTPUT HAZARD
Observe the output display for possible effects.

With Write Zoom, the Ultrasound line density and/or sampling frequency increases, giving a
better resolution.

Write Zoom is available only in pre-processing.

You can preset the write zoom window size (height and width) on Utility > Imaging >
B-Mode.
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NOTE
The difference between Read Zoom and Write Zoom can be described in relation to
photography. With a photograph, Read Zoom manipulates the negative and enlarges the
picture; whereas Write Zoom uses a telephoto lens to bring the image closer before taking
the picture.

NOTE
First use the Read Zoom (turn knob) to get to the area of interest, then use Write
Zoom (press knob).

V-Zoom
V-Zoom is intended to zoom the full screen for selected ROI. It works for both Read Zoom
and Write Zoom.
To activate V-Zoom, follow below steps:

1. Select Enable vZoom through Utility > System > System Imaging.

Figure 2-6 Enable vZoom in Utility

2. Press/rotate the Zoom knob during scanning, an ROI frame displayed on the screen.
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3. Adjust position and size by Pos/Size key.

Figure 2-7 Adjust position and size

4. Press the Zoom knob again to display the magnified ROI.

Figure 2-8 V-Zoom example

To exit V-Zoom, press B mode or the Zoom knob.
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Split screen

To activate a dual split screen, press Dual. To activate a quad display, press Quad.

To switch between active images, press Dual/Quad.

To deactivate, press Quad until the screen changes.

NOTE
To put a copy of the image on the opposite side when entering dual split screen, use the
When Entering Dual Image... preset via Utility > Application > Settings.

Freezing an image

To freeze an image, press Freeze key. The Freeze key backlight turns green. Image is on
freeze mode (Frozen image).

If you are in a mixed mode, both images freeze immediately. Deactivating Freeze restarts
both modes.

To reactivate the image, press Freeze key again. The Freeze key backlight becomes blue
(unfreeze). Image is on real time scan mode (Live image).

NOTE
Deactivating Freeze erases all measurements and calculations from the display (but not from
the report).

Use the Trackball to start CINE after pressing Freeze.

Activating CINE Mode

Follow below steps to activate CINE Mode.

1. Press Freeze key.
2. Move the Trackball to activate CINE.

Body Patterns

Press the Body Pattern key on the control panel to enter into body pattern mode.
Select the desired body pattern and the selected body pattern is displayed on the monitor.

• Select the Move Pattern control to reposition the body pattern with the Trackball and
Set controls.

• Move the body pattern to the desired location.
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NOTE
Body Pattern Position is reset to factory default when patient is changed (e.g. End
Exam).

• A probe mark is associated with the body patterns and illustrates the probe position on
the body pattern. This marker can be placed with the Trackball and rotated with the
Body Pattern button.

• The probe mark type is selectable by rotating the Probe Type control. There are different
choices available with one being a blank selection.

• To select the active side in dual B-Mode, use the Active Side rotary control on the
Primary Menu.

• To clear the body pattern, press the Body Pattern control to activate body patterns and
then press the Clear key.

• Press Set on the keyboard to exit without erasing the body pattern.

Annotating an Image

Pressing the Comment key or any keys on the alphanumeric keyboard initiates the comment
mode. This assigns the trackball function to controlling the cursor and displays the comment
library on the menu area.

In comment mode, text can be added by using the comment library or by typing from the
alphanumeric keyboard.

After activating the comment mode, a vertical bar type cursor appears on the screen. Use the
Trackball to move the cursor.

To delete comments by character, press the Backspace key.

To delete all comments and arrow marks, press the Clear key after entering the comment
mode.

To move by words or by text group, press the Tab key.

Arrow pointers can be used by activating the Arrow key on the keyboard. Comment key can
be activated either by pressing the Annotate key or Arrow key on the control panel. When the
pointer comes up, it is a GREEN color, indicating it is active and can be moved.

NOTE
Please notify that there is limitation on the length of annotations.
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Measurement and Analysis

Measurements and calculations derived from ultrasound images are intended to supplement
other clinical procedures available to the attending physician. The accuracy of measurements
is not only determined by system accuracy, but also by the use of proper medical protocols
by the user. When appropriate, be sure to note any protocols associated with a particular
measurement or calculation. Formulas and databases used within the system software that
are associated with specific investigators are so noted. Be sure to refer to the original article
describing the investigator's recommended clinical procedures.

NOTE
The system provides calculations (e.g. estimated fetal weight) and charts based
on published scientific literature. The selection of the appropriate chart and clinical
interpretation of calculations and charts is the sole responsibility of the user. The
authorized user should consider proper indications for the use of a calculation or
chart as described in the scientific literature. The diagnosis, decision for further
examination, and medical treatment must be performed by qualified personnel
following good clinical practice.

Location of Measurement Controls

Figure 2-9 Locating Measurement Controls - example

1. Cursor - Pointer Key. Select to display a pointer on the monitor.
2. Clear - During a measurement sequence, erases the measuring caliper and

measurement data from the display. When not performing a measurement sequence,
clears all calipers and measurements from the display.

3. Measure - Activates a measurement caliper and the calculation package associated with
the currently selected preset.
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4. Body Pattern - Body patterns can be added to measurements on the image.
5. Zoom/Ellipse

• To Zoom an image, rotate Zoom clockwise or press Zoom knob. For more details,
refer to Zoom on page 90.

• Press Ellipse knob to activate ellipse function. After the first caliper for a distance
measurement has been set and the second caliper positioned, Ellipse activates
the area/ellipse measurement function. To increase the size, adjust the Ellipse
control in a clockwise direction. To decrease the size, adjust the Ellipse control in a
counterclockwise direction.

6. Comment - Comments can be added to measurements on the image.
7. Trackball - Moves the measurement calipers, selects the measurement on the Summary

Window. Trackball also selects items on the Touch Panel with the Pointer and Set keys.
8. Trackball keys - The functionality of these keys changes (for example, Set, Change

Measure, etc.) depending on the mode or action. Current functionality is displayed on the
lower right corner of the monitor.

B-Mode Measurements

The following measurements can be made in B-Mode.

• Distance
• Circumference
• Circumference and Area

• Ellipse Method
• Trace Method
• Spline Method
• Intensity (Echo level) Method

NOTE
Prior to performing B-Mode measurements, scan the patient and then press Freeze.

WARNING
DO NOT perform a depth measurement using 4D probes.

Distance Measurement
To make a distance measurement:

1. Press Measure once; an active caliper displays.
2. To position the active caliper at the start point, move the Trackball.
3. To fix the start point, press Set.

The system fixes the first caliper and displays a second active caliper.
4. To position the second active caliper at the end point, move the Trackball.
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A dotted line connects the measurement points, if preset accordingly.
5. To complete the measurement, press Set.

The system displays the distance value in the Results Window.

HINTS

• Before you complete a measurement:

• To toggle between active calipers, press the top Trackball key.

• To erase the second caliper and the current data measured and start the
measurement again, press Clear once.

• After you complete the measurement:

• To rotate through and activate previously fixed calipers, adjust Cursor Select.

• To erase all data that has been measured to this point, but not data entered onto
worksheets, press Clear.

Circumference Measurement (Open Trace)
To trace the circumference of a portion of the anatomy and calculate its length:

NOTE
Set Open Trace to the Touch Panel in Utility > Measure before perform the measurement.

1. Press Measure.
2. Select Open Trace from the Touch Panel.
3. Position the caliper at the start point.
4. To fix the trace start point, press Set. The caliper changes to an active caliper.
5. Move the Trackball to trace the measurement area. A dotted line shows the traced area.
6. To complete the measurement, press Set. The system displays the circumference in the

Results Window.

Circumference and Area (Ellipse) Measurement
You can use an ellipse to measure circumference and area. To measure with an ellipse:

1. Press Measure once; an active caliper displays.
2. To position the active caliper, move the Trackball.
3. To fix the start point, press Set. The system fixes the first caliper and displays a second

active caliper.
4. To position the second caliper, move the Trackball.
5. Rotate the Ellipse control; an ellipse with an initial circle shape displays.
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6. To position the ellipse and to size the measured axes (move the calipers), move the
Trackball.

7. To increase the size, rotate the Ellipse control in a clockwise direction. To decrease the
size, rotate the Ellipse control in a counterclockwise direction.

8. To toggle between active calipers, press the top Trackball key.
9. To complete the measurement, press Set. The system displays the circumference and

area in the Results Window.

HINTS
Before completing the ellipse measurement:

• To erase the ellipse and the current data measured, press Clear once. The original
caliper is displayed to restart the measurement.

• To exit the measurement function without completing the measurement, press Clear a
second time.

Circumference and Area (Trace) Measurement
To trace the circumference of a portion of the anatomy and calculate its area:

1. Press Measure.
2. Press the top Trackball key to select Trace; a caliper displays.
3. To position the caliper at the start point, move the Trackball.
4. To fix the trace start point, press Set. The caliper changes to an active caliper.
5. To trace the measurement area, move the Trackball around the anatomy. A dotted line

shows the traced area.
6. To complete the measurement, press Set. The system displays the circumference and

the area in the Results Window.

HINTS
Before completing the trace measurement:

• To erase the line (bit by bit) back from its current point, move the Trackball or adjust the
Ellipse control counterclockwise.

• To erase the dotted line but not the caliper, press Clear once.

• To clear the caliper and the current data measured, press Clear twice.

Circumference and Area (Spline Trace) Measurement
To trace the circumference of a portion of the anatomy and calculate its area:
NOTE
Spline trace is not available through the factory default. The system defaults to trace. To
enable spline trace, modify the Measure Key Sequence preset found in Utility > Measure >
Advanced preset menu.

1. Press Measure.

Performing an Exam

98 Versana Premier/Versana Premier Lotus - User Manual
5928218-1EN Rev. 6



2. Press the top Trackball key to select Spline Trace; a caliper displays.
3. To position the first caliper at the start point, move the Trackball.
4. To fix the trace start point, press Set. The first caliper turns yellow. The second caliper

appears at the same position as the first caliper and is green.
NOTE
When pressing the Clear key once, the second caliper disappears and the first caliper is
activated.
If Clear is pressed again, the first caliper disappears and the Spline trace is cancelled.

5. To position the second caliper, move the Trackball and press Set. The third caliper
appears at the same position.
NOTE
The Clear key functionality is the same as noted in the previous step.
The spline trace requires at least three points to draw the trace. Continue setting the
points of the trace until the desired points are set.

6. Press Set again after the last caliper is fixed to finalize the spline trace. All points are
removed from the line and the spline trace turns yellow.
NOTE
Pressing Set twice finishes the trace measurement.
If Clear is pressed twice when more than 3 points exist on the trace, all points are
removed and the first caliper again displays.

Edit the Spline Trace

1. Select Cursor Select. The spline trace changes to green and all points appear on the
trace as yellow.

A pick-caliper appears on the center of the image and the message “Edit spline trace” displays at
the bottom of the screen.

NOTE
The pick-caliper is used to select and move the trace points.

Figure 2-10 Edit spline trace

Select Cursor Select again. The trace is deactivated (changes to yellow) and all points, including the
pick-caliper, are removed.

If the previous/next fixed caliper exists on the image, it is activated.

NOTE
Pressing Clear at this time removes all points and the trace graphic.

2. Move the pick-caliper to the desired point and press Set. The point is activated and turns
green.
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3. Move the point to the desired position and press Set. The point is fixed and turns yellow.
The pick-caliper appears on the center of the image.
NOTE
The spline trace is updated while system is running.

NOTE
To remove a point, press Clear while moving the point. The trace turns green and the
remaining points continue to be shown as yellow. If there are less than three points, the
spline trace is removed.

4. Press Set again. All points are removed from the trace and the trace is shown as yellow.

Intensity (Echo Level) Measurement
To make an echo level measurement:

1. Press Measure.
2. Press the top Trackball key to select Intensity. A caliper displays.
3. To position the caliper at the start point, move the Trackball.
4. To fix the trace start point, press Set. The caliper changes to an active caliper.
5. To trace the measurement area, move the Trackball around the anatomy. A dotted line

shows the traced area.
6. To complete the measurement, press Set. The system displays the echo level, as EL __

dB, in the Results Window.

NOTE
The echo level measurement is only available on a frozen image, not on a B-paused image.

NOTE
Echo Level is not available through the factory default. To enable echo level, modify the
Measure Key Sequence preset, found in the Utility > Measure > Advanced preset.

M-Mode Measurements

Basic measurements that can be taken in the M-Mode portion of the display are:

• Tissue Depth (Distance)
• Time Interval
• Time Interval and Velocity

WARNING
DO NOT perform a depth measurement using 4D probes.

Prior to performing M-Mode measurements:
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1. In the B-Mode part of the display, scan the anatomy you want to measure.
2. Go to the M-Mode part of the display.
3. Press Freeze.

Tissue Depth
Tissue depth measurement in M-Mode functions the same as distance measurement in
B-Mode. It measures the vertical distance between calipers.

1. Press Measure once; an active caliper with a vertical and horizontal dotted line displays.
2. To position the active caliper at the most anterior point you want to measure, move the

Trackball.
3. To fix the start point, press Set.

The system fixes the first caliper and displays a second active caliper.
4. To position the second caliper at the most posterior point you want to measure, move the

Trackball.
5. To complete the measurement, press Set.

The system displays the vertical distance between the two points in the Results Window.

Time Interval
To measure a horizontal time interval and velocity:

1. Press Measure. Press the top Trackball key to select Time; an active caliper with vertical
and horizontal dotted lines displays.

2. To position the caliper at the start point, move the Trackball.
3. To fix the first caliper, press Set. The system fixes the first caliper and displays a second

active caliper.
4. To position the second caliper at the end point, move the Trackball.
5. To complete the measurement, press Set. The system displays the time interval between

the two calipers in the Results Window.

Slope (Time Interval and Velocity)
To measure time and velocity between two points:

1. Press Measure. Press the top Trackball key to select Slope; an active caliper with
vertical and horizontal dotted lines displays.

2. To position the active caliper at the start point, move the Trackball.
3. To fix the start point, press Set.

The system fixes the first caliper and displays a second active caliper.
4. To position the second caliper at the end point, move the Trackball.
5. To complete the measurement, press Set.

The system displays time(s) and slope between the two points in the Results Window.
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Doppler Mode Measurements

Five basic measurements can be made in Doppler Mode.

• Velocity
• TAMAX and TAMEAN (Manual or Auto Trace)
• Two Velocities with the Time Interval and Acceleration between them
• Time Interval
• Volume Flow

Prior to performing Doppler Mode Measurements:

1. In the B-Mode part of the display, scan the anatomy you want to measure.
2. Go to the Doppler Mode part of the display.
3. Press Freeze.

Velocity
To measure velocity:

1. Press Measure; an active caliper with a vertical dotted line displays.
2. To position the caliper at the desired measurement point, move the Trackball.
3. To complete the measurement, press Set. The system displays the velocity

measurement in the Results Window.

TAMAX and TAMEAN
Manual Trace

The value measured depends upon the Vol Flow Method preset. The two selections available
are: Peak (TAMAX) and Mean (TAMEAN).

To do a manual trace of TAMAX or TAMEAN:

1. Press Measure. Press the top Trackball key to select Trace; a caliper displays. Select
Manual on the Touch Panel.

2. To position the caliper at the trace start point, move the Trackball.
3. To fix the start point, press Set.
4. To trace the velocity spectrum boundary, move the Trackball.

NOTE
To edit the trace line, move the Trackball.

5. To complete the measurement, press Set. The system displays the measurement values
in the Results Window.

Auto Trace
The value measured depends upon the Vol Flow Method preset. The two selections available
are: Peak (TAMAX) and Mean (TAMEAN).

Performing an Exam

102 Versana Premier/Versana Premier Lotus - User Manual
5928218-1EN Rev. 6



To auto trace TAMAX:

1. Press Measure. Press the top Trackball key to select Trace; an active caliper with a
vertical dotted line displays. Select Auto on the Touch Panel.

2. To position the caliper at the trace start point in the Doppler spectrum, move the
Trackball.

3. To fix the start point, press Set.
4. To position the vertical caliper at the end point, move the Trackball.
5. To complete the measurement, press Set. The system automatically fixes both calipers

and traces the maximum value between the two points. The system displays this value in
the Results Window.
NOTE
When you set the Auto Trace for Both (above and below), the system picks up the
maximum power of the signal, NOT the maximum velocity. If the maximum velocity
is not the maximum power, the system may not trace accurately. If you want to use
maximum velocity, select either Above or Below.

Edit Trace
Auto Trace can be edited after taking an Auto Trace measurement.

1. After taking an Auto Trace measurement, select the measurement result on the result
window. The Edit Trace (Edit Peak or Edit Mean) menu window appears.
NOTE
If the system cannot take the trace data correctly from the image, Edit Trace does not
work.

2. Select Edit Trace. The first caliper (manual trace caliper) appears on the center of the
image. Use the Trackball to move the caliper on the trace line to the start point.
NOTE
To cancel Edit Trace at this time, press Clear, Scan, or Freeze.

3. Press Set to fix the first caliper. The second caliper appears. Edit the trace manually
using the second caliper.

The Ellipse control is used to edit the trace.

NOTE
When pressing the Clear key once at this time, the second caliper disappears and the
first caliper appears in the center of the image.

NOTE
If you press Scan or Freeze at this time, the caliper is automatically fixed and the result
window updates.

4. Press Set to fix the second caliper. The trace and the result window update. The trace
data (TAMAX and TAMEAN) are updated, though the other points (e.g. PS, ED) are not
updated by trace. The points can be edited with Cursor Select.

Chapter 2

Versana Premier/Versana Premier Lotus - User Manual 103
5928218-1EN Rev. 6



NOTE
While in Edit Trace, Cursor Select is disabled.

5. Repeat Edit Trace as needed.

Slope (Velocity, Time Interval and Acceleration)
To measure two velocity values, the time interval (ms), and acceleration (m/s2):

1. Press Measure. Press the top Trackball key to select Slope; an active caliper with
vertical and horizontal dotted lines displays.

2. To position the caliper at the start point, move the Trackball.
3. To fix the start point, press Set. The system fixes the first caliper and displays a second

active caliper.
4. To position the second caliper at the end point, move the Trackball.
5. To complete the measurement, press Set. The system displays the two peak end point

velocities, the time interval, and the acceleration in the Results Window.

Time interval
To measure a horizontal time interval:

1. Press Measure. Press the top Trackball key to select Time; an active caliper with vertical
and horizontal dotted lines displays.

2. To position the active caliper at the start point, move the Trackball.
3. To fix the start point, press Set. The system fixes the first caliper and displays a second

active caliper.
4. To position the second caliper at the end point, move the Trackball.
5. To complete the measurement, press Set. The system displays the time interval between

the two calipers in the Results Window.

Volume
The volume calculation can be made from any of the following measurements:

• One distance
• Two distances
• Three distances
• One ellipse
• One distance and one ellipse

For details on how to make a distance measurement, refer to Distance Measurement on
page 96.

For details on how to make an ellipse measurement, see Circumference and Area (Ellipse)
Measurement on page 97.
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NOTE
IMPORTANT!! If you want to make a volume calculation using one or two distances, you
must select Volume BEFORE you make the measurements.

NOTE
If you select Fix Caliper by Print Key on the Utility > System > System Measure, the print
key does not function like the Set key, but instead ends the measurement sequence and
initiates the volume calculation based on the number of measurements taken so far.

To make a volume calculation using one or two distances:

1. Select Volume.
2. Make one or two distance measurements.
3. Select Volume.

The system displays the distances and the volume in the Results Window.

NOTE
Use the Clear key to erase the green caliper.

To make a volume calculation using three distances:

1. Make three distance measurements.
NOTE
Three distances can be done in the dual format mode (side by side images). One
measurement is usually made in the sagittal plane and two measurements in the axial
plane. To use the dual format mode, press the L or R key on front panel.

2. Select Volume.
The system displays the distances and the volume in the Results Window.

To make a volume calculation using one ellipse:

1. Make one ellipse measurement.
2. Select Volume.

The system displays the ellipse measurement and the volume in the Results Window.

To make a volume calculation using one ellipse and one distance:

1. Make one distance measurement and one ellipse measurement.
2. Select Volume.

The system displays the distance and ellipse measurement and the volume in the
Results Window.
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HINTS

• Volumes are most accurate when measurements are taken in the sagittal and axial scan
planes.

• To display sagittal and axial plane images simultaneously, use the side-by-side dual
format option.

NOTE
If you change the parameters or category during the volume measurement, please follow the
procedure below before you restart the measurement.

1. Check the number of each measurement in the summary window.
2. If the numbers are not all the same, it shows that you have the calculation which is not

completed. Open the Worksheet and clear that calculation.

Table 2-6 Volume Calculations 

Calc Name Input Measurements

Volume (spherical) One distance

Volume (prolate spheroidal) Two distances, d1>d2

Volume (spheroidal) Three distances

Volume (prolate spheroidal) One ellipse: (d1 major axis, d2 minor axis)

Volume (spheroidal) One distance d1, and one ellipse (d2 major axis, d3 minor
axis)

Figure 2-11 Volume Calculation Examples

1 One distance
2 Two distances
3 Three distances
4 Four distances
5 Five distances
Calculation formulas are available in the Advanced Reference Manual.

Post-Assignment for General Volume
You can input a unique name for the general volume measurement. You can group the
general volume measurements for each application.
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1. Complete the volume measurement.
2. Move the caliper to the measurement result box (with green frame) and select Set.
3. The volume name menu appears. Select Name Volume.

Figure 2-12 Volume Name Menu

4. The dialog box displays. Enter a new name or choose the existing name.

Figure 2-13 Volume Name Dialog box

NOTE
The factory default volume name cannot be changed (for example, Renal Volume).
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Application M&A

Abdomen
Abdominal measurements offer a few different types of measurement studies:

Figure 2-14 Abdomen Exam Category

• Generic-Common to all applications.
• Abdomen
• Renal
• Bypass Graft
• Aorta Iliac
• Vascular Renal
• Mesenteric
• Abdomen Vein
• Bladder

To change a study:

1. Press Measure.
2. Select Abdomen in Exam Category.
3. To choose another study, select the desired study.

Small Parts
B-Mode Measurements

The Small Parts exam category includes the following folders:

• Generic - Common to all applications.
• Thyroid
• Scrotal
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• Breast

OB
Prior to an ultrasound examination, the patient should be informed of the clinical indication,
specific benefits, potential risks, and alternatives, if any. In addition, if the patient requests
information about the exposure time and intensity, it should be provided. Patient access
to educational materials regarding ultrasound is strongly encouraged to supplement the
information communicated directly to the patient. Furthermore, these examinations should
be conducted in a manner and take place in a setting which assures patient dignity and
privacy.

• Prior material knowledge and approval of the presence of nonessential personnel with
the number of such personnel kept to a minimum.

• An intent to share with the parents per the physician’s judgement, either during the
examination or shortly thereafter, the information derived.

• An offer of choice about viewing the fetus.
• An offer of choice about learning the sex of the fetus, if such information becomes

available.

Ultrasound examinations performed solely to satisfy the family's desire to know the fetal sex,
to view the fetus, or to obtain a picture of the fetus should be discouraged.

Acoustic Output Considerations
DANGER
The ultrasound system is a multi-use device which is capable of exceeding FDA
Pre-enactment acoustic output (spatial peak-temporal average) intensity limits for fetal
applications. The interaction of sound energy with tissue at sufficiently high levels and/or
longer duration can produce biological effects (aka bioeffects) of either a mechanical or
thermal nature.

DANGER
It is prudent to conduct an exam with the minimum amount and duration of acoustic output
necessary to optimize the image's diagnostic value. The interaction of sound energy with
tissue at sufficiently high levels can produce biological effects (aka bioeffects) of either a
mechanical or thermal nature.

Concerns Surrounding Fetal Exposure

Always be aware of the acoustic output level by observing the Acoustic Output Display. In
addition, become thoroughly familiar with the Acoustic Output Display and equipment controls
affecting output.

Training

It is recommended that all users receive proper training in fetal Doppler applications before
performing them in a clinical setting. Please contact a local sales representative for training
assistance.

OB Type change

The ultrasound system includes measurements for the following studies: USA, Europe,
Tokyo, Osaka and ASUM.

Select OB Type in Utility > System > System Measure.
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NOTE
ASUM studies include the following measurements:

• ASUM: AC, BPD, and CRL
• ASUM 2001: AC, BPD, CRL, FL, HC, HL, and OFD

OB Report

The OB Report lists patient information, and all measurement and calculation data.
To view the OB Report, press the Report key on the control panel.
The OB Report has four sections of information:

1. Patient data
2. Measurement information
3. Calculation information
4. Report menu list

Patient Data
The Patient data section, at the top of the worksheet, lists information from the Patient Data
Entry screen.
The following fields can be selected:

• FetusNo – If this is a multi-gestational patient, select the fetus in this field. Fetus
selection can be adjusted to change the fetus.

• CUA/AUA – Select the ultrasound age calculation method

• Composite Ultrasound Age (CUA) – Regression calculation
• Average Ultrasound Age (AUA) – An arithmetic average

Select the method in this field or adjust the Select CUA/AUA control.

NOTE
CUA/AUA is only available when USA OB Type is selected in the Utility > System >
System Measure menu.

Information can be entered in the following fields:

• FetusPos – Enter information about the fetus position.
• PLAC – Enter information about the placenta.

Measurement information
This section lists the results of all measurements.

• CUA or AUA - If this field is checked, the system uses the measurement to calculate the
ultrasound age.

• Value - The measured value. If more than one measurement was made for an item, the
system uses the specified method (average, maximum, minimum, or last) to determine
this value.

• m1-m3 - Up to three measurement values for each item. If you make more than three
measurements, the report uses the last three.
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• Method - When there is more than one measurement for an item, this specifies the
method used to calculate the measurement value listed in the Value column. Choices are
average, maximum, minimum, last, or off. To change the method:

1. Move the Trackball to the Method field.
2. Press Set.
3. Move the Trackball to select from the list.
4. Press Set.

• AGE - The fetal age for this measurement.
• Range - The typical range of fetal age for this measurement.

Calculation Information
This section of the worksheet provides calculation choices and lists calculation results.

• EFW – Lists the parameters used to calculate EFW. This is followed by the calculation
result.

To change which parameters are used:

• Select this field or press Select EFW.
• Select the desired parameters.

• EFW GP – Lists the source used to calculate EFW–GP (growth percentile). This is
followed by the growth percentile.

To change the source:

• Select this field or press Select GP.
• Select the desired source.

The remaining calculation information shows ratios for several measurements, and the
Cephalic Index (CI).
The worksheet shows if any of the ratios are out of range (OOR). Out of range indicates one
of the following:

• The measurement is out of the normal range based on the gestational age that
is calculated from the LMP. The system determines OOR from the ultrasound age
compared to the gestational age. The gestational age is calculated from the last
menstrual period or the estimated delivery date.

• The measurement is outside of the range for the data used in the calculation.
That means that the measurement is either less than or more than the range of
measurements used to determine fetal age based on the measurement.

Report Menu list
Use the report menu list to switch between different summary reports.
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Anatomical Survey

The Anatomical Survey page provides a checklist that indicates which anatomy was imaged
and its appearance.

Figure 2-15 Anatomical Survey

1.Normal/Seen - Press to select normal/seen for all tables under APPEARANCE.
2.Clear - Clear all values in APPEARANCE tables.
3.Save - User can edit and save the current table as a default template.
4.Reset - Reset to factory default settings.

Editing
To activate the Anatomical Survey,

1. Select Anatomy on the OB Report screen.
2. Fill the required field.

Table 2-7 Anatomical Survey

Field Description

FetusPos Indicate the fetal position within the uterus.

PLAC Identify the location of the placenta.
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Field Description

ANATOMY
1. Display the anatomy for each part.
2. User can add up to 11 additional anatomy.
3. User can edit each parameter in the anatomy column.

APPEARANCE Indicate whether the appearance was seen, not seen, normal or
abnormal.

BIOPHYSICAL
PROFILE

The score is _ of 10 possible total points, depending upon the number of
parameters entered. Enter the following information to assess the fetus’s
biophysical well-being.

MOVEMENT Type/select 0, 1 or 2

TONE Type/select 0, 1 or 2

BREATHING Type/select 0, 1 or 2

FLUID Type/select 0, 1 or 2

REACTIVE NST Type/select 0, 1 or 2

COMMENTS Free text

Select Exit to return to the Scan screen.

NOTE
The patient specific contents input on the Anatomical Survey page are returned to the factory
default settings after starting a new patient.

OB Graphs

OB Graphs allow assessment of fetal growth compared to a normal growth curve. When a
patient has completed two or more ultrasound exams, the graphs can also be used to look at
fetal trending. For multi-gestational patients all fetuses can be plotted and the growth can be
compared on the graphs.
The ultrasound system provides the following two basic types of graphs:

• Fetal Growth Curve graphs – show one measurement per graph. These graphs
show the normal growth curve, positive and negative standard deviations or applicable
percentiles, and ultrasound age of the fetus using the current measurement. For multi-
gestational pregnancies, all fetuses can be viewed. If previous exam data is available,
the graph can show fetal trending.

• Fetal Growth Bar graph – shows the ultrasound age and the gestational age based on
patient data. Plots all measurements on one graph.

To View OB Graphs

To view OB graphs:

1. Press Measure.
2. Select Graph.

The system displays the OB Graph keys on the Touch Panel.
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To Edit Patient Data

When working with graphs, the following patient data can be changed or entered:

• GA(LMP) – This field is computed using the LMP date on the Patient Data Entry screen.
To change this field:
NOTE
This field can only be changed on the Fetal Growth Curve Graph in single view.

1. Move the Trackball to the field, which is left of the graph. To select the field, press
Set.
The system displays a window with the GA weeks and days.

2. To select each field, move the Trackball to the field and press Set.
3. Type the correct weeks or days.
4. Select OK.

The system makes the following changes:

• GA (LMP) is now GA (GA) and shows the age you entered.
• In the Patient Data section, the GA changes.
• In the Patient Data section, The EDD (LMP) changes to EDD(GA) and shows

an updated date, using the GA you entered.

The LMP is erased.

• FetusPos – Type information about the fetus position.
• PLAC – Type information about the placenta.

To Return from a Graph to the Scan Display

After viewing graphs, to return to the scan display, do one of the following:

• On the graph display, select Exit.
• On the Touch Panel, select Graph.

OB-Multigestational
Multiple Fetus

The ultrasound system allows measurement and reporting of the development of multiple
fetuses. The system can report a maximum of four fetuses.

To Enter the Number of Fetuses

If more than one fetus is imaged during the exam, enter the number of fetuses in the Patient
Data Entry Menu.
When an OB exam is started, the system automatically fills in the Fetus # field with 1. To
change the number:

1. Move the cursor to the fetus number and press Set twice.

The number is highlighted.
2. Type the correct number and press Set.

The system displays a message to confirm changing the fetus number.
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3. Select Yes.

To Identify Each Fetus

For measurements, calculations, and worksheet displays, the system labels each fetus A, B,
C, or D. Each fetus is identified by a letter and the total number of fetuses. For example, fetus
A/3 is fetus A from a total of 3.
When scanning, information can be entered about the fetus position and placenta location.
The information can be entered in the Patient Data section of the worksheets and the graphs.
Up to 23 characters can be entered in the FetusPos and PLAC fields.

Figure 2-16 Patient Data section of the OB Report

To Select a Fetus

During measurements and calculations, to change between fetuses, do one of the following:

• Adjust the Fetus selection.
• Move the Trackball to the Summary Window and select the fetus.

The fetus selection can be changed at any time during the exam.

NOTE
After changing to the next fetus, any measurements made are recorded and reported to that
fetus. If any active measurement or calculation is not completed when changing the fetus,
the system cancels the measurement or calculation.

To View Multiple Fetuses Data on Graphs

Gestational data for multiple fetuses can be displayed on fetal growth curve graphs. After
making measurements for each fetus, select Graph.

1. To view the graph for each fetus, do one of the following:

• Adjust the Fetus selection.
• In the Patient Data section, move the Trackball to highlight the FetusNo field. In the

list of fetuses, move the Trackball to select the desired fetus and press Set.

2. To display data for multiple fetuses on the same graph, select Fetus Compare.

The legend at the bottom of the graph shows the symbols and colors that represent each
fetus.

To Show Fetal Trending for Multiple Fetuses

When there is data for more than one exam, fetal trending for multiple fetuses can be viewed
and compared on one graph.
To view fetal trending for multiple fetuses:

1. Select Graph.
2. Select Fetus Compare.
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3. Select Plot Both.
NOTE
Fetal trending for multiple fetuses can only be viewed in single graph display.

The symbol key for fetal trending and multiple fetuses is shown at the bottom of the
graph.

To Compare Multiple Fetus Data on a Worksheet

Measurements of multiple fetuses can be listed and compared on the worksheet.
Select Worksheet, then select Fetus Compare.
When selecting Fetus Compare, the system lists the measurement results for each fetus on
the Worksheet.

SonoBiometry (AFB)

SonoBiometry (AFB) is an alternative to the common fetal biometry measurements. It
provides system suggested measurements for AC, BPD, FL, HL and HC which need to be
confirmed by the user or can be changed manually.

Table 2-8 List of Abbreviations

Abbreviati
on

Full Form Definition

AC Abdominal
Circumference

Abdominal Circumference of the baby's abdomen.

BPD Biparietal Diameter Transverse distance between the protuberances of
the two parietal bones of the skull.

FL Femur Length The length in centimeters of the developing baby's
femur (the femur is the long bone in the human
arm).

HC Head Circumference Head Circumference of the baby's head.

HL Humerus Length The length in centimeters of the developing baby's
humerus (the humerus is the long bone in the
human arm).

Using SonoBiometry (AFB):

1. Press Utility and then select System.
2. Select System Measure.
3. Check the desired boxes under SonoBiometry Option Selection to enable system

suggested measurements.
4. Select OB.
5. Press Measure.
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6. Select BPD/HC/AC/FL/HL.

Figure 2-17 SonoBiometry (AFB) option

NOTE
SonoBiometry (AFB) measurements are supported on only recalled raw DICOM images and
frozen images.

You can not use SonoBiometry (AFB) measurements on the following images:

• Images displayed in Dual/Quad view. In these views, an SonoBiometry (AFB)
measurement will change to manual measurement automatically.

• Zoomed image.
• Rotated image.

NOTE
If a particular scanned image does not have valid fetus data, a warning message appears:
"Auto measurement failure. Adjust calipers manually ...".

NOTE
If a particular image is not supported for SonoBiometry (AFB) measurement, a warning
message appears: "Auto measurements do not operate on DICOM images. Using manual
measurement ...".

GYN
The Gynecology exam category includes the following three studies:

• Generic. This study is common to all exam categories.
• General Gynecology. This study includes uterine, ovarian, ovarian follicle, and

endometrium measurements.
• OB/GYN Vessel. This study includes the following vessels: uterine, ovarian, umbilical,

middle cerebral artery, aorta, placenta, and descending aorta.
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NOTE
The calculation formulas are listed in the Advanced Reference Manual.

B-Mode Measurements

In B-Mode, you make the measurements in the General Gynecology study. These
measurements include:

• Uterine length, width, and height
• Ovarian length, width, and height
• Follicle
• Cervix
• Cervix Trace
• Endometrium

Follicle Measurements

Left and right ovary follicle measurements can be made from one, two, or three distances.
To select the left or right, rotate the rotary key on the control panel.

Endometrium Thickness

To measure the endometrium thickness, make one distance measurement.

1. Select Endometrium; an active caliper displays.
2. To position the active caliper at the start point, move the Trackball.
3. To fix the start point, press Set.

The system fixes the first caliper and displays a second active caliper.
4. To position the second active caliper at the end point, move the Trackball.

A dotted line connects the measurement points.
5. To complete the measurement, press Set.

The system displays the endometrium thickness in the Results Window.

Ovary Length, Width and Height

Length, width, and height of the left and right ovaries can be measured. Each measurement
is a typical distance measurement made in the appropriate scan plane.
Typically, length and height are measured on the sagittal plane while the width is measured
on the axial/transverse plane.
To measure ovarian length, width, or height:

1. Scan the patient's right or left ovary in the appropriate plane.
2. To select left or right, adjust the Side selection.
3. Select the OV folder, then select OV L, OV W, or OV H.
4. Perform a standard distance measurement.

1. To position the active caliper at the start point, move the Trackball.
2. To fix the start point, press Set.
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The system fixes the first caliper and displays a second active caliper, if preset
accordingly.

3. To position the second active caliper at the end point, move the Trackball.
A dotted line connects the measurement points.

4. To complete the measurement, press Set.
The system displays the distance value in the Results Window. After the first
and second measurement, the system displays an active caliper for the next
measurement.

5. To make the second and third distance measurements, repeat steps 3–4.

After you complete the length, width, and height measurements, the system displays the
ovarian volume in the Results Window.

Uterus Length, Width and Height

Each of these is a standard distance measurement. Typically, length and height are
measured on the sagittal plane while the width is measured on the axial/transverse plane.
To measure uterus length, width, or height:

1. Scan the patient in the appropriate scan plane.
2. Select the UT folder, then select UT L, UT W, or UT H.

An active caliper displays.
3. Perform a standard distance measurement.

1. To position the active caliper at the start point, move the Trackball.
2. To fix the start point, press Set.

The system fixes the first caliper and displays a second active caliper.
3. To position the second active caliper at the end point, move the Trackball.

A dotted line connects the measurement points.
4. To complete the measurement, press Set.

The system displays the distance value in the Results Window. After the first
and second measurement, the system displays an active caliper for the next
measurement.

4. To make the second and third distance measurement, repeat steps 2–3.

After you complete the third distance measurement, the system displays the uterine volume
in the Results Window.
Cervix Measurements

Cervix measurements can be made from one distance or spline trace.

One Distance

1. Select CX; an active caliper displays.
2. To position the active caliper at the start point, move the Trackball.
3. To fix the start point, press Set.

The system fixes the first caliper and displays a second active caliper.
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4. To position the second active caliper at the end point, move the Trackball.
A dotted line connects the measurement points.

5. To complete the measurement, press Set.
6. The system displays the cervix measurement in the Result Window.

Spline Trace

1. Select CX Trace; an active caliper displays.
2. To position the caliper at the start point, move the Trackball.
3. To fix the trace start point, press Set. The first caliper turns yellow. The second caliper

appears at the same position as the first caliper and is green.
4. To position the second caliper, move the Trackball and press Set. The third caliper

appears at the same position.
The spline trace requires at least three points to draw the trace. Continue setting the
points of the trace until the desired points are set.

5. Press Set again after the last caliper is fixed to finalize the spline trace. All points are
removed from the line and the spline trace turns yellow.
NOTE
Pressing Set twice finishes the trace measurement.

6. The system displays the cervix measurement in the Result Window.

Cardiac
Cardiology measurements offer two different types of measurement studies, Generic and
Cardiac.

• Generic – Each exam category has a Generic study. The Generic studies provide you
quick access to measurements.

• Cardiac – This study includes all cardiac measurements.

Naming Format for Cardiac Measurements

When making a measurement, select the abbreviation for the measurement on the Touch
Panel. Most abbreviations are made using acronyms. The following table lists acronyms used
for naming cardiac measurements.
Table 2-9 Cardiology Abbreviations

Acronym Name

% STIVS % Interventricular Shortening

A Area

Acc Acceleration

AccT Flow Acceleration Time

ALS Aortic Leaflet Separation

Ann Annulus

Ao Aorta
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Acronym Name

AR Aortic Regurgitation

Asc Ascending

ASD Atrial Septal Defect

AV Aortic Valve

AV Cusp Aortic Valve Cusp Separation

AVA Aortic Valve Area

AV-A Aortic Valve Area by Continuity Equation

BSA Body Surface Area

CI Cardiac Index

CO Cardiac Output

d Diastolic

D Diameter

Dec Deceleration

DecT Deceleration Time

Desc Descending

Dur Duration

EdV End Diastolic Volume

EF Ejection Fraction

EPSS E-Point-to-Septum Separation

EsV End Systolic Volume

ET Ejection Time

FS Fractional Shortening

FV Flow Volume

FVI Flow Velocity Integral

HR Heart Rate

IVRT IsoVolumetric Relaxation Time

IVS Interventricular Septum

L Length

LA Left Atrium

LAA Left Atrium Area

LAD Left Atrium Diameter

LPA Left Pulmonary Artery

LV Left Ventricle
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Acronym Name

LVA Left Ventricular Area

LVID Left Ventricle Internal Diameter

LVL Left Ventricle Length

LVM Left Ventricular Mass

LVPW Left Ventricle Posterior Wall

ML Medial to Lateral

MPA Main Pulmonary Artery

MR Mitral Regurgitation

MV Mitral Valve

MVcf Mean Velocity Circumferential Fiber Shortening

MVO Mitral Valve Orifice

OT Outflow Tract

P Papillary Muscles

PA Pulmonary Artery

PAP Pulmonary Artery Pressure

PDA Patent Ductus Arteriosus

PEP Pre-Ejection Period

PFO Patent Foramen Ovale

PG Pressure Gradient

PHT Pressure Half Time

PI Pulmonary Insufficiency

PISA Proximal Isovelocity Surface Area

PR Pulmonic Regurgitation

PV Pulmonic Valve

PV-A Pulmonic Valve Area by Continuity Equation

PVein Pulmonary Vein

PW Posterior Wall

Qp Pulmonic Flow or CO

Qs Systemic Flow or CO

RA Right Atrium

RAA Right Atrium Area

Rad Radius

RAD Right Atrium Diameter
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Acronym Name

RPA Right Pulmonary Artery

RV Right Ventricle

RVA Right Ventricle Area

RVAW Right Ventricle Anterior Wall

RVD Right Ventricle Diameter

RVID Right Ventricle Internal Diameter

RVL Right Ventricle Length

RVOT Right Ventricle Outflow Tract

s Systolic

SI Stroke Index

ST Shortening

SV Stroke Volume

SVI Stroke Volume Index

T Time

TA Tricuspid Annulus

TAML Tricuspid Annulus Medial to Lateral

TR Tricuspid Regurgitation

TV Tricuspid Valve

TVA Tricuspid Valve Area

Vcf Velocity Circumferential Fiber Shortening

Vel Velocity

VET Valve Ejection Time

Vmax Maximum Velocity

Vmean Mean Velocity

VSD Ventricular Septal Defect

VTI Velocity Time Integral

In this manual, the abbreviation for each measurement is listed in parenthesis after the
measurement, as follows:

• Aortic Root Diameter (Ao Diam)
• Left Ventricle Posterior Wall Thickness, Diastolic (LVPWd)

For example, to measure the Aortic Root Diameter, select Ao Diam on the Touch Panel.
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Auto EF Measurements

Automated Ejection Fraction (Auto EF) is a semi-automatic measurement tool used for
measurement of the global EF (Ejection fraction). The Auto EF tool is used as an optional
decision support tool.

The Auto EF tool tracks and calculates the myocardial tissue deformation based on feature
tracking on B-Mode cine loops.

Auto EF is performed on either one or both apical 4-chamber or 2-chamber views, in any
order.

The result is presented as Ejection Fraction value for each view and average Ejection
Fraction for the whole LV. All values are stored to the worksheet after the results are
approved.

NOTE
The Auto EF tool is intended for pediatric cardiology and is intended to be used in pediatric
cardiology.

Acquisition

1. Create an exam, connect the ECG device and make sure to obtain a stable ECG trace.
2. Acquire B-Mode cineloops of an Apical 4 chamber view (4-ch) and an Apical 2 chamber

view (2-ch).

• The frame rate should be between 37 and 80 frames per second. A higher frame
rate is recommended for high heart rate.

• The Versana Premier/Versana Premier Lotus should be configured to store at least
100 ms before and after each heart cycle.

• If the acquisition has more than one heart cycle, the analysis will be done on the
second last heart cycle.

• The entire myocardium should be visible.
• A depth range that includes the entire left ventricle should be used

NOTE
The Auto EF processed image loop runs slower than the actual cardiac motion. To
see the loop in correct playback speed, exit Auto EF.

Exit Auto EF

Press Exit to end Auto EF. Pressing Report, Patient or Scan also closes the Auto EF
package.

NOTE
Do not disable any sub-measurement of Auto EF in Utility > Measure, as this will disable
the whole set of Auto EF measurements.

NOTE
For consistent results, do not delete individual Auto EF measurements from the worksheet.
Always delete a full column.
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Vascular
Vascular measurements offer several different types of measurement studies:

Figure 2-18 Vascular Exam Category Touch Panel

• Generic – Common to all applications.
• Carotid
• LEA (Lower Extremity Artery)
• LEV (Lower Extremity Vein)
• TCD (Trans Cranial Doppler)
• UEA (Upper Extremity Artery)
• UEV (Upper Extremity Vein)
• Renal
• Bypass Graft
• UEV (Upper Extremity Vein) Map
• LEV (Lower Extremity Vein) Map

A vascular study is a group of particular vessels. Vessel exam calcs can be customized in the
configuration menu.
When using Auto Vascular calculation, use the vessel keys on the Touch Panel to post
assign vascular calculations. When not using Auto Vascular calculation, the vessel key is
used for manual measurement.

Naming Format for Vessels

When you want to measure a vessel, on the Touch Panel you select the folder for the vessel.
Many vessel folders are labeled with an abbreviation. The following table lists abbreviations
used for naming vascular vessels.
Table 2-10 Vascular Vessel Abbreviations

Acronym Name

ACA Anterior Cerebral Artery
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Acronym Name

AComA Anterior Communicating Artery

ATA Anterior Tibial Artery

ATV Anterior Tibial Vein

Axill Axillary Artery

Axill V Axillary Vein

BA Basilar Artery or Brachial Artery

Ba V Basilic Vein

Br V Brachial Vein

CCA Common Carotid Artery

Ceph V Cephalic Vein

CFV Common Femoral Vein

CHA Common Hepatic Artery

Com Femoral Common Femoral Artery

CIA Common Iliac Artery

CIV Common Iliac Vein

Com Iliac A Common Iliac Artery

DFA Deep Femoral Artery

DFV Deep Femoral Vein

Dors Pedis Dorsalis Pedis

DPA Dorsalis Pedis Artery

ECA External Carotid Artery

EIA External Iliac Artery

EIV External Iliac Vein

FV Femoral Vein

GSV Greater Saphenous Vein

ICA Internal Carotid Artery (Transcranial Doppler)

ICA Interior Carotid Artery (Carotid Artery)

IJV Internal Jugular Vein

IMA Inferior Mesenteric Artery

Inn Innominate

IVC Inferior Vena Cava

LSV Lesser Saphenous Vein

MCA Middle Cerebral Artery
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Acronym Name

Mcub V Median Cubital Vein

Mid Hep V Middle Hepatic Vein

MRA Main Renal Artery

PCA Posterior Cerebral Artery

PComA Posterior Communicating Artery

Peron Peroneal

POP Popliteal

PTA Posterior Tibial Artery

PTV Posterior Tibial Vein

RA Renal or Radial Artery

RV Renal or Radial Vein

SMA Superior Mesenteric Artery

SMV Superior Mesenteric Vein

SUBC Subclavian Artery

SUBC V Subclavian Vein

SFA Superficial Femoral Artery

TCD Transcranial Doppler

TIPS Transjugular Intrahepatic PortalSystemic Shunt

UA Ulnar Artery

VERT Vertebral Artery

IMT Measurement

The average of the intima media thickness can be measured for use as the index of arterial
sclerosis.

IMT can be measured both on the posterior and the anterior walls of the vessel.

NOTE
Due to the physical properties of ultrasound imaging, the posterior IMT measurement is
generally more accurate than the anterior IMT measurement.

IMT Measurement - Auto

Auto IMT automatically measures the thickness of the Intima Media on the far and near
vessel walls. Near Wall IMT is the distance between the trailing edges of the adventitia and
intima; the Far Wall IMT is the distance between the leading edges of the adventitia and
intima.
Set up the parameters you want to record on the worksheet on the Utility > Measure >
M&A page while are in the Carotid application. Select CCA/ICA/BIF, then click AutoIMT Far/
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AutoIMT Near to check the box under Parameter (Average, Max, Min, Standard Deviation,
Points, or Distance).

Figure 2-19 Configuring Auto IMT

In the Vascular Carotid application, the Auto IMT measurement is available.

Figure 2-20 Auto IMT Touch Panel

The following controls are available.
Table 2-11 Auto IMT Touch Panel Description

Parameter Description

Worksheet Select to view the Worksheet

IMT Far Select to begin the Far Field IMT measurement.

IMT Near Select to begin the Near Field IMT measurement.
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Parameter Description

AP Anterior Posterior

Trans Transverse

Length/Offset Rotary Push to save Length/Offset as a preset.
-40/+40 Length. At zero, you can freely adjust the length, but only
vertically.
Press key to save value as default.
Offset distance, -20 (Left) / +20 (Right)

Overall / IMT Trace Fit /
Intima

Adjusts (remeasures) the IMT automatically measured by the system.

Rt / Lt Side Select Left / Right Side.

Cursor Select Allows you to update cursor placement.

To measure the IMT:

1. In the Carotid application, press Freeze, press Measure.
2. Position the cursor, then select IMT Far.
3. Use the Trackball to set the length.

Or
Use the Length / Offset control on the Touch Panel to set the length and offset distance.
The Offset key controls how far away from the vertical line the measurement starts.
Length is the length of the tool itself. If set to zero, you can adjust it anywhere on the
image.

4. Press Set.

Either adjust the trace prior to pressing the Print key, or press the Print key to store the
image which also saves the measurement to the Worksheet.
To adjust the trace, use the Overall IMT Trace Fit Intima control on the Touch Panel.
The Trace fit (up/down) adjusts the inter luminal line whereas the overall (rotate) adjusts
both IMT lines.
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Figure 2-21 Example of Auto IMT Far Measurement

5. Position the cursor, then select IMT Near.
6. Use the Trackball to set the length.

Or
Use the Length / Offset control on the Touch Panel to set the length and offset distance.

7. Press Set. “Store image to accept IMT measurement” displays in the message area. If
the traces fit both layers of the wall, approve the measurement by pressing the Print key
to store the image.

To adjust the trace prior to pressing the Print key, use the IMT Trace Fit control on the
Touch Panel. The measurement is saved to the Worksheet.

NOTE
Since the IMT measurements are semi-automatic, the operator has to approve the
detection by visual inspection before storing the results in the worksheet and report.

Auto Vascular Calculation

Auto Vascular Calculation enables the ultrasound system to detect and identify a cardiac
cycle. It allows you to assign measurements and calculations during live timeline imaging,
while the image is frozen, or in CINE. Peak values are detected for venous flow.
During cardiac cycle detection, the system identifies the cardiac cycle using calipers, vertical
bars, and/or highlighting of timeline data. Use of identifiers is based on measurements and
calculations selected by an operator for the current application. The system may place
calipers at early systolic peak, peak systole, minimum diastole and end diastole. Vertical
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bars may also be placed to indicate the beginning and end of the cardiac cycle. The peak
and/or mean trace may be highlighted. You can edit the cardiac cycle identified by the system
or select a different cardiac cycle.
Calculations to be displayed in the M&A Result window can be selected during live scanning
or on a frozen image. These calculations are displayed at the top of M&A Result Window
located adjacent to the image. These calculations are configurable by application, which
means they can be set up the default calculations to be displayed for each application.

Activating Auto Vascular Calculation

To activate Auto Vascular Calculation, select Auto Calcs from Live (calculations displayed
on the real-time image), or Frozen (calculations displayed on the frozen image).
To deactivate Auto Vascular calculation, select Off.

Set up Auto Vascular Calculation Parameters

• Select Auto Trace
To set continuous auto trace of the max or mean velocities:

• Select Max or Mean using the Trace Method Touch Panel pull-down menu.

• Select Trace Direction
Trace Direction allows peak timeline data above, below, or composite (above and below)
the baseline.

• Select Positive, Negative or Both to set the peak timeline data.

• Modify Calculation

1. Select the Modify Calcs Touch Panel key.
The Modify Calculation menu is displayed.

2. Select which measurements and calculations are to be displayed in the Auto
Vascular calculation window.

Select from the following parameters: PS, ED, MD, HR, TAMAX, PI, RI, Accel,
PS/ED, ED/PS, AT, Volume Flow, PV.

Auto Vascular Calculation Exam

1. Preset the system.
2. Perform the scan and press Freeze.
3. Activate Auto Vascular Calculation.

Chapter 2

Versana Premier/Versana Premier Lotus - User Manual 131
5928218-1EN Rev. 6



The system performs a calculation automatically.

Figure 2-22 Auto Vascular Calculation

The Auto Vascular calculation is assigned to particular vessel measurements.

1. Press Measure to display the Measurement menu.
2. Select the location of the vessel (Prox, Mid, or Dist) and Side (Right or Left).
3. Select the desired vessel name from the Touch Panel.
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Selected vessel measurements are automatically assigned with the Auto Vascular
calculation. The results are then displayed in the Results Window.

Figure 2-23 Assigned Vessel

NOTE
To cancel the assignment, use the Cancel Transfer Touch Panel key.

During the course of an exam, the cardiac cycle may be indicated between two yellow bars;
the peak trace and the mean trace may appear in green; calculation indicators appear on the
spectral trace as a caliper identifier (these vary, depending on the selected calculation in the
Results Window).
The right-most, most complete cycle is typically chosen to be the selected cardiac cycle. To
select a different cardiac cycle:

• Move through CINE memory with the Trackball until the desired cardiac cycle is selected
by the system.
NOTE
Several good cycles are required in front of the new cardiac cycle for this to be
successful. Oftentimes, this is problematic near a freeze bar.

• Use the Cycle Select control to cycle to a different cardiac cycle.

To move the systole or diastole position:

• Use the Cursor Select control to move the start systole position or the end diastole
position.

Manual Vascular Calculation

Calculations can be performed manually when Auto Doppler Calculation is not activated.
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1. Press Measure.

If necessary, you can select another Exam Calc and then select parameters from Modify
Calculation.

2. Select the location of the vessel (Prox, Mid, or Dist) and Side (Right or Left).
3. Select the desired vessel folder.

The Measurement menu is displayed.
Figure 2-24 Measurement Menu Example

4. Make the required measurements according to the system, or select your preferred
measurements.

To select vascular measurements

Your system is set up to show the measurements that you usually make for each vessel. To
make a measurement that is not shown for the selected vessel:

1. Enter Utility > Measure, select Vascular.
2. The system displays all possible vessel measurements.
3. Select Doppler tab.
4. Select the desired measurement.

NOTE
The following instructions assume that you first scan the patient and then press Freeze.

Urology
Urology measurements offer three different types of measurement studies:

• Generic–Common to all applications.
• Urology
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• This chapter describes Urology B-Mode measurements.
• The Urology M-Mode measurements are common to other applications.
• The Urology Doppler measurements are common to other applications.

• Pelvic Floor.
NOTE
Bladder(0.7) Vol, Bladder Vol, Post Void Vol, Prostate Vol, Renal Vol, Renal (0.8) Vol
and Volume can be displayed on the Touch Panel if preset at the Utility > Measure
screen.

Urology B-Mode Measurements

In B-Mode, the Generic Exam Calcs for Urology includes the following measurements:

• % Stenosis
• Volume
• Angle
• A/B Ratio
• Elasto
• E Ratio

The following measurements are located specifically in the Urology Exam Calcs. Those
specific measurements (Bladder Volume, Prostate Volume and Renal Volume) are listed on
the following pages.

Press Measure key and select Exam Category on Touch Panel. Then the following exam
category is displayed.

NOTE
Bladder(0.7), Bladder(0.5), Post Void, Prostate, Renal, Renal (0.49), Volume and STVOL
can be displayed if preset at the Utility > Measure screen.

Bladder Volume

This calculation uses a standard distance measurement. Length is typically measured in the
sagittal plane. Width and height are measured in the axial plane.
To measure Bladder Volume:

1. Scan the patient in the appropriate scan plane.
2. Select the Bladder folder, an active caliper displays.
3. Perform a standard distance measurement.

The system displays the distance value in the Results Window.
4. To make the second and third distance measurement, repeat steps 2–3.

After you complete the third distance measurement, the system displays the bladder volume
in the Results Window.

Renal Volume

This calculation uses a standard distance measurement. Length is typically measured in the
sagittal plane. Width and height are measured in the axial plane.
To measure Renal Volume:
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1. Scan the patient in the appropriate scan plane.
2. Select Rt or Lt side.
3. Select the Renal folder, an active caliper displays.
4. Perform a standard distance measurement.

The system displays the distance value in the Results Window.
5. To make the second and third distance measurement, repeat steps 2–4.

After you complete the third distance measurement, the system displays the renal volume in
the Results Window.

Prostate Volume

This calculation uses a standard distance measurement. Length is typically measured in the
sagittal plane. Width and height are measured in the axial plane.
To measure Prostate Volume:

1. Scan the patient in the appropriate scan plane.
2. Select the Prostate folder, an active caliper displays.
3. Perform a standard distance measurement.

The system displays the distance value in the Results Window.
4. To make the second and third distance measurement, repeat steps 2–3.

After you complete the third distance measurement, the system displays the prostate volume
in the Results Window.

PSA Measurement

Entering the value of PSA (Prostatic Specific Antigen) and PPSA Coefficient at the Urology
Patient screen, automatically calculates PSAD and PPSA.
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The values are displayed on the Worksheet and Report (if set appropriately on the Report
Designer page).

Figure 2-25 Urology Patient Screen

Figure 2-26 Measurement result window

PSAD: Prostatic Specific Antigen (PSA) Density – defined as: PSAD = PSA/Volume
PPSA: Predicted Prostate Specific Antigen – defined as: PPSA = Volume x PPSA Coefficient

Report

• For the prostate volume calculation, you can select the method "m1, m2..." in addition to
Avg., Max., Min. and Last.

• The value of PSA and PPSA are displayed.
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Pelvic Floor Measurements

Pelvic floor measurements can be performed in the Pelvic Floor study. The measurements
are located in the Exam Calc folder in the Urology preset.

Figure 2-27 Pelvic Floor Study Touch Panel

BN (Bladder Neck) Rest

Obtain an image with the patient at rest (relaxed).

1. Create a straight line (zero or baseline) to line up with the inferior/posterior of symphysis
pubis bone.

2. Once the baseline is positioned, a caliper appears. Position the caliper at the anterior
margin of the bladder neck. A positive number displays since the caliper is placed below
the baseline.

3. A distance is calculated in millimeters.

BN (Bladder Neck) Stress

Obtain an image after the patient performs the Valsalva maneuver.

1. Create a straight line (zero or baseline) to line up with the inferior/posterior of symphysis
pubis bone.

2. Once the baseline is positioned, a caliper appears. Position the caliper at the anterior
margin of the bladder neck.

If the bladder neck is below the baseline, the Bladder Neck Stress is a positive number.
If the bladder neck is above the baseline (closer to the transducer face), the number is
negative.

BN (Bladder Neck) Descent

The Bladder Neck Descent is a calculation that should be calculated after measuring the
Bladder Neck Rest and Bladder Neck Stress.
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BND = Bladder Neck Rest - Bladder Neck Stress

NOTE
If the Bladder Neck Stress is a negative number, it becomes positive and is added to the
bladder neck rest measurement.

DWT (Detrusor Wall Thickening)

Three distance measurements of the bladder wall dome are calculated into a mean
dimension and displayed in millimeters.

UT (Uterine) Descent Max

1. Create a straight line (zero or baseline) to line up with the inferior/posterior margin of
symphysis pubis bone.

2. Measure using a 2-caliper dimension to the inferior position of the uterus in a stress
image and display in millimeters

Rect Amp Des Max (Rectal Ampulla Descent Max)

1. Create a straight line (zero or baseline) to line up with the inferior/posterior margin of
symphysis pubis bone.

2. Measure using a 2-caliper dimension to the inferior position of the rectal ampulla in a
stress image and displayed in millimeters

Rectocele (Depth and Width)

Two 2-caliper diameter measurements to measure depth and width of the rectocele.
Displayed in millimeters.

Lev Hiat Stress (Levator Hiatus Stress)

Two 2-caliper diameter measurements and calculate an area displayed as cm squared.

Residual Urine

Two 2-caliper diameter measurements calculate as:
(x) times (y) times 5.9 minus 14.9 equals Residual Volume displayed in ml.

Auto Bladder Volume Measurement (Whizz On)

Auto Bladder Volume automatically measures the Bladder Volume. It's main application is to
measure three longest orthogonal lines (L, H and W) from two bladder slices.

It provides "Auto Bladder LxH" and "Auto Bladder W" to take L, H and W values, then
automatically calculate the Bladder Volume.

Set up the parameters you want to record on the report in Utility>Measure>M&A page.
Select the Auto Bladder Volume Tool.

The following controls are available.

Table 2-12 Auto Bladder Volume description

Parameter Description

L L value from bladder slice.
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Parameter Description

H H value from bladder slice.

W W value from the bladder slice.

Vol Bladder volume calculated by 0.7xLxHxW or 0.5xLxHxW.

To measure the bladder volume,

1. Select Bladder application.
2. Enter Utility>Application>Whizz page, check Preset as Bladder and configure Auto

IQ Optimization, Whizz CF, Auto Measurement and Auto Annotation.
3. Press Whizz key on the control panel to turn on Whizz.
4. Activate the M&A package, press Measure.
5. Auto Bladder(0.7) is selected automatically. If user wants to select Auto Bladder (0.5),

press Return to continue.
6. Place the caliper anywhere outside the bladder and position it. Press Set.
7. The first caliper is anchored in place and rectangle appears, free to adjust.

Move the second caliper to the right or to the left to generate a dotted rectangle
connecting the two cursors.

8. Press Set and complete the measurement. Annotation of Bladder will appear
automatically in the screen.

9. After a measurement, the length of lines are displayed in the result window as "Bladder
L/H/W and Bladder Vol".

10. User could select and adjust the calipers of lines by "Cursor Select".

NOTE
Do not select the region of interest including many non-bladder area. Do not select the
region of interest inside the bladder area.

NOTE
The accuracy for auto bladder volume measurement is ±30%.

Pediatrics
Pediatrics measurements offer two different types of measurement studies:

• Generic. The Generic Calculations study is common to all applications.
• Pediatric Hip (PedHip).

• This chapter describes Pediatrics B-Mode measurements.
• The Pediatrics M-Mode measurements and Doppler measurements are common to

other applications.
• The Pediatrics Doppler measurements are common to other applications.
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Pediatrics Hip

Figure 2-28 Pediatrics B-Mode Measurement

Hip Dysplasia Measurement

The HIP calculation assists in assessing the development of the infant hip. In this calculation,
three straight lines are superimposed on the image and aligned with the anatomical features.
The two angles are computed, displayed, and can be used by the physician in making a
diagnosis.
The three lines1 are:
1 - The baseline connects the osseous acetabulum convexity to the point where the joint
capsule and the perichondrium unite with the iliac bone.
2 - The inclination line connects the osseous convexity to labrum acetabulare.
3 - The Acetabulum roof line connects the lower edge of the os ilium to the osseous
convexity.

The α (Alpha) angle is the supplement of the angle between 1 and 3. It characterizes the osseous
convexity. The β (Beta) angle is the angle between lines 1 and 2. It characterizes the bone
supplementing additional roofing by the cartilaginous convexity.

Figure 2-29 Hip Dysplasia
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Anatomical Landmarks
a Ilium
b Iliac Bone
c Labrum
d Bony Roof
e Cartilaginous acetabular roof
f Femoral Head
1Source: R GRAF, Journal of Pediatric Orthopedics, 4: 735-740(1984)
To make a Hip Dysplasia measurement:

1. From the Touch Panel, select either the right or left side (orientation) and then select
Beta Alpha HIP.

A horizontal dotted line displays.
2. To place the baseline, move the Trackball. Position the crosshairs edge at the osseous

convexity of the ilium.
3. To rotate or change inclination, adjust the Ellipse control or Hip Rotate.
4. To fix the baseline, press Set.

The system displays a second dotted line at an angle.
5. To place the line along the inclination line of the osseous convexity to labrum

acetabulare, move the Trackball.
6. To rotate or change inclination, adjust the Ellipse control or Hip Rotate.
7. To fix the second measurement line, press Set.

The system displays a third dotted line at an angle.
8. To place the caliper along the acetabular roof line, move the Trackball.
9. To rotate or change inclination, adjust the Ellipse control or Hip Rotate.
10. To fix the third measurement line and complete measurement, press Set.

The system displays the hip measurements (α and β) in the Results Window.

Alpha HIP

The Alpha HIP measurement measures the angle between the iliac baseline and the bony
roof line. To make an Alpha HIP measurement:

1. From the Touch Panel, select either the right or left side (orientation) and then select
Alpha HIP.

A horizontal dotted line displays.
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2. To place the baseline, move the Trackball. Position the crosshairs edge at the osseous
convexity of the ilium.

3. To rotate or change inclination, adjust the Ellipse control or Hip Rotate.
4. To fix the baseline, press Set.

The system displays a second dotted line at an angle.
5. To place the caliper along the acetabular roof line, move the Trackball.
6. To rotate or change inclination, adjust the Ellipse control or Hip Rotate.
7. To fix the second measurement line, press Set.

The system displays the alpha hip measurement (α) in the Results Window.

d:D Ratio Measurement

The d:D Ratio measurement measures the percentage of the femoral head coverage under
the bony roof. To make this measurement:

1. From the Touch Panel, select either the right or left side (orientation) and then select
d:D Ratio.

A horizontal dotted line displays.
2. Use the Trackball to place the baseline along the ilium. Position the crosshairs edge at

the osseous convexity of the ilium.
3. Use the Ellipse control to adjust or change inclination or Hip Rotate.
4. Press Set to fix the baseline.
5. The system displays a circle representing the femoral head. Use the Trackball to

position the circle.
6. Use the Ellipse control to size the femoral head circumference.
7. Press Set to fix the femoral head circumference.

The system displays the d:D ratio for the femoral head in the Results Window.

Auto vs. Manual Calculations
The same calculations can be performed using either manual or auto calcs.

Manual Calcs
To perform manual calcs:

1. To turn Auto Calcs off and perform manual measurements, choose Auto Calcs > OFF
on the PW tab of the Touch Panel.

2. After obtaining a waveform, press Measure. Choose the appropriate vessel folder or
calculation. The system walks you through the measurement.

NOTE
To program which calculations are done under manual calcs when using measurement
folders for measuring specific vessels, press the Utility key. Select Measure > Doppler and
program your manual calcs (Auto Calcs OFF). Each vessel must be programmed individually
and saved after each change.
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Auto Calcs

To perform auto calcs:

1. Ensure that the auto calcs function is on by choosing Auto Calcs > Frozen or Live on
the Doppler tab of the Touch Panel.

• Live: Auto calculation activates when the system is in real-time.
• Frozen: Auto calculation activates when you press Freeze.
• Off

2. After obtaining a waveform, press Measure. Choose the appropriate vessel folder, side
and location. The measurements that are pre-programmed are performed automatically
and entered in the worksheet.

To modify auto calcs:

1. Select Modify Auto Calcs on the Touch Panel.
2. Choose the measurements to be performed with this preset.
3. To save these measurements:

• If this is a temporary change, press Return.
• If this is a permanent change, select Save as default.

The measurements are saved and can be performed with the auto calcs function.

Edit Auto Calcs

Auto Calcs can be edited after taking an Auto Trace measurement.

1. After taking an Auto Calc with a trace, select the measurement result on the result
window. The Edit Trace menu window appears.
NOTE
If the system cannot take the trace data correctly from the image, Edit Trace does not
work.

2. Select Edit Trace. The first caliper (manual trace caliper) appears on the center of the
image. Use the Trackball to move the caliper on the trace line to the start point.
NOTE
To cancel Edit Trace at this time, press Clear, Scan, or Freeze.

3. Press Set to fix the first caliper. The second caliper appears. Edit the trace manually
using the second caliper.

The Ellipse control is used to edit the trace.

NOTE
When pressing the Clear key once at this time, the second caliper disappears and the
first caliper appears in the center of the image.
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NOTE
If you press Scan or Freeze at this time, the caliper is automatically fixed and the result
window updates.

4. Press Set to fix the second caliper. The trace and the result window are updated. The
data is retaken from the trace and updated.
NOTE
While in Edit Trace, Cursor Select is disabled.

The trace data (TAMAX and TAMEAN) is updated, but the other selections (e.g. PS,
ED) are not updated by trace. The points can be edited using Cursor Select if needed.

5. Repeat Edit Trace as needed.

Modify Auto Calcs

When you select this key, the Modify Calculation menu is displayed as below. In this menu,
you select parameters to display in the Auto Vascular Calculation window. Only parameters
that can be used by the calculation are displayed.
Select Save as Default to save the selected parameters as the default calculations for this
application.
Select Return to return to the previous Touch Panel screen.
If you select PV, all selected parameters are turned off. When you deselect PV, the system
returns to the previously selected calculation.

Figure 2-30 Modify Auto Calculation Menu

Wide Dual Screen Measurements

To preform measurements in wide dual screen, select measurement item from Touch Panel.

NOTE
Ensure that the "Dual Screen" has been selected in the Automatic Wide Screen... portion of
the Utility>System>System Imaging.
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1. Press Dual Live button on the touch panel to enter wide dual screen.
2. Press Measure on the control panel, the Result window displays at the left bottom of

the screen. To perform measurement, select measurement item from left measurement
list or select measurement item from Touch Panel. To switch from different mode
measurement package, press Left/right arrow keys on the Alphanumeric keyboard.
NOTE
The location of Result Window and measurement item in wide dual screen is different
from single screen and dual screen.

Viewing and Editing Worksheets

As you complete measurements, the system puts measurement data in the appropriate
worksheets

NOTE
Worksheets are not saved if the system crashes.

For the same measurement item, the most recent 6 values can be averaged.

To view a worksheet
To view a worksheet, select Report on the Touch Panel.
The system displays the worksheet for the current study.
If a worksheet has more data on a second page, to view the next page, rotate the Page
Change knob or select directly on the Touch Panel.
To return to scanning, do one of the following:

• Select Report.
• Press Esc.
• Select the Exit button by Cursor.

To edit a worksheet
HINTS
Some fields on the report are view only, and others you can change or select. To easily see
which fields you can change or select, move the Trackball. As the cursor moves over a field
that you can change or select, the field is highlighted.

Change Data

1. Move the Trackball to the field you want to change.
2. Press Set.
3. Type the new data in the field. The new data is displayed in blue to indicate that it was

manually entered.
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Delete or Exclude Data

1. Move the Trackball to the field you want to delete or exclude, press the Cursor. The field
is highlighted.

2. Do one of the following:

• To delete the field, select Delete Value.
• To exclude the field, select Exclude Value.

The data in the field is not visible and is not included in worksheet calculations.
• To include a value that you previously excluded, select Exclude Value.

Type a comment

1. Select Comments. The Comments window opens.
2. Type comments about the exam.
3. To close the Comments window, select other Menu.

Turn the volume measurement value off
To turn the volume measurement value off, select the method type Off.

Delete All Worksheet Values
You can delete all measurement values on a worksheet.

1. When the Worksheet is displayed on the monitor, press the Clear key, the following
warning message appears:

Figure 2-31 Warning Message

2. Select OK to delete all.
Select Cancel to cancel the deletion.

Clinical Measurement Accuracy

Basic Measurements
The following information is intended to provide guidance to the user in determining the
amount of variation or measurement error that should be considered when performing clinical
measurements with this equipment. Error can be contributed by equipment limitations and
improper user technique. Be sure to follow all measurement instructions and develop uniform
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measurement techniques among all users to minimize the potential operator error. Also, in
order to detect possible equipment malfunctions that could affect measurement accuracy, a
quality assurance (QA) plan should be established for the equipment that includes routine
accuracy checks with tissue mimicking phantoms.
Please be advised that all distance and Doppler related measurements through tissue are
dependent upon the propagation velocity of sound within the tissue. The propagation velocity
usually varies with the type of tissue, but an average velocity for soft tissue is assumed. This
equipment is designed for, and the accuracy statements listed on are based on, an assumed
average velocity of 1540 m/s. The percent accuracy when stated applies to the measurement
obtained (not the full scale range). Where the accuracy is stated as a percent with a fixed
value, the expected inaccuracy is the greater of the two.
Table 2-13 System Measurements and Accuracies

Measurement Units Useful Range Accuracy Limitations or Conditions

Depth mm Full Screen ≤10%

Angle degree Full Screen ≤5%

Distance:

Axial mm Full Screen <5%

Lateral mm Full Screen <5% Linear Probes

Lateral mm Full Screen <5% Convex Probes

Lateral mm Full Screen <5% Sector Probes

Circumference:

Trace mm Full Screen ≤10% Linear Probes, Convex
Probes, Sector Probes

Ellipse mm Full Screen ≤5% Linear Probes, Convex
Probes, Sector Probes

Area:

Trace mm² Full Screen ≤5% Linear Probes, Convex
Probes, Sector Probes

Ellipse mm² Full Screen ≤5% Linear Probes, Convex
Probes, Sector Probes

Time s Timeline Display <5% M mode, AM mode, CM
mode, PWD mode, CWD

mode

Slope mm/s Timeline Display ≤10% M mode, AM mode, CM mode

Doppler SV
Position

mm Full Screen ≤2 mm PWD mode

Doppler
Velocity

cm/s Form 0 to 100 cm/s <15% PWD mode, CWD mode

From 100 to 130
cm/s

<10%
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Measurement Units Useful Range Accuracy Limitations or Conditions

Doppler Angle
Correction

cm/s From 0-80° ≤5% PWD mode
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Chapter 3
After The Exam Is Over
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Preset

Preset Menus provides the following functionality:

• System. View and update general system configuration settings, measurement settings,
backup and restore data, Peripherals, User Configurable Key, User Defined Gesture,
Probe Buttons and configuration files.

• Imaging. View and update exam and imaging parameters.
• Comments. Set up comment libraries by application.
• Body Patterns. Set up body pattern libraries by application.
• Application. Configure application- and user-specific settings.
• Test Patterns. Helps configure system settings.
• Connectivity. Define connection and communication setup, including exam dataflow

information.
• Measure. Customize exam studies, create measurements, set up manual sequencing,

and create OB Tables.
• Whizz Report. Allows you to managethe report template, import the report template, and

export Whizz Report Editor for creating user customized report template.
• Admin. Perform system administrator activities such as setting up user IDs and logon

formats.
• Service. Activates the Service Browser.
• Scan Coach. Create, import/export, and manage Scan Coach programs.
• Scan Assistant. Create, import/export, and manage Scan Assistant programs.
• Imaging Preset Manager. Manage Imaging Presets
• Whizz. Customize Whizz setting.
• Search. User can search for a parameter on the Utility pages (Measure, Reports, and

Service pages cannot be searched.)
• 3D/4D. Real-time 4D and Static 3D scanning.
• LDAP(Lightweight Directory Access Protocol). Allows you to enable/disable LDAP

authentication, and configure LDAP.
• Barcode. Manage barcode configuration.

To access these functions, select the Utility on the Touch Panel, then select the appropriate
menu key.

System Presets

System presets allows you to view or change the following parameters:

• General - Location, Date/Time, System Prompt Sound, Bi-plane Simultaneous Layout,
Report File Name Composition, Title Bar, Trackball, Key Usage, Utility, Scan Assistant,
Audio and Breast Care configuration

• System Imaging - Biopsy Guides, Follow Up Tool, Image Label Color, Image Label
Layout, Auto Zoom Linear Probe Images at Shallow Depth..., Controls, Display,
Automatic Wide Screen... and QAnalysis Statistic Value configuration

• System Measure - Measurement, Cursor and Results Window configuration,
SonoBiometry Option Selection
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• Backup/Restore - Backup, Media, EZMove, EZBackup, Restore, Detailed Restore of
User Defined

• Peripherals - Print and Store Options, Removable Media, Standard Printer Properties,
Default Printer and Setup configuration

• User Configurable Key - User Defined Key, Keyboard Key and User Defined Trackball
Key configuration

• User Defined Gesture - User Defined Gesture configuration.
• Probe buttons - L4-20t probe buttons configuration.
• About - Software, Base Image, Patents, Scan Coach Addendum, System, System

Image Patches and Additional Information.

Changing system parameters
To change system parameters:

1. Select Utility on the Touch Panel.
2. Then select System. The System screen displayed.
3. On the monitor display, move the Trackball to select the tab that has the information you

want to change.
4. Select values for the parameters you want to change.
5. To save the changes, press Save button. Press Exit to return to scanning. In some

cases, you may need to reboot the system for the change to take effect.

Keyboard Language Setup

1. Press Utility > System > General, select desired language under Language (restart
needed) and Input Language drop-down menu.

2. Press Save.
3. System restart pop-up appears, press Restart now to restart the system.

NOTE
To have the settings take effect, you MUST restart the system.

NOTE
Press Alt+Shift to change the input language.

Imaging Presets

Imaging screens allow you to specify parameters for the following:

• B-Mode (B)
• Color Flow Mode (CF)
• Power Doppler Imaging (PDI)
• Elastography (ELASTO)
• M-Mode (M)
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• Anatomical M-Mode (AMM)
• Pulse Wave Mode (PW)
• Continuous Wave Mode (CW)
• Harmonics (HAR)
• B Flow Mode (BF)
• B Flow Color (BFC)
• Ref
• Contrast (CON)
• Tissue Velocity Imaging (TVI)
• Tissue Velocity Doppler (TVD)
• General

Figure 3-1 Imaging Preset Example

1. Preset/application dependent setup parameters
2. Probe dependent setup parameters

Changing imaging presets
To change imaging presets:

1. On the Touch Panel, select Utility.
2. On the Touch Panel, select Imaging.

The system displays the Imaging screens.
3. In the row across the top of the screen, select the mode.

The system displays two sets of parameters and settings. The left column lists all
settings for the exam (for example, Abdomen). The right column(s) list settings that apply
only to the exam and probe combination.

4. In the Preset list, select the exam.
5. In the Probe list, select the probe.
6. To change a parameter, do one of the following:

• Select the value from a list
• Select one value from a choice of two or more buttons
• Select or clear a check box

7. After changing the parameters, to save the changes, select the Save button.
NOTE
When you Save changes to imaging parameters, the system saves changes to all
modes, not just the mode currently displayed.
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If you have problems with imaging, you can return parameters back to the original
settings. Select the exam, probe, and mode, and then select Reload Factory Defaults.
The system returns the selected parameters to the original settings.

For information about the specific parameters, refer to Chapter 2 Optimizing the Image.

General
You can specify a default probe per application and a default application per probe, ECG
Display or Sync Mode.

Default probe per application

1. To specify a default probe per application, select Utility > Imaging > General.
2. Check the parameter if you want to start it automatically.
3. Select the default probe from the pull-down menu.

Default mode and application per probe

1. To specify a default application per probe, select Utility > Imaging > General.
2. Under Probe, specify the desired mode and application from the pull-down menu.

Checkmark the following fields when you want the system to activate a certain display.
Values vary by probe.

• Simultaneous
• ECG

• ECG Display
• Sync Mode

If your system has the following options, you must assign the option to the button per
application and probe.

• B or HAR(Harmonics)
• Acoustic Output (%)

NOTE
If you use the user-defined preset as default preset, re-select the preset in Utility whenever
you overwrite the user-defined preset.

Imaging Preset Manager
Selecting an Application Preset

The exam category preset that best describes the desired exam to be performed is chosen
after the exam category is selected. The factory default preset selections are displayed on
the menu area.
Use these parameters as a starting point for the exam.

Creating a User-Defined Application Preset

To create a User-Defined Application Preset,
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1. Select the Probe tab on the Touch Panel.
2. Select the Model and Application you want to use as a basis for the new Application

Preset.
3. Select Create New.

Figure 3-2 Application Preset Menu

4. The Create New Application menu appears. Enter the name and check the "Add to My
Preset" box, then press Create.
NOTE
The new user application is based upon the current exam category and application, plus
any modifications you have made, including the comment library and M&A calcs.

NOTE
The name of the new application cannot include spaces or symbols. However, the name
can include numbers and letters.
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5. To view/edit the parameters for the user-defined preset, press Utility > Imaging Preset
Manager.

Figure 3-3 Preset Manager

If you change the settings for this application, make sure to save the changes via Save >
Overwrite (user application).

NOTE
If you select Reset for the user-defined application that you created, the settings for this
user-defined application revert back to the factory settings for the exam category and
application it was based upon.

NOTE
If you use the user-defined preset as default preset, re-select the preset in Utility whenever
you overwrite the user-defined preset.

NOTE
You can delete, rename, edit a user-defined application. And you can also create a new
application preset by selecting Create New.

Arranging Presets Position

On this screen, you can specify which and where you want the application presets to display
on the exam's Application Preset Menu.
To map the preset to the preset keys:
Select the mapping grid under My Preset/Preset/Fifth Column and select the preset you
want to display under Imaging Preset Manager, then press >>. The selected preset will be
under My Preset/Preset/Fifth Column.
OR
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Select the preset under Imaging Presets Manager and drag to any position you want to
locate under My Preset/Preset/Fifth Column.

Figure 3-4 Mapping the preset keys

User can move the location of the preset displaying on the Application Preset Menu via
Utility>Imaging Preset Manager.
To reposition a preset,

1. Select the Preset you want to move under My Preset/Preset/Fifth Column.
2. Use the Up/Down button on the left side to move the preset to the next grid, or press the

preset selected and drag to a new grid.

Fifth Column
Fifth Column locates on the right side of the Touch Panel screen. It contains Frequent
Presets, Recent Presets and Customized Presets.

Frequent Presets - Most frequent used presets.
Recent Presets - Most recent used presets.
Customized Presets- User can use >> key to move or directly drag the presets to this page.
The Fifth Column on the Touch Panel provides quick access to some presets from touch
panel. Swipe the fifth column with one finger from right to left/left to right to change between
Frequent Presets, Recent Presets and Customized Presets.

NOTE
Swipe black space can help to prevent accidentally Hit/Select any button on the touch panel.
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User can move the position of customized presets displaying on the Touch Panel via
Utility>Imaging Preset Manager (on touch panel).

Figure 3-5 Fifth Column Configuration

To reposition a Preset on the Touch Panel grid,

1. Select the Preset you want to move under Customized Presets.
2. Use the Up or Down button to move the Preset to the next grid, or press and drag the

selected Preset to any grid preferred.

Updating User Presets

You can edit, reset to factory default, or delete any user preset you create, as long as you
have selected it in the "Available Imaging Presets" column on the left.

Editing imaging Parameters
To view/edit the parameters for the user-defined preset,
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1. Adjust the image while in the user preset you want to edit.
2. Press Probe on the Touch Panel.
3. Select [Preset Name] and press Overwrite.
4. From the Utility > Imaging Preset Manager.

To view/edit the parameters for the user defined preset

1. Press Utility > Imaging Preset Manager. Select the user preset you want to view/edit
from Available Imaging Presets Column.

2. Press Edit. The Imaging page appears.
3. Edit the presets as necessary and press Save.

OR

1. Adjust the image while in the user preset you want to edit.
2. Press Probe on Touch Panel.
3. Select [Preset Name] and press Overwrite.

Renaming a User Preset

To rename a user preset,

1. Press Utility > Imaging Preset Manager. Select the user preset you want to rename.
2. Press Rename. The Rename Preset pop-up menu appears.
3. Type the new name and press Rename.

Deleting a User Preset

To delete a user preset,

1. Press Utility > Imaging Preset Manager. Select the user preset you want to delete.
2. Press Delete. The Delete Preset pop-up menu appears.
3. Confirm that you want to delete this user preset and press Yes.

Share My Presets between Versana Premier/Versana Premier LotusSystems

You can share the My Presets you have created between Versana Premier/Versana Premier
Lotus systems by exporting/importing the preset(s) you want to share.
To move a user preset from one ultrasound system to another (same software level), first
export the user preset(s) you wish to share.

Exporting User Presets
To export a user preset (or presets),

1. Enter Utility > Imaging Preset Manager.
2. Insert the media.
3. Press Export (on the bottom).
4. An Export Presets pop-up menu appears that indicates:

a. Destination location (USB Flash Drive/Hard Disk Drive location).
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b. Preset directory where the preset should be saved (Preset Export).
c. Available presets on the scanner.

Select the name for the Preset Directory from the Preset Directory pull-down.
5. Select the User Defined Presets under Available presets on scanner and press

Export.
6. Upon a successful export, an informational message will pop-up indicating that "1 preset

successfully exported." Press OK. Then press Exit to close the Export Presets pop-up
menu.

7. Press F3 to eject the media. Take the media to another system and follow the Importing
User Presets instructions below.

Importing User Presets
To import a User Preset,

1. Activate the Imaging Preset Manager from the Utility.
2. Insert the media (Flash Drive, USB Hard Drive).
3. Press Import. The Import Presets pop-up appears and displays the Source Directory

and Available Imaging Presets.
4. Select the User Defined Presets under Available Imaging Presets and press Import.

If these presets are already on this Versana Premier/Versana Premier Lotus, you will be
asked whether you want to:

• Overwrite this preset (Yes, Yes to All, No or No to All).
• Rename this preset (Type the new name and press Rename).
• Cancel.

5. Upon a successful Import, an informational message will pop-up indicating that "1 preset
successfully imported." Press OK. Then press Exit to close the Import Presets pop-up
menu.

6. Press F3 to eject the media.

Storing Images and Cineloops

Images and cineloops that are stored during a current examination are displayed as
thumbnails on the clipboard.
When an image is stored, all the additional information that is displayed is saved with it (i.e.
probe and application selected, image setting, annotations or measurements).
See Dataflow in Connectivity for detailed settings related storing image/Cine.
Image archive is set by the dataflow selected (See Dataflow in Connectivity for more
information.)
To print/store an image, P1 is most commonly used for the primary destination and internal
hard drive.

Storing an Image
To store an image:
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1. While scanning, press Freeze.
2. Scroll through the cine Loop and select the desired image.
3. Press the appropriate Print key.

The selected image is stored (per your preset instructions) and a thumbnail is displayed
on the clipboard.

NOTE
The ultrasound system numbers the images which are saved in the Local Archive
(Instance Number). However, Instance Numbers may change or get duplicated when
adding/deleting images to the exam. So for identification, the recommendation is to use
Content Date/Content Time on the DICOM server instead of Instance Number.

Storing a CINE Loop
A CINE loop is a sequence of images recorded over a certain time frame. The stored CINE
Loops are displayed chronologically on the clipboard.

CINE loops can be stored at any time during scanning. You can choose to preview the cine
loop before storage and save the cine loop directly, as described below.

The system can be configured to perform either

• Prospective clip: The system begins storing CINE from when you press the Print button,
based on the Time Span setting.

• Retrospective clip: The system stores CINE predetermined time before you press the
Print button, based on the Time Span setting.

NOTE
The ultrasound system numbers the images which are saved in the Local Archive (Instance
Number). But Instance Number may change or get duplicated when adding/deleting images
to the exam. So for identification, the recommendation is to use Content Date/Content Time
on the DICOM server instead of Instance Number.

Previewing and Storing a CINE Loop

1. While scanning, press Freeze.
2. Move the Trackball to activate Cine.
3. Use the trackball or Frame by Frame to scroll through the acquisition and find the

sequence of interest.
4. Press Start Frame or End Frame to set the corresponding cineloop boundary to the

current frame as necessary.

Rotate Start Frame and End Frame to trim or expand the cineloop boundaries.
5. Press Run/Stop to run the cineloop and then press the print key to store the cineloop.

Cine loops stored on the clipboard are indicated with a movie strip icon.
6. Press Run/Stop again to stop the cine loop.
7. Press Freeze to return to live scanning.

Depending on whether the system has been configured to enable or disable “Preview Loop
before store”, the following procedures enable the CINE loop to be stored directly.
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Storing a CINE Loop Without Preview

If “Preview Loop before store” is disabled:

1. While scanning, press the appropriate print key.
2. The last valid CINE loop is stored in the archive and a movie clip thumbnail is displayed

on the clipboard.
3. Scanning resumes immediately.

Storing a CINE Loop With Preview

If “Preview Loop before store” is enabled:

1. While scanning, press the appropriate print key.
2. The last valid cine loop is previewed.
3. Adjust the cine loop, as necessary.
4. Press the appropriate print key.

The movie clip thumbnail is displayed on the clipboard.

Data Transfer

The user can select and access the Exam Transfer services from the Exam Data Transfer
screen.

• Import
• Export
• Worklist
• Q/R (Query/Retrieve)
• Quick Save

NOTE
Ensure that all patients are exported or backed up BEFORE deleting them.

WARNING
Do not connect or disconnect the probes during data transfer.

WARNING
To avoid data loss, please do not unplug USB during data transfer.

Export/Import
To move exams from one ultrasound system to another system or to back up/retrieve exam
information, exam information must be imported/exported.

Chapter 3

Versana Premier/Versana Premier Lotus - User Manual 163
5928218-1EN Rev. 6



NOTE
Both database information and images are exported. No data is deleted from the local
archive when exporting data.

NOTE
Importing patient records may take more than ten (10) minutes. Please allow sufficient time
to import patients.

NOTE
The media used MUST be verified BEFORE performing Export/Import. Verify the media
once each session. If problems are encountered, eject the media and then re-insert the
media; then try the Export/Import again.

NOTE
If exporting a previously backed-up exam, the message “Can't Find Source file” displays.
The image data has already been removed from the hard disk drive with EZBackup.

NOTE
It is STRONGLY recommended to verify files on Eject when using Export.

NOTE
When dealing with a very large dataset (~500GB), the DICOMDIR file may be corrupted by
the system during the DICOM Export operation. This happens in extremely rare situations,
only with very large datasets, and the patient/exam dataset is not damaged or corrupted; the
user may not see the patient/exam listing. In this case, regenerate the DICOMDIR using 3rd
party tools. Please contact GE HealthCare service for any assistance.

Exporting Data

To export an exam(s) to a compatible Ultrasound system:

1. Format and label the removable media. Answer Yes/OK to the messages.
NOTE
The system formats the unformatted CD-R/DVD-R automatically when you select Export
on the data transfer screen.

2. Press Patient and select Data Transfer.
3. The Data Transfer screen is displayed. Select Export.
4. “Local Archive-Int.HD” displays on the Transfer From pull-down menu and the patient list

included in the Local Archive displays.
5. Select the destination at the Transfer To pull-down menu.
6. Select the patient(s) to export by using the Transfer From search field (the upper field).

Windows commands can be used to select more than one patient.

To select a consecutive list of patients, click the cursor on the first name, move the
cursor to the last name, then press and hold down the Shift+right Set key to select all the
names.

To select a non-consecutive list of patients, click the cursor at the first name, move the
cursor to the next name, then press and hold down the Ctrl+right Set key, move the
cursor to the next name, then press and hold down the Ctrl+right Set key again, etc.
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Search for patients via the Search key and string.

Or, use Select All to select all patient.

NOTE
Use best judgment when moving patients’ images. If there are many images or loops,
then only move a few patients at a time.

7. Press Transfer. The progress bar displays during the transfer.
8. Press F3 to eject the media. Specify to finalize the media.

NOTE
A dedicated viewer is needed to display exported DICOM or Raw DICOM images on a PC.

Importing Data

To import an exam(s) to another ultrasound system:

1. On the ultrasound system to import to, insert the media.
2. Press Patient and select Data Transfer (for Traditional Workflow). Press Patient and

select Archive (for Simplified Workflow).
3. The Data Transfer screen displays. Press Import.
4. Select the media from the From pull-down menu.
5. The From search field shows the patients available for import from the removable media

just loaded onto the system.
6. Select the patient(s) or the exam(s) from the list to be imported.
7. Press Transfer. The progress bar displays during the transfer.
8. Wait for the patient information to be copied to the system. Informational messages

appear while the import is taking place.
9. Press Eject to eject the media.

NOTE
Use Import to restore EZBacked up and images.

NOTE
Data can be retrieved from the media to the local drive, played back, or exam information
can be processed on the system as Raw Data.

NOTE
L6-12-RS Thyroid/Breast Color raw data is not compatible on High and Low configuration.
L6-12-RS Thyroid/Breast Color raw data acquired from High configuration cannot be used on
Low configuration (will have artifact).

Query/Retrieve (Search and retrieve the data from DICOM device)
NOTE
For Query/Retrieve to find a patient, the patient MUST have a patient ID.
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NOTE
Before you retrieve data from the Worklist server, make sure that default IP address is input
in the Default Gateway field in Utility > Connectivity > TCP/IP.

Query

1. Press Patient and select Data Transfer. The Data Transfer screen displays. (for
Traditional Workflow)
Press Patient and select Archive (for Simplified Workflow).

2. Select Q/R. The patient/exam list in the Local Archive displays in the To section.
NOTE
Only "Local Archive - Int.HD" is enabled for Transfer To.

3. Select the Query/Retrieve server from the From pull-down menu.
NOTE
The server is configured in the Utility screen. Multiple servers are able to be configured.

4. Press Query in the transfer From section. The Query is performed.
5. The server's patient list displays.

NOTE
Press Query again to refresh the list.

Retrieve

1. Select the patient(s) or the exam(s) to be retrieved from the patient list.
2. Select Transfer. Retrieve the data from the Query/Retrieve Server. The progress bar

displays during the transfer.

Worklist (Search and Retrieve the Patient/Exam Information)
NOTE
Before retrieving data from the Worklist server, ensure the default IP address is input in the
Default Gateway field in Utility > Connection Manager > Network > Wireless.

NOTE
Select the patient prior to sending images to a PACS device.

NOTE
User can configure the Worklist to the User Defined Key through Utility > System > User
Configurable Key > User Defined Key (Traditional workflow only).

1. Press Patient and select Data Transfer. The Data Transfer screen displays.
2. Select Worklist. The patient/exam list in the Local Archive displays.

After The Exam Is Over

166 Versana Premier/Versana Premier Lotus - User Manual
5928218-1EN Rev. 6



NOTE
Only “Local Archive - Int.HD” is enabled for Transfer To.

3. The previous Worklist used is displayed on the monitor display. Press Query to refresh
the list.
NOTE
The worklist server is configured on the Utility screen. Multiple servers can be
configured.
The auto-refresh worklist can be enabled/disabled on the Utility screen. The system
automatically refreshes the list when the exam data transfer accesses the Worklist
server or changes the Worklist server.

4. Select the patient(s) or the exam(s) from the list.
NOTE
User can also double click to enter a selected patient or exam.

5. Press Transfer. The progress bar displays during the transfer.

USB Quick Save
Quick Save easily sends Images to a USB flash drive storage.
The Images are stored either in JPG or WMV format.

USB Quick Save Setup

In Utility > Connectivity > Service, select USB Quick Save.

Figure 3-6 USB Quick Save

Chapter 3

Versana Premier/Versana Premier Lotus - User Manual 167
5928218-1EN Rev. 6



The USB Quick Save service can also be assigned to the Print keys via the Utility >
Connectivity > Button preset menu.

Figure 3-7 Assigning USB Quick Save to Print Keys

BluetoothSave
BluetoothSave can easily send images to a Bluetooth storage device (Android devices only).
User can press the configured hotkey to send current image or cineloop to folders in the
storage device.

Bluetooth Device Configuration

To add a new Bluetooth device,

1. Connect bluetooth adapter to the system and reboot the system.
2. Press Add New Device in Utility > Connectivity > Bluetooth.
3. Follow the steps in the dialogue to complete configuration.
4. Type the device name in the Name field. Android device name will displayed as default

name.

Table 3-1 Device

Preset Parameter Description

Add New Device/Remove Press Add new device to add a new device;
press Remove to delete a device.

Properties: Name Type the name of the device.
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Preset Parameter Description

Properties: MAC Address Unique network card address.
NOTE
Only available for MyComputer.

Properties: Date Added Display the new device added date.

Default Bluetooth Device Select default Bluetooth device from the list.

System hotkey configuration

1. Assign BluetoothSave as Numeric Hot Key or Alphabet Hot Key though Utility >
System > User Configurable Key.

2. Return to scan mode and press Freeze key, then press BluetoothSave hotkey.
3. Press OK to complete.

Send To (Send the image to the DICOM Device)
Send To sends the selected exam for a patient interactively to a destination DICOM device
configured on the system. An exam in this case includes its images and any corresponding
Structured Report.

1. Search and select the patient and press Review. The Exam View screen displays.
2. Select the exam which has the images and press Send To icon.

NOTE
You can only select "Local Archive - Int.HD" for Workflow.

3. The "Send To" Dialogue box displays.

Figure 3-8 Send To Dialogue

Select the destination device and press OK.

NOTE
The destination device is configured in the Utility screen. Multiple devices are able to be
configured.

4. The successful/unsuccessful message is displayed at the top of the screen.

Chapter 3

Versana Premier/Versana Premier Lotus - User Manual 169
5928218-1EN Rev. 6



Selectable Send To
Selectable Send To sends the selected images for an exam and to interactively Send-To the
exam from Local Archive or DICOM Read to a destination DICOM device configured on the
system.

1. Select a patient or an exam in the Archive menu.
2. Go to Active Images (for Traditional Workflow).
3. Select an image (images) and press Send To. Send To Dialogue displays.

NOTE
If the image is not selected, warning dialog is displayed and no image is sent.

4. Select a destination from pull-down menu and press OK.
"Selected image(s) is (are) send to" message displays on the status bar.

Using the DICOM Spooler
To monitor/control DICOM jobs, press F4. You can view, resend, redirect, and delete images
from the DICOM spooler by selecting a job, then specifying the action to be performed on this
job.

NOTE
If you find a failed job(s) in the Spooler, please remove the failed job(s) from the Spooler.

Table 3-2 Spooler status description

Status Description

Hold Waiting for user activity. Select Resend or Send-To to complete the job.

Pending Waiting for the previous job(s) to finish (a previous job may be Active or
Pending).
No user interaction required.

Append Not completed.
Example 1: Direct Storing job. Waiting for more images or the end of the exam
(by selecting New Patient or End Current Patient).
Example 2: Print job with 3x3 images has only 8 images. Waiting for one
more image or the end of the exam (by selecting New Patient or End Current
Patient).

Active Signifies network activity (or connection attempt).

Success Sent successfully.

Failed Unsuccessful job attempt. Job stays in spooler. Select Retry or Delete to
complete the job.

Done Finished successfully.
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Image/Data Management

Reviewing Patient Images
Retrieving and editing archived information contains below section:

• Searching for a patient
• Reviewing a patient exam
• Reviewing an image
• Deleting a patient, exam, or image

Clipboard
The clipboard displays thumbnail images of the acquired data for the current exam. Images
from other exams are not displayed on the current patient's clipboard.
All of the images can be viewed in the Active Images screen, available from the display or
from the Archive menu.

Saving the image /cine to the Clipboard
The active image/cine is stored and placed on the clipboard when you press the Store key.
The clipboard contains preview images with enough resolution to clearly indicate the contents
of the image. CINE Loops are indicated by a movie clip icon.

Previewing Clipboard Images

1. Select the Cursor key to obtain a cursor arrow.
2. Move the Trackball to position the pointer over the clipboard image you want to recall.
3. An enlarged preview of the image is displayed on the left-hand side of the monitor.

Recalling Images from the Clipboard
To recall images from the clipboard,

1. Select the Cursor key to obtain a cursor arrow.
2. Move the Trackball to position the pointer over the clipboard image you want to recall.
3. Press Set to recall the image.

To delete an image from the clipboard

1. Select the Cursor key to obtain a cursor arrow.
2. Place the cursor on the clipboard image you want to delete, then press Set to select the

image.
3. Place the cursor on the Delete icon and press Set.

A warning message is displayed asking the user to confirm the action to perform.
4. Select OK.
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SaveAs
Images and cineloops can be saved to a removable media storage to View on a Windows PC
in the following standard formats:

• Still images: JPEG, DICOM and RawDICOM (Raw data + DICOM)
• Cineloops: AVI, DICOM and RawDICOM (Raw data + DICOM)

Using Save As

To save images to media:

1. Insert the media into the drive or connect the USB drive to the system.
NOTE
If the media is not formatted, it will be formatted when you select Save As.

2. On the scan screen, press the Cursor key. The arrow cursor displays.
3. Place the cursor on the image or CINE Loop in the clipboard to be saved and press Set.

The image displays on the screen.
4. Select SaveAs in the lower of the screen. The Save As menu appears.

NOTE
If the image is saved as an .avi file, run the CINE Loop before you select SaveAs.
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NOTE
A 2D cineloop image cannot be saved as a .jpeg file.

Figure 3-9 Save As Menu

5. Select the media from the Save in archive pull-down menu.
6. Folder name: Create the folder for the saved file.

• Default is blank (The folder is not created)

NOTE
The folder name can not be edited when the folder is opened.

7. File Name: The name of the file is automatically completed, but a desired file name can
be typed as well.
NOTE
DO NOT use the following special characters when saving images: !, @, #, $, %, ^, &, *,
(, ), |, :, ;, <, >, ?, /, ~, [, ], {, }, and Yen sign.

8. Store: Select Image only or Secondary capture.

• Image only: Saves only the ultrasound image area
• Secondary capture: Saves the ultrasound image area, title bar, and scan information

area. Not available for DICOM or Raw DICOM images.
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NOTE
If “WMV” is selected for the Save as type, Secondary capture is disabled.

9. Compression: Specify Compression.

• None
• Rle
• Jpeg

NOTE
If “WMV” is selected for the Save as type, Compression is disabled.

10. Quality: Specify image quality (between 10-100). A high quality setting gives a lower
compression.
NOTE
If “WMV” is selected for the Save as type, Quality is disabled.

11. Save as type: Select one of the following.

• Raw DICOM: saves the still image or CINE Loop in both GE raw format and DICOM
format.

• DICOM: saves the still image or CINE Loop in pure DICOM format.

NOTE
DICOM Images shall be saved as Jpeg image. DICOM loops shall be saved as AVI
or WMV format.

• AVI: Saves the CINE Loop in AVI format.

NOTE
Store “Image Only” is available if you select AVI for Type.

• JPEG: Saves the still image in jpeg format.
• WMV: Saves the CINE Loop in wmv format.

NOTE
WMV type is only available with CINE loop image.

NOTE
The Save button is disabled when you select “AllFiles.” Select each Save as type when
saving the data.

If you want to see all data saved onto the SSD, select “AllFiles(.*)”. All the data names
display in the window.

12. For images transferring to USB, press Save.

The images are saved directly to the USB drives storage whenever you press Save.
If saving to a CD/DVD, select “For Transfer to CD/DVD,” the image is saved to the local
drive buffer.
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• If there is not enough free space in the destination to save all selected images, a
warning dialog will appear.

• If the same file name exists in the destination, the warning dialog displays.
OK: Overwrite file and continue to save selected images.
Cancel: Cancel.

WARNING
Buffer images for transfer to CD/DVD. Images are not cleared out of the image buffer
after you start a new exam or new patient. It is the responsibility of the user to clear
the image buffer before storing new patient data so that the CD/DVD does not contain
images from multiple patients.

13. Repeat steps 4-12 for each additional image to be stored to the CD/DVD.
14. After adding all of the images/loops to save and ready to write to the media, transfer all

the images at the same time. Press Save As > Transfer To CD/DVD.

A progress bar displays, notifying that the “Media transfer is in progress.”
If the total transfer size is bigger than CD/DVD free space size, then only the files that
can be copied to CD/DVD are transferred. After the copy is finished, a warning dialog
displays showing the total required file size and transferred file size. Press OK, insert a
new CD/DVD, and press Transfer to CD/DVD again.

15. To not save the image(s) to CD/DVD, select “Delete Files for Transfer” All images are
deleted.

16. Press Eject to eject the media. Select CD/DVD Recordable or USB drive. Select Yes
and Verify files for CD/DVD. This compares the expected number of files with the
actual number of files on the media. The files are also checked to ensure that they are
readable.

NOTE
The Report Save As feature is somewhat different. As soon a report is selected to be saved,
the report is saved.

NOTE
If a 3D image is saved as an WMV file, an annotation text “COMP” appears at the top of the
saved image which represents the compressed image.

NOTE
Time line image can be saved as multi frames image with SaveAs.

Table 3-3 Save As Formats

.wmv format MPEG Vue in Data Transfer

B, B+CF Multi frames Multi frames

B mode + Doppler mode Multi frames Single frame

B+M Multi frames Single frame

3D N/A Single frame
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Verify the saved image works correctly on the Windows PC. If the image does not work,
please save it again on the ultrasound system.

'SaveAs' Images - Traditional Workflow only

Multiple images can be selected to save at one time by selecting 'SaveAs' Images (Send To
for Simplified workflow) in the Active Images (Image Review for Simplified workflow) screen.

Features are almost the same as the Save As feature. See SaveAs on page 172 for more
information.

NOTE
It is suggested to save images page by page. Saving several images or raw data at once
can take a longer time.

NOTE
If the image has a filmstrip icon, this indicates a CINE Loop, which can be saved as a .wmv
or .mp4 file; single images can be saved as a jpeg file.

NOTE
'SaveAs' Images function doesn't support images which are query/retrieved.

1. In the Active Images screen, place the cursor on the image or CINE Loop to be saved
and press Set. Multiple images with multiple pages can be selected.

2. Press 'SaveAs' Images (Send To for Simplified workflow) on the monitor display or the
Touch Panel. The Save As (Send To for Simplified workflow) menu appears.

Figure 3-10 Save As menu

3. Ensure that Jpeg & WMV or Jpeg & MP4 (JPG / AVI, JPG / WMV, DICOM or JPG /
MP4 for Simplified workflow) is selected, then press Save (Send for Simplified workflow).
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NOTE
If you are saving to USB, images are transferred as soon as you press Save; if you are
saving via Transfer to CD/DVD, you need to save images to the hard drive, then images
are transferred when you select Transfer to CD/DVD. See below.

Storing Images with More Resolution

To store images with more resolution than is available with the JPEG selection, select Save
As and select AVI as the Save As Type. Single images can be saved as .avi files.
Table 3-4 Store Options

Image Type Store as Image Only Store as Secondary Capture

CINE Loop Provides a loop of just the image (no
title bar and scan information).

Provides a single image of the video
area. DO NOT USE, UNCLEAR
WHICH IMAGE FROM THE LOOP IS
SAVED.

Still Image Provides a single image (no title bar
and scan information).

Provides a single image of the video
area.

Data Backup
The backup and restore procedures described in this section are divided into two parts. The
first part describes procedures to backup and restore patient data. The second part describes
procedures to backup and restore system and user-defined configurations.

The Backup/Restore function enables the user to:

• Copy/Restore the patient archive.
• Copy/Restore the system configuration. The Copy/Restore system configuration feature

enables the user to configure several units with identical presets, providing that the units
have the same software version.

Depending on the system, you can use either a CD-R, DVD-R, USB Flash Drive, or USB
Hard Disk for system backup/restore. For the sake of simplicity, we have used the CD-R in
the following examples.

NOTE
The system ONLY supports CD-R / DVD-R and DOES NOT support CD-RW / DVD+R.

WARNING
GE is not responsible for lost data if the suggested backup procedures are not followed and
will not aid in the recovery of lost data.

WARNING
The Versana Premier/Versana Premier Lotus is not intended to be used as a storage device;
backup of the Patient and Image Database is your institution's responsibility. GE is NOT
responsible for any lost patient information or for lost images.
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WARNING
The system crash can cause the internal SSD corruption. The SSD is not considered a
permanent storage device. Backup data on a regular basis.

CAUTION
To minimize accidental loss of data, perform EZBackup and Backup on a regular basis.

1. First, perform EZBackup to save the images.
2. Next, perform Backup at Utility -> System -> Backup/Restore. Enable the following

checkboxes under Backup:

• Patient Archive
• User defined configuration
• Service

CAUTION
Archived data is managed at the individual sites. Performing data backup (to any device) is
recommended.

CAUTION

Make sure to verify the media after writing of data, such as EZBackup, SaveAs or Export.
Verifying media requires additional time, which varies depending on the amount of data
backed up or exported.

CAUTION
Before deleting a patient or image from the patient screen, make sure you have saved
the data by EZBackup/Backup or Export and verify that the media transfer of data was
successful.

EZBackup and EZMove

EZBackup or EZMove allows you to manage hard disk space (move images off the hard
drive) while maintaining the patient database on the scanner, as well as to back up the
patient database and images.
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HINTS

PLEASE READ THIS
Ensure that you have established a data management protocol for your office/institution. You
MUST manage the backup media by keeping a log and by creating a media filing system.
For example, if you need to back up 500 MB/day, or 2.5 GB/week, then you need to back up
5 CDs/week, or ~250CDs/year.
Generally speaking, you should back up the system when you have 10 GB of images to back
up.
You should assign the person who is in charge of performing the backups. Backups will vary
by the volume of your work. You need to track how long it takes your office/institution to get
to 10 GB, and set the back-up parameters accordingly.
Your office/institution needs to determine your backup strategy, for instance, backup weekly
and move monthly. It should be an easy strategy to perform and to remember. And follow
this same strategy/schedule consistently.
It's also useful to keep your more recent information on the hard drive since it's easier to
recall that way.

CAUTION
You can still do a backup/move daily; but ALWAYS do a patient archive backup after each
move.

CAUTION
Only cancel the backup/move in case of an emergency. The system completes backing up
the current media and then cancels the operation.

CAUTION

When EZBackup requires more than one disk (CD-R or DVD-R) for backup, a message
appears when the first disk is full. If you select "Cancel" to stop the backup procedure and
later try EZBackup again, all the data may not be backed up.
Select "Full Backup" on the first EZBackup wizard screen if the last time you were performing
EZBackup you selected "Cancel".

CAUTION
If you use EZBackup or EZMove as a "true" patient archive, you must maintain a separate
backup of the patient database (Patient Archive and Report Archive). If for any reason the
Local Archive - Int HD gets corrupted or the base system software has to be reloaded, then
the patient archive is the ONLY way to rebuild the EZBackup and EZMove patient archive.
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CAUTION

DO NOT turn off the power while EZBackup is running. The data may be lost. It may take
several hours for EZBackup to finish, depending on the amount of data being backed up.
The following may give the impression of a lockup, but EZBackup is continuing in the
background.

• The progress bar does not move.
• The screen may become white.
• The hourglass icon keep turning.

CAUTION
NEVER restore the patient archive from media made previous to the last move.

NOTE
EZBackup/EZMove saves data as RAW data. If you import data to the system, you can
modify the image data.

NOTE
To display exported Raw DICOM images on a PC, you need the dedicated viewer.

NOTE
When backing up or moving reports, do not use EZBackup or EZMove, EZBackup or
EZMove cannot back up or move reports.

NOTE
"Archived" information is saved to each exam during EZBackup. When you perform
EZBackup, the system backs up the exams except for the archived exam.

NOTE
EZBackup/EZMove cannot span a single image across two (2) or more media. Therefore,
if EZBackup/EZMove encounters an image that is greater than the capacity of the media, it
skips the oversized image.

NOTE
EZBackup/EZMove does not store images to media in sequential order. Instead it maximizes
the most amount of images per media.

NOTE
If the system locks up during the media auto format process, shutdown the system by
holding down the power button and reboot the system. After the system is up, replace the
media to a new one and execute EZBackup or EZMove again. To avoid trouble such as data
loss, do not reuse the failed media for any other function.

NOTE
If you try exporting a previously backed-up exam, the message "Can't Find Source file"
displays. The image data had already been removed from the hard disk drive with
EZBackup/EZMove.
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Basically, when you perform the EZBackup or EZMove procedure, you insert the media (or
connect USB HDD if applicable), the system backs up/moves the images, and creates a
reference between the patient database and the media's volume.

EZBackup/EZMove can take up to 20 minutes (or longer, depending on the size of the
backup). Make sure to schedule this at the same time daily, when no patients are scheduled.

1. Prepare unformatted media or the USB HDD before starting EZBackup/EZMove.
2. Specify the EZBackup/EZMove setup on the Utility > System > Backup/Restore page.
3. To start the EZBackup/EZMove procedure, go to the Patient menu and select

EZBackup/EZMove. The EZBackup/EZMove Wizard starts.
NOTE
If you use the USB HDD, some wizards and the pop-up messages DO NOT appear.

4. Verify the information on the first page of the EZBackup/EZMove Wizard, then press
Next.

Full backup options display on the first page of the EZBackup wizard. If you want to
backup all of the exams in the range (even if the exam was previously backed up, check
this option). If you uncheck this option, the system only backs up exams which have not
yet been backed up.

EZBackup does not back up the exams which were previously backed up once by
EZBackup or Export.

NOTE
You can set the range in Utility > System > Backup/Restore > Move files older than
in days for EZMove.

NOTE
If you update an exam which is already backed up, the exam is also backed up.

Figure 3-11 EZBackup/EZMove Wizard 1

5. Verify the information on the EZBackup/EZMove Wizard, Page 2. The backup may span
multiple media. This page tells you how many media you need to do this backup. After
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you have gathered the media (allow for one extra media, just in case), you are ready to
begin the backup. Press Next.

Free Space/Total Size: tells you the size of the data you have selected to store/and the
total size of the USB Hard Drive storage media. If the storage capacity of the USB HD
is insufficient, you will see the message, "Selected Location does not have enough free
space."

NOTE
The calculation for the number of backup CD is only an estimate. Allow for one
additional CD when performing an EZBackup/EZMove.

NOTE
This message appears if you press Next without inserting the backup media: "Please
insert a blank media...". Insert the media and continue.

Figure 3-12 EZBackup/EZMove Wizard 2

6. A pop-up message appears that provides you with the media label. Label the media,
then insert the media. Press OK.

Figure 3-13 Insert Media Message
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a. Ensure that you label the media with not only the volume name indicated on the
Insert Media Message, but with the name of the ultrasound system where this
backup/move procedure was done.

b. Update the EZBackup/EZMove log with this information the volume information and
the location of the media.

c. After the backup/move has been completed, file the media.

Table 3-5 Typical EZBackup/EZMove Log

Date Scanner ID
Name

Backup
Images Y/N

Older than _
Days

Move Images
Y/N

Media Label
(and Scanner

ID)

7. The system will check whether the media is inside the drive.

• If the media is in the drive, the window automatically disappears when the checking
is completed. The EZBackup progress then begins.

• If the media is not in the drive, a pop-up message appears notifying that there is no
media in the drive. Press OK.

Figure 3-14 Insert Disc Error

A pop-up message appears that provides you with the media label. Label the media,
then insert the media. Press OK.
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8. The status menu appears. When the backup/move has been completed, press Next.

Figure 3-15 EZBackup Wizard 3

NOTE
When/if you need to insert the next media, a message appears providing you with the
media label. Label the media, then insert the next media and press OK.

9. When the backup is complete, the completed wizard page appears. Press Finish.
10. Do a patient archive after each EZBackup/EZMove.

We recommend attaching the patient list to the EZBackup/EZMove media.

NOTE
Use Import to restore EZBackup images.

To Review EZBackup/EZMove and Export Images
You can review backed up media via the Patient Menu, Import, and the DICOM Read
dataflow.

If you review EZMoved image,

1. Select the patient on the Patient Menu (on the same system where the EZMove was
performed).

2. Insert the media volume indicated on the Patient Menu
3. View the exam from the media.

NOTE
You may need to insert a media volume prior to or after the recommended media.
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NOTE
If the patient is split over multiple media, images on the previous or next media are displayed
as triangles.

NOTE
To view the whole patient on the system, use Import, from as many media as you have
for that patient. However, take care not to import studies over existing studies; duplicate or
missing images may result. Delete the existing exam first.

Backup and Restore

To minimize accidental loss of data, perform backup of the patient archives stored on the
local hard drive DAILY as described in this section. Use a formatted Backup/Restore disk to
back up patient archives from the hard drive, using the backup procedure described in this
section. Data from the Backup/Restore disk may be restored to the local hard drive using the
restore procedure.

NOTE
To perform backup and restore procedures, you must login with administrator privileges.

Backup procedure
Back up patient data AFTER you've archived (via EZBackup/EZMove) images so that the
pointers to the patient's images reflect that the images have been moved to removable media
and are no longer on the hard drive.

1. Insert a media into the drive or USB device into a USB port.
2. On the Archive screen under dataflow, select Local Archive - Int. HD.
3. Go to Utility > System > Backup/Restore.
4. In the Backup list,

• Select Patient Archive to backup the patient records.
• Select User Defined Configuration to copy system settings and user presets.
• Select Service to backup service presets.

NOTE
The detailed section of this menu decouples the user defined configuration above. This
allows you to selectively restore what you want to restore across multiple machines.

5. Specify where to save data in the media field.
6. Select Backup.

The system performs the backup. As it proceeds, status information is displayed on the
Backup/Restore screen.

7. At the end of the process, the Backup completed message is displayed on the monitor.
Press Eject (F3) for eject media/disconnect USB device.

8. Make sure to physically label the media. An identification of the system should also be
noted on the media and a backup log should be kept.

File the media in a safe place.
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Restore procedure
CAUTION

The restore procedure overwrites the existing database on the local hard drive. Make sure to
insert the correct media.
You cannot restore the data between systems with different software versions.

CAUTION
To avoid the risk of overwriting the local patient and report archives, DO NOT check Patient
Archive when restoring user-defined configurations.

1. Go to Utility > System > Backup/Restore.
2. In the Restore list,

• Select Patient Archive to backup the patient records.
• Select User Defined Configuration to copy system settings and user presets.
• Select Service to backup service presets.

3. In the Media field, select the appropriate Source device.
4. Select Restore.

The system performs the restore. As it proceeds, status information is displayed on the
Backup/Restore screen.

5. System restarts automatically when restore is done.

Backup and restore strategy: user-defined configurations
In addition to generating a safety copy, the backup/restore function of the user-defined
configuration (presets) can be used to configure several Versana Premier/Versana Premier
Lotus systems with identical presets (preset synchronization).

Preset synchronization
The procedure for preset synchronization of several scanners:

1. Make a backup of the user-defined configurations on a removable media from a fully
configured Versana Premier/Versana Premier Lotus system.

2. Restore user-defined configurations from the removable media to another Versana
Premier/Versana Premier Lotus system (you can restore all the user-defined presets
or select specific presets to restore via Detailed Restore).

Configuring Connectivity

You use Connectivity functionality to set up the connection and communication protocols for
the ultrasound system. This section gives an overview of each of the Connectivity functions.

Connectivity Functions
To set up your institution's connectivity, you must login with administrator privileges.
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1. TCP/IP: allows you to configure the Internet Protocol including IP settings and wireless
configuration.

2. Device: allows you to set up devices.
3. Service: allows you to configure a service (for example, DICOM services such as

printers, worklist, and other services such as standard print) from the list of supported
services. This means that the user can configure a device with the DICOM service(s) that
particular device supports.

4. Dataflow: allows you to adjust the settings of the selected dataflow and associated
services. Selecting a dataflow customizes the ultrasound system to work according to the
services associated with the selected dataflow.

5. Button: allows you to assign a pre-configured output service (or a set of output services)
to the Print keys on the control panel.

6. Removable Media: enables formatting (DICOM, database, or blank formatting) and
DICOM verification of removable media.

7. Miscellaneous: allows you to set up the patient/exam menu options, print and
store options, patient/exam Message options, Other ID Options and columns in the
examination listing.

8. Bluetooth: allows you to set up Bluetooth device connection.

Configure these screens from left to right, starting with the TCP/IP tab first.

NOTE
The ultrasound system is pre-configured for many services, with default settings selected.
You can change these services and settings as needed.

CAUTION
You must restart the ultrasound system after making any changes to connectivity settings in
the Utility menus. This includes any changes on the TCP/IP or Dataflow setup screens.

Imaging Insights

Imaging Insights automatically collects DICOM data from GE HealthCare and other vendors'
ultrasound equipment or equipment fleet and displays system utilization and operator usage
insights in a plotted dashboard. Operational insights include exam volumes, first and last
exam time, probes utilization, exam type; operator usage data includes length of exam, scan
mode, probes, and exam type. It helps optimize system and probe fleet investment plans,
identify staff assignment and training needs, and monitor variability of staff usage patterns.
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1. Press Utility > Connectivity > TCP/IP > Imaging Insights to enter Imaging Insights
configuration window.

Figure 3-16 Imaging Insights button

2. Configure the server information in the pop-up window and then check Send data to
Imaging Insights check box.

3. Click Save Settings to save the configuration and send data to Imaging Insights
server.

a.If the network connection to the server passes, data will be sent to server successfully.
b.If the network connection to the server fails, a question will pop out for user.

Figure 3-17 Imaging Insights question

Typical failed causes:

• Network cable not connected.
• Configuration error(s).

NOTE
If the user is doing the exam with patient information created, the data will be sent to
the server immediately when the user clicks End Exam: If the user is scanning without
creating patient information, the data will be sent to the server every two hours before
system shutdown.
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NOTE
User can press View Statistics button to check whether the data is sent successfully or not.

Anti-Virus Software Note
Anti-virus software IS NOT present on the Versana Premier/Versana Premier Lotus system.
Since the ultrasound is already protected against attack by the measures listed below, no
Anti-virus software is deemed necessary.

• Only communication ports required for system operation are enabled.
• Only operating system services required by system application software are enabled.
• Software programs CANNOT be loaded onto the ultrasound system (e.g., e-mail, web

browser, etc.).
• An auto-executable file CANNOT be run automatically on the ultrasound system.
• The ultrasound system software includes the latest MS Windows security protection.

We have worked diligently to develop a combination of the safety measures noted above and
the security standards of Windows 10 Enterprise 2016 LTSB to provide a degree of safety
against Viruses, Worms, Trojan Horses, etc., especially for a system used in a professional
hospital grade networking environment that also typically features its own sufficient safety
measures.

Printing Options

Setting up Digital Peripherals
You set up digital peripherals from the Utility > System > Peripherals menu.

NOTE
Printing using a standard printing service overrides the orientation and N-up feature of
the printer preferences. Printer preferences are set up in the printer folder (via Utility
> System > Peripherals. Select Properties under Standard Printer Properties).

Digital Printer Setup
There are two steps to do when setting up a digital printer: follow the procedure below for
each printer, then set up specific properties for each printer if you need.
Follow this procedure for each printer:

1. Select Utility > Connectivity > Service. Add the Standard Print. Highlight Standard
Print in the Service list. Select the printer from the Printer pull-down Properties menu.
For the UP-D898 printer, select "Portrait" as orientation.

2. Type the printer name in the Name field. This name is used on the Button screen. After
you select the printer from the Printer pull-down Properties menu again, it turns white.
Press Save.

3. Select Button. Select the appropriate print key (Print1, Print2, Print3) from the
Physical Print Buttons section as shown in the figure below. Select the printer from
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the MyComputer column and press >> to move it to the Printflow View column. Press
Save.

Figure 3-18 Digital Printer Setup

Sony UP-D898 Instructions
Follow these steps to set up the paper size of Sony UP-D898 printer.

1. Press Utility > System > Peripherals. Select the UP-D898 from the pull-down menu
under Standard Printer Properties. Click Properties.

2. Click Printer > Printing Preferences on the menu of Properties Window.

3. Select Paper Size. Press Apply. Press OK.
4. Press Save, then Exit.

Setting up the Off-line paper printer
You can connect an off-line paper printer via the USB connection.
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CAUTION
ONLY plug in devices to the USB ports located at the rear of the system WHILE the
ultrasound system is NOT powered up. If you plug in a device while the ultrasound system is
powered on, your system may become unusable.

CAUTION
DO NOT place an off-line paper printer inside the patient environment. This assures
compliance to leakage current.

Figure 3-19 Patient Environment

NOTE
The printer driver is customized for the ultrasound system at the factory; you do not need to
change the settings.

1. Connect the printer to the USB port.
2. Go to Utility > Connectivity > Service. Select the printer and press Add to add the

printer.
3. Select the printer from the Printer pull-down Properties menu.

NOTE
After selecting the printer, the field turns white.

4. Set the following parameters in Properties:

• Rows=3
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• Columns=2
• Orientation=Portrait
• Right Margin (mm)=10

5. Type the printer name in the Name field.
NOTE
This name is used on the Button screen.

6. Press Save, then select the Button tab.
7. Select the Print key from the control panel.
8. Select the printer from MyComputer column and press >> to move it to the Printflow

View column.
9. If you want to assign this printer to the Standard Print Button on the Active Image

Screen, select this printer at the Active Image Printer section.
10. Press Save.

NOTE
If you want settings other than 1 image per sheet, or 2x3 sheet, or to improve the image
quality, refer to the manual that came with the printer.

Setting up the Printer to Print Reports
To set up the Off-Line Printer to print reports,

1. Enter Utility > System > Peripherals.
2. Select the printer from Default Printer pull-down menu.
3. Press Save.
4. Press Print on the Report screen to print the report.
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Electronic Documentation (Not applicable for China)

Documentation Distribution

The manuals for user will be supplied via several types: hardcopy, softcopy in media and
softcopy inside system software.

• Hardcopy

• User Manual (translated)
• Advanced Reference Manual (English and French)
• Release Notes and Workarounds (translated)
• Basic Service Manual (English only)
• AIUM Acoustic Output Booklet (USA only, hard copy)

• Electronic media. You can view user documentation (all languages) on a PC or on the
Ultrasound Scanner via the Customer Documentation media, which includes:

• User Manual (translated)
• Advanced Reference Manual (English and French)
• Release Notes and Workarounds (translated)
• Basic Service Manual (English only)

Using Online Help Via Help

Online Help is available via the Help key. After pressing Help key, Help screen displays the
User Manual in PDF format. The PDF reader allows to browse, search and zoom into the
page of User Manual.

Viewing Online Help in a Language Different from the System Language
Go to Utility > System > General > Manual Language, select the preferred language to
view Online Help.
If the translated Online Help is not available, you will be directed to select a different
language.
Translated Online Help files can be updated via the eIFU USB Flash Drive. Please contact
your Applications/Field Service Representative to order an updated eIFU Kit.
Go to Utility > System > General > Manual Language, select the preferred language to
view Online Help.
If the translated Online Help is not available, you will be directed to select a different
language.
Translated Online Help files can be updated via the eIFU USB Flash Drive. Please contact
your Applications/Field Service Representative to order an updated eIFU Kit.
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Browsing through the Bookmarks
Online Help is organized with individual chapters, sections, and pages. Click on the plus (+)
sign next to the chapter title to open up that chapter. Click on the section you want to view to
open up that section.

Searching for a Topic
To search for a specific topic, click on the Search tab in the tool bar of the Help page. Type in
the topic name to search.

Figure 3-20 Search for a Topic

Zoom into the Page
To zoom into a specific page, click on the Zoom icon in the tool bar of the Help page.

Figure 3-21 Zoom into the Page

Using the Index
You can look for topics by using the Index. Press the Index tab, then use the scroll bar to look
up a topic.

Exiting Online Help
To exit Online Help, press the `X' in the upper, right-hand corner of the Online Help window.

Electronic media

Accessing Documentation Via a PC
To view user documentation on a PC,

1. Plug in the media into the media drive.
2. Open the media drive.
3. Double click on gedocumentation.html.
4. Click the item in desired language to view the user documentation.

To close the window, click on the `X' in the upper, right-hand corner of the browser window.
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NOTE
If your PC does not have Adobe Reader, a free download is available on the Adobe web site
at http://www.adobe.com.

Updating Documentation on the Ultrasound Scanner Via the media
The latest version of the User Manual is available to the user on the USB Flash Drive.
In order to update the system User Manual to the latest version,

1. Power down the ultrasound system and insert the eIFU USB Flash Drive into a rear USB
port.
NOTE
Ensure that the system is USB Device Enabled (check setting on System Admin Utility
Page).

2. Power on the ultrasound system. Online Help files will be loaded onto the ultrasound
system automatically, following several screen prompts:

a. Select Install SW... on the Start Application screen.
b. Press OK on the StartLoader screen to continue.
c. Press any other key to continue when the first C:\windows\system32\cmd.exe

screen displays.
d. When a C:\windows\system32\cmd.exe window pops up indicating the installation

complete, press any key to restart the system and remove the eIFU USB Flash
Drive from the system.
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System Care and Maintenance

The user must ensure that safety inspections are performed at least every 12 months
according to the requirements of the patient safety standard IEC 60601-1. Refer to the
Chapter 10 of Service manual.
Only Service Representatives are allowed to perform the safety inspections mentioned
above.
Technical descriptions are available on request.
To ensure that the unit constantly operates at maximum efficiency we recommend that the
following procedures be observed as part of the customer’s internal routine maintenance
program.
Contact the local Service Representative for parts or periodic maintenance inspections.

Expected Service Life Description

The expected service life for the Versana Premier/Versana Premier Lotus system and probes
is identified in this table:
Table 3-6 Expected Service Life

Equipment / Accessory Expected Service Life

Versana Premier/Versana
Premier Lotus system

The expected service life for the Versana Premier/Versana Premier
Lotus is seven (7) years from the manufacturing date under the
provision of regular maintenance by authorized service personnel.

Probes The expected service life for the probes meets or exceeds five
(5) years from the date the probe is placed in service, under the
provision that the customer follows the care instructions provided
on the Probe Care Card / Accompanying Versana Premier/Versana
Premier Lotus Instructions for Use.

Maintenance Schedule

Follow this Maintenance Schedule to maintain optimum system function and patient care:
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Table 3-7 Maintenance Schedule

Monthly Weekly Daily After Each Patient

Inspect the following
on a monthly basis:

• Connectors on
cables for any
mechanical
defects

• Entire length of
electrical and
power cables for
cuts or abrasions.

• Equipment for
loose or missing
hardware.

• Control panel and
keyboard for
defects.

• Casters for
proper movement
and locking
operation.

Clean and disinfect
the following on a
weekly basis:

• Console

• System
Cabinet

• Removable
Trackball/
Trackball

• Air Filters
(weekly, or
as needed)

• Footswitch
• B/W Printer

• Monitor
• Operator

Controls panel

Clean and Disinfect
the following areas
where Cross
Contamination can
occur:

• Operator Panel
• Monitor
• Front and Rear

Handles

Clean and Disinfect
the following after
each patient:

• Probe
• Biopsy Bracket,

as applicable.

Additionally, Clean
and Disinfect any
area on the system
that has visible
contamination from
the previous exam
NOTE
Biopsy Accessories
must be cleaned
and disinfected
or disposed of
after each patient.
Refer to the
Probes Chapter,
for instructions on
probe cleaning,
disinfection and
inspection.

CAUTION

To avoid electrical shock hazard, do not remove panels or covers from console. Servicing
must be performed by GE HealthCare qualified service personnel. Failure to do so could
cause serious injury.
If any defects are observed or malfunctions occur, do not operate the equipment but inform a
qualified service person. Contact a Service Representative for information.

WARNING
Do not perform system care and maintenance in the patient environment.

NOTE
Frequency of the cleaning is dependent on the environment.

Failure to perform required maintenance may result in unnecessary service calls.
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CAUTION
When performing cleaning and disinfection procedures, to prevent the risk of system
damage, always observe the following precautions:

• Use only cleaning and disinfection materials and solutions as recommended in the
procedures described below.

• Never use thinner, benzene, ethanol or methanol alcohol, abrasive cleaners, or other
strong solvents, as these may cause damage to the cabinet or monitor. Only use
isopropyl alcohol, when instructed to do so.

• Do not spray any liquid directly onto the ultrasound system covers, monitor or keyboard.
• Do not allow any chemical agents to drip or seep into device openings or connections.
• Use only recommended cleaners or disinfectants on system surfaces. Immersion-type

disinfectants are not approved for use on system surfaces.
• DO NOT scratch or press on the panel with any sharp objects, such as pencils or pens,

as this may result in damage to the LCD panel.
• Make sure not to spill or spray any liquid on the controls, into the system cabinet, or in

the probe connection receptacle.
• Prior to cleaning, turn OFF power to the system and disconnect the mains cable.

Cleaning and Disinfecting the system

WARNING
All cleaners and disinfectants NOT on this list in Table 3-8 Compatible Chemicals for
Cleaning and disinfection on page 199 are unapproved by GE HealthCare. Failure to follow
guidelines could result in damage to the device.

CAUTION
When processing the operator control panel, make sure not to spill or spray any liquid on the
controls, into the system cabinet, or in the probe connection receptacle.

CAUTION
To avoid liquids entering the product, DO NOT spray any liquid directly onto the surfaces.
ALWAYS use a cloth or wipe.

These cleaners/disinfectants can be used on the console (Operator Panel, Monitor, Probe
Holders, etc.), except for the probes. Probe Intermediate-Level Disinfection - Wipe on page
310 for probe disinfectant information and web links.

Always consult the cleaner or disinfectant manufacturer's instructions for proper use of their
product. Wear appropriate PPE as indicated by the manufacturer.

Appropriate cleaners/disinfectants for the console that have been validated for compatibility
are shown below:

WARNING
User shall read the instruction and be trained before doing cleaning and disinfection. Ensure
that you follow the cleaning procedure and use the cleaning agents provided in this manual.
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Table 3-8 Compatible Chemicals for Cleaning and disinfection

Chemical System
Cabinet

Operator
Control
Panel

Monitor and
Touch Panel

Track Ball Probe Holder
and Gel
Holder

PDI Sani-
Cloth Plus

X X X X X

Protex X X X X X

Tristel Wipes X X X X X

Wet Wipe X X X X X

Sono
Ultrasound
Wipes

X X X X X

Clorox wipes X X X X X

Cavi Wipes X X X X X

PDI Super
Sani-Cloth
Plus

X X X X X

PDI Easy
Screen
Cleaning
Wipe

X X X X X

70% isopropyl
alcohol

X X X X X

NOTE
Effective Disinfection is always a balance between safe inactivation of infectious agents
and undesirable side effects. Due to the generally uneven and irregular surface
of Ultrasound consoles, a comprehensive surface disinfection process cannot be
recommended by the manufacturer.

Console
The ultrasound system console includes the System enclosure, Monitor, Operator Panel,
Probe Holders and Gel Warmer. For Probes Reprocessing, see Probe Intermediate-Level
Disinfection - Wipe on page 310.

Cleaning the Console

Always clean visible soil from surfaces first before disinfecting the Console.
Follow the cleaning/disinfecting frequency suggested in Maintenance Schedule on page 196.
To clean the system,

1. Moisten a soft, non-linting cloth with a mild, general purpose, non-abrasive soap and
water solution or approved cleaning/disinfecting agent.
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NOTE
The cloth/wipe should be damp, not dripping wet and running. Moisture should not drip
into the crevices anywhere on the console.

NOTE
Refer to Table 3-8 Compatible Chemicals for Cleaning and disinfection on page 199 for
a list of compatible solutions to be used on the Console.

2. Use a gentle wiping action to clean any surface on the console.
HINTS
A scrubbing action with the wipe may be necessary to help remove stubborn soil from
the surfaces. However be careful with this action over cervix and gaps in the surface to
prevent liquid from being scraped off the wipe and entering the product.

3. Wipe off excess cleaning agents.
NOTE
Do not spray any liquid directly into the unit.

NOTE
DO NOT scratch or press on the panel with any sharp objects, such as pencils or pens,
as this may result in damage to the LCD panel.

Disinfecting the Console

For disinfectants to be effective, the surface must first be clean.
ALWAYS follow the manufacturer's instructions concerning the use of the disinfectant and
follow the contact time to be sure the disinfectant's claims are accomplished.
Follow the cleaning/disinfecting frequency suggested in Maintenance Schedule on page 196.
Disinfect the desired surfaces of the console. To prevent cross contamination, surfaces that
are often touched during exams should be disinfected after every patient. To disinfect the
system,

1. Moisten a non-linting cloth with a liquid disinfectant or remove pre-moistened disinfectant
wipe from the container.
CAUTION
If a cleaner/disinfectant wipe was used to clean off visible soil per the above section, a
second, fresh cleaner/disinfectant product should be used for the disinfectant step.

2. Wet the surfaces by gently applying the cloth or wipe. Avoid high pressure or squeezing
the wipe to avoid having the liquid enter the gaps and cervices of the Console. Scrubbing
is not necessary in the disinfecting step; evenly applying the liquid is the goal.

3. Let the surface remain wet for the appropriate contact time.
4. If the surface does not remain wet for the full contact time, apply an additional application

of the disinfectant, as necessary, to extend the time.
5. After the contact time has expired, remove excess liquid with a dry sterile cloth.
6. To avoid disinfectant buildup, or to remove disinfectant residue which may cause skin

irritation, perform a rinse step with a sterile damp cloth.

Monitor

To clean the monitor (LCD Panel and monitor frame):
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1. Moisten a soft, non-linting cloth with a mild, general purpose, non-abrasive soap and
water solution.
NOTE
The cloth should be damp, not dripping wet.

2. Wipe down the top, front, back, and both sides of the monitor.
3. Wipe off excess cleaning agents with a non-linting cloth.

NOTE
Never use thinner, benzene, alcohol (ethanol, methanol, or isopropyl alcohol), abrasive
cleaners, or other strong solvents, as these may cause damage to the monitor.

NOTE
DO NOT scratch or press on the LCD panel with any sharp objects, such as pencils or pens,
as this may result in damage to the panel.

For disinfection for this part, refer to system level disinfection in Disinfecting the Console on
page 200.

Control panel and keyboard
NOTE
Diligent cleaning of the console reduces the risk of spreading infection from person to
person, and also helps to maintain a clean working environment.

Only use the following cleaners on the Control panel:

1. A non-abrasive soap and water solution (e.g. Palmolive Dishwashing Liquid,
manufactured by Colgate-Palmolive).

2. Sani Wipes Alcohol-free (manufactured by Microgen Inc).
3. T-Spray II (manufactured by Pharmaceutical Innovations, Inc).

To clean the Control panel:

1. Turn off the power of the system.
2. Moisten a soft, non-linting cloth with water or a mild, non-abrasive soap and water

solution.
3. Gently wipe the surface of the console.
4. Use a cotton swab to clean around keys or controls. Use a toothpick to remove solids

between keys and controls.
When cleaning the operator control panel, make sure not to spill or spray any liquid on
the controls, into the system cabinet, or in the probe connection receptacle.

5. In the event that disinfection is required or any stubborn stains remain, absorb a small
quantity of isopropyl rubbing alcohol on a soft, dust-free cloth. Wipe the surface of the
console. Make sure no liquid drips on or between the keys. Allow to dry.

To clean the keyboard:

1. Clean the keyboard as described above for the Control panel.
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2. In the event that disinfection is required or any stubborn stains remain, absorb a small
quantity of isopropyl rubbing alcohol on a soft, dust-free cloth. Wipe the surface of the
key caps. Make sure no liquid drips on or between the keys. Allow to dry.

NOTE
When cleaning the operator control panel, make sure not to spill or spray any liquid on the
controls, into the system cabinet, or in the probe connection receptacle.

For disinfection for this part, refer to system level disinfection in Disinfecting the Console on
page 200.

Probe Cleaning Notes

Cleaning and disinfection solution for probe and console are different. Please avoid
damaging the control panel while cleaning/disinfecting probes. Refer to the Probes Chapter,
for probe cleaning and disinfecting instructions.

CAUTION
NEVER use any cleaner or disinfectant containing alcohol.

Probe shall not stay in probe holder on the Ultrasound system during cleaning/disinfection. If
you use a spray cleaner, spray AWAY from the Ultrasound system. Spray can damage the
controls.

Figure 3-22 DO NOT Spray a Probe While in its Holder

Cleaning the Trackball

Dust is often building up behind the ball, so it interferes with the ball rotation and for optical
trackballs the light used for sensing. To get access for cleaning, you need to remove the ball.

The ball is held in position by the Dust Gasket.

1. Power off the system.
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2. Rotate the retainer counterclockwise until it can be removed from the keyboard.

Figure 3-23 Rotate the retainer

3. Separate the trackball and the retainer. Wipe off any oil or dust from the trackball,
retainer and the trackball housing using a cleaner or cotton swab.

4. Assemble the trackball and retainer, then put it into the housing and rotate it clockwise
until its notches are set in position.

CAUTION
When cleaning, make sure not to spill or spray any liquid into the trackball housing (keyboard
or system). DO NOT use cleaning agents containing ammonia, such as Windex, Screen-
Clean, which will remove the anti-glare coating on the Trackball.

Probe holder

1. Remove the holder.

Figure 3-24 Remove the probe holder

2. Wash the holder with mild soap in lukewarm water. Scrub it using a soft non-linting
sponge, gauze, or cloth to remove all visible residue from the surface. Prolonged soaking
or scrubbing with a soft bristle brush (such as a toothbrush) may be necessary if material
has dried onto the surface.
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3. Rinse the holder with enough potable water.
4. Dry with a soft cloth and put it back.

For disinfection for this part, refer to system level disinfection in Disinfecting the Console on
page 200.

System Cabinet

To clean the system cabinet:

1. Moisten a soft, non-linting cloth with a mild, general purpose, non-abrasive soap and
water solution or a general purpose disinfectant.

2. Wipe down the top, front, back and both sides of the cabinet. Do not spray any liquid
directly onto the unit.

3. In the event that disinfection is required or any stubborn stains remain, absorb a small
quantity of isopropyl rubbing alcohol on a soft, dust-free cloth. Wipe the system cabinet
and allow to dry.

NOTE
Do not spray any liquid directly into the unit.

Other Maintenance
Footswitch

To clean the footswitch:

1. Moisten a soft, non-abrasive folded cloth with a mild, general purpose, non-abrasive
soap and water solution.

2. Wipe the external surfaces of the unit then dry with a soft, clean, cloth.

Cleaning the air filters

Clean the system's air filters to ensure that a clogged filter does not cause the system to
overheat and reduce system performance and reliability. It is recommended the filters be
cleaned every two weeks, but the requirements will vary due to your system use.

CAUTION

Be sure to lock the wheels before cleaning the air filters to avoid injury by any unexpected
movement of the system.
DO NOT operate the unit without the air filters in place.
Allow the air filters to dry thoroughly before re-installing them on the unit.
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1. Pull the air filter from the back cover of the system.

Figure 3-25 Remove the air filter

2. Dust the filters with a vacuum cleaner and/or wash it with a mild soapy solution.
NOTE
If washed, RINSE and DRY the filters before re-installation.

3. Put back the air filters.

Prevention of static electricity interference

Interference from static electricity can damage electronic components in the system. The
following measures help to reduce the likelihood of electrostatic discharge:

• Wipe the alphanumeric keyboard and monitor with lint-free tissue or a soft cloth
dampened with anti-static spray on a monthly basis.

• Spray carpets with anti-static spray because constant walking on carpets in or near the
scanning room may be a source of static electricity.

Disposal

Table 3-9 WEEE symbol

Symbol Location

Rear of the system and Probe connector

This symbol indicates that waste electrical and electronic equipment must not be disposed of
as unsorted municipal waste and must be collected separately. Please contact an authorized
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representative of the manufacturer for information concerning the decommissioning of your
equipment.

Troubleshooting

Please refer to Service Manual if other messages appear on the monitor display.
Table 3-10 Error messages

The system has detected the lower air filter
requires cleaning. Please clean the lower air filter.

1. Shutdown the system. Disconnected the
power cord.

2. Clean the air filter according to Cleaning the
air filters on page 204.

System temperature is too high. System will shut
down.

1. Shutdown the system.
2. Clean the air filter according to Cleaning the

air filters on page 204.

System voltage fault. System will shut down.

1. Select OK and reboot the system.
2. If the same message appears after reboot,

shut down the system and turn off the
breaker. Then turn on the system according
to Power On on page 44.

System Error. Please reboot the system.

1. Select OK and reboot the system
2. If the same message appears after reboot,

shut down the system and turn off the
breaker. Then turn on the system according
to Power On on page 44.
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InSite ExC

InSite ExC is your direct link with a GE Online Service Engineer or Applications Support

Engineer or a Request for Service via the InSite ExC  link at the upper right of the
monitor.

Types of InSite ExC Service

1. ContactGE. Opens a service dispatch with GE HealthCare Service.
2. Start/Stop Agent. Enable/Disable Agent.
3. ConnectToGE. Agent is set to fast poll after running the command.
4. Connect Clinical Lifeline. Agent is set to fast poll, turn on disruptive mode, if disruptive

mode is off. Turn on VNC, if VNC server is not running.
5. EZ Configuration Wizard. Use to configure some common system settings.
6. Temperature And Power. Use to check the temperature log.
7. EZ Diagnostic. Use to analyze the system error automatically.
8. Versana Club. Use to enter Versana Club.
9. Disruptive and VCO. Use to enable Disruptive mode and open VCO. Click it and the

following window will appear.

Figure 3-26 Select Enable

Here is the explanation for current design on "Disruptive mode and VCO" button function:

a. The button is designed to Enable VCO in quick way, so when clicking "Enable",
it will enable both "Disruptive mode" and "VCO" (Disruptive mode ON is the
prerequisites for VCO ON).

b. When clicking "Disable", it can only disable "VCO", but will not disable the Disruptive
mode.

c. The user has to enter CSD to disable the Disruptive mode if he/she wants to do that.

10. EZ Settings Restore. Use to quick backup and restore network configuration, user
defined settings and RSVP configuration.

11. Download. Use to download the latest software package.
12. Cancel. Use to abort the downloading task and clear the downloaded data.

Initiating a Request for Service (RFS)
To initiate an RFS,
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1. Position the Windows pointer on top of the GE InSite ExC icon at the top right of the
display.

2. Press Set Key, select ContactGE. This opens of the RFS screen which sends a service
dispatch directly to GE HealthCare Service after you fill in the following information:

• Problem Type
• Problem Area
• Problem Description
• First Name
• Last Name
• Phone Number
• Email

3. After you have completed filling in all of this information, press Submit to initiate the
Request for Service.

After the request is submit successfully, the following status appears:

Figure 3-27 Request for Service is submitted

All requests for service are listed on the RFS History for your review. You can review your
RFS details by clicking Details on RFS History list.

Figure 3-28 RFS History

Initiating a Technical or Clinical Support Request
To initiate Technical or Clinical Support,
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1. Position the Windows pointer on top of the GE HealthCare InSite ExC icon at the upper
right of the display.

2. Press the Set Key.
NOTE
When you have contacted the Online Center/Field Engineer (OLC/FE), you may be
asked to click on ContactGE to increase the polling rate so that the OLC/FE can
connect more quickly.

3. Select ConnectToGE for Technical Support or press Cancel to exit.

NOTE
In addition to contacting a technical/clinical support person, selecting this also changes the
polling time from 15 minutes to 15 seconds so that your call can be answered as quickly as
possible, as well as allowing disruptive mode.

InSite ExC icons appear differently, depending on their state:
Table 3-11 InSite Icons

RSvP Agent is not registered and Disruptive mode is off.

RSvP Agent is not registered and Disruptive mode is on.

RSvP Agent is connected and Disruptive mode is off.

RSvP Agent is connected and Disruptive mode is on.

Device is remotely connected.

InSite ExC Definitions
Here are definitions for the different InSite ExC states:

Virtual Console Observation (VCO). Allows Technical Support to control the ultrasound
system functionality remotely.

Disruptive. Allows GE HealthCare's Technical Support person to connect to your system
via VCO, to run diagnostics directly on your ultrasound system system, and to collect
system logs. When the system is in Disruptive Mode, the icons are red. There are two
disruptive states. If you see a telephone with a clock, then the system is in Disruptive,
Not Connected Mode. If you see a telephone with GE HealthCare, then the system is in
Disruptive, Connected Mode.

Non-Disruptive. Allows GE's Technical support person to look around on your system, but
cannot perform any service-related functions, depending on whether InSite has connected
or not connected. There are two Non-Disruptive states. If you see a black and white icon,
InSite ExC is activated, but not open for Technical Support access. If you see a yellow icon,
InSite ExC is activated and the Technical Support person can look around on your system,
but cannot perform any service-related functions.

Connected. InSite ExC is connected.

Not Connected. InSite ExC is not connected
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NOTE
When Disruptive mode has been activated or a diagnostic has been run, the message,
"Due to Service testing reboot required," appears in red at the bottom of the display. It is
recommended that you reboot the system before use. Make sure you disable disruptive
mode before rebooting or the message will not be cleared.

Exiting InSite ExC
To exit InSite ExC,

1. Exit InSite ExC page.
2. Reboot your ultrasound system.

EZ Configuration Wizard
EZ Configuration wizard is a function to enable the operator to configure some common
system settings when turning on the system for the first time after the software installation.

NOTE
Password setting is required when turning on the system for the first time after the software
installation.

User can also enter EZ Configuration Wizard by clicking the Insite icon at the top right of the
screen.

Figure 3-29 Enter EZ Configuration Wizard

Then follow below steps to complete configuration.

1. Select password level in Password Policies or Skip For Now to setup later. User can
change the policy level later by Utility > Admin > User policies.
Users can select the option Lowest, Medium, High or Highest for policy level. The
complexity of the password will be differed by the policy level you selected.

NOTE
Password policy level setting is only required when turning on the system for the first
time or after the software installation.
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NOTE
When user select lowest, a warning will display to inform that the current security policy
will put your system at risk.

Figure 3-30 Select password policy level

NOTE
If user select lowest level in password policies, ADM password can be empty during
Admin Registration.

NOTE
Exit button is not activated in password policies setting, users are not able to exit the EZ
Configuration Wizard in this step.

2. Set ADM password in Admin Registration.
NOTE
Admin Registration is only required when turning on the system for the first time or after
the software installation.

NOTE
Exit button is not activated in Admin Registration setting, users are not able to exit the
EZ Configuration Wizard in this step.

NOTE
ADM password can be empty if password policy level is selected as LOWEST.
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NOTE
A valid password must be at least 8 characters long and has a maximum length of 256
characters.

Figure 3-31 ADM password setting

If users did not set ADM password during system setup. User can also set operator
password later by Utility > Admin > Users.

3. Press Next to select the appropriate language for system language and keyboard
language from the drop-down list.

Figure 3-32 System Language settings

NOTE
All required setting after turning on system for the first time is done. If you select Exit,
you will be able to exit the EZ Configuration Wizard and start using your system.

• If you do not change the language, press Next to continue.
• If you change the language setting, a language setup window will display.
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Set language and keyboard language, then press OK to restart the system.

Figure 3-33 Language settings confirmation

NOTE
If you press Previous, you will go to the previous page.

4. This screen shows the hospital and time information, you can set the system date and
time on this page.

Figure 3-34 General Information

Press Next to continue.
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5. The Network Information screen shows the configuration of wireless and local network.

Figure 3-35 Network Information

Press Next to continue.
6. Summary Information shows the report of the previous settings. User can export it to

the database.

Figure 3-36 Summary Information
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Press Export and click OK to save the summary information.

Figure 3-37 Export Summary

7. Press Finish to exit EZ Configuration Wizard. The system will display a warning to
restart to activate your configuration. Press OK to restart.

NOTE
System will restart only after user configures EZ Configuration Wizard for the
first time or new software version is installed.

NOTE
For better security, it is recommended to change the passwords of these two accounts when
using the device for the first time. Go to Utility > Service > Utilities > Change Password,
change the passwords of GEService and SVCservice. The complexity of the new password
cannot be lower than the password policy level that has been set (Lowest, Medium, High or
Highest).

eDelivery - Software update

External software environment of the ultrasound system should be updated regularly for
better use experience. If necessary, the external software environment of the ultrasound
system can also be updated urgently.
User can update to the latest software in two ways.
As part of the product lifecycle management, GE HealthCare regularly analyzes and
integrates software updates from our third party vendors into our products. These are
typically released as part of regular updates or software releases.
The two available downloading options for eDelivery are:

• Through the GE HealthCare service platform on the ultrasound system. This requires
Insite RSvP connectivity.

• Through an end-user portal to a local storage location (i.e. a readable / writeable flash
drive with enough storage space) and install it on the ultrasound system.

Software update via Insite Remote Service Platform (RSvP)
Software update for the system may become available for download and installation through
the GE HealthCare Service platform.

Users must have administrator rights to perform the software download and installation. A
user who is not logged in as ADM (administrator) will see the notification of an available
update, but not be allowed to initiate the download.
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CAUTION
Please backup presets and patient data when updates system software. Remote software
download should not change user presets or affect customer database; however, it is always
best practice to ensure patient data and preset are backed up before proceeding with any
software installation.

NOTE
Be sure to end any open exams before software update.

NOTE
Please allow approximately half an hour for complete software download (the download time
may vary due to network connection speed).

NOTE
Please allow approximately 30 minutes for complete installation.

NOTE
Software upgrade through the GE HealthCare service platform may not be available in all
markets.

Software download and installation
CAUTION
Please end current exam before downloading the package provided by eDelivery.

1. Press the notification icon to display the service menu, click Download to check the
update.

Figure 3-38 Service Notification

2. Available software updates are displayed in the list. If you want to refresh the query for
available updates, press Refresh.
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3. Select the desired software version and press Download to download the software
package, or press Exit to exit the window.

Figure 3-39 Download or Exit

4. During the software download process, the status will be displayed as “Downloading”.
You can press Pause to suspend the download or press Cancel to abort the download.

Figure 3-40 Downloading

NOTE
While the software is downloading, the Exit button is disabled. If you want to go back
to scanning page, please press Pause to suspend the download process first and then
press the Exit button.

• When the download is in progress, press the Pause button to suspend the download
process.

• When the download process is suspended, press the Resume button to recover the
download process from the point where it is stopped.

• If there is an error during the downloading process, press the Retry button to
recover the download process from the beginning.
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NOTE
Before installation, user should login with the ADM account, otherwise there will be
pop-up message to remind. Only after logging in with the ADM account, the user will
have access to install software.

Figure 3-41 Access Denied
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5. When the download process finishes, the software is ready to be installed in the
ultrasound system. Log in with the ADM account, then click Yes to start the installation.

Figure 3-42 Install to the system

Figure 3-43 Start Installation

NOTE
Please allow enough time for ultrasound device to reboot automatically to complete the
installation process.

6. The system will reboot several times to complete the installation.
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NOTE
DO NOT power off the system during the software installation.

NOTE
A typical full installation may take up to 30 minutes.

7. After software installation is complete and the system is rebooted, a Reminder after
Installation window will appear. This is to remind the user to manually restore
configurations if the system has related settings backed up before the software update.

Figure 3-44 Reminder after Installation

8. Click OK to confirm the installation is completed.

NOTE
Ensure that the entire system functions normally after service procedures.

Software update via End-User Portal
Customers who have purchased the end-user eDelivery option will receive a customer
account to download software within the End-User Portal.
Users are created for the account based on e-mail addresses provided by the customer at
the point of sale. These e-mail addresses are the log-in credential for the End-User Portal
along with a temporary password provided to the user through e-mail. When logging in to
the End-User Portal the first time, the user is prompted to change the password and enter a
secret question and answer for password retrieval.
Follow the below instructions to download software from the portal:

1. Log on to the portal website which is provided to end user via a welcome email:
https://gehealthcare.flexnetoperations.com/flexnet/operationsportal
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2. Log in using the user name (e-mail) and password.

Figure 3-45 Login Window

3. The License & Delivery Portal dashboard is displayed. All downloadable packages will
be listed in a link under Your Downloads.

Figure 3-46 Your Downloads
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4. Click the link to enter the Download Packages page. Downloadable packages with links
will be listed. Click on the desired link to enter the Downloads page.

Figure 3-47 Select link

5. Right click on the link under File Name, select Save link as... to download the file to
your storage device (a readable and writeable USB flash drive with enough capacity).

Figure 3-48 Save Link as...

NOTE
Multiple files may be downloaded on one device.

6. Load the downloaded software on the ultrasound system from the selected storage
location.

Loading the Software

To load a software onto the ultrasound system,
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1. Power off the ultrasound system.
2. Insert the USB Flash Drive into a USB port.

NOTE
Ensure that the system is USB Device Enabled.

3. Power on the ultrasound system. The software program files will be recognized
automatically, select Install SW... on the Start Application screen.

Figure 3-49 Select Install SW...

NOTE
If by accident you try to load a software that is not compatible with the software on the
ultrasound system, an error message will indicate "The package present in media is
not compatible. Please contact GE HealthCare Service" and "Software installation is not
started".

4. Click OK on StartLoader screen. Then select the package you want to install, and click
INSTALL to start installation.

5. When the installation is complete, the system will reboot automatically.
6. Remove the USB stick from the ultrasound device.
7. The whole installation is completed once system reboots.

NOTE
Installation time depends on the type of update. No action is needed until the installation is
completed.

Reload the Software
Reload Software provides specific software versions for users to reload.

NOTE
Users are required to be logged into the system as administrators (ADM) in order be granted
access.

To reload the software onto the ultrasound system:
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1. Press Utility > System > About, click Reload Software to enter the operation page.

Figure 3-50 Reload Software

2. Select the software version needed, then click OK.

Figure 3-51 Select the software version

• By default, current installed software version will be displayed, user can reload
current software version to rollback software changes to the initial installed state.

• After a new full software package is installed, current version will be displayed as
previous version, user can select to reload current version or previous version.
NOTE
After rollback to previous software version, the "Current/Previous" reload options
will alternate.
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3. A pop-up message will appear to remind user to continue or cancel the reload process.
Click Yes to start reloading software or No to cancel.

Figure 3-52 Pop-up message

Assistance

Supplies/Accessories
CAUTION
DO NOT connect any probes or accessories without approval by GE HealthCare.

CAUTION

Use only GE HealthCare approved internal equipment when replacing an internal peripheral.
The user or the operator should never install/replace the internal peripheral. Service
representatives authorized by GE HealthCare will install/replace the internal peripheral.

Not all features, products, probes or peripherals described in this document may be available
or cleared for sale in all markets. Please contact your local GE HealthCare Ultrasound
representative to get the latest information.
Contact the distributor, GE HealthCare affiliate or sales representative for approved
peripherals. For HCATs, contact your sales person.
The following supplies/accessories have been verified to be compatible with the system:
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Peripherals
Table 3-12 Peripherals and Accessories

Accessory Units

Printer USB isolation Each

Gel Warmer Each

Video Output Adapter Each

HDMI cable option Each

Wireless Adaptor Each

Bluetooth Adaptor Each

Transcend TS8XDVDS-K DVDRW kit Each

UP-D898DC Printer Each

BW PRINTER (UP-D898MD) Each

SONY UPD25 Color Printer Each

898 printer paper Each

HP Officejet 200 Mobile series Printer Each

USB Stick Each

1TB mobile USB HDD Each

Footswitch MKF 2 1S/1S-MED USB GP26 Each

1-Peadl type footswitch ‘Whanam FSU-1000’ Each

USB barcode reader Each

ECG ASSY Each

1 TB SSD Each

Digital Expert Connect Each

Rechargeable Li-ion Battery Pack Each

Power Cord Each

Push-Push A/N keyboard Each

ADULT TEE CLIP-ON BITE GUARD Each

ADULT TEE CLIP-ON BITE GUARD OPR. Each

ADULT TEE SCANHEAD PROTECTION COVER Each

ADULT TEE CONVENTIONAL BITE GUARD Each

BITE HOLE INDICATOR Each

TEE STORAGE RACK Each

China Control panel protect film Each

A/N Keyboard Film Each
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NOTE
Other commercial printers not listed in above table must connect with PIT (Printer Isolation
Transformer) when being used.

NOTE
The transformer does not support the printer with power more than 150VA.

NOTE
The ultrasound system supports two types printer isolation transformers: 110V/220V. Please
use the appropriate type according to the local power supply.

Probe
Table 3-13 Probes and Accessories

Probe HCAT Biopsy Guide Biopsy
Guide
HCAT

Biopsy Guide Image

4C-RS
Convex

H4000SR Multi-angle, disposable
needle guide with a
reusable plastic bracket

E8385NA

8C-RS
Convex

H40402LS Not Available N/A N/A

E8C-RS
Convex

H40402LN Fixed angle, disposable
needle guide

E8385MJ

Fixed angle, reusable
with a stainless steel
bracket

H40412LN

E8Cs-RS
Convex

H48062AF Fixed angle, disposable
needle guide

E8385MJ

Fixed angle, reusable
with a stainless steel
bracket

H40412LN

C1-5-RS
Convex

H40462AL Multi-angle, disposable
needle guide with a
reusable plastic bracket

H40432LE
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Probe HCAT Biopsy Guide Biopsy
Guide
HCAT

Biopsy Guide Image

IC9-RS
Convex

H48691PJ Fixed angle, disposable
needle guide

H48691YX

Fixed angle, disposable
needle guide (with cover)

H48691YW

Fixed angle, reusable
with a stainless steel
bracket

H48701MN

3Sc-RS
Sector

H45041DL Multi-angle, disposable
needle guide with a
reusable plastic bracket

H46222LC

6S-RS
Sector

H45021RP Not Available N/A N/A

12S-RS
Sector

H44901AB Not Available N/A N/A

L6-12-RS
Linear

H48062AC Multi-angle (in plane
biopsy kit), disposable
needle guide with a
reusable plastic bracket

H40432LC

12L-RS
Linear

H40402LY Multi-angle (in plane
biopsy kit), disposable
needle guide with a
reusable plastic bracket

H40432LC

Infinite-angle (in plane
biopsy kit), disposable
needle guide with a
reusable plastic bracket

H48392LT

Transverse bracket (out
of plane biopsy kit),
disposable needle guide
with a reusable plastic
bracket

H48392LL
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Probe HCAT Biopsy Guide Biopsy
Guide
HCAT

Biopsy Guide Image

L3-12-RS
Linear

H44901AP Multi-angle Bracket H48302AA

LK760-RS
Linear

H44901AF Not Available N/A N/A

L8-18i-RS
Linear

H40462LF Not Available N/A N/A

9L-RS
Linear

H40442LL Multi-angle, disposable
needle guide, with a
reusable plastic bracket

H4906BK

L4-20t-RS
Linear

H48062AJ Verza biopsy starter kit H45201BLF

RAB2-6-RS
4D

H48681WR Multi-angle, disposable
needle guide with a
reusable plastic bracket

H48681ML

RIC5-9A-
RS
4D

H48701EJ Fixed-angle, disposable
needle guide with
a disposable plastic
bracket

H48691Z

Fixed-angle, disposable
needle guide with
a disposable plastic
bracket

H48681GF

Fixed-angle, reusable
needle guide with a
stainless steel bracket

H46721R

Chapter 3

Versana Premier/Versana Premier Lotus - User Manual 229
5928218-1EN Rev. 6



Probe HCAT Biopsy Guide Biopsy
Guide
HCAT

Biopsy Guide Image

E7C8L-RS
Bi-plane

H48062AL Fixed-angle, disposable
needle guide with a
reusable plastic bracket

H40202E

Fixed-angle, disposable
needle guide

NA NA

BE9CS-RS
Bi-plane

H40482LN Fixed angle, disposable
needle guide

E8387M/
E8013AW

Fixed angle, reusable
needle guide with a
stainless steel bracket

E8387MA/
E8013AX

6Tc-RS
TEE

H45551ZE Not Available NA NA

System Data

Features/Specifications
Table 3-14 Physical Attributes

Dimensions and Weight

• Height: less than 1840 mm
• Width: less than 600 mm
• Depth: less than 970 mm
• Weight: less than 73 kg without any

probes or peripherals

Console Design

• 3, 4 or 5 active probe ports
• SSD (Solid State Disk)
• Integrated speakers
• Cable hooks
• Handle
• Removable air filter
• Lever for moving control panel up/down

and swivel
• Gel Holder and Probe holder
• Fixed or Flexible arm
• Locking mechanism that provides caster

lock

Keyboard

• Alphanumeric keyboard
• Interactive back-lighting
• Digital keyboard

Monitor

• High-Resolution monitor
• Brightness and contrast adjustment
• LCD Fold-down and lock mechanism for

transportation

Electrical Power

• Voltage: 100-240 V AC (±10%)
• Frequency: 50/60 Hz
• Power: Consumption less than 500VA

with on board peripherals
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Table 3-15 Inputs and Outputs Signal

External Inputs and Outputs

• USB port
• Ethernet

Outputs

• Composite Video out (via an adaptor)
• S-Video (via an adaptor)
• HDMI video

Table 3-16 System Overview - Operating Modes and Peripheral Options

Operating Modes

• B-Mode
• CHI-Mode
• M-Mode
• Color Flow Mode (CF)
• PW (Pulse Wave) Doppler (with High

PRF)
• CW (Continued Wave) Doppler (option)
• Combined Mode: B+B, B+M,

B+CF, B+PDI, B+PW, B+CW,
B+CF+PW, B+CF+CW, B+PDI+PW,
B+PDI+CW, CHI+CHI, CHI+M,
CHI+CF, CHI+PDI, CHI+PW,
CHI+CW, CHI+CF+PW, CHI+CF+CW,
CHI+PDI+PW, CHI+PDI+CW
Note: Whether the combined modes
listed above can be implemented
depends on whether the corresponding
independent mode options are installed.

• Power Doppler Imaging (PDI)
• Directional Power Doppler Imaging

(Directional PDI)
• Color M Mode (option)
• Anatomical M-Mode (AMM) (option)
• Curved Anatomical M-Mode (Curved

AMM) (option)
• Tissue Velocity Imaging (TVI) (option)
• TVM (Tissue Velocity M Mode image)

(option)
• Tissue Velocity Doppler (TVD) (option)
• Static 3D/Realtime 4D (option)
• B Flow (option)
• B Flow Color (option)

Peripheral Options

• Printer USB isolation
• Gel Warmer
• Video Output Adapter
• HDMI cable option
• Wireless adapter
• Bluetooth adaptor
• DVDRW kit
• B&W (black and white) image printer
• Color image printer
• HP Officejet 200 Mobile series Printer
• USB memory stick
• 1TB mobile USB HDD
• Footswitch
• Barcode reader
• ECG kit
• Digital Expert Connect
• Rechargeable Li-ion Battery Pack
• Power Cord
• Push-Push A/N keyboard
• Report printer
• External USB printer
• Removable storage media
• Isolation USB port
• A/N keyboard film
• SSA (Secured Service Access)
• Second SSD
• Endo-probe holder

Table 3-17 System Overview - System Features

System Features
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• Contrast Image (option)
• Elastography(option)
• Easy 3D (option)
• Advanced 3D (option)
• TUI (Tomographic Ultrasound Imaging)

combined in 4D (option)
• Tissue Velocity Imaging (TVI) with

QAnalysis (option) (option)
• LOGIQView (option)
• CrossXBeam (option)
• SRI HD
• Auto-IMT (option)
• Stress Echo (option)
• Auto EF (Ejection Fraction) (option)
• Virtual Convex
• Sonobiometry
• VOCAL (option)
• Breast productivity (including BI-RADS)

(option)
• Thyroid productivity (including TI-RADS)

(option)
• Breast Productivity-AI (option)
• Thyroid productivity-AI (option)
• Auto Bladder Volume measurement
• Needle recognition (option)
• Auto TGC
• Auto Tissue Optimization (ATO)
• Automatic Spectrum Optimization (ASO)
• Whizz
• Whizz CF

• Whizz Easy Style (option)
• Digital LGC
• Digital TGC
• Digital Keyboard
• V-Live 2.0 (option)
• Strain Imaging (option)
• Strain Rate (option)
• Whizz Follicle (option)
• Whizz RenderLive (option)
• Breast Care (option)
• Follow-up tool (option)
• LI-RADS(ACR) (option)
• ECG (option)
• Cine
• DICOM (option)
• Scan Coach
• Scan Assistant
• My Trainer
• Report/Worksheet
• Multi-touch
• Fast boot-Standby
• Wide dual screen measurement
• Synchronous mode
• Voice Comment
• VCO for customer (option)
• Probe Check
• Imaging Insights (option)
• Whizz Report
• Whizz Note
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Quality Assurance

A good Quality Assurance Evaluation program consists of periodic systematic actions that
provide the user with adequate confidence that their diagnostic ultrasound system will
produce consistently high quality images and quantitative information.
Therefore, it is in the best interests of every ultrasound user to routinely monitor equipment
performance.
The frequency of Quality Assurance evaluations should be based on user's specific needs
and clinical practice.
Periodic monitoring is essential in order to detect the performance changes that occur
through normal aging of system components. Routine equipment evaluations may also
reduce the duration of exams, number of repeat exams, and maintenance time required.
For details on system and peripheral routine preventive maintenance instructions, see
System Care and Maintenance section for more information.

Typical Tests to Perform

Quality assurance measurements provide results relating to system performance. Typically
these are:

• Axial Measurement Accuracy
• Lateral Measurement Accuracy
• Axial and Lateral Resolution
• Penetration
• Functional & Contrast Resolution
• Gray Scale Photography.

With these tests, a performance baseline can be set at installation with the phantom in your
department. Future test results can be compared to the baseline in order to maintain a record
of system performance trends.
The phantom shown is shown as a representative example of a phantom. You can select
from any number of phantoms available on the market.

Frequency of tests
Quality assurance tests are used to determine whether a scanner is providing the same level
of performance from day to day.
The frequency of testing varies with the amount of system usage and modes to be tested.
It is recommended that the user perform quality assurance tests at least every three months
or every 400 patient studies. Tests should also be performed when a question about system
performance exists.
A mobile system may require more frequent tests.
Image quality should also be tested immediately after the following events:

• Service calls
• System upgrades/modifications
• Dropped probe, power surge, etc.
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Phantoms
Quality Assurance Evaluations may be done with phantoms and test objects that are
applicable to the parameters being evaluated or to the user's clinical practice.
Typical phantoms are composed of material that acoustically mimic human tissue. Pins,
anechoic and echogenic targets are physically positioned to provide information for a variety
of tests.
The RMI 403GS phantom is shown in the illustration below as a representative example of a
phantom.

Figure 3-53 Representative Phantom Example

1. Penetration
2. Axial Distance Measurement
3. Functional Resolution
4. Lateral Resolution
5. Lateral Distance Measurement
6. Axial Resolution
7. Contrast Resolution and Gray Scale Photography
8. Gray Scale Plane Targets

Baselines

An absolute necessity for a quality assurance program is establishing baselines for each test
or check. Baselines are established after the system has been verified to be working properly
at installation or after a repair. If a probe or major assembly is replaced, new baselines
should be generated.
Baselines can be made by adjusting system parameters to prescribed levels or to the best
possible image. The key factor to remember is reproducibility. The same conditions must be
reproduced for each periodic check.

After The Exam Is Over

234 Versana Premier/Versana Premier Lotus - User Manual
5928218-1EN Rev. 6



All system parameters not displayed on the monitor should be recorded for the permanent
record.

Periodic Checks

Periodic checks should be performed in accordance with your facility’s quality assurance
requirements. For the data to be valid, periodic checks should mimic the baseline setup
parameters.
The resulting image, when scanning the phantom exactly as before, should be recorded and
compared to the baseline. When a matching image is obtained, it can be assumed that the
system performance has not degraded from the baseline.
If a significant difference between the baseline and periodic check is noted, double check the
system setup and repeat the test. If the difference between the baseline and periodic check
persists, contact a local Service Representative.
Failing to reproduce the control settings as in the baselines will introduce errors in the data
and potentially invalidate the results.

Results

Lack of standardization among test instruments, the wide range of acceptance criteria, and
incomplete knowledge regarding the significance of certain performance parameters prohibit
the establishment of absolute performance criteria for these tests.
Quality Assurance Evaluation results should be compared to previously-recorded results.
Performance trends can then be detected. Unacceptable performance or diminishing trends
should be identified for maintenance or repair before a malfunction or inappropriate diagnosis
occurs.
The user should determine the best method for recording and archiving the baseline and
periodic checks. In most cases the choice is hard copy.
It is important to maintain good consistent records for inspections that may arise, as well as
to detect system performance trends.

System Setup

The user should tailor the tests to their particular needs. It is certainly not necessary to make
all checks with all probes. A representative example, with the probes used most often by the
customer, should be adequate in judging system performance trends.
Use a gray scale phantom as the scan object for the tests. Commercial phantoms are
supplied with its own operator manual. Be familiar with proper phantom operating procedures
prior to use for quality assurance evaluations.

1. Adjust image monitor. Brightness and contrast should be set to the normal viewing of a
good gray scale image.

2. Check all recording devices for proper duplication of image monitor. Ensure that what is
seen is what is recorded.
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3. Annotate non-displayed image processing controls.
4. Set TGC slide pots to center (detent) position.
5. Place focal zone marker(s) in area of interest for an optimum image.

Test Procedures

The following are recommended Quality Assurance tests. A brief description of the test, the
benefit it provides and steps to accomplish the test are supplied.
The importance of recording scan parameters and consistent record keeping cannot be
stressed enough. Reproducibility to monitor system trends is the key to quality assurance
evaluations.
Using the system's dual image display format is often very convenient and saves recording
media.

Axial distance measurements
Description

Axial measurements are the distance measurements obtained along the sound beam. See
Figure 3-53 Representative Phantom Example on page 234 for more information.

Benefit

The accurate measurement of the size, depth and volume of a structure is a critical factor in
determining a proper diagnosis. Most imaging systems use depth markers and/or electronic
calipers for this purpose.

Method

Axial distance should be measured in the near, mid and far fields as well as in zoom. If
necessary, different depths or fields of view can be tested.

Procedure

To measure axial distance:

1. Scan a test phantom with precisely-spaced vertical pin targets. Adjust all scan controls,
as necessary, for the best image of the pin targets to typical depths for the probe being
used.

2. Press Freeze to stop image acquisition and perform a standard distance measurement
between the pins at different points in the image. Record all images for archiving.

3. Scan the vertical pins in zoom or at different depth/scale factors.
4. Press Freeze to stop image acquisition; repeat the distance measurements between pins

and record the images for archiving.
5. Document the measurements for reference and future comparison.

Contact a Service Engineer if vertical measurements differ by more than 1.50% of the
actual distance.

After The Exam Is Over

236 Versana Premier/Versana Premier Lotus - User Manual
5928218-1EN Rev. 6



Lateral distance measurements
Description

Lateral measurements are distance measurements obtained perpendicular to the axis of the
sound beam.

Benefit

The purpose is the same as vertical measurements. Precisely-spaced horizontal pin targets
are scanned and results compared to the known distance in the phantom.

Method

Lateral distance should be measured in the near, mid and far fields as well as in zoom. If
necessary, different depths of fields of view can be tested.

Procedure

To measure lateral distance:

1. Scan a test phantom with precisely-spaced horizontal pin targets. Adjust all scan
controls, as necessary, for the best image of the pin targets from side to side.

2. Press Freeze to stop image acquisition and perform a standard distance measurement
between the pins at different points in the image. Record all images for archiving.

3. Scan the horizontal pins in zoom or at different depth/scale factors.
4. Press Freeze to stop image acquisition; repeat the distance measurements between pins

and record the images for archiving.
5. Document the measurements for reference and future comparison.

Contact a Service Engineer if horizontal measurements differ by more than 3mm or 3%
of that distance, whichever is greater.

Axial resolution
Description

Axial resolution is the minimum reflector separation between two closely-spaced objects to
produce discrete reflections along the axis of the sound beam. It can also be monitored by
checking the vertical size of known pin targets.

Benefit

In clinical imaging, poor axial resolution displays small structures lying close together as a
single dot. This may lead to improper interpretation of the ultrasound image.

Procedure

To measure Axial resolution:

1. Scan a test phantom with precisely-spaced vertical pin targets.
2. Adjust all scan controls, as necessary, for the best image of the pin targets to typical

depths for the probe being used.
3. Press Freeze to stop image acquisition.
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4. Perform a standard distance measurement of the pin vertical thickness at different points
in the image. Record all images for archiving.

5. Scan the vertical pins in zoom or at different depth/scale factors.
6. Press Freeze to stop image acquisition; repeat the vertical thickness measurements of

the pins and record the images for archiving.
7. Document the measurements for reference and future comparison.

Axial resolution should remain stable over time. Contact a Service Engineer if any
changes are observed.

Lateral resolution
Description

Lateral resolution is the minimum reflector separation between two closely spaced objects
to produce discrete reflections perpendicular to the axis of the sound beam. It can also
be monitored by checking the horizontal size of known pin targets. See Figure 3-53
Representative Phantom Example on page 234 for more information.
Lateral resolution is dependent upon the beam width produced by the probe. The narrower
the beam, the better the lateral resolution.
The beam width is affected by the frequency, degree of focusing, and distance of the object
from the face of the probe.

Benefit

Clinically, poor lateral resolution will display small structures lying close together as a single
dot. This may lead to improper interpretation of the ultrasound image.

Procedure

To measure lateral resolution:

1. Scan a test phantom with precisely-spaced horizontal pin targets.
2. Adjust all scan controls, as necessary, for the best image of the pin targets from side to

side.
3. Press Freeze to stop image acquisition and perform a standard distance measurement

of the horizontal thickness of a pin at different points in the image. Record all images for
archiving.

4. Scan the horizontal pins in zoom or at different depth/scale factors.
5. Press Freeze to stop image acquisition; repeat the horizontal thickness measurements of

the pins and record the images for archiving.
6. Document the measurements for reference and future comparison.

Pin width should remain relatively constant over time ("1mm). Dramatic changes in pin
width may indicate beamforming problems. Contact a Service Engineer if beam width
changes consistently over 2 to 3 periodic tests.

Penetration
Description

Penetration is the ability of an imaging system to detect and display weak echoes from small
objects at large depths. See Phantoms on page 234 for more information.
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Penetration can be affected by the system's:

• Transmitter/receiver
• Degree of probe focusing
• Attenuation of the medium
• Depth and shape of reflecting object
• Electromagnetic interference from local surroundings.

Benefit

Weak reflecting echoes are commonly produced from the internal structure of organs.
Definition of this tissue texture is important in the interpretation of the ultrasound findings.

Method

Scan a phantom to see how echoes begin to fade as depth is increased. The maximum depth
of penetration is the point at which homogeneous material in the phantom begins to lose
brightness.

Procedure

To measure penetration:

1. Set the front panel TGC slide pots to their center (detent) position.
2. Gain and acoustic output can be adjusted, as necessary, since these values are

displayed on the monitor.
3. Scan a test phantom along the vertical pin targets to typical depths for the probe being

used.
4. Perform a standard distance measurement from the top of the image displayed to the

point at which homogeneous material in the phantom begins to lose brightness.
5. Document the depth measurement for reference and future comparison.

Contact a Service Engineer if the depth of penetration shifts more than one centimeter
(1cm) when using the same probe and same system settings.

Functional resolution
Description

Functional resolution is an imaging system's ability to detect and display the size, shape, and
depth of an anechoic structure, as opposed to a pin target.
The very best possible image is somewhat less important than reproducibility and stability
over time. Routine tests at the same settings should produce the same results.

Benefit

The data obtained will give a relative indication of the smallest structure the system is
capable of resolving at a given depth.

Procedure

To measure functional resolution:

1. Set the front panel TGC slide pots to their center (detent) position.
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2. Gain and acoustic output can be adjusted as necessary, since these values are
displayed on the monitor.

3. Scan a test phantom with a vertical row of anechoic cyst targets to typical depths for the
probe being used.

4. Evaluate the cysts at various depths for a good (round) shape, well-defined borders and
no fill in. Remember, TGC slide pots are centered and should remain fixed. This may
NOT provide optimal cystic clearing.

5. Document all results for future reference and comparison.

Contact a Service Engineer if a greatly distorted image is obtained.

Contrast resolution
Description

Contrast resolution is the ability of an imaging system to detect and display the shape and
echogenic characteristics of a structure.
Specific values measured are less important than stability over time. Routine tests at the
same settings should produce the same results.

Benefit

A correct diagnosis is dependent upon an imaging system's ability to differentiate between a
cystic or solid structure versus echo patterns from normal surrounding tissue.

Method

A phantom with echogenic targets of different sizes and depths should be used.

Procedure

To measure contrast resolution:

1. Set the front panel TGC slide pots to their center (detent) position. Set dynamic range to
54 db.

2. Gain and acoustic output can be adjusted, as necessary, since these values are
displayed on the monitor.

3. Scan a test phantom with echogenic targets at the depths available.
4. Evaluate the echogenic targets for contrast between each other and between the

surrounding phantom material. Remember, TGC slide pots are centered and should
remain fixed. This may NOT provide an optimal scan image.

5. Document all results for future reference and comparison.

Contact a Service Engineer if the echogenic characteristics or shapes of the targets
appear distorted.

Gray Scale photography
Description

Poor photography will cause loss of low level echoes and the lack of contrast between large
amplitude echoes.
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Benefit

When photographic controls and film processors are properly adjusted, weak echoes, as well
as strong echoes, are accurately recorded on film.

Procedure

1. Adjust the camera according to the manufacturer's instructions until the hard copy and
video display are equal.

2. Scan the phantom and it's echogenic contrast targets.
3. Make a hard copy photograph of the display and compare it to the image on the video

monitor for contrast and weak echo display.
4. Document all results for future reference and comparison.

Contact a Service Engineer if camera cannot duplicate what is on the image monitor.

NOTE
Optimization of brightness/contrast controls on the display monitor is imperative in order
to make sure that the hardcopy and monitor look alike.

The display monitor is adjusted first. The hardcopy camera or printer is adjusted to match
the display monitor.

Setting up a Record Keeping System

Preparation
The following is needed:

• Quality Assurance binder.
• Hard copy or electronic file of images.
• Quality Assurance Checklists.
• Display the following information while testing quality assurance:

• Acoustic Output
• Gain
• Depth
• Probe
• Dynamic Range
• Set up new patient to be the name of the test.

• Annotate the following:

• Any control where its value is NOT displayed.
• Significant phantom information.

Record Keeping
Complete the following:
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1. Fill out the Ultrasound Quality Assurance Checklist for each probe, as scheduled.
2. Make a hard copy or archive the image.
3. Compare images to baseline images and acceptable values.
4. Evaluate trends over previous test periods.
5. File hard copy or electronic file of images and checklist in Quality Assurance binder.

Ultrasound Quality Assurance Checklist

Table 3-18 Ultrasound Quality Assurance Checklist (Part 1)

Performed By Date

System Serial Number

Probe Type Probe Model Serial Number

Phantom Model Serial Number Room Temperature

Acoustic Output Gain Focal Zone

Gray Map TGC Depth

Monitor Setting

Peripheral Settings

Other Image Processing Control Settings

Table 3-19 (Part 2)

Test Baseline
Value
Range

Tested
Value

Image
Hardcopy/
Archived

Acceptable
? Yes/No

Service
Called
(Date)

Date
Resolved

Vertical Measurement Accuracy

Horizontal Measurement Accuracy

Axial Resolution

Lateral Resolution

Penetration

Functional Resolution

Contrast Resolution

Gray Scale Photography

Probe Check

Probe Check is a probe assessment tool that evaluates each probe element. Probes have
to be clean, any gel residue will provide incorrect data. This test is an assessment that is
intended to be used comparatively during the life of the probe to evaluate possible probe
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deterioration over time. The system default setting is running Probe Check every time for
USA region with software option control.

CAUTION
Probe Check can detect most probe defects but not ALL possible probe defects.

CAUTION
GE HealthCare is NOT responsible for the confirmation about the normal function of the
ultrasound probe before use.

Probe check will evaluate the probe performance and provide the user with an indication of
potential impact to the diagnostic image if it is compromised due to transducer malfunction.

CAUTION
DO NOT allow the probe head to hang free. Impact to the probe head could result in
irreparable damage.

CAUTION
DO NOT unplug the probe during Probe Check process, otherwise the test result shall be
failed.

Pass/Fail criteria
NOTE
If any one of the two Pass or Fail criteria listed below are met, the result is a failure.

1. Total number of element failures exceeded.
2. Number of adjacent element failures exceeded (based on a pre-defined gap between

elements which are considered adjacent).

Supported probes
Probe Check supports on all probes for this system.

Presets
Probe Check provides five interval options for auto triggering, press Utility > System >
General > Probe Check to select the preset.

• Never: probe checking will never automatically opened.
• Every time: probe checking will be automatically opened each time while triggering

probe active.
• Once 1 day: probe checking will be automatically opened one time every day while

triggering probe active.
• Once 7 days: probe checking will be automatically opened one time every week while

triggering probe active.
• Once 30 days: probe checking will be automatically opened one time every month while

triggering probe active.
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NOTE
The system default is every time for USA region. For other regions, the system default is
Never. The first boot up shall follow this setting.

CAUTION
User shall perform probe check manually if the auto trigger interval is not configured as
"every time" when changing a probe with the same name as previous probe.

NOTE
For all options other than NEVER, Probe Check will be triggered automatically while
switching the probes. Switching the presets individually will not trigger Probe Check.

Figure 3-54 Probe Check preset

Probe Test
Auto Trigger

NOTE
Always remember to clean the probe surface before probe check procedure.

1. Check that the probe to be tested is thoroughly clean and dry. For cleaning the probe,
refer to Care and Maintenance on page 300 for more information. Connect it to the probe
port on the scanner, then hold the probe in the air ready for testing.

NOTE
The auto trigger assessment is only available when the Probe Check preset is
Every Time.

NOTE
The auto trigger assessment is only available for the probe connected to the
activated probe port.

NOTE
Prior to inserting the probe, ensure that the connector locking handle is
positioned to the unlock state.

NOTE
Ensure the probe is locked to the system before you start the probe diagnostics.
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2. Press Probe on touch panel, select the probe then the system will do probe test
automatically, a message will pop-up on the monitor "Probe Check: Testing probe,
please wait...".

3. If the probe test is Passed, there will be a message "Probe Check: Probe test passed."
showing on the monitor.

Figure 3-55 Probe Check: Probe test passed

4. If the probe test is Failed, the checking results will be shown on the pop-up window.

Figure 3-56 Probe Test Fail

NOTE
The testing results may vary in different series of GE HealthCare ultrasound
products due to differentiated design. If you have any concern with the testing
result, please contact with your service partner.

5. Follow the suggestions shown on the pop-up window to contact with your service
partner, follow the guidance from your service partner to determine if there is issue with
the probe or the system itself.

Manual Trigger

A manual probe check should be conducted when images acquired with a deficient probe
look abnormal. Phenomena include, but are not limited to overall decreased brightness
or/and partial signal loss.
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Example phantom scanning images are provided below for your reference. Whenever you
see similar cases or are not confident in the status of a probe, please perform probe check
manually.

• Condition 1: Total number of element failures exceeded.

Figure 3-57 Abnormal image acquired with a deficient L6-12-RS probe that has distributed defect
elements

• Condition 2: Number of adjacent element failures exceeded.

Figure 3-58 Abnormal image acquired with a deficient L6-12-RS probe that has adjacent defect elements

Users can perform probe check manually:
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1. Press Probe on touch panel, select the probe to be tested, click Test Probe button.

Figure 3-59 Manual Probe Test on Touch Panel

2. Click Test Probe button on the pop-up window. The testing workflow is same as step 2
to step 5 in Auto Trigger.

Figure 3-60 Manual Probe Test
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Image Quality Check (IQC)

Image Quality Check is intended to facilitate Image Quality checks during Quality Assurance
Evaluations. Quality Assurance tests are used to determine whether a scanner is providing
the same level of performance year after year.

By using the same settings year after year, this ensures that the data collection is consistent,
independently of who performs the test.

This preset only includes fundamental settings for B-Mode. Processing modes like SRI,
Harmonics, etc., are turned off.

NOTE
A tissue-mimicking phantom should be used for IQC evaluations.

To performn an Image Quality Check (IQC):

1. Activate IQC via Utility > Imaging Preset Manager > Category (select the Category
first).

2. Click on the plus sign in front of IQC for Service and select IQC.
3. Assign IQC to a Touch Panel key by using the right arrow key.
4. Map the IQC to the location you want it to appear on the Touch Panel.
5. Select Probe. Then select IQC.
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Privacy and Security

Potential Hazardous Situations Resulting from Failures of the IT Network

The following general hazardous situations have been identified as potentially hazardous as
a result of the IT network failing to provide the required characteristics specified above.

• Delayed or impaired access to images or other exam information or patient data.
• Permanent loss of images or other exam information or patient data.
• Corruption of images or other exam information or patient data.
• LAN connection loss during operation may cause loss of data, and damage data

integrity.

Warning

In addition to the hazardous situations identified above, connection of the Ultrasound System
Software to a network that includes other equipment could result in other unidentified risks
to patients, operators or third parties. The responsible organization should identify, analyze,
evaluate and control these risks on an ongoing basis including after changes to the network
such as those listed below, which could introduce new risks and require additional analysis.

• Changes in network configuration.
• Connection of additional items to the network.
• Disconnecting items from the network.
• Update of equipment connected to the network.
• Upgrade of equipment connected to the network.
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Contact Information

Contacting GE HealthCare Ultrasound

For additional information or assistance, please contact your local distributor or the
appropriate support resource listed on the following pages:
Internet
http://www.gehealthcare.com
https://cleaning.gehealthcare.com
Clinical Questions
For information in the United States, Canada, Mexico and parts of the Caribbean, call the
Customer Answer Center. TEL: (1) 800-682-5327 or (1) 262-524-5698
In other locations, contact your local Applications, Sales, or Service Representative.
Service Questions
For service in the United States, call GE HealthCare CARES.
TEL: (1) 800-437-1171
In other locations, contact your local Service Representative.
Information Requests
To request technical product information in the United States, call GE HealthCare.
TEL: (1) 800-643-6439
In other locations, contact your local Applications, Sales, or Service Representative.
Placing an Order
To order accessories, supplies, or service parts in the United States, call the GE HealthCare
Technologies Contact Center.
TEL: (1) 800-558-5102
In other locations, contact your local Applications, Sales, or Service Representative.
Table 3-20 Americas

ARGENTINA GE HealthCare Argentina
Nicolas de Vedia 3616 piso 5
Buenos Aires - 1307

TEL: (+54) 11-5298-2200

BRAZIL GE HealthCare do Brasil Comércio e Serviços
para
Equipamentos Médicos - Hospitalares Ltda.
Av. Magalhães de Castro, 4800, Andar 10 Conj.
101 e 102, Torre 3
Cidade Jardim
CEP: 05676-120 - São Paulo/SP - Brasil

TEL:
3004 2525 (Capitals and
Metropolitan Regions)
08000 165 799 (Other
Locations)

CANADA GE HealthCare Ultrasound
9900 Innovation Drive
Wauwatosa, WI 53226

TEL: (1) 800-668-0732
Customer Answer Center
TEL: (1) 262-524-5698
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LATIN & SOUTH
AMERICA

GE HealthCare Ultrasound
9900 Innovation Drive
Wauwatosa, WI 53226

TEL: (1) 262-524-5300
Customer Answer Center
TEL: (1) 262-524-5698

MEXICO GE HealthCare Sistemas Medicos de Mexico S.A.
de C.V.
Rio Lerma #302, 1° y 2° Pisos
Colonia Cauhtemoc
06500-Mexico, D.F.

TEL: (5) 228-9600
FAX: (5) 211-4631

USA GE HealthCare Ultrasound
9900 Innovation Drive
Wauwatosa, WI 53226

TEL: (1) 800-437-1171
FAX: (1) 414-721-3865

Table 3-21 Asia

ASIA PACIFIC JAPAN GE HealthCare Asia Pacific
4-7-127, Asahigaoka
Hinoshi, Tokyo
191-8503, Japan

TEL: +81 42 585 5111

AUSTRALIA 32 Phillip Street
Parramatta 2150
Sydney, NSW, Australia

TEL: 1800 659 465

CHINA GE HealthCare - Asia
No. 1, Yongchang North Road
Beijing Economic & Technology Development
Area
Beijing 100176, China

TEL: (8610) 5806 8888
FAX: (8610) 6787 1162
Service: 4008128188
(24h)

INDIA Wipro GE HealthCare Pvt Ltd
No. 4, Kadugodi Industrial Area
Sadaramangala, Whitefield
Bangalore, 560067

TEL: +(91)
1-800-425-8025

KOREA 15F, 416 Hangang Dae ro,
Chung-gu
Seoul 04637, Korea

TEL: +82 2 6201 3114

NEW ZEALAND Level 7 Vero Centre
48 Shortland St, Auckland, 1010
New Zealand

TEL: 0800 659 465

SINGAPORE GE HealthCare ASEAN (Singapore)
11 North Buona Vista Drive
#11-07 The Metropolis Tower 2
Singapore 138589

TEL: +65 6291 8528
FAX: +65 6291 7006
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Table 3-22 Africa

EGYPT GE Medical Systems Egypt, LLC
Plot 44 Tesseen
El Shamaly Street Al Salam Axis First Sector
City Centre, 5th settlement
Cairo, Egypt

TEL: +20 2 25354200
FAX: +20 2 25370031

KENYA GE HealthCare East Africa Services Limited
General Mathenge Drive, Courtyard Building
Westlands
Nairobi 30
00100 KE

TEL: +254 719 093 044

NIGERIA GE HealthCare International Operations (Nig) Ltd
Bishop Aboyade Cole Street No. 927/928
Mansard Place, PO Box 54255
Victoria Island
Lagos LA
NG

TEL: +234 (01) 4607101
TEL: +234 (01) 4607102

KINGDOM OF SAUDI
ARABIA

GE HealthCare Arabia Co. Ltd
Platinum Centre, Building 1
Salahuddin Ayoubi Road
Riyadh-12811
Kingdom of Saudi Arabia

TEL: +966 (11) 494 5779
FAX: +966 (11) 207 3946

SOUTH AFRICA GE HealthCare South Africa (Pty) Ltd.
60 Glenhove Road
Green on Glenhove Customer Innovation Centre
Johannesburg GP
2196 ZA

TEL: +270100725000
FAX: +27 0862958385

Table 3-23 Europe

AUSTRIA GE HealthCare Austria GmbH & Co OG
EURO PLAZA, Gebäude E
Technologiestrasse 10
A-1120 Vienna

TEL: (+43) 1 97272 0
FAX: (+43) 1 97272 2222

BELGIUM &
LUXEMBURG

GE HealthCare BVBA/SPRL
Kouterveldstraat 20
1831 DIEGEM

TEL: (+32) 2 719 7204
FAX: (+32) 2 719 7205

CZECH REPUBLIC GE Medical Systems Ceská Republika, s.r.o.
Bucharova 2641/14
158 00 Praha 5
Česká republika

TEL: (+420) 224 446 162
FAX: (+420) 224 446 161

DENMARK GE HealthCare
Park Allè 295
DK-2605 Brøndby, Denmark

TEL: (+45) 43 295 400
FAX: (+45) 43 295 399
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ESTONIA & FINLAND GE HealthCare Finland Oy
Kuortaneenkatu 2, 000510 Helsinki
P.O. Box 330, 00031 GE Finland

TEL: (+358) 10 39 48 220
FAX: (+358) 10 39 48 221

FRANCE GE Medical Systems SCS
Division Ultrasound
24 Avenue de l'Europe - CS20529
78457 Vélizy Villacoublay Cedex

TEL: (+33) 1 34 49 52 70
FAX: (+33) 13 44 95 202

GERMANY GE HealthCare GmbH
Beethovenstrassee 239
42655 Solingen

TEL: (+49) 212-28 02-0
FAX: (+49) 212-28
02-380

GREECE GE HealthCare
8-10 Sorou Str. Marousi
Athens 15125 Hellas

TEL: (+30) 210 8930600
FAX: (+30) 210 9625931

HUNGARY GE HealthCare Hungary Zft.
Bence utca 3
Budapest BU
1138 HU

TEL: (+36) 23 410 314
FAX: (+36) 23 410 390

IRELAND NORTHERN IRELAND
GE HealthCare
Victoria Business Park
9, Westbank Road
Belfast BT3 9JL.

TEL: (+44) 028 90229900

REPUBLIC OF IRELAND
GE HealthCare
3050 Lake Drive
Citywest Business Campus
Dublin 24

TEL: 1800 460 550
FAX: (+353) 1 686 5327

ITALY GE Medical Systems Italia spa
Via Galeno, 36, 20126 Milano

TEL: (+39) 02 2600 1111
FAX: (+39) 02 2600 1417

KAZAKHSTAN «Дженерал Электрик Қазақстан» ЖШС
Қазақстан, Алматы қаласы, Медеу
ауданы, көшесі ЗЕНКОВ, үй 26/41,
пошталық индексі 050010

T +7 727 3560020

LUXEMBORG See Belgium.

NETHERLANDS GE HealthCare
De Wel 18 B, 3871 MV Hoevelaken
PO Box 22, 3870 CA Hoevelaken

TEL: (+31) 33 254 1290
FAX: (+31) 33 254 1292

NORWAY GE HealthCare Vingmed Ultrasound AS
Sandakerveien 100C
0484 Oslo, Norway

TEL: (+47) 23 18 50 50
FAX: (+47) 23 18 60 35

GE HealthCare Vingmed Ultrasound
Strandpromenaden 45
P.O. Box 141, 3191 Horten

TEL: (+47) 33 02 11 16
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POLAND GE Medical Systems Polska
Sp. z o.o., ul. Woloska 9
02-583 Warszawa, Poland

TEL: (+48) 22 330 83 00
FAX: (+48) 22 330 83 83

PORTUGAL GE HealthCare Portuguesa SA
Avenida do Forte 6 - 6A
Edificio Ramazzotti
2790-072 Carnaxide

TEL: (+351) 21 425 1300
FAX: (+351) 21 425 1343

RUSSIA GE HealthCare
Presnenskaya nab. 10
Block C, 12 floor
123317 Moscow, Russia

TEL: (+7) 4957 396931
FAX: (+7) 4957 396932

SPAIN GE HealthCare España
C/ Gobelas 35-37
28023 Madrid

TEL: (+34) 91 663 2500
FAX: (+34) 91 663 2501

SWEDEN GE HealthCare Sverige AB
FE 314, 182 82 Stockholm
Besöksadr: Venevagen 89
Danderyd, Sverige

TEL: (+46) 08 559 500 10
FAX: (+46) 08 559 500 15
Service Center (+46)
020-120 14 36

SWITZERLAND GE Medical Systems (Schweiz) AG
Europastrasse 31
8152 Glattbrugg

TEL: (+41) 1 809 92 92
FAX: (+41) 1 809 92 22

TURKEY GE HealthCare Türkiye
Istanbul Office
Levent Ofis
Esentepe Mah. Harman Sok.
No:8 Sisli-Istanbul

TEL: +90 212 398 07 00
FAX: +90 212 284 67 00

UNITED ARAB
EMIRATES (UAE)

GE HealthCare
Dubai Internet City, Building No. 18
First Floor, Dubai - UAE

TEL: (+971) 4 429 6101
or 4 429 6161
FAX: (+971) 4 429 6201

UNITED KINGDOM GE Medical Systems Ltd
Pollards Wood
Nightingales Lane
Chalfont St Giles
Buckinghamshire HP8 4SP

TEL: (+44) 1494 544000
FAX: (+44) 1707 289742

For all other European countries not listed, please contact your local GE HealthCare distributor or the
appropriate support resource listed on www.gehealthcare.com.

Manufacturer

GE Medical Systems (China) Co., Ltd.
No. 19, Changjiang Road
Wuxi National Hi-Tech Development Zone
214028 Jiangsu
P.R. China
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TEL: +86 510 85225888; FAX: +86 510 85226688

Factory Sites

GE Medical Systems (China) Co., Ltd.
No. 19, Changjiang Road
Wuxi National Hi-Tech Development Zone
214028 Jiangsu
P.R. China

The product from below factory site can only be available in India:
Wipro GE Medical Device Manufacturing Private Limited
No. 4 Kadugodi Industrial Area, Sadarmangala, Whitefield
Bangalore, Karnataka, 560067 INDIA
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Chapter 4
Safety
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Owner Responsibility

Owner requirements

It is the responsibility of the owner to ensure that anyone operating the system reads
and understands this section of the manual. However, there is no representation that the
act of reading this manual renders the reader qualified to operate, inspect, test, align,
calibrate, troubleshoot, repair or modify the system. The owner should make certain that only
properly trained, fully-qualified service personnel undertake the installation, maintenance,
troubleshooting, calibration and repair of the equipment.
The owner of the ultrasound unit should ensure that only properly trained, fully-qualified
personnel are authorized to operate the system. Before authorizing anyone to operate the
system, it should be verified that the person has read, and fully understands, the operating
instructions contained in this manual. It is advisable to maintain a list of authorized operators.
Should the system fail to operate correctly, or if the unit does not respond to the commands
described in this manual, the operator should contact the nearest field GE HealthCare
Ultrasound Service Office.
For information about specific requirements and regulations applicable to the use of
electronic medical equipment, consult the local, state and federal agencies.

Notice against user modification

Never modify this product, including system components, software, cables, and so on.
User modification may cause safety hazards and degradation in system performance. All
modification must be done by a GE HealthCare qualified person.

Safety
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Bioeffect Disclosure

Following are potential risks inherent to technology:

1. During a diagnostic ultrasound examination, high frequency sound penetrates and
interacts with tissue in and around the area of anatomy to be imaged. Only a small
portion of this sound energy is reflected back to the transducer for use in constructing
the image while the remainder is dissipated within the tissue. The interaction of
sound energy with tissue at sufficiently high levels can produce biological effects
(aka bioeffects) of either a mechanical or thermal nature. Although the generation of
bioeffect is intentional with therapeutic ultrasound, it is generally undesired in diagnostic
application and may be harmful in some conditions.

2. Cavitation may occur by Ultrasound technology during a diagnostic ultrasound
examination. Mechanical Index (MI) is an attempt to indicate the probability that
cavitation might occur within the tissue. Always observe the Acoustic Output display
for possible effects.

Training

During each ultrasound examination the user is expected to weigh the medical benefit of the
diagnostic information that would be obtained against the risk of potentially harmful effects.
Once an optimal image is achieved, the need for increasing acoustic output or prolonging
the exposure cannot be justified. It is recommended that all users receive proper training in
applications before performing them in a clinical setting. Contact the GE HealthCare sales
representative for training assistance.

ALARA

CAUTION

• Ultrasound can produce harmful effects in tissue and potentially result in patient injury.
• Always minimize exposure time and keep ultrasound levels low when there is no

medical benefit. Use the principle of ALARA (As Low As Reasonably Achievable),
increasing output only when needed to obtain diagnostic image quality. Observe the
acoustic output display and be familiar with all controls affecting the output level. See
the Bioeffects section of the Acoustic Output chapter in the Advanced Reference Manual
for more information.

CAUTION

• Ultrasound can produce harmful effects in tissue and potentially result in patient injury.
• The operator of the device must sufficiently understand the acoustic output and be

able to obtain the related thermal index values. Always minimize exposure time to the
irradiation and keep ultrasound acoustic output level low for embryos or fetuses.
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Safety Precautions

Precaution Levels

Various levels of safety precautions can be found on the equipment. Different levels of
concern are identified by one of the following flag words and icons, which precede the
precautionary statement.

DANGER
A danger symbol and icon indicates that a specific hazard is known to exist which, through
inappropriate conditions or actions, will cause :

• Severe or fatal personal injury

WARNING
A warning symbol and icon indicates that a specific hazard is known to exist which, through
inappropriate conditions or actions, may cause:

• Minor personal injury

• Substantial property damage (substantial property damage is defined as damage
requiring service for the system to function)

CAUTION
A caution symbol and icon indicates that a potential hazard may exist which, through
inappropriate conditions or actions, will or can cause:

• Property damage

NOTE
A note indicates precautions or recommendations that should be used in the operation of the
ultrasound system, specifically:

• Maintaining an optimum system environment
• Using this Manual
• Notes to emphasize or clarify a point

Hazard Symbols

Icon Description
Potential hazards are indicated by the following icons:

Safety
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Table 4-1 Potential Hazards

Icon Potential Hazard Usage

Biological Hazard
Describes precautions necessary to prevent the risk of
disease transmission or infections.

• Patient/user infection due to contaminated
equipment.

• Cleaning and care
instructions

• Sheath and glove
guidelines

Electrical Hazard
Describes precautions necessary to prevent the risk of
injury through electric hazards.

• Electrical micro-shock to patient, e.g., ventricular.

• Probes
• ECG, if applicable
• Connections to back

panel

Moving Hazard
Describes precautions necessary to prevent the risk of
injury through moving or tipping hazard!

• Console, accessories or optional storage devices
that can fall on patient, user, or others.

• Collision with persons or objects may result
in injury while maneuvering or during system
transport.

• Injury to user from moving the console.

• Moving
• Using brakes
• Transporting

Acoustic Output Hazard

• Patient injury or tissue damage from ultrasound
radiation.

• ALARA, the use
of Power Output
following the ‘as
low as reasonably
achievable’ principle

Explosion Hazard
Describes precautions necessary to prevent the risk of
injury through explosion hazard.

• Risk of explosion if used in the presence of
flammable anesthetics.

• Flammable
anesthetic

Fire and Smoke Hazard

• Patient/user injury or adverse reaction from fire or
smoke.

• Patient/user injury from explosion and fire.

• Replacing fuses
• Outlet guidelines

Important Safety Considerations
The following topic headings (Patient Safety, and Equipment and Personnel Safety) are
intended to make the equipment user aware of particular hazards associated with the use
of this equipment and the extent to which injury can occur if precautions are not observed.
Additional precautions may be provided throughout the manual.
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DANGER
Improper use can result in serious injury. The use of the system outside the described
conditions or intended use, and disregarding safety related information is considered
abnormal use. The user must be thoroughly familiar with the instructions and potential
hazards involving ultrasound examination before attempting to use the device. Training
assistance is available from GE HealthCare if needed.

Disregarding information on safety is considered abnormal use.
Following are potential risks inherent to technology:

• Ultrasonic energy delivered to non-targeted tissue with the use of Ultrasound devices,
and the interaction of sound energy with tissue at sufficiently high levels can produce
biological effects.

• Monitoring the Mechanical Index (MI) can be a tool to help monitor the probability that
cavitation could occur.

Reporting
Any serious incident related to the use of this GE HealthCare ultrasound device should be
reported to both the Manufacturer and the health authority/competent authority where the
device is installed.
To report to GE HealthCare:
Either contact your local service representative or report to:
in-box.complaints@gehealthcare.com.
Please provide the following information:

• The catalogue number or the model designation of the device as stated on its
identification plate affixed on the device.

• The SystemID/serial number/lot number of the device.
• Date of incident.
• Description of incident, including any patient or user impact/injury.
• Your contact information(facility, address, contact name, title, and telephone number).

Patient Safety Related Hazards

WARNING
The concerns listed can affect the safety of patients undergoing a diagnostic ultrasound
examination.

Patient Identification
Always include proper identification with all patient data and verify the accuracy of the
patient's name and ID numbers when entering such data. Make sure correct patient ID is
provided on all recorded data and hard copy prints. Identification errors could result in an
incorrect diagnosis.
The ultrasound system is not meant to be long term storage for patient data or images.
The customers are responsible for the data on the system and a regular backup is highly
recommended.

Safety
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It is advisable to back up system data prior to any service repairs to the hard drive. It is
always possible during system failure and repair to lose patient data. GE HealthCare will not
be held responsible for the loss of this data.

Diagnostic Information
The images and calculations provided by the system are intended for use by competent
users, as a diagnostic tool. They are explicitly not to be regarded as the sole, irrefutable
basis for clinical diagnosis. Users are encouraged to study the literature and reach their own
professional conclusions regarding the clinical utility of the system.

The user should be aware of the product specifications and of the system accuracy and
stability limitations. These limitations must be considered before making any decision based
on quantitative values. If in doubt, the nearest GE HealthCare Ultrasound Service Office
should be consulted.

Equipment malfunction or incorrect settings can result in measurement errors or failure
to detect details within the image. The equipment user must become thoroughly familiar
with the equipment operation in order to optimize its performance and recognize
possible malfunctions. Applications training is available through the local GE HealthCare
representative. Added confidence in the equipment operation can be gained by establishing a
quality assurance program.

WARNING
The system provides calculations (e.g. estimated fetal weight) and charts based on
published scientific literature. The selection of the appropriate chart and clinical interpretation
of calculations and charts is the sole responsibility of the user. The authorized user should
consider proper indications for the use of a calculation or chart as described in the scientific
literature. The diagnosis, decision for further examination, and medical treatment must be
performed by qualified personnel following good clinical practice.

CAUTION

Features that facilitate measurements such as VOCAL or SonoNT must be used with
extreme care. The measurement results are a suggestion of the system, if in doubt verify
with manual measurement methods.
The user is responsible for the diagnostic interpretation of the measurement results.

Mechanical hazards
The use of damaged probes or improper use and manipulation of intracavity probes can
result in injury or increased risk of infection. Inspect probes often for sharp, pointed, or rough
surface damage that could cause injury or tear protective barriers. Become familiar with all
instructions and precautions provided with special purpose probes.

ELECTRICAL HAZARD
A damaged probe can also increase the risk of electric shock if conductive solutions come
in contact with internal live parts. Inspect probes often for cracks or openings in the housing
and holes in and around the acoustic lens or other damage that could allow liquid entry.
Become familiar with the probe's use and care precautions outlined in Probes and Biopsy.

DANGER
Ultrasound transducers are sensitive instruments which can easily be damaged by rough
handling. Take extra care not to drop transducers and avoid contact with sharp or abrasive
surfaces. A damaged housing, lens or cable can result in patient injury or serious impairment
or operation.
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WARNING

Observe probe immersion levels.
Inspect probes for sharp edges or rough surfaces that could injure sensitive tissue.
DO NOT bend or pull the cable forcefully, to avoid mechanical shock or impact to the probe.

Scanner and electrosurgical units
CAUTION
This equipment provides no special means of protection from high frequency (HF) burns that
may result from using an electrosurgical unit (ESU). To reduce the risk of HF burns, avoid
contact between the patient and ultrasound transducer or ECG electrodes while operating
the ESU. Where contact cannot be avoided, make sure the transducer or ECG electrodes
are not located between the ESU active and dispersive electrodes and keep the ESU cables
away from the transducer or ECG cables.

Equipment and Personnel Safety

The concerns listed in the Equipment and Personnel Safety section can seriously affect the
safety of equipment and personnel during a diagnostic ultrasound examination.

Equipment and Personal Safety Related Hazards
DANGER
This equipment contains dangerous voltages that are capable of serious injury or death.

If any defects are observed or malfunctions occur, stop operating the equipment and perform
the proper action for the patient. Inform a qualified service person and contact a Service
Representative for information.
There are no user replaceable or serviceable components inside the console. Refer all
servicing to qualified service personnel only.
Ensure that unauthorized personnel do not tamper with the unit.

ELECTRICAL HAZARD
To avoid injury:

• Do not remove protective covers. No user serviceable parts are inside. Refer servicing
to qualified service personnel.

• To assure adequate grounding, connect the attachment plug to a reliable (hospital
grade) grounding outlet (having equalization conductor ).

• Never use any adaptor or converter of a three-prong-to-two-prong type to connect with a
mains power plug. The protective earth connection will loosen.

• Do not place liquids on or above the console. Spilled liquid may contact live parts and
increase the risk of shock.

• In North America, a 220-240V installation requires the use of a center-tapped AC power
source.

Safety
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WARNING
Any electronic device can fail without warning signs, therefore the user is advised to follow
local clinical practice guidelines for having a backup imaging plan when performing time-
critical image-guided examinations and interventions.

WARNING
Remove probe from patient body before defibrillation application.

WARNING
Keep the system away from magnetic resonance imaging (MRI) equipment.

WARNING
The internal circuits of the unit use high voltages, capable of causing serious injury or death
by electrical shock.

WARNING
To avoid risk of electric shock, this equipment must only be connected to a supply mains
with protective earth.

CAUTION
In case any serious incident occurred in relation to this ultrasound system should be reported
to GE Healthcare and the competent Authority.

DANGER
The concerns listed below can seriously affect the safety of equipment and personnel during
a diagnostic ultrasound examination.

EXPLOSION HAZARD
Risk of explosion if used in the presence of flammable anesthetics.

Never operate the equipment in the presence of flammable or explosive liquids, vapors
or gases. Malfunctions in the unit, or sparks generated by fan motors, can electrically
ignite these substances. Operators should be aware of the following points to prevent such
explosion hazards.

• If flammable substances are detected in the environment, do not plug in or turn on the
system.

• If flammable substances are detected after the system has been turned on, do not
attempt to turn off the unit, or to unplug it.

• If flammable substances are detected, evacuate and ventilate the area before turning off
the unit.

SMOKE AND FIRE HAZARD
The system must be supplied from an adequately rated electrical circuit. The capacity of the
supply circuit must be as specified.
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DANGER
Biological Hazard

For patient and personnel safety, be aware of biological hazards while performing invasive
procedures. To avoid the risk of disease transmission:

• Use protective barriers (gloves and probe sheaths) whenever possible. Follow sterile
procedures when appropriate.

• Thoroughly clean probes and reusable accessories after each patient examination and
disinfect or sterilize as needed. Refer to Probes and Biopsy for probe use and care
instructions.

• Follow all infection control policies established by your office, department or institution
as they apply to personnel, equipment and accessories.

DANGER
Do not unpack the ultrasound system. This must be performed by qualified service personnel
only. Improper unpacking could lead to injury.

DANGER
GE HealthCare recommends dedicated probes for use on humans only or animals only.
Mark probes dedicated for animals with special labels.

Observe any country specific rules and regulations for handling equipment used on both
animals and humans. Such national restrictions may prohibit transfer of probes used on
animals to humans and vice-versa.
Failure to follow these instructions could lead to exposure to infectious agents.

DANGER
Reusable accessories should be cleaned and disinfected or sterilized as stated by the
manufacturer, after each patient examination.

WARNING

• Be sure to verify the media after writing data, such as EZBackup, SaveAs or Export.

• Before deleting a patient or image from the patient screen, make sure you have saved
the data by EZBackup/Backup or Export and verify that the media data transfer was
successful. Not following the instructions could result in the loss of data requiring a
rescan.

WARNING
When you move the Control Panel up/down with the monitor, place BOTH hands on
the Control Panel. Touching other moving parts other than the Control Panel may cause
personal injury.

WARNING
Contact with natural rubber latex may cause a severe anaphylactic reaction in persons
sensitive to the natural latex protein. Sensitive users and patients must avoid contact with
these items.
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WARNING
The ultrasound system is not intended to be used as a data storage device; backup of
the Patient and Image Database is your institution’s responsibility. GE HealthCare is NOT
responsible for any lost patient information or for lost images. Loss of image data may
require a rescan.

WARNING
To minimize accidental loss of data, perform EZBackup and Backup on a regular basis.

1. First, perform EZBackup to save the images.
2. Next, perform Backup at Utility > Backup/Restore. Enable the following checkboxes

under Backup:

• User defined configuration

• Service

CAUTION
Only approved and recommended peripherals and accessories should be used.

All peripherals and accessories must be securely mounted to the ultrasound system. Failure
to follow these instructions could lead to unexpected diagnostic performance.

CAUTION
Non-supported peripheral devices that use their own AC power source CANNOT be
attached to the ultrasound system. DO NOT connect the peripheral device’s power cord
into the ultrasound system. Only peripheral devices purchased from GE HealthCare with the
purpose of being used with the ultrasound system should be used.

Use a USB printer cable that is less than 3 meters in length.
Failure to follow these instructions could lead to unexpected diagnostic performance.

CAUTION
Do not use this equipment if a safety problem is known to exist. Have the unit repaired and
performance verified by qualified service personnel before returning to use.

CAUTION
To avoid injury or system damage, NEVER place any object or liquid on the operator panel.

CAUTION
Archived data is managed at the individual sites. Performing data backup (to any device) is
recommended.

CAUTION

DO NOT touch the patient and any of the connectors on the ultrasound unit simultaneously,
including ultrasound probe connectors.
DO NOT touch the conducting parts of the USB, Ethernet, Video, HDMI, Audio cables when
connecting equipment to the unit.
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Material Safe Data

Rubber Part
Material: GFE 15&17
Where Used: Probe holder/Rubber cover for arm stopper/ Rubber plug

Monitor Related Hazards
WARNING

• DO NOT place a finger, hand or any object on the joint of the monitor or monitor arm to
avoid injury when moving the monitor and monitor arm.

• To avoid result of injury or system damage, NEVER place any object or liquid on the
monitor, whether in the home or flip down/transport position.

• DO NOT scratch or press on the panel with any sharp objects, such as a pencil or pen,
as this may result in damage to the panel.

• To avoid injury or damage, make sure nothing is within the range of motion before
moving the monitor and monitor arm. This includes both objects and people.

• Pay attention to the monitor arm position to avoid hitting it against anyone or anything.

• Before moving the system to another location, be sure to lock the monitor arm in the
transport position.

• The monitor screen may have defective pixels. These pixels may appear as a slightly
light or dark area on the screen. This is due to the characteristics of the panel itself, and
not the product.

• The backlight of the monitor has a fixed life span. When the screen becomes dark or
begins to flicker, contact a qualified Service Representative for information.

NOTE
Bright light could impact readability of screen.

Material Safe Data

Rubber Part
Material: Silicon
Where Used: Handle Screw Cap/Monitor Rubber
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Allergic reactions to latex-containing medical devices
CAUTION

Due to reports of severe allergic reactions to medical devices containing latex (natural
rubber), the FDA advises health-care professionals to identify latex-sensitive patients, and
be prepared to treat allergic reactions promptly. Latex is a component of many medical
devices, including surgical and examination gloves, catheters, incubation tubes, anesthesia
masks and dental dams. Patient reaction to latex has ranged from contact urticaria, to
systemic anaphylaxis.
For more details regarding allergic reaction to latex, refer to FDA Medical Alert MDA91-1,
March 29.

Electrical safety

Device classifications
Equipment is Class I or Internally Powered equipment, Type BF or Type CF Applied Part for
probes, DEFIBRILLATION-PROOF Type CF Applied Part for ECG.

Internally connected peripheral devices
The system, together with peripheral devices, such as video printer, meets IEC 60601-1
standards for electrical isolation and safety. These standards are applicable only when the
specified peripheral devices are plugged into the AC outlets provided on the unit.

External Connection of other peripheral devices
CAUTION

External devices can be used only if CE marked and in compliance with related standards
(EN 60601-1 or EN 60950/62368). Conformance to EN 60601-1 must be verified.
Accessory equipment connected to the analog and digital interfaces must be certified
according to the respective IEC standards (e.g. IEC 60950/62368 for data processing
equipment and IEC 60601-1 for medical equipment). Furthermore all complete
configurations shall comply with the valid version of the system standard IEC 60601-1.
Anybody connecting additional equipment to the signal input part or signal output part of the
ultrasound unit configures a medical system, and is therefore responsible that the system
complies with the requirements of the valid version of IEC 60601-1. If in doubt consult the
technical service department or your local GE HealthCare representative.

Other external devices, such as printers, and external monitors, usually exceed allowable
leakage limits and, when plugged into separate AC outlets that are then connected to the
unit, are in violation of patient safety standards. Suitable electrical isolation of such external
AC outlets may be required in order to meet UL60601-1 and IEC 60601-1 standards for
electrical leakage.
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EMC (Electromagnetic Compatibility)

The product was tested according to the recommendations of IEC TR 60601-4-2: Medical
electrical equipment – Part 4-2: Guidance and interpretation – Electromagnetic immunity:
performance of medical electrical equipment and medical electrical systems.

NOTE
This equipment generates, uses and can radiate radio frequency energy. The equipment
may cause radio frequency interference to other medical and non-medical devices and radio
communications. To provide reasonable protection against such interference, this product
complies with emissions limits for a Group 1, Class A Medical Devices Directive as stated in
EN 60601-1-2. However, there is no guarantee that interference will not occur in a particular
installation.

NOTE
If this equipment is found to cause interference (which may be determined by turning the
equipment on and off), the user (or qualified service personnel) should attempt to correct the
problem by one or more of the following measure(s):

• Reorient or relocate the affected device(s)
• Increase the separation between the equipment and the affected device
• Power the equipment from a source different from that of the affected device
• Consult the point of purchase or service representative for further suggestions.

NOTE
The manufacturer is not responsible for any interference caused by using other than
recommended interconnect cables or by unauthorized changes or modifications to this
equipment. Unauthorized changes or modifications could void the users’ authority to operate
the equipment.

NOTE
To comply with the regulations on electromagnetic interference for a Class A FCC Device,
all interconnect cables to peripheral devices must be shielded and properly grounded. Use
of cables not properly shielded and grounded may result in the equipment causing radio
frequency interference in violation of the FCC regulations.

"Harmful interference" is defined in 47 CFR §2.122 by the FCC as follows: Interference which
endangers the functioning of a radionavigation service or of other safety services or seriously
degrades, obstructs, or repeatedly interrupts a radio communication service operating in
accordance with the [ITU] Radio Regulations.

NOTE
Do not use devices which intentionally transmit RF Signals (cellular phones, transceivers,
or radio controlled products), other than those supplied by GE HealthCare, in the vicinity of
the equipment, as it may cause performance outside the published specifications. Keep the
power to these type devices turned off when near this equipment.

The medical staff in charge of this equipment is required to instruct technicians, patients, and
other people who maybe around this equipment to fully comply with the above requirement.

Safety
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EMC Performance
All types of electronic equipment may characteristically cause electromagnetic interference
with other equipment, either transmitted through air or connecting cables. The term EMC
(Electromagnetic Compatibility) indicates the capability of equipment to curb electromagnetic
influence from other equipment and at the same time not affect other equipment with similar
electromagnetic radiation from itself.

Proper installation following the service manual is required in order to achieve the full EMC
performance of the product.

The product must be installed as stipulated in Notice upon Installation of Product section.

CAUTION
Use of this equipment adjacent to or stacked with other equipment should be avoided
because it could result in improper operation. If such use is necessary, this equipment and
the other equipment should be observed to verify that they are operating normally. Failure to
follow these instruction could lead to unexpected diagnostic performance.

In case of issues related to EMC, please call your service personnel.

The manufacturer is not responsible for any interference caused by using other than
recommended interconnect cables or by unauthorized changes or modifications to this
equipment. Unauthorized changes or modifications could void the users’ authority to operate
the equipment.

WARNING
Portable RF communications equipment (including peripherals such as antenna cables and
external antennas) should be used no closer than 30 cm (12 inches) to any part of the
ultrasound system, including cables specified by the manufacturer. Otherwise, degradation
of the performance of this equipment could result.

WARNING
Use of this equipment adjacent to or stacked with other equipment should be avoided
because it could result in improper operation. If such use is necessary, this equipment and
the other equipment should be observed to verify that they are operating normally.

WARNING
Use of accessories, transducers and cables other than those specified or provided by
the manufacturer of this equipment could result in increased electromagnetic emissions or
decreased electromagnetic immunity of this equipment and result in improper operation.

Cable Specification
This device contains the following cables:
Table 4-2 Cable specification list

Number Name Cable Length Cable Shielded

1 Power supply cord 1m<L<3m Unshielded

2 Probe cord (except for 6Tc-RS) 1m<L<3m Shielded

3 6Tc-RS probe cord >3m Shielded
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Number Name Cable Length Cable Shielded

4 HDMI cable for connection to Digital
Expert Connect, external display etc.

1m<L<3m Shielded

5 HDMI cable option for connection to
Video Output Adapter

0.375m<L <1m Shielded

6 Type-C cable for connection to external
device

1m<L<3m Shielded

7 Ethernet cable for connection to local
area network

1m<L<3m Unshielded

8 Port on Video adapter, connect through
Video adapter HDMI transmission cable

1m<L<3m Shielded

9 Port on Video adapter, connect through
S-video transmission cable

3m Shielded

10 Port on Video adapter, connect through
CVBS transmission cable

3m Shielded

11 Power supply cord for Gel Warmer <1m Unshielded

12 NORAV ECG lead wire >3m Shielded

13 NORAV ECG USB Cable 0.375m<L <1m Shielded

14 Footswitch MKF 2 1S/1S-MED USB
GP26 transmission cable

1m<L<3m Shielded

15 Footswitch FSU-1000 transmission
cable

1m<L<3m Shielded

16 Western Digital 1TB mobile USB HDD
transmission cable

0.375m<L <1m Shielded

17 Transcend TS8XDVDS-K transmission
cable

0.375m<L <1m Shielded

18 NETGEAR wireless adapter A8000
transmission cable

0.375m<L <1m Shielded

19 SONY UP-D25MD Printer transmission
cable

1m<L<3m Shielded

20 SONY UP-D898MD Printer transmission
cable

1m<L<3m Shielded

21 Printer OfficeJet 200 Mobile Printer
transmission cable

1m<L<3m Shielded

22 Printer USB isolator transmission cable 0.375m<L <1m Shielded

23 Barcode Reader 1950 transmission
cable

1m<L<3m Shielded

Notice upon Installation of Product
Separation distance and effect from fixed radio communications equipment: field strengths
from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and
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land mobile radios, amateur radio, AM and FM radio broadcast, and TV broadcast transmitter
cannot be predicted theoretically with accuracy. To assess the electromagnetic environment
due to fixed RF transmitters, an electromagnetic site survey should be considered. If the
measured field strength in the location in which the ultrasound system is used exceeds the
applicable RF compliance level as stated in the immunity declaration, the ultrasound system
should be observed to verify normal operation. If abnormal operation is observed, additional
measures may be necessary, such as re-orienting or relocating the ultrasound system or
using an RF shielded examination room may be necessary.

1. Use either power supply cords provided by GE HealthCare or ones designated by
GE HealthCare. Products equipped with a power source plug should be plugged into
the fixed power socket which has the protective grounding conductor. Never use any
adaptor or converter to connect with a power source plug (e.g. three-prong-to-two-prong
converter).

2. Locate the equipment as far away as possible from other electronic equipment.
3. Be sure to use only the cables provided by or designated by GE HealthCare. Connect

these cables following the installation procedures (e.g. wire power cables separately
from signal cables).

4. Lay out the main equipment and other peripherals following the installation procedures
described in the Option Installation manuals.

General Notice
WARNING
Use of accessories, transducers and cables other than those specified or provided by
GE of this equipment could result in increased electromagnetic emissions or decreased
electromagnetic immunity of this equipment and result in improper operation.

1. Designation of Peripheral Equipment Connectable to This Product.

The equipment indicated in the Supplies/Accessories section can be hooked up to the
product without compromising its EMC performance.
Avoid using equipment not designated in the list. Failure to comply with this instruction
may result in poor EMC performance of the product.

2. Notice against User Modification.

The user should never modify this product. User modifications may cause degradation in
EMC performance.
Modification of the product includes changes in:
Cables (length, material, wiring, etc.)
System installation/layout
System configuration/components
Securing system parts (cover open/close, cover screwing)

3. Operate the system with all covers closed. If a cover is opened for some reason, be sure
to shut it before starting/resuming operation.

4. Operating the system with any cover open may affect EMC performance.
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Peripheral Update for EC countries
The following is intended to provide the users in EC countries with updated information
concerning the connection of the ultrasound system to image recording and other devices or
communication networks.

Peripherals used in the patient environment
The ultrasound system has been verified for overall safety, compatibility and compliance with
the image recording devices listed in Supplies/Accessories section.

The ultrasound system has also been verified for compatibility, and compliance for
connection to a local area network (LAN) via the rear panel Ethernet connection, provided
the LAN components are IEC/EN 60950/62368 compliant.

The ultrasound system may also be used safely while connected to devices other than those
recommended above if the devices and their specifications, installation, and interconnection
with the system conform to the requirements of IEC/EN 60601-1.

Accessory equipment connected to the analog and digital interfaces must be certified
according to the respective IEC standards (i.e., IEC 60950/62368 for data processing
equipment and IEC 60601-1 for medical equipment). Furthermore, all complete
configurations shall comply with the valid version of the system standard IEC 60601-1.
Everyone who connects additional equipment to the signal input part or signal output part
of the ultrasound system configures a medical system, and is therefore responsible to ensure
that the system complies with the requirement of the valid version of IEC 60601-1. If in doubt,
consult the technical service department or your local GE representative.

General precautions for installing an alternate on-board device would include:

1. The added device(s) must have appropriate safety standard conformance and CE
Marking.

2. The total power consumption of the added devices, which connect to the ultrasound
system and are used simultaneously, must be less than or equal to the rated supply of
the ultrasound system.

3. There must be adequate heat dissipation and ventilation to prevent overheating of the
device.

4. There must be adequate mechanical mounting of the device and stability of the
combination.

5. Risk and leakage current of the combination must comply with IEC/EN 60601-1.
6. Electromagnetic emissions and immunity of the combination must conform to IEC/EN

60601-1-2.
7. The added device(s) must be used for their intended purpose having a compatible

interface.
8. Signal or mains isolation devices and additional protective earth may be needed to

assure compliance with IEC/EN 60601-1.

CAUTION
The connection of equipment or transmission networks other than as specified in the user
instructions can result in an electric shock hazard or equipment malfunction. Substitute or
alternate equipment and connections requires verification of compatibility and conformity
to IEC/EN 60601-1 by the installer. Equipment modifications and possible resulting
malfunctions and electromagnetic interference are the responsibility of the owner.

Safety
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Peripheral used in the non-patient environment
The ultrasound system has also been verified for compatibility, and compliance for
connection to a USB HDD/USB memory via the system USB port, provided the USB
HDD/USB memory are IEC/ EN 60950/62368 compliant.

Interference caution
Intended healthcare environment: Professional healthcare facility environment.

CAUTION
Use of devices that transmit radio waves near the unit could cause it to malfunction.

Devices which intrinsically transmit radio waves, such as cellular phones, radio transceivers,
mobile radio transmitters, radio-controlled toys, etc., should preferably not be operated near
the unit. See Minimum distances on page 278 about the recommended minimum separation
distances between portable and mobile RF communications equipment and the ultrasound
unit.
Medical staff in charge of the unit are required to instruct technicians, patients, and other
people who may be around the unit to fully comply with the above recommendations.
Any electrical device can unintentionally emit electromagnetic waves. However, minimum
device separation distances cannot be calculated for such unspecified radiation. When the
ultrasound unit is used adjacent to or in close proximity to other equipment the user should
be attentive to unexpected device behavior which may be caused by such radiation.
The Medical Electrical System is suitable for use in professional healthcare facility
environment.
The ultrasound unit is intended for use in the electromagnetic environment specified in the
tables below.
The user of the ultrasound unit should ensure that the device is used in such an environment.

Declaration of Emissions
This system is suitable for use in the following environment. The user must assure that it is
used only in the electromagnetic environment as specified.

Table 4-3 Declaration of Emissions

Guidance and manufacturer’s declaration - electromagnetic emissions
The system is intended for use in the electromagnetic environment specified below. The user
of the system should assure that it is used in such an environment.
Emission Type Compliance Electromagnetic Environment

RF Emissions
CISPR 11

Group 1 This system uses RF energy only for its internal function.
Therefore, its RF emissions are very low and are not likely to
cause any interference in nearby electronic equipment.
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Guidance and manufacturer’s declaration - electromagnetic emissions
The system is intended for use in the electromagnetic environment specified below. The user
of the system should assure that it is used in such an environment.
Emission Type Compliance Electromagnetic Environment

RF Emissions
CISPR 11

Class A This system is suitable for use in all establishments, other
than domestic establishments and those directly connected
to the public low-voltage power supply network that supplies
buildings used for domestic purposes.Harmonic Emissions

IEC 61000-3-2
Class A

Voltage Fluctuations/
Flicker Emissions
IEC 61000-3-3

Complies

WARNING
The EMISSIONS characteristics of this equipment make it suitable for use in industrial
areas and hospitals (CISPR 11 class A). If it is used in a residential environment (for which
CISPR 11 class B is normally required) this equipment might not offer adequate protection to
radio-frequency communication services. The user might need to take mitigation measures,
such as relocating or reorienting the equipment.

WARNING
This system is intended for use by healthcare professionals only. This system may cause
radio interference or may disrupt the operation of nearby equipment. It may be necessary
to take mitigation measures, such as re-orienting or relocating the system or shielding the
location.

Declaration of Immunity
The system is suitable for use in the specified electromagnetic environment and it has meets
the following immunity test levels. Higher immunity levels may cause the system's essential
performance lost or degraded.
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Table 4-4 Electromagnetic Immunity

Phenomenon Basic EMC
Standard or
Test Method

Regulatory Acceptable
Level

EMC Environment and
Guidance

Electrostatic
discharge

IEC 61000-4-2 ± 8 kV contact
± 2 kV, ± 4 kV, ± 8 kV, ±
15 kV air

Floors should be wood,
concrete, or ceramic tile. If
floors are covered with synthetic
material, the relative humidity
should be at least 30%.
Mains power quality should be
that of a typical commercial
and/or hospital environment. If
the user requires continued
operation during power mains
interruptions, it is recommended
that the system be powered from
a UPS or a battery.
NOTE: UT is the a.c. mains
voltage prior to application of the
test level.
Power frequency magnetic fields
should be at levels characteristic
of a typical location in a typical
commercial and/or hospital
environment.

Radiated RF
EM fields

IEC 61000-4-3 3 V/m
80 MH - 2.7GHz
80%AM at 1kHz

Proximity fields
from RF
wireless
communication
s equipment

IEC 61000-4-3 See the RF
wireless communication
equipment table in
"Minimum distances".

Rated power
frequency
magnetic fields

IEC 61000-4-8 30 A/m
50 Hz or 60 Hz

Electric fast
transients
bursts

IEC 61000-4-4 Power supply port: ± 2
kV, 100 kHz repetition
frequency;
Signal input/output parts
Port: ± 1kV, 100 kHz
repetition frequency.
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Table 4-5 Electromagnetic Immunity (continued)

Phenomenon Basic EMC
Standard or
Test Method

Regulatory Acceptable
Level

EMC Environment and
Guidance

Surges IEC 61000-4-5 Line to line: ± 0.5 kV, ±
1 kV
Line to earth: ± 0.5 kV,
± 1 kV, ± 2 kV

Separation distance to radio
communication equipment must
be maintained according to the
method below. Interference may
occur in the vicinity of equipment
marked with the symbol:

Image degradation or
interference may occur due to
conducted RF noise on the
equipment mains power supply
or other signal cable. Such
interference is easily recognized
and distinguishable from patient
anatomy and physiological
waveforms. Interference of
this type may delay the
examination without affecting
diagnostic accuracy. Additional
mains/signal RF isolation or
filtering may be needed if
this type interference occurs
frequently.

Conducted
disturbances
induced by RF
fields

IEC 61000-4-6 3 V in 0.15 MHz - 80
MHz
6 V in ISM and/or
amateur radio bands
between 0.15 MHz and
80 MHz
80 % AM at 1kHz

Voltage dips IEC 61000-4-11 0% UT: 0.5 cycle
at 0°, 45°, 90°, 135°,
180°, 225°, 270°, and
315°
0% UT: 1 cycle and
70% UT: 25/30 cycles
sine phase at 0°

Voltage
interruptions

IEC 61000-4-11 0% UT: 250/300 cycle

NOTE: These guidelines may not apply in all situations. Electromagnetic propagation is
affected by absorption and reflection from structures, objects, and people. If noise generated
from other electronic equipment is near the probe's center frequency, noise may appear on
the image. Good power line isolation is required.

Minimum distances
Recommended separation distances between portable and mobile RF
communications equipment and the ultrasound unit

The ultrasound unit is intended for use in an electromagnetic environment in which radiated
RF disturbances are controlled. The customer or the user of the ultrasound unit can
help prevent electromagnetic interference by maintaining a minimum distance between
portable and mobile RF communications equipment (transmitters) and the ultrasound unit
as recommended below, according to the maximum output power of the communications
equipment. Portable and mobile radio communications equipment (e.g. two-way radio,
cellular/cordless telephones and similar equipment) should be used no closer to any part
of this system, including cables, than determined according to the following method:
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Recommended separation distances between portable and mobile RF
communications equipment and the ultrasound unit

Test
frequency
(MHz)

Band
(MHz)

Service Modulation Maximum
power (W)

Distance
(m)

Immunity
test level
(V/m)

385 380 - 390 TETRA 400 Pulse
modulation
18Hz

1.8 0.3 27

450 430 - 470 GMRS 460
FRS 460

FM ± 5 kHz
deviation 1
kHz sine

2 0.3 28

710 704 -787 LTE Band
13, 17

Pulse
modulation
217 Hz

0.2 0.3 9

745

780

810 800 - 960 GSM
800/900,
tetra 800,
iDEN 820,
CDMA 850,
LTE Band 5

Pulse
modulation
18 Hz

2 0.3 28

870

930

1720 1700 - 1990 GSM 1800,
CDMA
1900,
GSM 1900,
DECT,
LTE Band
1, 3, 4, 25,
UMTS

Pulse
modulation
217 Hz

2 0.3 28

1845

1970

2450 2400 - 2570 Bluetooth,
WLAN,
802.11
b/g/n,
RFID 2450,
LTE Band 7

Pulse
modulation
217 Hz

2 0.3 28

5240 5100 - 5800 WLAN,
802.11 a/n,

Pulse
modulation
217 Hz

0.2 0.3 9

5500

5785

For transmitters rated at a maximum output power not listed above the recommended
separation distance d in meters (m) can be estimated using the equation applicable to the
frequency of the transmitter, where P is the maximum output power rating of the transmitter
in watts (W) according to the transmitter manufacturer.
NOTE 1: At 80 MHz and 800 MHz, the separation distance for the higher frequency range
applies.
NOTE 2: These guidelines may not apply in all situations. Electromagnetic propagation is
affected by absorption and reflection from structures, objects and people.

Chapter 4

Versana Premier/Versana Premier Lotus - User Manual 279
5928218-1EN Rev. 6



Wireless Adapter Specification
Table 4-6 Wireless Adapter specification

Received frequency
(GHz)

Emission frequency
(GHz)

Modulation
Type

Effective radiation
frequency

2.412 2.412 OFDM <=100mW

2.417 2.417

2.422 2.422

2.427 2.427

2.432 2.432

2.437 2.437

2.442 2.442

2.447 2.447

2.452 2.452

2.457 2.457

2.462 2.462

Bluetooth Specification
• Frequency Range: 2.4GHz ISM Band (2.402 - 2.480 GHz)
• Maximum Output Power: ≤100 mW (+20 dBm)
• Data Transmission Rate: 3 M/s (10 meters on the PC to PC)
• Modulation Type: FSK, GFSK
• Transmission protocol: Bluetooth protocol

WARNING
Even if other devices meet the emission requirements of the corresponding national
standards, the device or system may still be interfered by other devices.

Essential performance
The essential performance of the ultrasound unit is:

1. The ability to be free from noise on a waveform or artefacts or distortion in an image or
error of a displayed numerical value which cannot be attributed to a physiological effect
and which may alter the diagnosis.

2. The ability to be free from the display of incorrect numerical values associated with the
diagnosis to be performed a.

3. The ability to be free from the display of incorrect safety-related indications a.
4. The ability to be free from the production of unintended or excessive ultrasound output.
5. The ability to be free from the production of unintended or excessive TRANSDUCER

ASSEMBLY surface temperature.
6. The ability to be free from the production of unintended or uncontrolled motion of

TRANSDUCER ASSEMBLIES intended for intra-corporeal use.
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NOTE
a: “incorrect” in the sense that the displayed value differs from what is calculated (having
been altered during data transfer), or the calculation itself is not correct.

Performance as per IEC TR 60601-4-2
Performance as per IEC TR 60601-4-2 for the ultrasound unit is:

• The ability to display physiological images as input for diagnosis by trained physician.
• The ability to display physiological traces as aid for diagnosis by trained physician.
• The ability to display quantified data as input for diagnosis by trained physician.
• No reset to factory defaults (manufacturer’s presets).

Patient Environmental Devices

1. Left side

• Gel bottle holder / Gel warmer
• 2 probe holders

2. Right side

• Probe holders

3. Front panel

• Inside Printer Box
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• 4 or 5 active probe ports (For Versana Premier Lotus)
3 or 4 active probe ports (For Versana Premier)

4. Rear panel

• 1 HDMI port (1080P)
• 3 USB ports (2 type A ports, 1 type C port)
• 1 Ethernet port (100MBase-T)

Acceptable Devices
The Patient Environmental devices shown on the previous page are specified to be suitable
for use within the PATIENT ENVIRONMENT.

CAUTION
DO NOT connect any probes or accessories without approval by GE HealthCare within the
PATIENT ENVIRONMENT.

Unapproved Devices
CAUTION

DO NOT use unapproved devices.
If devices are connected without the approval of GE HealthCare, the warranty will be
INVALID.
Any device connected to the Versana Premier/Versana Premier Lotus must conform to the
requirements for IEC or equivalent standards appropriate to devices.

Accessories, Options, Supplies
CAUTION
Unsafe operation or malfunction may result. Use only the accessories, options and supplies
approved or recommended in these instructions for use.

Acoustic Output

CAUTION
Allowing the machine to transmit acoustic output with the probe not in use (or in its holder)
can cause the transducer to build up heat. Always lower the acoustic power or freeze the
image when not in use.

When the Auto Freeze preset is selected on the Utility > System > System Imaging
screen, the system auto freezes if it detects no change in the image.
Located on the upper right section of the system display monitor, the acoustic output display
provides the operator with real-time indication of acoustic levels being generated by the
system, and the acoustic output level could be adjusted by user. See the Acoustic Output
chapter in the Advanced Reference Manual for more information.

Safety
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Acoustic Output Display Specifications
The display consists of three parts: Thermal Index (TI), Mechanical Index (MI), and a relative
Acoustic Output (AO) value. Although not part of the IEC standard, the AO value informs the
user of where the system is operating within the range of available output.
The TI and MI are displayed at all times. The TI and MI display starts at a value of 0 and
increments in steps of ≤0.2.
Always be aware of the acoustic output level by observing the Acoustic Output Display. In
addition, become thoroughly familiar with the Acoustic Output Display and equipment controls
affecting output.

Thermal Index

Depending on the examination and type of tissue involved, the TI parameter will be one of
three types:

• Soft Tissue Thermal Index (TIS). Used when imaging soft tissue only, it provides an
estimate of potential temperature increase in soft tissue.

• Bone Thermal Index (TIB). Used when bone is near the focus of the image as in the third
trimester OB examination, it provides an estimate of potential temperature increase in
the bone or adjacent soft tissue.

• Cranial Bone Thermal Index (TIC). Used when bone is near the skin surface as in
transcranial examination, it provides an estimate of potential temperature increase in the
bone or adjacent soft tissue.

Mechanical Index

MI recognizes the importance of non-thermal processes, cavitation in particular. The Index is
a relative indicator of the likelihood of mechanical bioeffect within the tissue.

Changing the Thermal Index Type

You can select the displayed TI type on Utility > Imaging > B-Mode. This preset is application
dependent so each application could specify a different TI type.

TI and MI Display Accuracy

When display MI>= 0.6, TI>= 3.6, the displayed values of MI and IT is not lower than 50% or
higher than 150% of the measured value.
When display MI < 0.6, TI < 3.6, the absolute error of MI <= 0.3, the absolute error of TI <=
1.8.

Controls Affecting Acoustic Output
The potential for producing mechanical bioeffects (MI) or thermal bioeffects (TI) can be
influenced by certain controls.
Direct. The Power Output control has the most significant effect on Acoustic Output.
Indirect. Indirect effects may occur when adjusting controls. Controls that can influence MI
and TI are detailed under the Bioeffects portion of each control in the Optimizing the Image
sections.
Always observe the Acoustic Output display for possible effects.
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Best Practices While Scanning
HINTS
Raise the Acoustic Output only after attempting image optimization with controls that have
no effect on Acoustic Output, such as Gain and TGC.

NOTE
Refer to the Optimizing the Image sections for a complete discussion of each control.

DANGER
Be sure to have read and understood control explanations for each mode used before
attempting to adjust the Acoustic Output control or any control that can affect Acoustic
Output. During a screening and diagnostic ultrasound examination, high frequency sound
penetrates and interacts with tissue in and around the area of anatomy to be imaged. Only a
small portion of this sound energy is reflected back to the transducer for use in constructing
the image, while the remainder is dissipated within the tissue. The interaction of sound
energy with tissue at sufficiently high levels can produce biological effects (aka bioeffects) of
either a mechanical or thermal nature. Although the generation of bioeffect is intentional with
therapeutic ultrasound, it is generally undesired in screening and diagnostic applications and
may be harmful in some conditions.

ACOUSTIC OUTPUT HAZARD
Use the minimum necessary acoustic output to get the best diagnostic image or
measurement during an examination. Begin the exam with the probe that provides an
optimum focal depth and penetration.

Acoustic Output Default Levels
In order to assure that an exam does not start at a high output level, the ultrasound
system initiates scanning at a reduced default output level. This reduced level is preset
programmable and depends upon the exam category and probe selected. It takes effect
when the system is powered on or Patient is selected.
To modify acoustic output, adjust the Power Output level.

Safety statement
Although no harmful biological effects have been demonstrated for ultrasound frequencies,
intensities, or exposure times used in examination with the GE HealthCare system, GE
HealthCare recommends using the lowest acoustic output settings which will produce
diagnostically acceptable information.

RoHS Hazardous Substances

The following product pollution control information is provided according to SJ/T11364-2014
Marking for Control of Pollution caused by Electronic Information Products.

Safety
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The symbol above indicates the product contains hazardous materials in excess of the limits
established by the Chinese standard GB/T 26572 Requirements for Concentration Limits for
Certain Hazardous Substances in Electronic Information Products. The number in the symbol
is the Environment-friendly Use Period (EFUP), which indicates the period during which the
hazardous substances or elements contained in electrical and electronic products will not
leak or mutate under normal operating conditions so that the use of such electrical and
electronic products will not result in any severe environmental pollution, any bodily injury or
damage to any assets. The unit of the period is “Year.”
In order to maintain the declared EFUP, the product shall be operated normally according to
the instructions and environmental conditions as defined in the product manual, and periodic
maintenance schedules specified in Product Maintenance Procedures shall be followed
strictly. Consumables or certain parts may have their own label with an EFUP value less than
the product. Periodic replacement of those consumables or parts to maintain the declared
EFUP shall be done in accordance with the Product Maintenance Procedures.
This product must not be disposed of as unsorted municipal waste, and must be collected
separately and handled properly after decommissioning.

Name and Concentration of Hazardous Substances
Table 4-7 Table of hazardous substances' name and concentration

Component Name Hazardous substances' name
Pb Hg Cd Cr (VI) PBB PBDE

LCD Monitor X O O O O O

Printed Circuit Board
Assemblies

X O O O O O

Touch Panel X O O O O O

Keyboard Assemblies X O O O O O

Power Assemblies X O O O O O

Console Cabinet O O O O O O

Ultrasound Probes X O O O O O

Wheels O O O O O O

This table is prepared according to SJ/T 11364.
O: Indicates that this hazardous substance contained in all of the homogeneous materials for this part
is below the limit requirement in GB/T 26572.
X: Indicates that this hazardous substance contained in at least one of the homogeneous materials
used for this part is above the limit requirement in GB/T 26572.
Data listed in the table represents best information available at the time of publication.
Applications of hazardous substances in this medical device are required to achieve its intended
clinical uses, and/or to provide better protection to human beings and/or to environment, due to lack
of reasonably (economically or technically) available substitutes
Note: Options may not be present on every system.
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WEEE Passport

The WEEE (Waste Electrical and Electronic Equipment) Passport describes product recycling
information. To access the WEEE passport for GE HealthCare products:

1. Go to the GE HealthCare Support Documentation Library at:

https://www.gehealthcare.com/support/documentation
2. Select the modality "Ultrasound (UL)."
3. Enter the document name or the keyword "WEEE."
4. Press “Search.”
5. Select the desired WEEE passport.

Safe Product and Packaging Disposal

This product and package should be disposed of according to hospital disposal practices,
and local environmental and waste disposal regulations. Components and accessories of the
ultrasound system which have come into direct or indirect contact with the patient may be
biohazardous, and should be disposed of according to facility guidelines for biohazardous
material. The waste of electrical and electronic equipment must not be disposed as
unsorted municipal waste and must be collected separately. Please contact an authorized
representative of the manufacturer for information concerning the disposal/decommissioning
of equipment.

General Caution

CAUTION
Standard maintenance must be performed by authorized service personnel for the lifetime of
the product (7 years).

CAUTION
Proceed cautiously when crossing door or elevator thresholds. Use the handle to push/pull
the system, e.g., do not use the monitor. Failure to do so may cause serious injury or system
damage.

Safety
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Device Labels

Label Icon Description

The following table describes the purpose and location of safety labels and other important
information provided on the equipment.

NOTE
This machine should be used in compliance with law. Some jurisdictions restrict certain
uses, such as gender determination (shown for country specific label).

Table 4-8 Label Icons

Label/Icon Purpose/Meaning Location Reference

Manufacture's name and address Rating
Plate

EN ISO 15223-1

Date of manufacture: The date
could be a year, year and month,
or year, month and day, as
appropriate.

Rating
Plate

EN ISO 15223-1

Serial Number Rating
Plate

EN ISO 15223-1

Catalog Number Rating
Plate

EN ISO 15223-1

Part Number Rating
Plate

GE HealthCare created

IP Code: IPX8
FSU-1000, MKF
2-MED GP26

Indicates the degree of protection
provided by the enclosure per IEC
60529.
Protected against the effects of
continuous immersion.

Bottom of
footswitch

IEC 60601-1 (EN
60601-1)

IP Code: IPX7
Probe head

Indicates the degree of protection
provided by the enclosure per IEC
60529.
Protected against the effects of
temporary immersion.

Probe
Connector

IEC 60601-1 (EN
60601-1)

Authorized European
Representative address.

Rating
Plate

EN ISO 15223-1
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Label/Icon Purpose/Meaning Location Reference

The CH-REP label indicates
the authorized representative in
Switzerland.

Rating
Plate

Swiss Medical Devices
Ordinance (MedDO)

Type CF Defib-Proof Applied Part
(heart in the box with paddle)
symbol is in accordance with IEC
60417-5336.

ECG
Bracket
and ECG
Module

IEC 60601-1 (EN
60601-1)

General Warning. Various IEC 60601-1 (EN
60601-1)

Avoid pinching hands during
adjusting the monitor or control
panel height adjustment assy.

Various GE HealthCare created

"CAUTION" - Dangerous voltage"
(the lightning flash with arrowhead)
is used to indicate electric shock
hazards.

Body back
cover

IEC 60601-1 (EN
60601-1)

Indicates the power on (green),
power off (white) and no power (no
light) position.
CAUTION: This Power Switch
DOES NOT ISOLATE Mains
Supply.

See the
Console
Overview
section for
location
information
.

IEC 60601-1 (EN
60601-1)

"Protective Earth" indicates the
protective earth (grounding)
terminal.

Inside
Power Box

IEC 60601-1 (EN
60601-1)

"Equipotentiality" indicates the
terminal to be used for connecting
equipotential conductors when
interconnecting (grounding) with
other equipment.

Rear panel IEC 60601-1 (EN
60601-1)

This symbol indicates that
waste electrical and electronic
equipment must not be disposed
of as unsorted municipal
waste and must be collected
separately. Please contact an
authorized representative of the
manufacturer for information
concerning the decommissioning of
your equipment.

Body back
cover and
probe
connector

WEEE Recast Directive
2012/19/EU

Safety
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Label/Icon Purpose/Meaning Location Reference

The separate collection symbol is
affixed to a battery, or its packaging,
to advise you that the battery
must be recycled or disposed of
in accordance with local or country
laws. Please consult the service
manual or equipment instructions.
Information on the potential effects
on the environment and human
health of the substances used
in batteries is available at this
url: http://www.gehealthcare.com/
euen/weee-recycling/index.html

Battery
Pack

2006/66/EC Directive

Do not place any objects on the
monitor.

Back of
Monitor

GE HealthCare created

Do not force the monitor with your
hands.

Back of
Monitor

GE HealthCare created

There is a pinch point on the
monitor. Take care to avoid injuring
hands or fingers when flipping down
the monitor.

Back of
Monitor

GE HealthCare created

Use the rear handle for horizontal
movement only.

Back of
Monitor

GE HealthCare created

"Consult accompanying documents"
is intended to alert the user to
refer to the operator manual or
other instructions when complete
information cannot be provided on
the label.

Various EN 60601-1/A1 (IEC
60601-1/A1)
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Label/Icon Purpose/Meaning Location Reference

DO NOT place a finger, hand or any
object on the joint of the monitor or
monitor arm to avoid injury when
moving the monitor and monitor
arm.

Flexible
Arm

GE HealthCare created

The maximum load weight is 1.5kg. Various GE HealthCare created

Do not push the system body
without using handle.

Back of
Monitor

EN 60601-1/A1 (IEC
60601-1/A1)

GOST symbol: Russia Regulatory
Country Clearance.
Note: Only after Russian regulatory
registration is complete, this label
will be located on the console rating
plate.

Rating
plate

Russia regulatory
requirements.

Ukrainian mark of conformity with
the Technical Regulations.
This product meets the
requirements of the Technical
Regulations on medical devices,
approved by Resolution No.753 of
the Cabinet of Ministers of Ukraine
of 2 October 2013. Note: Only after
Ukrainian regulatory registration is
complete, this label will be located
on the console.

Body back
cover

Ukraine regulatory
requirements.

Indian BIS certificate Mark.
Note: Only after Indian BIS
certificate is complete, this icon will
be located on the battery or LCD.

Battery Indian BIS
requirements.

INMETRO Certification: SGS
Note: Only after Brazilian regulatory
registration is complete, this label
will be located on the console rating
plate.

Rating
plate

Brazil regulatory
requirement.

CAUTION: This machine should be
used in compliance with law. Some
Jurisdictions restrict certain uses,
such as gender determination.
Note: For China, Korea and India
only.

Body back
cover

GE HealthCare created

Safety
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Label/Icon Purpose/Meaning Location Reference

The maximum weight of the system
with all hardware and mechanical
configurations connected.

Rating
plate

GE HealthCare created

Every system has a unique marking
for identification, the Unique Device
Identification (UDI) Label. The UDI
label consists of a series of alpha-
numeric characters and barcode
which uniquely identify the system
as a medical device manufactured
by General Electric. Scan or enter
the UDI information into the patient
health record as required by
country-specific laws.

Rating
plate

GE HealthCare created

Federal law restricts this device
to sale by or on the order of a
physician.

Body back
cover

United States
regulatory requirement.

The CE Mark of Conformity
indicates this equipment conforms
with the MDR - REGULATION (EU)
2017/745.

Rating
plate

Europe regulatory
requirement.

Input Rating
plate

GE HealthCare created

This symbol indicates that the
device is a Medical Device
according to MDR - REGULATION
(EU) 2017/745.

Rating
plate

EN ISO 15223-1

The symbol indicates that the
device is only for GE HealthCare
Ultrasound device.

Gel
Warmer

GE HealthCare created

Symbol indicating that the
Instructions for Use are supplied in
electronic form.
NOTE: The symbol is valid for eIFU
only when the system meets eIFU
requirement.

Body back
cover

ISO7000-3500

Keep the system away from
magnetic resonance imaging (MRI)
equipment.

Body back
cover

ASTM F2503-20
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Label Locations

Ultrasound system warning labels are provided in English.

Table 4-9 Label Location Explanations

No Explanation

1 Possible shock hazard. Do not remove covers or panels. No user serviceable parts
are inside. Refer servicing to qualified service personnel.

2 MRI Warning label.

3 Do not use the following devices near this equipment: cellular phone, radio
receiver, mobile radio transmitter, radio controlled toy, etc. Use of these devices
near this equipment could cause this equipment to perform outside the published
specifications. Keep power to these devices turned off when near this equipment.

4 WEEE Label

5 United States only

• Prescription Requirement label

6 Symbol indicating that the Instructions for Use are supplied in electronic form.

7 "Consult accompany document" is intended to alert the user to refer to the operator
manual or other instructions when complete information cannot be provided on the
label.

8 NRTL Listing and Certification Mark.

Safety
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No Explanation

9 CISPR CAUTION: The ultrasound system conforms to the CISPR11, Group
1, Class A of the international standard for Electromagnetic disturbance
characteristics.

NOTE
The warning labels are on the rear of the system. The label content may be different for
different regions. Please refer to the warning labels on the system for the actual content.

Figure 4-1 Label Location - example
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Figure 4-2 Battery Label

1. Do not put the battery in fire.
2. Do not disassemble or mistreat the battery.
CAUTION
Do not disassemble or mistreat the battery. Do not put the battery in fire. Replace the
battery with the same battery type only. Failure to follow these instructions many present
risk of explosion fire or high temperature. See the battery user manual for additional safety
instructions.

Probe Label Explanation

The following information appears on all probe labels, regardless of the connector type,
except for "IPX7", "CE Mark", and "XDclearTM" which only appears on applicable probes.

Safety

294 Versana Premier/Versana Premier Lotus - User Manual
5928218-1EN Rev. 6



NOTE
The probe label displayed in this manual is only for illustrational purposes. Refer to the
actual probe label for the specific information.

Figure 4-3 Probe label

Table 4-10 Probe label icon explanation

1. GE Logo
2. Probe Model (Name)
3. UDI Symbol and Data Matrix
4. UDI Human Readable Label Text:

Global Trade Item Number, GTIN, (01),
Manufacturing Date (11), Serial Number
(21)

5. Probe Applied Part (Can be CF or BF
Type: depends on applied part symbol
used.)

6. Caution: Consult the Manual
7. WEEE Waste Symbol

8. Chinese RoHS Hazardous Substance
Symbol

9. CE Mark and Notified Body Number
10. REF: Catalog/model number
11. Serial Number
12. Manufacturer's site country of origin
13. Legal Manufacturer's Name and Address
14. Date of Manufacture, as YYYY-MM
15. IP Classification

NOTE
Non-GE probes will also have a UDI symbol and equivalent information.
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Probe Box Label

NOTE
The probe box label displayed in this manual is only for illustrational purposes. Refer to the
actual probe box label for the specific information.

Figure 4-4 Probe box label

1. Probe Box Label UDI GTIN
2. Probe Box Label Barcode Location

Safety
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Chapter 5
Probes and Biopsy
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Probe Overview

Ergonomics

Probes have been ergonomically designed to:

• Handle and manipulate with ease
• Connect to the system with one hand
• Be lightweight and balanced
• Have rounded edges and smooth surfaces
• Stand up to typical wear by cleaning and disinfectant agents, contact with approved gel,

etc.

Cables have been designed to:

• Connect to system with appropriate cable length

Cable handling

Take the following precautions with probe cables:

• Keep free from wheels.
• Do not bend the cable acutely.
• Avoid crossing cables between probes.

Probe orientation

Each probe is provided with an orientation marking. This mark is used to identify the end of
the probe corresponding to the side of the image having the orientation mark on the display.

Figure 5-1 Orientation Marking on Probe (Example)

1. Orientation Mark

Probes and Biopsy
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Labeling

Each probe is labeled with the following information:

• Seller's name and manufacturer
• GE part number
• Probe serial number
• Month and year of manufacture
• Probe designation-provided on the probe grip and the top of the connector housing, so

it is easily read when mounted on the system and is also automatically displayed on the
screen when the probe is selected.

E7C8L-RS Probe Composition

1. Probe body, including:

• Probe body
• Cable
• Connector

2. Probe Care Card
3. Carrying Case

Illustration for E7C8L-RS probe

Figure 5-2 E7C8L-RS Illustration

1. Knob
2. Twist lock
3. Sterile/Sanitary Outer Sheath

L4-20t-RS Probe Configuration

1. Press Probe buttons from Utility > System.
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2. For each button on the probe handle, select the operation to perform from the drop-down
menu.

Figure 5-3 L4-20t-RS Probe Configuration

3. Press Save to save the configuration.

NOTE

Simultaneously press the button (1, 2) or (3, 4) can enable or disable the probe button
functions.

Probe Usage

For details on connecting, activating, deactivating, disconnecting, transporting and storing the
probes, refer to Probes on page 50 for more information.

Care and Maintenance

Planned maintenance program
The following maintenance schedule is suggested for the system and probes to ensure
optimum operation and safety.

Table 5-1 Planned Maintenance Program

Do the Following Daily After Each Use As Necessary

Inspect the Probes X X X

Clean the Probes X X

Disinfect Probes X X

Probes and Biopsy
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CAUTION

Improper handling can lead to early probe failure and electric shock hazards.
DO follow the specific cleaning and disinfection procedures provided in this chapter and the
chemical manufacturers instructions.
Failure to do so will void probe warranty.

CAUTION
Transesophageal, endocavitary and intraoperative probes require special handling. Refer to
the user documentation enclosed with these probes.

It is recommended to keep a maintenance log and note all probe malfunctions. Follow the
maintenance schedule below to ensure optimum operation and safety:

After each use

• Inspect the probe.
• Clean the probe.
• Disinfect the probe.

Before each use

• Inspect the probe.

Environmental Requirements
Probes should be operated, stored, or transported within the parameters outlined below.

For probe environment requirements. See Environmental Requirements on page 17 for more
information.

CAUTION
Ensure that the probe face temperature does not exceed the normal operation temperature
range.

Inspecting the probe
CAUTION
If any damage is found, DO NOT use the probe until it has been inspected and released for
further use by a GE HealthCare service representative.

Before each use

1. Inspect the probe.
CAUTION

Inspect probes for sharp edge or rough surfaces that could injure sensitive tissue.
Inspect the probe's lens, cable, casing, and connector for cracks, cuts, tears, and other
signs of physical damage.

2. Look for damage that might allow liquid into the probe.
3. Test the functionality of the probe.
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Table 5-2 Probe parts

1. Housing
2. Strain relief
3. Seal
4. Lens

After each use

1. Inspect the probe's lens, cable, casing, and connector for cracks, cuts, tears, and other
signs of physical damage. Look for any damage that would allow liquid to enter the
probe. If any damage is found, do not use the probe until it has been inspected and
repaired/replaced by a GE HealthCare Service Representative.

2. Look for damage that might allow liquid into the probe.

Probe Care Cards
The Probe Care Card, supplied with every probe, contains a list of additional processing
products that are compatible with probe materials, but GE HealthCare has not validated their
efficacy. When using these products, refer to their manufacturer's instructions for use.

The reprocessing instructions provided in this document have been validated with the
chemicals specified in Table 5-5 Chemicals used for Efficacy Validation on page 305.

A complete list of compatible products is also available on the Ultrasound Probes website.
This list updates periodically with new products and probes.

Table 5-3 Website Links

Support Documentation Library Website:

https://www.gehealthcare.com/documentation

Ultrasound Probes Website

https://www.gehealthcare.com/transducers

GE HealthCare chemicals compatibility

https://cleaning.gehealthcare.com/

With the exception of the chemicals listed in Chemicals Used for Efficacy Validation on
page 304, the chemicals listed on the website have been validated for compatibility only.
Therefore, only those agents listed are recommended due to validated efficacy, and any
reprocessing performed using chemicals not listed on the website must be validated by the
user.
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Adequate cleaning and disinfection between patient cases are necessary to prevent disease
transmission. All probes must be thoroughly cleaned prior to disinfection. The level of
disinfection required is based on patient contact.

• Probes that contact mucosal or non-intact skin require cleaning followed by high-level
disinfection by either soaking or use of a trophon EPR or trophon 2.

• Probes that contact intact skin require cleaning followed by intermediate-level
disinfection (wipe or spray).

• Verify probe compatibility using Chemicals Used for Efficacy Validation on page 304 and
the Ultrasound Probe Website listed above.

Table 5-4 Description of Pictogram on Care card

Pictogram Description

"ATTENTION" - Consult accompanying documents is intended to alert the user
to refer to the operator manual or other instructions when complete information
cannot be provided on the label.

"CAUTION" - Dangerous voltage (the lightning flash with arrowhead) is used to
indicate electric shock hazards.

Biohazard - Patient/user infection due to contaminated equipment.
Usage

• Cleaning and care instructions
• Sheath and glove guidelines

Symbol that indicates a useful information.

Pictogram on Probe Care Card:
Describes precautions necessary to prevent the risk of disease transmission or
infections.

Ultrasound probes are highly sensitive medical instruments that can easily be
damaged by improper handling. Use care when handling and protect from
damage when not in use.

Do not immerse the probe into any liquid beyond the level specified for that
probe. Refer to the user manual of the ultrasound system.

Since there is a possibility of having negative effects on the probe, observe
the specified immersing time by the germicide manufacturer strictly. Do not
immerse the probe in liquid chemical germicides more than the time prescribed
in the care card.

"Consult accompany document" - Refer to the ultrasound system user manual
for important probe care and cleaning instruction.
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Pictogram Description

This is to illustrate compatible ultrasound coupling gels.

This is to illustrate compatible cleaners or disinfectants available in spray
format (to be used according to instruction from the manufacturers of these
products).

This is to illustrate compatible cleaners or disinfectants available in wipes
format (to be used according to instruction from the manufacturers of these
products).

This is to illustrate compatible cleaners or disinfectants available in powder (to
be used according to instruction from the manufacturers of these products).

This is to illustrate compatible cleaners or disinfectants available in liquid
format (to be used according to instruction from the manufacturers of these
products).

This is to illustrate compatible automated reprocessors (to be used according
to instruction from the manufacturers of these products).

CAUTION

CREUTZFIELD-JACOB DISEASE
This device is not indicated for neurological use. Neurological contact on patients with this
disease must be avoided. If a device/probe becomes contaminated, there is no adequate
means to disinfect it. In this case, the contaminated device/probe must be discarded in
accordance with local biologic waste hazard procedures.

CAUTION
Please refer to the probe care card for GE HealthCare approved probe disinfectants.

Chemicals Used for Efficacy Validation
The table below lists the products and intended use (clean, ILD, HLD) that were validated.
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Table 5-5 Chemicals used for Efficacy Validation

Product Type Trade
Name

Manufacturer Minimum
Contact
Time

Active
Ingredient

Validated for
Probe

Cleaning
(Wipe)

OxivirⓇ
Tb

Diversey N/A Hydrogen
Peroxide

3Sc-RS, 4C-RS,
E8C-RS, 8C-RS,
E8Cs-RS, C1-5-RS,
IC9-RS, L3-12-RS,
L6-12-RS, 9L-RS,
12L-RS, L8-18i-RS,
L4-20t-RS, RAB2-6-
RS, RIC5-9A-RS,
BE9CS-RS

Cleaning
(Soak)

EnzolⓇ Advanced
Sterilization
ProductsⓇ
(J&J)

1-Minute
Soak

Proteolytic
Enzymes

3Sc-RS, 6S-RS,
12S-RS, 4C-RS,
E8C-RS, 8C-RS,
E8Cs-RS, C1-5-RS,
IC9-RS, L3-12-RS,
L6-12-RS, 9L-RS,
12L-RS, L8-18i-RS,
L4-20t-RS, RAB2-6-
RS, RIC5-9A-RS,
BE9CS-RS, E7C8L-
RS

(Cidezym
eⓇ)

MetriZyme
™

Metrex™

Prolystica
Ⓡ 2X
Concentra
te
Presoak &
Cleaner

Steris

Intermediate-
level
Disinfectant
(wipe or liquid)

OxivirⓇ
Tb

Diversey 10-Minute
Exposure

Hydrogen
Peroxide

3Sc-RS, 4C-RS,
8C-RS, C1-5-RS,
L3-12-RS, L6-12-
RS, 9L-RS, 12L-RS,
L4-20t-RS, RAB2-6-
RS

Intermediate-
level
Disinfectant
(wipe)*

Sani-Cloth
AF3

PDI 3-Minute
Exposure

Quaternary
ammonium

12S-RS, 6S-RS

High-level
Disinfectant
(Soak)

CidexⓇ
OPA
(FDAclear
ed)

Advanced
Sterilization
Products (J&J)

12-Minute
Soak

Ortho-
phthalaldeh
yde

3Sc-RS, 6S-RS,
12S-RS, 4C-RS,
E8C-RS, 8C-RS,
E8Cs-RS, C1-5-RS,
IC9-RS, L3-12-RS,
L6-12-RS, 9L-RS,
12L-RS, L8-18i-RS,
LK760-RS, RAB2-6-
RS, RIC5-9A-RS,
BE9CS-RS, E7C8L-
RS.

McKesson
OPA/28

McKesson 10-minute
soak
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Product Type Trade
Name

Manufacturer Minimum
Contact
Time

Active
Ingredient

Validated for
Probe

High-level
Disinfectant
(wipe)**

Tristel Trio Tristel 1-minute
soak

Chlorine
dioxide

RIC5-9A-RS

Tristel
Duo ULT

Probe Pre-Cleaning Instructions (Required for All Probes)
The pre-cleaning step is for removal of gel and gross contamination.

NOTE
Manual cleaning is required to ensure the probes are cleaned to the extent necessary for
further processing.

1. After each use, disconnect the probe from the ultrasound console. Remove protective
sheath from the probe and gently remove all coupling gel from the probe by wiping with
soft, lint-free cloth.

2. Wipe the probe with one of the wipes listed in Probe Care Card from the lens, past the
strain relief and approximately fifty (50) centimeters down the cable. Wipe the cable with
a lint-free cloth dampened with potable water to remove chemical residue. Dispose of the
cloth, wipe and gloves in the clinical trash.

Figure 5-4 Cleaning the Probe Cable

NOTE
Use of wipes listed in the Probe Care Card may result in discoloration of the cable.
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WARNING
Use caution when cleaning the connector. This cable connector should only be cleaned
with a slightly dampened cloth or wipe. Exposure to excessive moisture will result in
damage to the probe and possibly the ultrasound console. DO NOT wet the connector/
console interface surface or labels.

3. After each use, inspect the lens, cable, and housing of the probe. Look for any damage
that would allow liquid to enter the probe. If the probe is damaged, do not place it into
any liquid (e.g. for disinfection) and do not use it until it has been inspected and repaired/
replaced by a GE HealthCare Service Representative.

Probe Manual Cleaning Instructions (Required for All Probes)

1. Put on a clean pair of gloves and fill a sink or basin with warm potable water (30 - 40℃)
to a level allowing immersion of the probe up to the immersion line.

2. Prepare the cleaning solution in accordance with the detergent manufacturer's
instructions.

3. Immerse the probe in the prepared cleaning solution up to the immersion line and
ensure no air bubbles are trapped on the surface. Do not submerge probe beyond the
immersion line.
NOTE
Manual cleaning efficacy has been validated using ENZOLⓇ Enzymatic Detergent.

4. Brushing with a clean, soft, nylon bristle brush from the base of the cable strain relief to
the distal tip is critical to ensure cleaning and disinfection efficacy.

Figure 5-5 Cleaning the probe using a brush
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CAUTION
Do not use the brush on the probe lens.

Figure 5-6 Probe Lens Examples

5. Continue brushing the probe for not less than the minimum contact time listed on the
detergent manufacturer's label.

6. Visually inspect the probe for soil. Repeat Steps 3 through 5 until all visible soil has been
removed from the surface of the probe.

7. Rinse the probe under running warm potable water (30 - 40℃) for not less than 2
minutes. Scrub the surface of the probe with a clean, soft, nylon bristle brush from the
base of the cable strain relief to the distal tip.
WARNING
User should pay more attention to the protection of probe connector during the cleaning.

CAUTION
Take extra care when handling the lens face of the ultrasound transducer. The lens
face is especially sensitive and can easily be damaged by rough handling. NEVER use
excessive force or abrasive paper products when cleaning the lens face.

8. Visually inspect the device in a well-lit area to ensure all surfaces are free from residual
cleaning solution. Repeat Step 7 if visible cleaning solution is observed.

9. Thoroughly dry the probe using a clean lint-free soft and dry cloth or wipe.

Cable and Connector Manual Cleaning
WARNING
Use caution when cleaning the connector. This cable connector should only be cleaned with
a slightly dampened cloth or wipe. Exposure to excessive moisture will result in damage to
the probe and possibly the ultrasound console. DO NOT wet the connector/console interface
surface or labels.

1. The cable and connector surfaces can be cleaned with the cleaners or wipes listed in the
Probe Care Card.
NOTE
Use of wipes listed in the Probe Care Card may result in discoloration of the cable.
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2. Wipe the cable with a lint-free cloth dampened with potable water to remove chemical
residue.

Figure 5-7 Cleaning the Probe Cable

Probe Intermediate-Level Disinfection - Spray
For Intermediate-Level Disinfection of surface-contacting probes, choose either the spray or
wipe method.

NOTE
Probes that contact only intact skin may be disinfected in this manner. All probes that contact
non-intact skin or intact mucous membranes (e.g., endocavitary or transesophageal) require
High-Level Disinfection.

1. Put on a new pair of gloves and spray enough disinfectant solution to saturate a new
disposable lint-free wipe or cloth.

2. Holding the probe near the strain relief, apply the dampened cloth to the patient
contacting lens. Wipe the probe from the lens to the strain relief, slightly rotating the
probe after each wiping pass.

3. After the probe has been completely wiped, dampen a second wipe with disinfectant
and starting at the probe lens begin wiping the probe in a rotating motion moving down
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towards the strain relief. Spray disinfectant directly on the recessed areas and ridges to
saturate.

Figure 5-8 Disinfecting the Probe Moving from Lens to Strain Relief

4. Once the probe has been completely wiped, dampen a third wipe with disinfectant and
continue wiping the probe as needed to ensure the surface remains wet for the required
exposure time. Use as many wipes as needed and respray disinfectant on recessed
areas and ridges, to ensure all surfaces remain wet for the minimum required contact
time listed in the disinfectant manufacturer's instructions for use.

5. Dry all surfaces of the probe using a soft lint-free wipe or cloth.
6. Saturate a soft lint-free wipe with de-ionized or soft water (remove excess water, wipe

should be damp but not dripping) and thoroughly wipe all surfaces of the probe to
remove chemical residue. Discard the wipe.

7. A total of three (3) rinses are required. Repeat Step 6 two additional times using new
wipes and water.
WARNING
Failure to properly rinse probes with water following disinfection may cause skin
irritation.

8. Thoroughly dry all surfaces of the probe using a soft lint-free wipe or cloth, changing
wipes/cloths when necessary to ensure the probe is completely dry. Visually inspect the
probe to ensure all surfaces are dry. Repeat drying steps if any moisture is visible.

9. After each use, inspect the lens, cable, and housing of the probe. Look for any damage
that would allow liquid to enter the probe. If the probe is damaged, do not place it into
any liquid (e.g. for disinfection) and do not use it until it has been inspected and repaired/
replaced by a GE HealthCare Service Representative.

Probe Intermediate-Level Disinfection - Wipe

1. Put on a new pair of gloves. Holding the probe near the strain relief, apply the wipe to the
patient contacting lens. Wipe the probe from the lens to the strain relief, slightly rotating
the probe after each wiping pass.

2. After the probe has been completely wiped, use a second wipe and starting at the probe
lens begin wiping the probe in a rotating motion moving down towards the strain relief.
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Wring the wipe above recessed areas, seams, and ridges to drip disinfectant directly
onto these less accessible surfaces.
NOTE
Intermediate-level disinfection efficacy has been validated using OxivirⓇ Tb Wipes.

Figure 5-9 Disinfecting the Probe Moving from Lens to Strain Relief

3. Once the probe has been completely wiped, use a third wipe and continue wiping the
probe as needed to ensure the surface remains wet for the required exposure time. Use
as many wipes as needed and drip additional disinfectant on recessed areas and ridges,
to ensure all surfaces remain wet for the minimum required contact time listed in the
disinfectant manufacturer's instructions for use.

Figure 5-10 Disinfecting the Probe

4. Dry all surfaces of the probe using a soft lint-free wipe or cloth.
5. Saturate a soft lint-free wipe with de-ionized or soft water (remove excess water, wipe

should be damp but not dripping) and thoroughly wipe all surfaces of the probe to
remove chemical residue. Discard the wipe.
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6. A total of three (3) rinses are required. Repeat Step 5 two additional times using new
wipes and water.
WARNING
Failure to properly rinse probes with water following disinfection may cause skin
irritation.

7. Thoroughly dry all surfaces of the probe using a soft lint-free wipe or cloth, changing
wipes/cloths when necessary to ensure the probe is completely dry. Visually inspect the
probe to ensure all surfaces are dry. Repeat drying steps if any moisture is visible.

8. After each use, inspect the lens, cable, and housing of the probe. Look for any damage
that would allow liquid to enter the probe. If the probe is damaged, do not place it into
any liquid (e.g. for disinfection) and do not use it until it has been inspected and repaired/
replaced by a GE HealthCare Service Representative.

Probe High Level Disinfection - Soak

1. Put on a clean pair of gloves and fill a sink or basin with high level disinfectant diluted in
accordance with the disinfectant manufacturers instructions to a level allowing immersion
of the probe up to immersion line shown in the user manual and in the illustration below.
NOTE
High-level disinfection efficacy has been validated using CidexⓇ OPA.

NOTE
Cleaning and disinfection instructions for Transesophageal probes are documented in
the Transesophageal Probe Care Card and Probe User Manual.

NOTE
All semi-critical probes that contact non-intact skin or intact mucous membranes require
High-Level Disinfection.
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NOTE
Handles of semi-critical probes that are not submerged during High-Level Disinfection
require low or Intermediate-Level Disinfection to avoid cross contamination.

Figure 5-11 Probe Immersion Levels
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Table 5-6 Description of Pictogram for Probe Immersion Levels

Pictogram Description

Fluid Level

WARNING
Use only high-level disinfectants that are listed in the Probe Care Card enclosed with
the probe. In addition, refer to the local / national regulations. Do not steam autoclave or
subject the probe to Ethylene Oxide (ETO).

2. Immerse probe in the disinfectant up to the immersion line and ensure no air bubbles are
trapped. Ensure the probe remains in the disinfectant for at least the minimum contact
time listed in the disinfectant manufacturer's instructions for use.
WARNING

Do not immerse the probe in liquid beyond the level specified for that probe.
Never immerse the probe connector or probe adapters in liquid.
The probe should not be exposed to the disinfectant longer than specified to achieve the
desired effect.
DO NOT soak or saturate probes with solutions containing alcohol, bleach, ammonium
chloride compounds or hydrogen peroxide.

CAUTION
Ensure that the probe is suspended. The probe face should not be resting against the
tank/basin surface and should be in full contact with the liquid. Carefully place the probe
in the basin, taking care not to damage the transducer lens.

Figure 5-12 Probe suspended in disinfectant basin

NOTE
When performing high-level disinfection of GE HealthCare ultrasound probes with the
TrophonⓇ EPR, it is not necessary to disconnect the probe from the ultrasound system.
The probe must be inactive (not selected) during the disinfection cycle.

3. Thoroughly rinse the probe by immersing it in a large volume of critical (purified) water
for a minimum of 1 (one) minute. Remove the probe and discard the rinse water.

Do not reuse the water. Always use fresh volumes of water for each rinse. Repeat Step 3
two additional times, for a total of 3 (three) rinses.
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WARNING
Failure to properly rinse probes with water following disinfection may cause skin
irritation.

4. Thoroughly dry all surfaces of the probe using a soft, lint-free wipe or cloth, changing
wipes' cloths when necessary to ensure the probe is completely dry. Visually inspect the
probe to ensure all surfaces are clean and dry. Repeat drying steps if any moisture is
visible.

5. After each use, inspect the lens, cable, and housing of the probe. Look for any damage
that would allow liquid to enter the probe. If the probe is damaged, do not place it into
any liquid (e.g. for disinfection) and do not use it until it has been inspected and repaired/
replaced by a GE HealthCare Service Representative.

6. If the probe is not immediately reused, store the probe in a manner that will protect and
keep the probe from being recontaminated. This may be accomplished by placing the
probe in a storage cabinet with filtered air flow and/or by using a disposable storage
cover placed over the probe.

The instructions provided above have been validated to properly prepare GE HealthCare
Ultrasound probes for re-use. It remains the responsibility of the processor to ensure that
the processing, as actually performed using equipment, materials and personnel in the
processing facility, achieves the desired result. This requires verification and/or validation
and routine monitoring of the process.

WARNING

CREUTZFELDT-JACOB DISEASE
Neurological use on patients with this disease must be avoided. If a probe becomes
contaminated, there is no adequate disinfecting means.

CAUTION
Ensure that you follow the probe disinfection procedure provided by GE HealthCare.

CAUTION
Review the probe care card that is packed with each probe.

CAUTION
Please refer to the probe care card for GE HealthCare approved probe disinfectants.

Covering the Transducer using a Sterile, Protective Sheath

CAUTION
Protective barriers may be required to minimize disease transmission. Probe sheaths
are available for use with all clinical situations where infection is a concern. Use of
legally marketed, sterile probe sheaths is mandatory for intra-cavitary and intra-operative
procedures.

1. Place an appropriate amount of gel inside the protective sheath and/or on the transducer
face.
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2. Insert transducer into sheath, making sure to use proper sterile technique. Pull cover
tightly over transducer face to remove wrinkles and air bubbles, taking care to avoid
puncturing the sheath.

Figure 5-13 Applying the Sheath

a. Secure the Sheath with a rubber band.
b. The probe sheath should extend past the end of the probe to the probe's cable.

NOTE
No gel was applied to the probe in this photo.

3. Secure the sheath in place.
NOTE
Failure to use a sheath that fully covers the transducer to the cable strain relief may lead
to cross-contamination of the transducer.

4. Inspect the sheath to ensure there are no holes or tears. If the sheath becomes
compromised, stop the procedure and replace immediately.

E7C8L-RS Operation

NOTE

Inspect probe for damage or cracks prior to each use. A damaged probe may cause an
electrically hazardous condition when coupled to the human body. DO NOT use any probe
with damaged lens to scan a patient.
Further more, a damaged probe will not produce a desirable image.

Inspecting before each use or the operation

1. Make a visual inspection of the probe before each use for damage or degradation to the
housing, strain relief, lens and seal.

2. Check all surfaces of the probe, especially the patient contact area, to ensure that there
are no rough or sharp edges that could damage the sheath or patient tissue.
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Tilting the grip

Figure 5-14 Grip adjustment

1. Loosen the screw by turning the knob on the probe body counterclockwise.
2. Set the grip to the desired angle and securely tighten the screw by turning the knob

clockwise.

CAUTION
If there is an attempt to tilt the grip or change the grip angle after the sterile sheath is placed
on the probe, the sterile sheath may break if it gets caught in the grip. To avoid this, be sure
to tilt the grip before putting on the sterile sheath.

System Preparation
Connect the two E7C8L-RS probe connectors to the Ultrasound system's probe ports. Before
inserting the connector into the probe port, inspect the probe connector pin. If the pin is bent,
do not use the probe until it has been inspected and repaired/replaced by a GE HealthCare
Service Representative.

NOTE
Sterile/sanitary sheaths are to be used on the probe during its actual use with patients.
Wearing gloves protects the patient and operator.

Patient Preparation for Transrectal Imaging

1. Prepare the patient. An enema is recommended one hour before the exam.
2. Transaxial imaging is best performed with the patient in the supine position.

Change Scan Method
Change scan methods between convex and linear as follows:

• Press the Probe key on the touch panel.
• Select probe that corresponds to the probe port used.

The split-screen 2D mode display format may be useful as well.

Patient Scan

1. Scan the patient. The probe handle orientation mark indicates the image scan plane.
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2. If necessary, when the probe is in position, attach it to the mechanical stepping device.

Steps for attaching probe to stepper:

a. Place the probe into clamp.
b. Tighten the probe clamp.
c. Attach the needle placement guide.
d. Align the probe to the needle placement guide.
CAUTION

Ensure that the arrow at the bottom center of the Needle Placement Guide accurately
aligns to the center line marked on the probe shaft.
Failure to do so will cause the needle placement not to match the ultrasound display.

3. If a needle placement is to be performed, display the needle placement grid on the image
screen.

CAUTION

Before needle insertion, scan the patient to determine the correct puncture depth and
site.
Only the sterile/sanitary sheath, rubber band or twist lock and finger cot with rubber
band are on the E7C8L-RS probe during the pre-needle placement scanning.

4. When the examination is over:
a.Carefully remove the probe.
b.Remove the twist lock. Remove and discard the sheath.
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c.Thoroughly clean and disinfect the probe and equipment. Return the probe to its box.

Figure 5-15 Scan Plane Orientation Transaxial View

Figure 5-16 Transrectal Image Orientation Axial View

Probe Safety

Handling precautions
WARNING
Ultrasound probes are highly sensitive medical instruments that can easily be damaged by
improper handling. Use care when handling and protect from damage when not in use. DO
NOT use a damaged or defective probe. Failure to follow these precautions can result in
serious injury and equipment damage.
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Electrical shock hazard
ELECTRICAL HAZARD
The probe is driven with electrical energy that can injure the patient or user if live internal
parts are contacted by conductive solution:

• DO NOT immerse the probe into any liquid beyond the level indicated by the immersion
level diagram. Refer to the immersion illustration in the Probe Cleaning Process section.
Never immerse the probe connector into any liquid.

• DO NOT drop the probes or subject them to other types of mechanical shock or impact.
Degraded performance or damage such as cracks or chips in the housing may result.

• Prior to each use, visually inspect the probe lens and case area for cracks, cuts,
tears, and other signs of physical damage. DO NOT use a probe which appears to
be damaged until you verify functional and safe performance. You must perform a more
thorough inspection, including the cable, strain relief, and connector, each time you
clean the probe.

• Before inserting the connector into the probe port, inspect the probe connector pins. If a
pin is bent, do not use the probe until it has been inspected and repaired/replaced by a
GE HealthCare Service Representative.

• DO NOT kink, tightly coil, or apply excessive force on the probe cable. Insulation failure
may result.

• Electrical leakage checks should be performed on a routine basis by GE HealthCare
Service or qualified hospital personnel. Refer to the service manual for leakage check
procedures.

Mechanical hazards
WARNING
Allergic reactions possible with any probe sheaths and needle used.

WARNING
There is a potential risk that ultrasound imaging may be lost during a critical procedure,
such as biopsy scenario. If ultrasound imaging is lost, please restart the device and follow
hospital's procedure to take care of patients.

WARNING
Image noise (such as white lines) could be seen during scanning. These can be caused by
a short-term external interference source. For example, strong electromagnetic interference
equipment (e.g. high frequency electric knife) or larger fluctuations of the power load of other
equipment which is connected to the same power grid. Please take mitigation measures,
such as relocating or re-orienting the equipment; if the noise is still there, please check and
remove the interference source.
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CAUTION
A defective probe or excessive force can cause patient injury or probe damage:

• Observe depth markings and do not apply excessive force when inserting or
manipulating intracavitary probes.

• Inspect probes for sharp edges or rough surfaces that could injure sensitive tissue.
• DO NOT apply excessive force to the probe connector when inserting into the probe

port. The pin of a probe connector may bend.

6Tc-RS Probe Thermal Safety
Maintaining a safe thermal environment for the patient has been a design priority at GE. It
is generally agreed that in order to avoid damage to body tissues, for long term exposures,
tissue contact probe tip temperatures should be less than 42.7℃. The ultrasound scanner
incorporates an elaborate thermal safety system which informs the physician of the operating
temperature of the probe, and prevents the operative temperature from exceeding given
limits. Whenever the 6Tc-RS Probe is plugged into the system and selected, the probe tip
temperature is displayed on the system monitor. When the probe tip temperature is over
41.0℃, the temperature displayed on the system monitor turns to red.

NOTE
When the probe tip temperature is higher than 41.0℃, there will be a warning
message displays on the screen. User can press OK to continue scanning or press
Cancel to freeze the image.

WARNING
The transesophageal probe should be separated from the patient before using the
defibrillator.

If the temperature sensor is not working properly when you plug the probe into the system,
the probe will not be accepted and scanning will not be possible.
If the probe temperature is over 42.7℃ (including probe temperature measurement error), the
system will shut down the probe transmitting.
The absolute tolerance of 6Tc-RS probe surface temperature measurement is less than
0.5℃.

High temperature protection levels

The temperature is always displayed on the system monitor. The system has two levels of
upper thermal limit: the first high limit is set at 41.0℃, and the second high limit is set at
42.7℃. If the temperature of the probe tip reaches 41.0℃, the temperature display turns red,
the system enters freeze mode, and a warning appears on the monitor, asking the user if
he/she wishes to continue scanning up to a higher temperature limit. If the response is OK,
the scanner will resume scanning. If he/she selects Cancel, or no response is given, the
system will remain in Freeze mode. If the temperature reaches 42.7℃, the system will freeze
unconditionally. The user will not be allowed to start scanning until the temperature has
decreased 0.5℃ below the limit where the system entered Freeze mode. To restart scanning,
the user must press the Freeze button.

After the probe has been selected, the scan plane positioning system automatically
calibrates. This calibration cycle lasts 10 to 15 seconds. After the calibration is complete,
the probe temperature sensor is activated, and the probe temperature is displayed.
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In case the initialization of the probe fails (no response from the scan plane button after
initialization), re-select the probe to repeat the initialization routine.

CAUTION
Transesophageal probes require special handling. Refer to the user documentation enclosed
with these probes.

Special handling instructions

Using protective sheaths
CAUTION
Protective barriers may be required to minimize disease transmission. Probe sheaths
are available for use with all clinical situations where infection is a concern. Use of
legally marketed, sterile probe sheaths is mandatory for intra-cavitary and intra-operative
procedures. Use of legally marketed, sterile, pyrogen free probe sheaths is required for
neurological intra-cavity and intra-operative procedures.

Instructions. Custom made sheaths are available for each probe. Each probe sheath kit
consists of a flexible sheath used to cover the probe and cable and elastic bands used to
secure the sheath.

Sterile probe sheaths are supplied as part of biopsy kits for those probes intended for use
in biopsy procedures. In addition to the sheath and elastic bands, there are associated
accessories for performing a biopsy procedure which are included in the kit. Refer to the
biopsy instructions for the specific probes in the Discussion section of this chapter for further
information.

Reordering. To reorder sheaths, please contact your local distributor or the appropriate
support resource.

CAUTION
Devices containing latex may cause severe allergic reaction in latex sensitive individuals.
Refer to FDA's March 29, 1991 Medical Alert on latex products.

CAUTION
Do not use pre-lubricated condoms as a sheath. In some cases, they may damage the
probe. Lubricants in these condoms may not be compatible with probe construction.

CAUTION
DO NOT use an expired probe sheath. Before using probe sheaths, verify whether the term
of validity has expired.

Endocavitary Probe Handling Precautions
If the disinfectant solution comes out of the endocavitary probe, please follow the cautions
below.

CAUTION
Sterile/sanitary sheaths are to be used on the probe during its actual use with patients.
Wearing gloves protects the patient and operator.
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CAUTION

Disinfectant Exposure to Patient: Contact with a disinfectant to the patient's skin or
mucous membrane may cause an inflammation. If this happens, refer to the disinfectant's
instruction manual.
Disinfectant Exposure from Probe Handle to Patient: DO NOT allow the disinfectant to
contact the patient. Only immerse the probe to its specified level. Ensure that no solution has
entered the probe's handle before scanning the patient. If disinfectant comes into contact
with the patient, refer to the disinfectant's instruction manual.
Disinfectant Exposure from Probe Connector to Patient: DO NOT allow the disinfectant
to contact the patient. Only immerse the probe to its specified level. Ensure that no solution
has entered the probe's connector before scanning the patient. If disinfectant comes into
contact with the patient, refer to the disinfectant's instruction manual.
Endocavitary Probe Point of Contact: Refer to the disinfectant's instruction manual.

Probe handling and infection control

This information is intended to increase user awareness of the risks of disease transmission
associated with using this equipment and provide guidance in making decisions directly
affecting the safety of the patient as well as the equipment user.

Diagnostic ultrasound systems utilize ultrasound energy that must be coupled to the patient
by direct physical contact. Depending on the type of examination, this contact occurs with a
variety of tissues ranging from intact skin in a routine exam to recirculating blood in a surgical
procedure. The level of risk of infection varies greatly with the type of contact.

One of the most effective ways to prevent transmission between patients is with single use
or disposable devices. However, ultrasound transducers are complex and expensive devices
that must be reused between patients. It is very important, therefore, to minimize the risk of
disease transmission by using barriers and through proper processing between patients.

CAUTION
To reduce the risk of infection, ALWAYS clean and disinfect the probe according to the
probe specific instructions including probe compatible chemicals between patients to the
level appropriate for the type of examination and use FDA-cleared probe sheaths where
appropriate.

CAUTION

Adequate cleaning and disinfection are necessary to prevent disease transmission. It is
the responsibility of the equipment user to verify and maintain the effectiveness of the
infection control procedures in use. Always use sterile, legally marketed probe sheaths for
intra-cavitary and intra-operative procedures.
For neurological intra-operative procedures, use of a legally marketed, sterile, pyrogen free
probe sheath is REQUIRED. Probes for neuro surgical use must not be sterilized with liquid
chemical sterilants because of the possibility of neuro toxic residues remaining on the probe.
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CAUTION

In order for liquid chemical disinfectants to be effective, all visible residue must be removed
during the cleaning process. Thoroughly clean the probe, as described earlier before
attempting disinfection.
You MUST disconnect the probe from the ultrasound system prior to cleaning/disinfecting
the probe. Failure to do so could damage the system.
DO NOT soak probes in liquid chemical disinfectant for longer than is stated by the
disinfectant instructions for use. Extended soaking may cause probe damage and early
failure of the enclosure, resulting in possible electric shock hazard.

WARNING
Ultrasound transducers can easily be damaged by improper handling and by contact with
certain chemicals. Failure to follow these precautions can result in serious injury and
equipment damage.

• Do not immerse the probe into any liquid beyond the level specified for that probe.
Never immerse the transducer connector or probe adapters into any liquid.

• Avoid mechanical shock or impact to the transducer and do not apply excessive bending
or pulling force to the cable.

• Transducer damage can result from contact with inappropriate coupling or cleaning
agents:

• Do not soak or saturate transducers with solutions containing alcohol, bleach,
ammonium chloride compounds or hydrogen peroxide

• Avoid contact with solutions or coupling gels containing mineral oil or lanolin

• Avoid temperatures above 50℃

• Inspect the probe prior to use and after use for damage or degeneration to the housing,
strain relief, lens and seal. Do not use a damaged or defective probe.

Special Reprocessing Instructions for E7C8L-RS

To properly disinfect the E7C8L-RS probe, the probe handle can be disassembled and
reassembled so that the entire probe and handle can be immersed in the germicide
solution. Allow the germicide to remain in contact with the fully immersed probe, for high
level disinfection, according to the germicide manufacturer's recommended time. To remove
all germicide residue, final rinsing should be done following the germicide manufacturer's
instructions. Remove excess water by shaking and allow to air dry.

Disassemble the probe handles

1. Turn the probe knob counterclockwise until the pin can be removed.
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2. Grasp the probe and slide the left piece (the one with GE Logo) towards the arrow
direction to separate the two handle pieces.
NOTE
The indicated direction of the arrows on the handles are only for disassemble process;
to reassemble the handles, follow the opposite direction.

Figure 5-17 Disassemble the probe handles

Reassemble the probe handles

1. Align the probe with the right handle piece (the one without GE logo).
NOTE
Ensure the probe cables are well positioned to allow the mating piece to be slide in.

2. Place the left handle piece on the right handle piece and slide to lock.
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3. Insert the knob and tighten it clockwise till it is well locked.

Figure 5-18 Reassemble the probe

Instruction for reprocessing the probe

1. Disassemble the probe handles.
2. Dispense the RTU cleaning wipe from the wipe canister to wipe the entire probe, handle

piece and locking nut. Wrap a wipe around a soft nylon bristle brush to clean the
positioning teeth on the handle and probe body.

3. Use a round, soft bristle brush wrapped with a cleaning wipe to clean the through hole on
the probe and handle.

4. Ensure the probe remains exposed to the cleaning solution for at least the minimum
contact time listed on the enzymatic cleaner label.

5. Rinse under running water for at least 2 minutes, or until no visible signs of cleaner
residue.

6. Visually inspect the device in a well-lit area to ensure that no cleaning residue remains
on all surfaces. Repeat Step 5 if visible cleaning solution is observed.

7. Use a clean, lint-free soft and dry cloth or wipe to dry the probe thoroughly. Do not use
abrasive paper products.

8. Visually inspect the probe for residue, if necessary, repeat steps 2 to 5 until the probe is
visibly clean.

9. Put on a clean pair of gloves.
10. Prepare a basin with High-level disinfectant per manufacturer's disinfectant instructions.
11. Immerse the probe, handle and knob in the disinfectant. Ensure that the probe is

immersed above the cable strain relief device, and ensure that no air bubbles are
trapped. Ensure that the probe remains in the disinfectant for at least the minimum
contact time listed in the manufacturer's disinfectant instructions.

12. Rinse the probe, handle and knob thoroughly with running water for at least 2 minutes.
13. Reassemble the probe handles.
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Coupling gels

WARNING
Do not use unrecommended gels (lubricants). They may damage the probe and void the
warranty. Please refer to the probe care card for GE HealthCare approved probe gels.

Applying
In order to assure optimal transmission of energy between the patient and probe, a
conductive gel or couplet must be applied liberally to the patient where scanning will be
performed.

CAUTION
Do not apply gel to the eyes. If there is gel contact with the eye, flush eye thoroughly with
water.

Precautions
Coupling gels should not contain the following ingredients as they are known to cause probe
damage:

• Methanol, ethanol, isopropanol, or any other alcohol-based product
• Mineral oil
• Iodine
• Lotions
• Lanolin
• Aloe Vera
• Olive Oil
• Methyl or Ethyl Parabens (para hydroxybenzoic acid)
• Dimethyl Silicone
• Polyether glycol based
• Petroleum

WARNING
User should select the Non-toxic and nonirritating GEL.

Returning/Shipping Probes and Repair Parts
US Department of Transportation and GE policy requires that equipment returned for service
MUST be clean and free of blood and other infectious substances.
When you return a probe or part for service (Field Engineer or customer), you need to clean
and disinfect the probe or part prior to packing and shipping the equipment.
Ensure that you follow probe cleaning and disinfection instructions provided in this manual.
This ensures that employees in the transportation industry as well as the people who receive
the package are protected from any risk.
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Sterile Ultrasound Procedures
ONLY ultrasound gel that is labeled as sterile, is sterile.
Ensure you always use sterile ultrasound gel for those procedures that require sterile
ultrasound gel.
Once a container of sterile ultrasound gel is opened, it is no longer sterile and contamination
during subsequent use is possible.
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Probe Discussion

The Versana Premier/Versana Premier Lotus supports the following types of probes:

• Convex Array. Convex Array probes.
• Linear Array. Linear Array probes.
• Sector Phased Array. Sector Phased Array probes.
• Volume Probes. 4D probe: Convex Array.
• Bi-plane Probe. Convex and Linear Array probe and Convex and Convex Array probe.

CAUTION
Probes for transvaginal and transrectal applications require special handling. Transvaginal/
transrectal examinations and probe insertions should be performed only by personnel with
adequate training. Refer to the user documentation enclosed with these probes.

Application

Table 5-7 Probe Indications for Use

Probe
Application

Abdominal X X X X X X X X X

Fetal /
Obstetrical

X X X X X X X X X

Gynecology X X X X X X

Vascular/
Peripheral
Vascular

X X X X X X X X X X X

Urology X X X X X X X X

Pediatric [1] X X X X X X X X X

Small Parts
(includes breast,
testes, thyroid)

X X X X X X

Musculoskeletal
Conventional [2]

X X X X X X X X X

Musculoskeletal
Superficial

X X X X X X

Cardiac Adult X X

Cardiac
Pediatric

X X X X
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Probe
Application

Thoracic/Pleural X X X X X X X X

Transcranial X X X X

Transrectal X X X X X X

Transvaginal X X X X

Transesophagea
l

X

Interventional Guidance

Tissue biopsy X X X X X X X X X X X X X X X X

Fluid drainage X X X X X X X X X X X X X X X X X X X X X

Vascular X X X X X X X

Non-Vascular
access

X X X X X X X X X X X X X X X X X X X X X

[1]: Pediatric application is applicable for Neonatal, Infants, Children and Adolescents, and
the age limit ranges from birth up to 21. (Reference: `Guidance for Industry and FDA Staff:
Premarket Assessment of Pediatric Medical Devices' dated March 24, 2014.)
[2]: Musculoskeletal Conventional is equal to Musculoskeletal General.

Features

Table 5-8 Probe modes of operation and Features

Probe
modes of
operation
and
Features

B Mode X X X X X X X X X X X X X X X X X X X X X

M Mode X X X X X X X X X X X X X X X X X X X X X

PW Mode X X X X X X X X X X X X X X X X X X X X X

CW Mode X X X X

CF Mode X X X X X X X X X X X X X X X X X X X X X

Color M
Mode

X X X X

PDI X X X X X X X X X X X X X X X X X X X X X
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Probe
modes of
operation
and
Features

Directional
PDI

X X X X X X X X X X X X X X X X X X X X X

Combined
Modes

X X X X X X X X X X X X X X X X X X X X X

Harmonic
Imaging

X X X X X X X X X X X X X X X X X X X X X

TVI X X X X

TVM X X X X

TVD X X X X

Static 3D/4D X X

BFlow X X X X X X X

BFC X X X X X X X

Contrast X X X X

Elastography X X X X X X X X

Anatomical M X X X X X X X X

Curved
Anatomical M

X X X X

Easy 3D X X X X X X X X X X X X X X X X X X

Advanced 3D X X X X X X X X X X X X X X X X X X

TUI X X

TVI w/
QAnalysis

X X X X

Logiq View X X X X X X X X X X X X X X X X X X X X X

CrossXBeam X X X X X X X X X X X X X X X X X

SRI HD X X X X X X X X X X X X X X X X X X X X X

Auto IMT X X X X X X

Stress Echo X

Auto EF X

Virtual
Convex

X X X X X X X X X X

Sonobiometry X X X

Vocal X X
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Probe
modes of
operation
and
Features

Breast
Productivity
and ACR BI-
RADS

X X X X X

Thyroid
Productivity
and ACR TI-
RADS

X X X X X X

Auto Bladder X X X X X X X X

Needle
Recognition

X X X X X X X X

Auto TGC X X X X X X X X X X X X X X X X X X X X X

ATO X X X X X X X X X X X X X X X X X X X X X

ASO X X X X X X X X X X X X X X X X X X X X X

Whizz X X X X X X X X X X X X X X X X X X X X X

Whizz Color
Flow

X X X X X

Whizz Easy
Style

X X X X

Touch LGC X X X X X X X X X X X X X X X X X X X X X

Digital TGC X X X X X X X X X X X X X X X X X X X X X

V-Live 2.0 X X

Whizz
RenderLive

X X

Whizz Follicle X X

V-Zoom X X X X X X X X X X X X X X X X X X X X X

Strain X X X X

Strain Rate X X X X

Whizz Label X X

Intensity
Ratio

X X X X X X X X X

Cine X X X X X X X X X X X X X X X X X X X X X

ECG X X X X

ARC Li-
RADS

X X X X X X X X X
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Probe
modes of
operation
and
Features

Breast Care X X X X X

Follow-up
Tool

X X X X X X X X X X X X X X X X X X X X X

Brachytherap
y

X

Probe Check X X X X X X X X X X X X X X X X X X X X X

eDelivery X X X X X X X X X X X X X X X X X X X X X

Imaging
Insights

X X X X X X X X X X X X X X X X X X X X X

Insite
AutoConnect

X X X X X X X X X X X X X X X X X X X X X

DICOM X X X X X X X X X X X X X X X X X X X X X

Scan Coach X X X X X X X X X X X X X X X X X X X X X

Scan
Assistant

X X X X X X X X X X X X X X X X X X X X X

My Trainer X X X X X X X X X X X X X X X X X X X X X

Whizz Report X X X X X X X X X X X X X X X X X X X X X

Simplified
Workflow

X X X X X X X X X X X X X X X X X X X X X

Multi-Touch X X X X X X X X X X X X X X X X X X X X X

Standby X X X X X X X X X X X X X X X X X X X X X

Whizz Note X X X X X X X X X X X X X X X X X X X X X

Digital
Keyboard

X X X X X X X X X X X X X X X X X X X X X

Specifications

Table 5-9 System Probe Definitions

Probe Designation Center Image
Frequency (MHz)

Frequency Range
(MHz)

Doppler Frequency
Range (MHz)

3Sc-RS 2.75 MHz ± 10% 1.7~4.0 1.7~3.3

6S-RS 4.5 MHz ± 10% 3.0~7.0 3.0~4.5

12S-RS 7.75 MHz ± 10% 4.2~12.0 4.2~6.7
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Probe Designation Center Image
Frequency (MHz)

Frequency Range
(MHz)

Doppler Frequency
Range (MHz)

4C-RS 3.10 MHz ± 10% 2.0~5.0 2.0~3.3

E8C-RS 6.5 MHz ± 20% 4.2~10.0 4.2~6.3

8C-RS 6.5 MHz ± 20% 4.2~10.0 4.2~6.3

E8Cs-RS 6.5 MHz ± 20% 4.0~10.0 4.0~6.0

C1-5-RS 3.4 MHz ± 20% 2.0~5.0 2.0~3.6

IC9-RS 6.25 MHz ± 0.35 3.6~9.0 3.6~6.7

L3-12-RS 6.575 MHz ± 1 3.6~12.0 3.6~9.1

L6-12-RS 7.75 MHz ± 20% 4.0~13.0 4.0~6.0

9L-RS 5.25MHz ± 20% 4.0~10.0 4.0~5.0

12L-RS 7.5 MHz ± 20% 4.2~13.0 4.2~7.7

L8-18i-RS 9.5 MHz ± 20% 6.7~18.0 6.7~10.0

LK760-RS 7.15 MHz ± 10% 3.5~10.0 3.5~5.0

L4-20t-RS 9.1 MHz ± 20% 5.0~20.0 5.0~10.0

6Tc-RS 4.8 MHz ± 0.4 3.0~8.0 3.0~5.0

RAB2-6-RS 3.3 MHz ± 10% 2.0~6.0 2.0~4.0

RIC5-9A-RS 6.5 MHz ± 10% 4.2~10.0 4.2~6.3

BE9CS-RS 7.5 MHz ± 20% 4.0~10.0 4.0~6.3

E7C8L-RS
(-L: Linear

Transducer)

6.5 MHz ± 0.5 5.0~10.0 5.0~6.7

E7C8L-RS
(-C: Convex
Transducer)

6.5 MHz ± 0.5 5.0~10.0 5.0~6.7

Slice Thickness Specification

Table 5-10 System Probe Definitions

Probe Designation Probe Slice Thickness Specification [mm]

3Sc-RS ≤ 16.0mm

6S-RS ≤ 8.0mm

12S-RS ≤ 8.0mm

4C-RS ≤ 12.0mm

E8C-RS ≤ 13.0mm

8C-RS ≤ 13.0mm
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Probe Designation Probe Slice Thickness Specification [mm]

E8Cs-RS ≤ 13.0mm

C1-5-RS ≤ 12.0mm

IC9-RS ≤ 13.0mm

L3-12-RS ≤ 8.0mm

L6-12-RS ≤ 8.0mm

9L-RS ≤ 14.0mm

12L-RS ≤ 8.0mm

L8-18i-RS ≤ 8.0mm

LK760-RS ≤ 12.0mm

L4-20t-RS ≤ 8.0mm

6Tc-RS ≤ 8.0mm

RAB2-6-RS ≤ 12.0mm

RIC5-9A-RS ≤ 13.0mm

BE9CS-RS ≤ 13.0mm

E7C8L-RS
(-L: Linear Transducer)

≤ 8.0mm

E7C8L-RS
(-C: Convex Transducer)

≤ 13.0mm

Probe Illustration

Figure 5-19 Probe illustration - Example

1. Connector: Socket to connect console receptacle for transmitting electrical signals.
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2. Cable: Transmit electrical signals between transducer and connector, wrapped with soft
plastics.

3. Housing: A molded hard plastic part to housing transducer and forming the outer shape
of a probe.

Sector Probe
Table 5-11 Sector Probe Illustration

Probe Illustration Probe Illustration

3Sc-RS 6S-RS

12S-RS

Convex Probe
Table 5-12 Convex Probe Illustration

Probe Illustration Probe Illustration

4C-RS E8C-RS

8C-RS E8Cs-RS

C1-5-RS IC9-RS
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Linear Probe
Table 5-13 Linear Probe Illustration

Probe Illustration Probe Illustration

L3-12-RS L6-12-RS

9L-RS 12L-RS

L8-18i-RS L4-20t-RS

LK760-RS
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TEE (transesophageal) Probe
Table 5-14 TEE (transesophageal) Probe Illustration

Probe Illustration Probe Illustration

6Tc-RS

Mechanical 4D Probe
Table 5-15 Mechanical 4D Probe Illustration

Probe Illustration Probe Illustration

RAB2-6-
RS

RIC5-9A-
RS

Bi-plane Probe
Table 5-16 Bi-plane Probe Illustration

Probe Illustration Probe Illustration

BE9CS-
RS

E7C8L-
RS
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Biopsy Special Concerns

Precautions Concerning the Use of Biopsy Procedures

WARNING
Only qualified and trained physicians or sonographers could do TEE probe scanning and
biopsy procedures.

WARNING

Do not freeze the image during a biopsy and TEE procedure. The image must be live to
avoid a positioning error.
Biopsy guide zones are intended to assist the user in determining optimal probe placement
and approximate the needle path. However, actual needle movement is likely to deviate from
the guideline. Always monitor the relative positions of the biopsy needle and the subject
mass during the procedure.

CAUTION
The use of biopsy devices and accessories that have not been evaluated for use with this
equipment may not be compatible and could result in injury.

CAUTION
The invasive nature of biopsy procedures requires proper preparation and technique to
control infection and disease transmission. Equipment must be cleaned as appropriate for
the procedure prior to use.

• Follow the probe cleaning and disinfection procedures and precautions to properly
prepare the probe.

• Follow the manufacturer's instructions for the cleaning of biopsy devices and
accessories.

• Use protective barriers such as gloves and probe sheaths.
• After use, follow proper procedures for decontamination, cleaning, and waste disposal.

CAUTION
Improper cleaning methods and the use of certain cleaning and disinfecting agents can
cause damage to the plastic components that will degrade imaging performance or increase
the risk of electric shock.

WARNING
NEVER reuse the TR5° disposable biopsy guide attachment and Disposable sterile Ultra-Pro
II Needle guide kits.

WARNING
Please wear sterilized gloves during the biopsy procedure, meanwhile do not operate the
console and any non-sterilized area in case any cross infection.
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WARNING
Please wear sterilized gloves during scanning with Transvaginal & Transrectal probe and the
probe shall with one sterilized rubber condoms in case any cross infection.
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Preparing for a Biopsy

Displaying the Guide zone

Activate the Biopsy Kit by selecting it from the B-Mode.

WARNING
There is potential risk in biopsy, brachytherapy and TEE exam scenario without imaging
guidance.

The available biopsy options appear when Biopsy Kit is selected. There are fixed and
adjustable angle biopsy kits and plastic/disposable and reusable biopsy guides available with
the ultrasound system depending on the probe. Select the desired biopsy kit.

Rotate Biopsy Kit rotary to turn it off.

Figure 5-20 Biopsy Guide zones for the 4C-RS Probe

The biopsy guide zone represents a path of the needle. The dots which make up the guide
zones is the depth readout where:

• Yellow represent 1 cm increments.
• Red represents 5 cm increments.

The display should be carefully monitored during a biopsy for any needle deviation from the
center line or guide zone.

The angular accuracy of the biopsy display shall be ±5 degrees (angle between the center
line and the two biopsy guide lines and the needle is inserted).

Before scanning, verify the needle can be visualized within the imaging plane. User
appropriate needle length to reach target area.

The Biopsy Guide zone adjusts along with image adjustments, such as image inversion/
rotations, zoom and depth changes.
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The needle may vary from the center line or guide zone for various reasons:

• Needle barrel to needle clearance or strength.
• Bracket manufacturing tolerance.
• Needle deflection due to tissue resistance.
• Needle size chosen. Thinner needles may deflect more.

Table 5-17 Biopsy Guide Availability

Probe Fixed Angle Multi-Angle
MBX1 (cm) MBX2 (cm) MBX3 (cm)

4C-RS 4.0 6.0 10.0

E8Cs-RS TR5: 85 Degree (15.3 cm)
RU: 90 Degree

3Sc-RS 4.2 5.7 8.2

L6-12-RS 1.5 2.5 3.5

12L-RS 1.5 2.5 3.5

RAB2-6-RS 4.0 6.0 8.0

E8C-RS TR5: 85 Degree (15.3 cm)
RU: 90 Degree

RIC5-9A-RS RIC59_Single:90 Degree
RIC59_RU:90 Degree

BE9CS-RS 0.6 4.0 6.0 8.0

C1-5-RS 4.0 6.0 8.5

9L-RS 4.0 5.5 7

L3-12-RS 1.5 2.5 3.5

IC9-RS TR5: 89 Degree

Table 5-18 Biopsy Guide Availability for E7C8L-RS

Probe Multi-Angle

E7C8L-RS (-L: Linear
transducer)

MBX1, MBX2, MBX3, MBX4, MBX5, MBX6, MBX7, MBX8

E7C8L-RS (-C: Convex
transducer)

MBX, GBX1, GBX3

Table 5-19 Biopsy Guide Availability for L4-20t-RS

Probe Fixed
Angle

Multi-Angle
MBX1

(degree)
MBX2

(degree)
MBX3

(degree)
MBX4

(degree)
MBX5

(degree)

L4-20t-RS 60 48 38 29 23
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DANGER

Failure to match the guide zone displayed to the guide may cause the needle to track a path
outside the zone.
It is extremely important that when using the adjustable angle biopsy guides, the angle
displayed on the screen matches the angle set on the guide, otherwise the needle will not
follow the displayed guide zone which could result in repeated biopsies or patient injury.

Preparing the Biopsy Guide Attachment

Convex, Sector and Linear probes have optional biopsy guide attachments for each probe.
The guide consists of a non-disposable bracket to attach to the probe, disposable needle clip
to attach to the bracket, sheath, gel (sterile gel if necessary) and disposable needle barrels.

The disposable needle barrels are available for a variety of needle sizes.

CAUTION
Please refer to the manufacturer's instructions included in the biopsy kit.

The bracket is packaged non-sterile and is reusable. To avoid possible patient contamination,
ensure bracket is properly cleaned, sterilized or disinfected before each use.
Disposable components are packaged sterile and are single-use only. Do not use if integrity
of packing is violated or if expiration date has passed.

Fixed Needle Biopsy Guide Assembly
WARNING
DO NOT use the needle with the catheter (soft tube). There is a possibility of breaking the
catheter in the body.

CAUTION
Before inserting the needle, scan the patient to determine the correct puncture depth and
site. Only the sterile/sanitary sheath and rubber band are on the probe during the pre-needle
placement scanning.

Preparation

To prepare the endocavitary probe for use:

1. Remove the probe from the box and carefully examine it for any damage.
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2. If the biopsy guide is to be attached, use the filling removal tool to clean out the
attachment area on the probe head.

Figure 5-21 Attachment Filling Removal

a. Probe Head
b. Attachment
c. Filling Removal Tool

3. Clean, then disinfect the probe.

NOTE
Ensure that protective gloves are worn.

Installing the sheath

To install the sheath:

1. Remove the sheath from its package. Do not unroll the sheath.
NOTE
Remember to rinse all sanitary probe sheaths of powder before placing on the probe.
Powder can degrade the displayed image.

2. Place an adequate amount of ultrasound gel inside the sheath tip (the gel is between the
sheath inner surface and the probe aperture).
NOTE
Ensure that only acoustic coupling gel is used for this purpose.

3. Place the sheath tip over the probe aperture and then pull the sheath end toward the
probe handle.
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4. Inspect the sheath for nicks, cuts or tears.

Figure 5-22 E8C-RS Probe with Sheath

a. Probe Handle
b. Probe Body
c. Sanitary Sheath

5. Rub a finger over the tip of the probe to ensure all air bubbles have been removed.

Biopsy Guide Preparation

1. If a biopsy is to be performed, snap the metal or plastic biopsy guide on to the probe over
the sheath.
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CAUTION
Patient injury or repeated biopsies may result. The needle placement will not be as
intended if the needle guide is not properly seated and secure.

Figure 5-23 Disposable Biopsy Guide 5 degree Angle

Figure 5-24 Reusable Biopsy Guide

a. Fix with a screw
2. Place an adequate amount of ultrasound gel on the gel-filled sheath tip's outer surface.
3. Ensure the guide is properly seated and secure by pushing forward on the needle

insertion end of the guide until the attachment node is firmly in place in it's hole.

Multi Angle Biopsy Guide Assembly
WARNING
DO NOT attempt to use the biopsy bracket and needle guide until the manufacturer's
instructions, provided with the biopsy bracket and needle guide in the kit, have been read
and thoroughly understood.
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1. Scan the patient and identify the target for biopsy. Move the probe to locate the target to
the center of the image. Enable the system biopsy guide zone and try guide zone angles
MBX1 to MBX3 to decide the best angle setting for needle path.

Figure 5-25 Example

2. Pull up on the knob (a) to freely move the needle guide attachment. Align the knob with
the selected position of the needle guide attachment.
Push the knob down (b) into the desired slot to secure the angle position of the needle
guide attachment.

Figure 5-26 Pull up and push down the knob

3. Fit a convex of the biopsy bracket (a) in a concave of the probe (b).

Figure 5-27 Probe/Bracket Alignment
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Hold the side (a) and tuck down the needle guide side (b) until it clicks or locks in place.

Figure 5-28 Probe/Multi-angle Bracket Alignment 2

4. Place an adequate amount of coupling gel on the face of the probe.
5. Place the proper sanitary sheath tightly over the probe and biopsy bracket. Use the

rubber bands supplied to hold the sheath in place.

Figure 5-29 Applying Sanitary Sheath

6. Snap the needle guide onto the biopsy guide bracket.

Figure 5-30 Snap the needle guide

Probes and Biopsy

348 Versana Premier/Versana Premier Lotus - User Manual
5928218-1EN Rev. 6



7. Push the locking mechanism towards the bracket to secure the lock (a). Make sure the
needle guide is firmly attached to the bracket.

Figure 5-31 Lock the Needle guide

8. Choose the desired gauge (size) needle barrel. Twist it back and forth to remove it from
the plastic tree.

Figure 5-32 Needle Barrel

9. Place the needle barrel into the needle clip with the desired gauge facing the needle clip
and snap into place.

Figure 5-33 Needle Barrel Installation
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Remove the biopsy guide

Hold the other side and push out the needle clip attachment side.

Figure 5-34 Remove the biopsy guide

Releasing the needle
According to the following procedure, you remove the needle from a probe and an assembly
without moving the needle.

1. Push the knob portion of a sleeve in the direction of the arrow.
2. The needle is released from the assembly.
3. Push the probe and the assembly in the direction of the larger arrow to remove the

needle.
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4D Biopsy Guide Assembly - Representative Example

Figure 5-35 Mounting the Biopsy Needle Guide to the 4D Probe

1. Fit the biopsy guide bracket onto the probe.
2. Fix the bracket by locking the frame on the opposite side of the needle guide.
3. Snap the needle guide onto the biopsy guide bracket, refer to Multi Angle Biopsy Guide

Assembly on page 346 for detailed information.

NOTE
Needle guide sterilization with autoclave is recommended if possible for needle guide
sterilization.

4D Probe Biopsy Needle Path Selection

To select the needle path and verify that the path of the needle is accurately indicated within
the guide zone on the system monitor, perform the following before use:

1. Properly install the bracket and biopsy guide.
2. Scan in a container filler with water (47℃).
3. Select Biopsy kit. The available biopsy options from the Touch Panel.

Select the biopsy guide zone where the needle echo passes through the center of the
guide zone. Use the selected biopsy guide zone when performing the biopsy

Biopsy Needle Path Verification

To verify that the path of the needle is accurately indicated within the guide zone on the
system monitor, perform the following:

• Properly install the bracket and biopsy guide.
• Scan in a container filled with water (47℃).
• Display the biopsy guide zone on the monitor.
• Ensure that the needle echo falls within the guide zone markers.
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The Biopsy Procedure

WARNING
Biopsy procedures must only be performed on live images.

1. Place coupling gel on the scanning surface of the probe/sheath/biopsy guide assembly.
2. Activate the biopsy guide zone on the system through the B-Mode menu. When using

multi-angle guides, ensure that the proper guide zone angle is displayed.
3. Scan to locate the target. Center the target in the electronic guide zone path.

NOTE
Enabling color flow would allow for visualization of the vascular structure around the
area to be biopsied.

4. Place the needle in the guide between the needle barrel and needle clip. Direct it into the
area of interest for specimen retrieval.

Post Biopsy

When the biopsy is complete, remove the needle barrel, needle clip and probe sheath.
Properly dispose of these items in accordance with current facility guidelines.

Clean and disinfect the probe per the instructions provided in this manual.

The biopsy bracket can be cleaned and disinfected in a recommended disinfecting agent and
reused.

CAUTION
When the biopsy needle guide kit is opened, all parts must be discarded after the procedure
whether they have been used or not.
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Whizz Easy Style

Whizz Easy Style is a feature intended to provide different image style/presentation for
user to choose. It provides different appearance on tissue smoothness, contrast, border
delineation and tissue differentiation. The existing GE HealthCare image style is still available
for the user to choose.
Whizz Easy Style is only available on specific probes with specific presets. Refer to Table 5-8
Probe modes of operation and Features on page 330 for detail information.
Table 6-1 Whizz Easy Style on each probe

Probe Presets

4C-RS Abdomen, Renal, OB-2/3, OB-1, Fetus Echo

C1-5-RS Abdomen, Renal, OB-2/3, OB-1, Fetus Echo

RAB2-6-RS OB-2/3, OB-1, Fetus Echo

L3-12-RS Nerve, Shoulder, Knee, MSK GEN, MSK Sup and Thyroid

Activating

Whizz Easy Style is enabled by clicking Whizz Easy Style on Touch Panel, and then select
Level 1 or Level 2. To exit, press Whizz Easy Style on the Touch Panel, and then select
OFF to disable it.

Figure 6-1 Whizz Easy Style on touch panel
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Whizz CF

Whizz CF optimizes the color flow by adjusting color flow gain and frequency automatically
when activated by user. Auto gain adjusts the color flow gain according to noise of color
image and depth of color ROI. Auto frequency adjusts the frequency with the depth change
automatically. This may provide better resolution when ROI is in the near field, or penetration
when ROI in the far field. Whizz color flow mode will be turned off automatically if the user
adjusts color gain or frequency manually. Adjusting other parameters will not turn this feature
off.

NOTE
If user is not satisfied with Whizz color, color gain and frequency can be adjusted or Whizz
color can be turned off.

Using Whizz CF

Whizz CF only supports available on specific probes with specific modes. Refer to Table 5-8
Probe modes of operation and Features on page 330 for detail information.
To activate Whizz CF,

1. Select Utility > Whizz > Whizz CF.

Figure 6-2 Whizz CF configuration
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2. Press Whizz key under CF mode, the backlight of Whizz key turns to green and the
Whizz parameter on the scanning screen will display as On.

Figure 6-3 Whizz CF On

To exit Whizz CF, press Whizz key on the control panel or adjust CF gain or frequency
manually.
If user doesn’t adjust CF gain/frequency manually when Whizz CF is on, the gain and
frequency will return to the value before Whizz CF is activated. If user adjusts CF gain/
frequency manually when Whizz CF is on, Whizz CF will be turned off and the gain and
frequency will stay as the adjusted value.
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B Flow / B Flow Color (Option)

B Flow

B-Flow is intended to provide a more intuitive representation of non-quantitative
hemodynamics in vascular structures.
B-Flow is digitally-encoded Ultrasound, using digital codes to enhance weak signals from
small particulate reflectors (blood flow) and suppress signals from strong reflectors (tissue).
Flow and tissue are displayed simultaneously without threshold decision and overlay.
All B-Mode measurements are available with B-Flow active: depth, distance along a straight
line, % stenosis, volume, trace, circumference, and enclosed area.

Presetting
Preset the default B Flow Mode, either B Flow or B Flow Color via Utility > Imaging >
BF/BFC button. Specify the default to be either B Flow or B Flow Color.

Activating
To activate/deactivate B-Flow, press B-Flow button on the touch panel or user-defined hard
key. Doppler Mode is available while in B-Flow; however, M-Mode and Color Flow/PDI
Modes are not available.

Using B-Flow
To optimize the image:
Adjust the frequency, display depth, and focal zone location based on the patient body
type and anatomy of interest. Adjust Sensitivity/PRI and Background setting as needed (see
below).
Adjust the remaining Imaging parameters and presets as needed; functionally is the same as
B-mode when in B-Flow mode.

Scanning Hints
B-Flow provides an intuitive view of blood flow, acute thrombosis, soft plaque, small vessel
perfusion, and high grade stenosis. Compared to Color Doppler, it does not display bleeding,
blooming, or aliasing artifacts.
The greater the speed, the better the image scatter density and size. If the scan direction
is the same as the flow direction, then the image scatter is elongated; if the scan direction
is the opposite as the flow direction, then the image scatter is tighter. Therefore, have the
scan direction opposite to that of flow direction. Switch the way you hold the probe, with the
probe orientation marker inferior to maintain correct orientation on the monitor. Flow starts
from where the focal zone is located.
Turn off the background when imaging the kidney, liver, and spleen. Keep the focal zone as
close to flow as possible. It is beneficial to narrow the sector width and increase the frame
rate.
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Benefits
Compared to Color Doppler mode, B-Flow provides better spatial and temporal resolution,
displays blood flow in the entire image, i.e. NO ROI, and is not angle dependent as it does
not use the Doppler Principle. B-Flow is therefore a more realistic (intuitive) representation of
flow information, allowing you to view both high and low velocity flow at the same time.

Affect on other controls
When you activate B-Flow, the system remembers the imaging parameters set while in
B-Mode. When you optimize the frame rate via Line Density, you compromise the resolution
and when you optimize the resolution, you compromise the frame rate. B-Flow is not
available in 3DView.

Bioeffects
Using B-Flow Frequency, Focus Position/Number, Sensitivity/PRI, Line Density,
Visualization, and Power Output may change the TI and/or MI. Observe the output display for
possible effects.

Flow Type
There are two type of flow type available in B Flow: Low or High.

• Low= Most sensitivity for slow flow (venous, small parts). This setting has the slowest
frame rate.

• High= Most sensitivity for fast flow. Provides the highest frame rate and better detection
of flow dynamics. Use whenever possible to capitalize on the high frame rate.

Accumulation

Description
Accumulation enhances the flow in an image; ideal to capture dynamic flow in a still picture.

Values
Off - Infinite. Infinite provides the same result as applying CINE Capture to a B-Flow CINE
clip.

Benefit
Accumulation detects the maximum signal and holds it (accumulates it) for the level specified
(Off - Infinite).

Background

Description
In the Background ON mode, both of B-Flow and B-mode are displayed in one image.

Value
On or Off.
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Sensitivity/PRI
Sensitivity/PRI (Pulse Repetition Interval) is proportional to the time interval between the
pulses sent to develop the B-Flow image.

In general, a larger value is recommended for slow flow as slow flow detection requires
more time separation between pulses so the system can detect the difference in flow profile.
However, a larger value could cause bar artifacts on the image. Therefore, it is suggested to
not increase the PRI value more than needed. A small value of PRI should be used when the
interest is in fast flow only, e.g. viewing a jet in a stenosis case, where the jet is of interest.

NOTE
Sensitivity/PRI is Probe and Model dependent.

B-Flow Color (BFC)

B-Flow Color is intended to provide a B-Flow representation with colorized flow and
background B-Mode image.
Although the BFC is based on B-Flow technology, the BFC image is processed and made by
the Color Flow processor and therefore has both the advantages of B-Flow and Color Flow.
Consequently, imaging parameters and presets are functionally the same as Color Flow/PDI.

Activating
To activate B-Flow Color,

• While in B-Mode, press B-Flow on the touch panel or user-defined hard key to activate
B-Flow. Then press Color on the Touch Panel.

• Adjust the parameters to get the best image.

Enhance (B-Flow Color)
Enhance provides a range of choices for B-Flow Color image quality.

Values
Enhance “Off” is the original B-Flow Color setting which gives you the dynamic appearance of
the flow with high frame rate.
Enhance “On” adds sensitivity and stability/continuity to the flow’s appearance, along with
lower frame rates than Enhance “Off.”

Scale
Same as Scale in Color Flow/PDI Mode.

Values
Increase for higher flow states.
Decrease to display smaller vessels and slower flow.
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Stress Echo (Option)

The Versana Premier/Versana Premier Lotus ultrasound system provides an integrated
stress echo package, with the ability to perform image acquisition, review, image
optimization, and wall segment scoring and reporting for a complete, efficient stress echo
examination.
The stress package provides a protocol template for the two types of stress exams (exercise
and pharmacological stress).
In addition to preset factory protocol templates, templates can be created or modified to suit
your needs.
You can define various quad screen review groups, in any order and combination, that will
suit your normal review protocol.
When reviewing stress examination images, the images are viewed at their original image
quality, and different post-processing and zoom factors may be applied to the images under
review for effective image optimization.
The protocol template may be configured for Continuous Capture.
A stress echo examination consists of three steps:

• Selection of a stress test protocol template
• Image acquisition
• Stress Analysis

NOTE
If WallMotion Segment Score is not displayed on the screen, select the “WallMotion”
preset in the Utility > Measure > M&A > Plot > Available Folders and
Measurements.

Getting started with a stress study

1. After selecting the appropriate application and probe and connecting ECG, press the
Protocol tab on the Touch Panel. The protocol screen displays the layout of the default
stress protocol for the current probe. This layout is also known as a template.
Table 6-2 Protocol Tab

Parameter Description

Analyze Display the Analysis screen

Template Editor Display the template editor screen

Add Level Add Level to the template

Delete Images Delete the selected image

Move Image Move the selected image to the another cell

Sync. Select Synchronize the selected images.

End CC End Continuous Capture

Begin/Cont. Begin or continue the acquisition
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Parameter Description

Template Display the template list

T1 Display/Hide the timer T1

T2 Display/Hide the timer T2

Cancel Cancel Stress Echo

2. To use the current template, press Begin/Cont. to initiate scanning.
To use another template, press Template. The template list displays.

Figure 6-4 Template List

3. Trackball to the desired template and press Set.
4. The selected template displays.

Figure 6-5 Template (Example)

a Level
b Projection
c Current Acquisition (green)

5. Press Begin/Cont. to initiate scanning using the new template.
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Image acquisition

Images are acquired in a pre-defined order, according to the selected template. The
highlighted (green) cell of the template matrix, displayed in the Clipboard window, indicates
which view is currently being acquired.
The names of the view and levels for the current cell are displayed on the top left corner of
the image area and under the template matrix.
Acquisition Screen

Figure 6-6 Acquisition Screen

1 Current View Level
2 Timer
3 Template Matrix
4 Current View (Green cell)

Starting acquisition

1. Select the template.
2. Press Begin/Cont.
3. Perform a scan that conforms with the view that is highlighted in the template matrix on

the Clipboard window.
4. Press the Store key.

• If the actual stress level is configured to preview the cine loop before storing, use the
cine loop controls to select the most appropriate heart cycle and if desired adjust the
loop markers. Press Store again to save the selected cine loop.
or
If you do not want to store the cine loop, press Freeze to cancel. Return to the scan
screen.
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• If the actual stress level is not configured to preview the cine loop before storing, the
system automatically stores the last heart cycle.

Stress levels can be configured for side-by-side display/comparison of the reference loop
from baseline or previous level and the loop to acquire.

5. After storing the cine loop, the system automatically highlights the next view in the matrix
to be acquired.

6. Repeat previous steps until all required views are completed.
7. If you select Auto Start Analysis on the Template Editor for this template, a dialogue

asking “Do you want to start protocol analysis now?” displays when the last acquisition is
complete. If you select Yes, the Stress Echo Analysis screen is displayed.

The template used can be configured so that analysis automatically starts by displaying the
first protocol group. The wall segment scoring diagrams for each view is displayed in the
Parameter window on the left side of the screen.
If the Protocol tab is selected during acquisition, the following Touch Panel displays.
Table 6-3 Protocol Tab during acquisition

Parameter Description

Stop Stop Stress Echo.

Pause Pause Stress Echo. The template matrix continues in display. Even if you
press P1, the cine loop does not store to the matrix.

Select Cycles The Continuous Capture Selection screen is displayed (only available in
Continuous Capture mode).

Analyze Enter Analysis screen.

Template Enter Template screen.

Add Level Add level to the template.

T2 Display (Start)/Hide Timer T2.

Selecting a view during acquisition
A fixed protocol is provided for scanning, based on the selected template. The system
automatically highlights the next view to be acquired in the template matrix, as images are
stored. However, the order of scanning may be changed manually as follows:

Manual selection of a view during acquisition

1. Use the Trackball or the arrow keys on the alphanumeric keyboard to move the cursor
to the cell that represents the view to be acquired.

The selected cell in the template matrix, highlighted in red, indicates the non-default
position. When blinking, it contains a previously-stored acquisition.

2. Scan and save the selected loop as explained in the previous section.

After storage, the system automatically highlights the next available view to be acquired.
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Moving an acquired image
An image can be moved from one cell to another during acquisition.

Procedure 1

1. When in the Protocol screen, press Move Image.
2. Use the Trackball to move the cursor to the desired image.
3. Press Set.
4. Use the Trackball to move the cursor to the destination cell.
5. Press Set. The image is moved from the source cell to the destination cell.

Procedure 2

1. In the Protocol screen, use the Trackball to move the cursor to the cell containing the
image to move (source cell).

2. Press and hold down Set.
3. With the Set key still depressed, move the Trackball to the desired cell.
4. Release the Set key. The image is moved from the source cell to the destination cell.

If the destination cell contains an image, the images from the source and destination
cells is exchanged when moving an acquired image.

Timers
Two timers can be displayed in the Stress mode acquisition screen, beside the template
matrix.

Timers

• T1 displays the elapsed time from the start of stress examination.
• T2 starts when entering live scanning on the second stress level.

Both T1 and T2 timers can be manually stopped and restarted during the acquisition.

The display of T1 and T2 is user-configurable.

NOTE
If you activate the Timer in Stress Echo, the T1 timer is displayed in the lower left-hand
corner of the image area after exiting Stress Echo.

Continuous Capture mode

Continuous Capture mode enables the user to perform acquisition continuously for all views
at any level depending on the selected template configuration. Continuous Capture consists
of temporary saving images acquired in a storage buffer. To enable best possible use of the
limited storage buffer capacity, a Pause/Capture mode is provided, as opposed to the normal
Freeze/Scan mode. The Pause mode enables scanning and live display on the screen,
without any capture, thereby leaving the buffer available.
To run Continuous Capture, the user has to select a template where this feature is activated.
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The buffer bar
When entering a level with Continuous Capture enabled, a buffer bar displays in the window.
The Buffer bar displays the following information:

• The scanning state

• Pause (live scanning without storing)
• Capture (live scanning with storing to buffer)

• The percentage of the buffer that is filled
• The buffer filling progression showed by a filling gage
• The capturing sessions, reflected by the red lines along the buffer bar

Figure 6-7 Buffer Bar

Controlling the capture process
When entering a stress level with Continuous Capture enabled, the system is automatically
set in Pause mode.

1. Press Store to start image capture.
“Capture” is displayed in the buffer bar, the gage starts filling and the percentage of filled
memory buffer increases.

2. Press Store again to stop capture.
“Pause” is displayed in the buffer bar.

When 90% of the memory buffer is filled up, the text display in the buffer bar turns red.
The system enters Freeze mode automatically once the buffer is full and the captured loops
display in the Continuous Capture selection screen.

Activating Continuous Capture

1. Do all your pre-stress acquisitions in the Cardiac application.
2. Press the Protocol tab to enter the Stress Echo mode. The Protocol screen displays.
3. Press Template. The template list displays.
4. Select the template Exercise 2x4 from the list.
5. Press Begin/Cont..
6. Acquire the resting loops in all four views.

NOTE
Use the Store key to store the images.

7. Once the fourth loop is acquired, the system enters into a waiting mode where
Continuous Capture is in a pause state awaiting the patient to exercise.
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8. When the patient is back on the bed, press Store. The Continuous Capture acquisition
starts.

9. Acquire all your views.

The memory buffer gage increases. When memory exceeds 90%, the percent number
turns red.

10. Press Freeze to finish.
11. Press Select Cycle.

The Continuous Capture selection screen displays.
If the buffer is full, the system automatically displays the Continuous Capture Selection
screen.
Refer to the next section if additional image acquisitions are necessary after the buffer is
full.

Figure 6-8 Continuous Capture Selection Screen

12. Assign the cine loops to the four views.
a -Trackball to the desired loop.

Chapter 6

Versana Premier/Versana Premier Lotus - User Manual 367
5928218-1EN Rev. 6



b -Press Set. A drop-down menu appears with the available choices.

Figure 6-9 Drop-down Menu

c -Trackball to the appropriate view.
d -Press Set.

NOTE
To access additional cycles, use the arrow keys on the lower left portion of the select
cycle screen.

e -Continue these steps until all views are selected.
f - Select Done when complete. A dialogue window displays, asking whether the entire

Continuous Capture acquisition should be saved.

Figure 6-10 Dialogue Window

13. Press Delete to discard the loop or press Store all to keep the entire loop.
14. Perform Analysis and scoring.

Continuous Capture with additional image acquisition

If the buffer is filled up before all the image acquisitions are done, additional loops can be
stored in the clipboard before doing image assignment to the views.

1. Perform the Continuous Capture. Activating Continuous Capture on page 366 (Steps 1 to
11).

2. In the Continuous Capture selection screen, press Select Later.
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The Continuous Capture screen displays.
3. Perform the additional acquisition.
4. In order to resume the stress echo exam and assign loops for the views from

the Continuous Capture buffer, press Protocol. If not displayed, select the template
Exercise 2x4 from the template list.

5. Click the continuous capture images on the Protocol Template screen.

The Continuous Capture selection screen displays.
6. Assign the cine loops to the view. Activating Continuous Capture on page 366 (Step 12 a

- f).
7. Press Delete to discard the loop or press Store all to keep the entire loop.

The normal procedure is to discard the loop. The loop is very big and requires a lot of
disk space.

8. Perform Analysis and Scoring.

Postponed image assignment

The assignment of the cine loops to the view can be done on a later stage on a stored
Continuous Capture acquisition.

1. Perform the Continuous Capture. Activating Continuous Capture on page 366 (Steps 1 to
11).

2. Press Store all.

The entire Continuous Capture acquisition is stored. The examination can be ended and
the image assignment, analysis and scoring can be done later.

3. Re-open the examination, if necessary.
4. Press Protocol. The Protocol screen displays.
5. Click the continuous capture images on the Protocol Template screen.

The Continuous Capture selection screen displays.
6. Assign the cine loops to the view. Activating Continuous Capture on page 366 (Step 12 a

- f).
7. Select Done.
8. Perform analysis and scoring.

Restart capture from the Continuous Capture Selection

Press Restart Capture.
The recording in memory is deleted and the Continuous Capture starts again.

Resume Continuous Capture

Press Continue Capture.
Resumes Continuous Capture recording
(only if the Continuous Capture buffer is not full).
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Assigning and storing the cine loop
The cine loops captured in the buffer are assigned to the stress protocol views and stored
from the Continuous Capture selection screen.

Figure 6-11 Continuous Capture Selection Screen

a.Highlighted loop
b.Cycle number and total number of cycles
c.Blue Gauge: Position of the highlighted loop within buffer area.
d.Navigation Controls: << < > >> (back to first selection, back to previous selection, forward

to next selection, and forward to final selection).
Assigning a cine loop to a view

1. Use the Trackball to move the cursor to the desired cine loop in order to assign it to a
particular view of the stress template.

The frame of the loop is highlighted.
2. Press Set.
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A pop-up menu displays with the view names of the template.

Figure 6-12 Loop Assignment

a. Already assigned view
b. Views pop-up menu
NOTE
A checkmark appears on the Views pop-up after you have assigned a view to an image.

3. Use the Trackball to select the required view name.
4. Press Set.

The name of the view displays above the timers in the window.
5. Repeat steps 1 through 4 to assign loops to the other views of the level.
6. Press Done when complete.

A dialogue window displays asking whether the entire Continuous Capture acquisition
should be saved.

7. Press Delete to discard the loop or press Store all to keep the entire loop.

The normal procedure is to discard the loop. The loop is very big and requires a lot of
disk space.

Post Acquisition Features

Post acquisition, you can utilize Raw Data to adjust the following in B-Mode:

• Zoom
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• SRI HD
• Rejection
• Frame Average
• TGC
• Maps
• Dynamic Range
• Gain
• Rotation

You can also take measurements post Stress Echo acquisition.

Analysis

Analysis consists of viewing previously saved loops and assigning scores to each cardiac
segment, in order to quantify the function of the muscle or wall segment.
Depending on the protocol configuration, the analysis stage can start manually or
automatically after completion of the stress test. In this case, the usual procedure consists
of sequentially opening all image groups (if defined) and performing scoring from image to
image.
The quad screen is the standard display for comparing heart cycles. The heart cycle loops
in the display are synchronized to enable comparison. Each loop in the quad screen can be
magnified, using the zoom control.

Image Selection for Analysis
Images can be selected manually or from a pre-defined group in the Protocol screen.

Selection of Images from a group

If groups of images have been defined in the protocol template, you can select a group
of images for analysis and sequentially analyze all images from all groups from within the
Analysis screen.

1. In a stress examination, press Protocol. A preview of the acquisition displays.
2. Press Analysis. A pre-defined group appears in the display with a Wall Segment window

on the left.
3. To advance to other groups, use the Trackball to move the cursor to the arrows at the

bottom of the Wall Segment window. Select an arrow to advance to another group. For
further clarification, see callout F in Figure 6-13 Analysis Screen on page 373.

Manual selection of images from Analysis screen

1. When currently in the protocol analysis screen in the Stress analysis quad screen, hold
down the Shift key while performing Steps 2 through 4.

2. Use the Trackball to move the cursor to the first image to select in the template matrix.
3. Press Set. The frame of the selected loop is in the Stress analysis screen and the next

window in the quad screen is automatically selected.
4. Repeat step 2 and 3 to select other images.
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5. Depress Shift .

Manual selection of images in the Protocol screen

1. In a stress examination, press Protocol. A preview of the acquisition displays.
2. Use the Trackball to move the cursor to the first image to select.
3. Press Set. The frame of the selected loop highlights.
4. Repeat Steps 2 and 3 to select other images.
5. Press Analyze to open images in the Analysis screen.

Scoring acquired loops

1. After image selection, press Analyze.
The Stress Echo analyze screen displays.

Figure 6-13 Analysis Screen

a. Wall segment diagram
b. Selected loop (Highlighted frame)
c. Displayed loops (Highlighted frames)
d. Exit Wall motion scoring
e. Change page or enter next image group

2. Use the Trackball to move the cursor to a segment in one of the scoring diagrams and
press Set.
The Score pop-up list displays.

3. Use the Trackball to move the cursor to a score.
4. Press Set.

The score displays in the relevant segment area in the diagram.
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NOTE
To edit a score, select it and choose a new score.

5. Repeat step 1 through 3 to score relevant segments.
6. Press the Change Page arrow to display the next group of images.
7. Repeat step 1 through 3 to score relevant segments on the new loops.

Figure 6-14 Segment Scoring

NOTE
Since Cine changes into sync mode, subsequent scans are also synchronized. Exit sync
mode from the Cine menu.

Editing/Creating template

The stress package provides protocol templates for exercise as well as pharmacological
stress examinations.
The user can create new templates or modify existing templates to suit the individual needs.
Up to ten projections and fourteen stress levels can be created in a template.
Templates created may be temporary, used only during the current examination, or saved as
new templates, for future use and reference.
The editions that may be performed include:

• Adding/Deleting levels and projections.
• Assigning new labels to levels and projections.
• Defining level options.
• Defining new groups.

Templates are edited/created from the Template editor screen.
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Entering the Template editor screen

1. Press Protocol to enter the stress echo mode.
2. Press Template. The template list displays.
3. Use the Trackball to select the Template Editor.
4. Press Set. The Template Editor screen displays.

OR

1. Press Protocol to enter the stress echo mode.
2. Press Template Editor on the Touch Panel. The Template Editor screen displays.

Template Editor screen overview

Figure 6-15 Template Editor Screen

Table 6-4 Template

Parameter Description

Template Select a pre-defined template from the pull-down menu. The protocol template
preview updates accordingly.
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Table 6-5 Protocol Template Preview

Parameter Description

Protocol Template
Preview • Displays an updated preview of the template accordingly to the settings

applied.
• To change Projection and Stress level labels, select a pre-defined label from

the pull-down menu or press Set in the actual label field and type a new
name.

Table 6-6 Template Settings

Parameter Description

Template Settings • Cycles: select the number of cine loop heart cycles to store for each level
from the pull-down menu or enter the desired value manually.

• Continuous Capture: Checking this parameter enables continuous image
acquisition throughout the level. The images acquired are temporarily stored
in the system’s storage buffer.

• Preview of store: Checking this parameter enables review and adjustment of
cine loops before store.

• Show reference: Checking this parameter displays a dual screen with the
reference level (first or previous level) on the left and the live image on the
right.

Table 6-7 Scan Mode

Parameter Description

Scan Modes • 2D, Color, PW (Pulsed Wave Doppler), CW (Continuous Wave Doppler),
MM (M-Mode), Color MM, Color PW, Color CW
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Table 6-8 Other options

Parameter Description

Other Options • Grid Size: Enter the number of levels and projections for the selected
template.

• Timers: If you check this parameter, starts T1 and T2 timers automatically.
• Auto-start analysis: If you check this parameter, displays the Stress Echo

Analysis when the last acquisition is performed.
• Show Systole in Analysis: When selected, the systolic part of the cardiac or

ECG cycle is only displayed. The whole cycle is not displayed.
• Smart Stress: Check Smart Stress to store a subset of the image acquisition

settings (e.g., Zoom, Gain, Compress, etc.) for each view in the protocol.
Smart Stress enables you to set image acquisition settings for each view
at a baseline level and automatically get the same image settings in the
corresponding views in the next levels.

• Reference image: When Show Reference is selected, selects either
corresponding baseline loop or corresponding loop from the previous level to
be displayed as reference image during acquisition.

Table 6-9 Pre-defined groups

Parameter Description

Pre-defined groups • Shows the image groups created.
• New group: Creates a new image group. Select the desired images on the

template preview.
• Update group: Edits a selected group after new loop selection on the

template preview.
• Delete group: Deletes a selected group.

Selecting a base template to edit

1. Select the base template from the template pull-down menu on the upper left corner.
2. Press Set.

The selected template displays in the protocol template preview field, showing the levels,
projections and their labels.

Adding/Deleting levels and projections

1. Enter the number of levels and projections in the Grid size field.

The new grid size displays in the protocol template preview field.
2. Press New Template to create a new template.

or
Press Save Template to update the base template.
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Display timers
Check the box(es) to display timer(s) as specified.
NOTE
The timers can also be started or stopped at any time during stress examination by using the
T1 and T2 Touch panel key.

Start analysis automatically
Check Auto Start Analysis to display the Stress Echo Analysis screen when the last
acquisition is performed.

Smart Stress
Check Smart Stress to store and automatically reuse a subset of the image acquisition
settings in the baseline level view in the corresponding views in the next levels.

Configuring levels
The following options can be set up for each level:

Number of cycles to be stored in the cine loop:
Enter or select the desired number in the Cycles field.

Continuous Capture
Check Continuous Capture if continuous image acquisition throughout the level is desired.
When Continuous Capture is selected, preview of the cine loop and reference display during
acquisition are not possible.

Preview of store
Check Preview of store if review and adjustment of cine loops before storage is desired.

Show reference
Check Show reference if the display of the corresponding reference loop is desired during
acquisition (Dual screen mode).

Adding a group

1. In the Protocol template preview field, select the cells to be part of the group.
2. In the Pre-defined group field, press New group.

A dialogue box displays to ask the user to enter a name for the new group.
3. Enter the group name.
4. Press OK. The new group displays in the pre-defined group field.

Updating an existing group

1. In the Pre-defined group field, select the group to edit.

The selected cells are highlighted in the Protocol template preview field.
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NOTE
The selected group is highlighted by a Green frame.

2. Either select a new cell(s) to add to the group or deselect an existing cell(s) to remove
from the group.

3. Press Update group.
The display in the Protocol template preview field is updated accordingly.

Deleting a group

1. In the Pre-defined group field, select the group to delete.
NOTE
The selected group is highlighted by a Green frame.

2. Press Delete group.
The group is removed from the list in the pre-defined group field.

Specifying Scan Mode for each Projection
Specify the Scan Mode for each Projection: 2D (B-Mode), Color Flow Mode, M-Mode, Color
M-Mode, PW Mode, Color PW Mode, CW Mode, or Color CW Mode.

Saving the Template
You can save the template using controls at the bottom of the Template Editor page, or use
the controls on the Touch Panel.
Table 6-10 Template Editor Saving Options

Parameter Value

New Template Select this option to create an entirely new template.

Save As Template If you would like to create a new template based on the existing template
with your modifications, select to Save this Template As, and give it a
name.

Save Template Select this option to save the default template with your modifications.

Delete Template Select this option to delete a template.
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Wall Motion Segment Setup

You can set up the following parameters for Wall Motion Segment in the Utility screen (Utility
> Measure > Advanced > Cardiac).

Figure 6-16 Cardiac Wall Motion Segment Setup

Table 6-11 Wall Motion Segment Parameters

Parameter Value

WMS freeze loop at ES Specify to freeze the Loop at End Systole

WMS Segment Model Select 16 or 18 segments

WMS initial scoring Undefined or Normal

WMS scoring legend ASE, ASIA or European
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Utility Application Settings for Protocol

Figure 6-17 Protocol Setup

Table 6-12 Protocol Parameters

Parameter Description

Show Protocol Tab Show/Hide the Protocol tab for that preset (Bicycle Normal,
Bicycle Sporty, Contrast Pharmacological, Pharmacological 4x4,
Pharmacological 8x5, Exercise 2x4, Exercise 2x4 B, Pharmacological US
4x4, or User-configured).

Template Select the default template.

Reports

If you set up the Wall Motion Analysis field on the Report, you can insert the results.
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Select Report to view either the Bull’s Eye and/or Cut Plane Report.

Figure 6-18 Bull’s Eye and Cut Planes Report Sample
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ECG Option

WARNING
DO NOT USE the physiological traces of the Ultrasound system for diagnosis and
monitoring.

CAUTION
Use GE HealthCare provided ECG cable to ensure the protection performance against the
effects of a discharge of a cardiac defibrillator to the patient.

CAUTION
The operating environment requirement of the ECG is inconsistent with the console, and the
operating environment temperature with the ECG should be controlled above 10℃.

CAUTION

• The conductive parts of the electrodes used in the applied part and their connectors
(including the neutral electrode) should not come into contact with any other conductive
part, including ground.

• After the defibrillator stimulates the patient, the ECG needs 5 seconds for recovery.
• The quality of the ECG trace depends on the stability and conductivity of the electrodes

during the test, especially during high stages when the patient’s movements can cause
artifacts.

• Make sure that the lead wires do not swing.
• The device is not waterproof. Do not expose the device to water or any kind of liquid.

Maintain in a dry place:
• Worn or damaged patient cables are the most common cause of poor ECG signals.

ECG signals (or wave patterns) that consistently contain noise or artifact may suggest
need for ECG wire or cable replacement.

• Store the device in a dry place.
• Always protect the recorder from coming into contact with moisture. In rain or snow

conditions, protect the recorder from bad weather elements by wearing the recorder
inside a coat.

Intended Use for ECG
During the echocardiography examination, the electrocardiogram (ECG) is connected to
record the electrical activity of the heart synchronously, so as to analyze the regular changes
of the phase of cardiac activity.
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ECG connecting

The ECG module is connected to the system via USB ports.

Figure 6-19 Connecting ECG to the system

CAUTION
Install ECG Hardware Option before connecting the ECG trunk cable to the system.

NOTE
The conductive parts of the electrodes used in the applied part and their connectors
(including neutral electrodes) should not touch any other conductive parts, including the
earth.

Restart the system after ECG module is connected.

To activate ECG Option

Go to Utility > System > User Configurable Key to define a key for activating ECG.
To display the ECG Signal on the monitor, go to Utility > Imaging > General > ECG > ECG
Display.
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Operation

1. Connect the standard A-type plug of the USB cable (Detail 1) to the USB connector of
the host.

Figure 6-20 USB cable

2. Connect the Mini-B type USB plug of the USB cable (Detail 2) to the input of the
ECG-USB1 acquisition device (Detail 1).

Figure 6-21 ECG-USB1
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3. Connect plug of detachable patient cable (Detail 3) to the round connector on ECG-
USB1 (Detail 2).

Figure 6-22 Detachable patient cable

4. Apply the leads to the patient (Right Arm, Left Arm and Right Leg) according to their
markings (R(RA), L(LA) and N(RL) respectively).

5. Operate through the host system.

Patient preparation

The ECG traces quality depends very much on the stability and conductivity of the electrodes
during the test, especially during high stages when the patient movements can cause
artifacts. Here are some basic rules to ensure good electrical contact:

• Shave hair at the electrode contact points
• Use high quality liquid gel electrodes
• Make sure that the lead wires do not swing

Attach the leads as shown in Figure 6-22 Detachable patient cable on page 386. Detachable
3 leads each 100cm with clip connectors on the patient end designed for use with disposable
ECG electrodes.

Cleaning and Disinfection

CAUTION
ECG is not waterproof. Do not expose the device to water or any kind of liquid. Maintain in a
dry place.
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CAUTION

Before performing any cleaning and disinfection, always ensure that the product is
disconnected from the patient and other equipment.
To avoid the risk of damaging the product, do not use any automated cleaning and
disinfection procedures.
Only use approved cleaning and disinfection agents.

Frequency of visual inspections, cleaning, and disinfection

• ECG modules should be cleaned weekly - ECG lead wires should be cleaned and
disinfected after each patient use.

• Visually inspect products before and after cleaning and disinfection procedures.
• Damaged products should not be used. Evidence of product damage may include, but is

not limited to, corrosion, discoloration, excessive scratching, flaking, cracking, and wear.

Permitted Cleaners and Disinfectants
PDI Super Sani-Cloth Disposable Sterilization Swab

Cleaning

1. Put on new gloves.
2. Perform a pre-cleaning and wipe the surface of the product to ensure that all surfaces

are cleaned evenly. Repeat cleaning until the product is visibly clean.
3. Use cotton swabs or other suitable cleaning accessories (such as soft brushes) to clean

hard-to-reach areas. Do not use any sharp tools to clean the product.
4. The product can be rinsed manually thoroughly with a clean, soft, lint-free cloth saturated

with warm tap water (water temperature range 0 to 50°C, 32 to 122°F).
5. Allow the product to air dry until visibly dry or wipe it thoroughly dry with a clean, soft,

lint-free cloth. Drying time may vary depending on environmental conditions.

Disinfection

1. Put on new gloves.
2. Wipe the entire surface of the product. The treated surface must remain visibly wet for

at least two minutes (Super Sani-Cloth) or according to the disinfectant manufacturer's
instructions.

3. Use cotton swabs or other suitable cleaning attachments (e.g. soft brushes) to clean
hard-to-reach areas. Do not use any sharp tools to clean the product.

4. The product can be thoroughly rinsed manually using a clean, soft, lint-free cloth
saturated with warm tap water (water temperature range 0 to 50°C, 32 to 122°F).

5. Allow the product to air dry until visibly dry or wipe it thoroughly dry with a clean, soft,
lint-free cloth. Drying time may vary depending on environmental conditions.
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Troubleshooting - Noisy ECG Signal

"Noise" refers to any degradation of the ECG signal that makes it difficult to accurately detect
and classify beats. Causes of noise, such as artifact and electrical interference, should be
avoided whenever possible.
Some common causes of noisy ECG signals include:

• Poor skin prep.
• Dried electrode gel.
• Muscle artifact caused by shivering, movement or tremors.
• Baseline wander caused by excessive chest movement, or the electrical differences

between two brands of electrodes.
• Respiration artifact caused by thoracic or abdominal movement of both spontaneous and

ventilated breathing patterns.
• Nearby electrical equipment.

Table 6-13 Noisy ECG Signal

Problem Appearance Cause Corrective Action

Baseline
Wander

Rhythmic Up-
and-down
movement of
ECG baseline

Movement of the
Patient.
Improperly applied
electrodes.

Make sure patient is comfortable
and still
Reapply electrodes

Irregular
Baseline

Rough, jagged
baseline

Poor electrical contact.
Faulty or dry
electrodes.

Reapply electrodes, using proper
technique. Check for loose
connections on lead/cable
Apply new electrodes

Muscle
Artifact

Fuzzy, irregular
baseline

Tense, uncomfortable
patient.
Tremors, Diaphoresis.
Poor electrode
placement.

Make sure patient is comfortable
and still.
Check that electrodes are applied
on flat, on-muscular areas of the
torso.
Reapply electrodes if necessary.

Poor
Electrical
Contact

Trace switching
from high to low
in steps and/or
dashed trace

Loose electrodes
Defective leads/cables

Change all electrodes, using good
skin prep.
Replace leads/cables.

Power Line
Interferenc
e (50/ 60
Hz)

Regular saw
tooth baseline.

Poor electrode
placement.
Possible non-grounded
instrument near patient.

Reapply electrodes.
Check grounding of equipment near
patient.
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ECG Trace Monitor Display

The scanned image is synchronized with the ECG trace. In Doppler or M-Mode, the traces
are synchronized with that particular mode’s sweep.
The user can control the gain, position and sweep speed of the traces.

Figure 6-23 ECG Trace Display

1. ECG
2. Auto Heart Rate Display

ECG menu

The ECG menu provides for control of the input signals.

Without the ECG option, the ECG menu will not be displayed.
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NOTE
After connect ECG module to the ultrasound system, please restart to activate the
ECG option.

Figure 6-24 ECG Touch Panel

Table 6-14 ECG parameters

Parameter Description

Sweep Speed Change the speed of the trace. The sweep speed of the physio signal on the
B-Mode image can be set independent of the timeline (Doppler and M-Mode) sweep
speed.

ECG Trigger Enables intermittent imaging based on the ECG. The trigger location(s) relative to
the R trigger are set with the Delay Time key.

• Press ECG Trigger and select one of the options (None, Trig1, Trig2, and Both)
and adjust the delay time using the Delay Time key.

ECG Trig 1 specifies the delay (ms) from R-wave to triggered frame.
ECG Trig 2 specifies the delay from R-wave to second frame.
Both activates ECG Trig 1 and ECG Trig 2 simultaneously. Trig 2 must be
greater than Trig 1 for dual triggering (Both) to be active.

ECG Display Provides the ability to turn on the ECG trace and Auto Heart Rate for display on the
monitor.

ECG Trigger
Period

The control specifies the number of heart cycles (R-waves) that are skipped
between ECG triggers.
The default is 1 or no skipping.
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Parameter Description

Delay Time In ECG Trigger Mode: If only ECG Trig1 or ECG Trig2 is selected via the ECG
Trigger key, the Delay Time key controls the R-Delay time of the active trigger. If
both triggers are selected (Both), press this key to toggle ECG Trig1 and ECG Trig2
and rotate the key to change the delay time. Once the trigger is set, the snap shot
image is displayed each time the update line passes the active trigger(s).
In Timer Trigger Mode: Rotating the knob changes the delay time between images.

ECG Gain/
Position

Allows for the amplitude control of the ECG trace or allows for the vertical positioning
of the ECG trace on the image display.
Press the knob to toggle between Gain and Position. The default is Gain.
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Using 3D (Option)

WARNING
DO NOT scan any pacemaker patient using the sensor device. The magnetic fields emitted
from the device may interfere with the pacemaker operation.

Easy 3D is compatible with every 2D transducer using a freehand acquisition to generate a
volume dataset.
Table 6-15 3D Package Options

3D Type Description Sensor/No Sensor Available Tabs

Easy 3D Designed for rendering
B Mode images, e.g.,
Baby Face scans.

No sensor 3D Acquisition, Easy
3D, Movie

Advanced 3D Designed for rendering
B Mode images, e.g.,
vessel trees.

No sensor 3D Acquisition, Easy
3D, Advanced 3D,
Movie

3D Volume datasets are allowing the navigation in the 3D cube itself and providing access to
the 3 different main planes - axial, sagittal and coronal.

Easy 3D

Acquiring a 3D Scan
To acquire a 3D scan,

1. Optimize the B-Mode image. Ensure even gel coverage.
2. Press the 4D/3D key on the control panel.

NOTE
Set appropriate values for PreAcq and Scan Plane. Also, set the scan distance before
scanning.

3. To start acquiring the image, press Start key.
4. To perform a parallel scan, scan evenly. To perform a sweep (fan) scan, rock the probe

once. Note the distance of the scan.
5. The 3D volume of interest (VOI) is dynamically assembled on the right side of the

screen.
NOTE
If the image stops before you’re done scanning, start acquiring the 3D volume of interest
again.

6. To complete the 3D scan, press PreMode key.
NOTE
You can also press Freeze, but then you need to also press the 3D key to obtain the
final render.
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3D Notes

• Adjust the 3D data set brightness with B-Mode Gain.
• Use Colorize to change the color of the active data set.
• Use Zoom to increase the zoom factor of the active data set.
• Vertical lines may be seen in a resliced image. This usually happens when you scan too

fast or if the scan distance is set to a high value.

Scan more slowly, adjust the frame rate for a faster rate or adjust the scan distance.

Manipulating the Volume of Interest
Imagine you are able to manipulate the 3D volume of interest (VOI) in your hand. The 3D VOI
is a tangible anatomical object that you can see and manipulate easily using the Trackball
and Set control panel keys.
Practice positioning the pointer at different places within the 3D VOI. Highlight different colors
(white, red, yellow, or green). Press Set to select a VOI for manipulation. Use the hand to
manipulate the 3D VOI.

Rotating the 3D VOI Left/Right or Forward/Backward

You can rotate it left to right or right to left. You can rotate it forward/backward. Press right
Set key when the white pointer finger is positioned on the white box. Move the closed white
hand to manipulate the 3D VOI.

Figure 6-25 Manipulating the 3D Volume of Interest (White Hand)
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Moving Through the 3D VOI

You can move through the 3D VOI using the red hand. Press Set when the red pointer finger
is positioned on the red box. Move the closed red hand to move through the 3D VOI.

Figure 6-26 Moving through a 3D Volume of Interest (Red Hand)

NOTE
Any plane in the volume can be made active (highlighted with red box) by clicking on it.

Viewing Specific Portions of the Anatomy

You can pull back tissue to view specific portions of anatomy using the yellow hand. Press
Set when the yellow pointer finger is positioned on the yellow box. Move the closed yellow
hand to manipulate the 3D VOI.

Advanced Features

394 Versana Premier/Versana Premier Lotus - User Manual
5928218-1EN Rev. 6



NOTE
This actually moves an edge. A yellow hand appears only when the pointer is on an edge of
the VOI.

Figure 6-27 Manipulating the Edge of a 3D Volume of Interest (Yellow Hand)

Pulling Back a Corner of the VOI to View Specific Anatomy

You can pull back a corner to view specific portions of anatomy using the green hand. Press
Set when the green pointer finger is positioned on the green box. Move the closed green
hand to manipulate the 3D VOI.
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NOTE
A green hand appears only when the pointer is on a corner of the VOI.

Figure 6-28 Manipulating a Corner of the 3D Volume of Interest (Green Hand)

3D Acquisition Parameter Description

Table 6-16 3D Acquisition Description and Instructions for Use

3D Parameter Description

Application Presets Selections: None, OB - Baby Face
None. No application preset applied.
OB - Baby Face. After having scanned in this mode, certain rendering
parameters are set automatically. The gray surface mode is activated and the
texture mode is switched off. The gray surface mode values for opacity and
threshold are set automatically according to the datasets histogram.
User1, User2, User3. User defined preset.
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3D Parameter Description

Acquisition Mode Selections: Sensorless Parallel, Sensorless Sweep
Sensorless Parallel. In this mode the probe must be moved during 3D data
acquisition without angling it. You should scan the object you want to render in
2-4 seconds. The speed at which you scan should be constant. No sensor is
mounted on the probe.

• Since the time for post-processing depends on the acquired number of
frames, it is recommended that you check the frame rate. Low frame
rates result in fewer acquired frames for the 3D dataset which results in
intensive post-processing (interpolation). Therefore, low frame rate = long
post-processing.

Sensorless Sweep. In this mode the probe must be moved to a position
where you can clearly see a middle cut of the object you want to scan and
render. Tilt the probe to about 30 degrees until the object you want to scan
disappears. Start the acquisition and tilt the probe over a distance of around
60 degrees until the object disappears again. The entire scan time should
be around 2-4 seconds. During the sweep, the probe may not be moved
parallel, just tilted. No sensor is mounted on the probe.
Before starting an acquisition, take care that the transmitter is positioned
correctly during data acquisition and that the transmitter cannot move.

Scan Plane Selections: Front to Back, Side to Side
Front to Back. After having scanned in this mode, the rendered dataset is shown
in a frontal view. For acquiring a fetal face in sagittal cuts, use this mode.
Side to Side. After having scanned in this mode, the rendered dataset is shown
from a side view. For acquiring a fetal face in coronal cuts, use this mode.

3D Starts the rendering process.

Scan Distance Adjusts the distance covered during the scan. Depending on the real width of a
scan acquired during a sensorless 3D acquisition, the volume of interest’s width
can be enlarged or reduced. You can adapt the form of a fetal face if the baby’s
head looks oval instead of round. The assumed default width of a parallel scan is
6 cm; of a sweep scan 60 degrees.

Display Format Change the layout between 50/50 and only 2D.

NOTE
Selection of user preset shall be effective only while 3D mode is active. Exiting 3D mode and
activating again then 3D preset shall be changed to the default, even without New Patient or
changing application.

NOTE
When 3D image is recalled, no 3D preset shall be active and parameters are recalled from
image file.
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NOTE
Default Scan Distance, Opacity and Threshold may not consistent and change per scan.
After User Preset was saved and recalled, Opacity and Threshold are consistent.

Figure 6-29 Easy 3D

Descriptions and instructions for using Easy 3D follow:
Table 6-17 Easy 3D Description and Instructions for Use

3D Parameter Description

Reset Resets the 3D volume of interest back to its original orientation.

Utilities Select Average Off, Average Light, Average Medium, or Average Strong.

Undo Undoes any manipulation you have done to your 3D dataset.

Auto Movie Initializes the calculation and display of a 3D movie. A rotation of 30 degrees
left and right around the actual image position (either the default position after
acquisition or the position that was manually defined by manipulating the 3D
volume of interest) is shown. For this 60 degree rotation, eleven images in steps
of 6 degrees are calculated.

Scalpel Structures, for example a part of the placenta hiding the view to a fetal face, can
be cut out in a rendered image. All visible structures can be cut out.
The option of ‘erase inside’ deletes all structures inside the marked region. The
option of ‘erase outside’ deletes all structures outside the marked region.
The region in the rendered image is marked with the right Set key. To define
the contour of the region, press the right Set key for each vertex. To close the
contour, double click the right Set key. As long as a contour is not closed, it can
be traced back with the left Set key. The cut out process can be undone by the
Undo Last function.
As soon as the Apply button is pressed, a new dataset is generated.

Gray Surface Activates the gray surface rendering mode. It leads to a transparent appearance
of the object, generated by displaying only a surrounding shell of structures.
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3D Parameter Description

Texture Activates the texture or photorealistic rendering mode. It creates a photorealistic
appearance of the object. The shading depends on the orientation of the surface
of the object.
If both Texture and Gray Surface mode are switched on, the mixture percentage
of both modes can be defined.

Render Changes between the rendered image view and the view of a volume of interest.
The volume of interest shows the acquired ultrasound images transformed
into an isotropic rectangular coordinate system. The volume of interest can be
manipulated as described above.

Threshold/Opacity Threshold defines which gray values are used for rendering and which are
considered noise. Opacity defines how strict Threshold is used for discrimination.
A low opacity value creates a firmer appearance of the surface. A high opacity
value leads to a transparent appearance of the rendered image.

Colorize/Contrast Colorizes the 3D render or adds contrast to the 3D rendered image.

Overwrite User1/
User2/User3

Overwrite the application preset file with the changes you just
made.

Orientation Marker You can now specify/define, then add the following orientation markers while in
3D via the Orientation Marker key:

• TRV Sup to Inf

Ant Scan
Prb Rt

• TRV Inf to Sup

Ant Scan
Prb Rt

• SAG Lt to Rt

Ant Scan
Prb Sup

• SAG Rt to Lft

Ant Scan
Prb Sup

• Defined

Superior
Inferior
Left
Right
Anterior
Posterior
Cancel

• None
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3D Parameter Description

Active Data Manipulations of rendering parameters only have an effect on the data defined
as Active Data. After having selected Active Data, a list of data is displayed,
Gray Data or Inversion. Choose the data to be manipulated. Active Data is
only available when you select both Inversion and Gray Data in Visible Data.
Inversion Mode is only available for Black-and-White mode.

Visible Data After selecting Visible Data, a list of data is displayed, Gray Data or Inversion.
Choose the data you want to display. For example, if only Inversion is chosen,
the B-Mode image is switched off in the rendered image and only inversion mode
is displayed.

Advanced 3D

Descriptions and instructions for using Advanced 3D follow:
Table 6-18 Advanced 3D Descriptions and Instructions for Use

3D Parameter Description

Reset Resets the 3D volume of interest back to its original orientation.

Contrast Adjust to increase or decrease the contrast of the image.

Colorize Colorizes the gray scale image to enhance the eye’s discrimination capability.

Utilities Use smoothed volume for rending the 3D.
Strong = Most Smoothing.

Auto Movie Initializes the calculation and display of a 3D movie. A rotation of 30 degrees
left and right around the actual image position (either the default position after
acquisition or the position that was manually defined by manipulating the 3D
volume of interest) is shown. For this 60 degree rotation, eleven images in steps
of 6 degrees are calculated.

Save Preset Save as a user preset (User1, 2, or 3).

Undo Undoes any manipulation you have done to your 3D dataset.

Tile The display can be divided into 1, 2, 4, or 6 windows. Switching to a lower
number of windows keeps the images from left to right.

Scalpel Structures, for example a part of the placenta hiding the view to a fetal face, can
be cut out in a rendered image. All visible structures can be cut out.
The option of ‘erase in’ deletes all structures inside the marked region. The
option of ‘erase out’ deletes all structures outside the marked region.
The option of ‘erase outside’ deletes all structures outside the marked region.
The region in the rendered image is marked with the Enter key. To define the
contour of the region, press the right Set key for each vertex. To close the
contour, double click the Enter key. As long as a contour is not closed, it can
be traced back with the left Set key. The cut out process can be undone by the
Undo Last function.
As soon as the Apply button is pressed, a new dataset is generated and the cut
is permanent
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3D Parameter Description

Active Data Manipulations of rendering parameters only have an effect on the data defined as
Active Data. After having selected Active Data, a list of data is displayed, Gray
Data or Inversion. Choose the data to be manipulated.
Active Data is only available when you select multiple items in Visible Data.
NOTE
Inversion Mode is only available for Black-and-White mode.

Visible Data After selecting Visible Data, a list of data is displayed, Gray Data or Inversion.
Choose the data you want to display. For example, if only Inversion is chosen,
the B-Mode image is switched off in the rendered image and only inversion mode
is displayed.

Define Axis For certain display and measurement modes (Angular Plane Mode, Angular
Volume Measurement Mode), an axis in the volume of interest is required. To
define the axis, set the start point by using the Trackball to position one end of
the axis and pressing the Enter key, then positioning the other end of the axis
and pressing the Enter key.

Group Planes Selections: Off, Main, Parallel
Off. A VOI or a rendered image is displayed. The Render button changes
between the rendered image view and the view of the VOI. The VOI shows the
acquired Ultrasound images transformed into an isotropic rectangular coordinate
system.
Main. Three orthogonal cuts (with colored frames) of the acquired VOI are
displayed after pressing Main. The VOI shows the acquired ultrasound images
transformed into an isotropic rectangular coordinate system.
On the left top of the image a complete VOI is displayed. It shows the position
of the three orthogonal planes in the VOI. A green point displayed in each plane
defines the point of intersection of the three planes. This point can be set to
different positions in the planes by double clicking the Enter key. A plane can be
moved parallel in the VOI by pressing the Enter key on the position of the green
point and moving the Trackball up and down inside the plane.
Parallel. In this mode all displayed VOIs get the orientation of the last modified
volume. Normally four VOIs are displayed. It is possible to display six VOIs by
increasing the number of displayed volumes in the Tile area. Between the first
and the last VOI, the selected planes are parallel and equidistant. A modification
on the plane in one VOI results in a parallel modification of the planes in all other
VOIs.
To move these planes, press and hold down the Enter key while moving the
Trackball.
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3D Parameter Description

Type 1/2 Defines the rendering modes. Selections: Gray Surface, Texture, Maximum
Intensity, Minimum Intensity, Average Intensity, and None. If both Type 1 and
Type 2 rendering modes are switched on, the mixture of both modes can be
defined.
Gray Surface. Activates the gray surface rendering mode. It leads to a opaque
appearance of the object, generated by displaying only a surrounding shell of
anatomical structures. Adjust Threshold and Opacity as well.
Texture. Activates the texture of photorealistic rendering mode. It creates a
photorealistic appearance of the object. The shading depends on the orientation
of the surface of the object. Adjust Threshold and Opacity as well.
Maximum Intensity. Transparent appearance of the object. Generated by
displaying the maximum gray values in the VOl.
Minimum Intensity. The rendered image is generated by displaying the lowest
gray values in the VOl that exceed the defined threshold. Dark anatomical
structures, like cysts, can be shown in this mode.
Average Intensity. Transparent appearance of the object. Generated by a
summation of the gray values.
None for Type 2. No second rendering mode is used in addition to the Type 1
rendering mode.

3DLandscape Shows a combination of 2D slices and a 3D rendered image. After a color
acquisition you can combine the 2D B-Mode image slices with a 3D rendered
color image. This mode allows stepping through the B-Mode images along a
vessel structure.
The 2D slice can be moved with the Enter key. The Trackball symbol has to be
positioned inside the 2D plane.
3DLandscape is only available with a color acquisition image.
3DLandscape is greyed out in the Menu Select pull-down menu with Black-and-
White mode acquisition image.

Render Changes between the rendered image view and the view of a volume of interest.
The volume of interest shows the acquired ultrasound images transformed
into an isotropic rectangular coordinate system. The volume of interest can be
manipulated as described above.

Reslice Selections: Cube, Virtual Rescan, and Cubic Plane.
Cube. The VOI shows the acquired ultrasound images transformed into
an isotropic rectangular coordinate system. This mode allows you to work
simultaneously with six cut planes.
Virtual Rescan. The marked cut planes under Reslice Cube (red border) is
displayed without any perspective distortions, e.g., parallel to the screen. This
allows you to move through the volume one slice at a time in any direction.
Cubic Plane. Only one cut plane view is shown in a perspective displayed VOI.
The cut plane can be moved freely without any limitations.

Overwrite
User1/2/3

Overwrite the application presets defined in 3D Acquisition.

Comments To initiate the comment mode on the 3D image.
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Movie 3D

Descriptions and instructions for using Movie 3D follow
Table 6-19 Movie 3D Descriptions and Instructions for Use

3D Parameter Description

Manual An animated rotation of the rendered image can be calculated and displayed
by this function. Using this function, you first need to define the start and end
position of the rotation. To define this, move the VOI to the start position, the
press Define Start. Move the VOI to the end position and press Define End.

Movie 360 The calculation and display of a complete rotation around the axis, defined by the
Axis button, starts in steps of 15 degrees.

Auto Movie Initializes the calculation and display of a 3D movie. A rotation of 30 degrees
left and right around the actual image position (either the default position after
acquisition or the position that was manually defined by manipulating the 3D
volume of interest) is shown. For this 60 degree rotation, eleven images in steps
of 6 degrees are calculated.

Axis All rotations (Auto Move and Movie 360) are calculated as rotations around the
specified axis (X, Y, or Z).

Movie Speed You can adjust the speed of any 3D rotation.

Pause Stops and restarts the rotation. As soon as Pause is pressed, the different
rotation steps can be displayed by moving the Trackball.

Colorize/Contrast Colorizes the 3D render or adds contrast to the 3D rendered image.
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Elastography (Option)

Elastography shows the spatial distribution of tissue elasticity properties in a region of interest
by estimating the strain before and after tissue distortion caused by external or internal
forces. The strain estimation is filtered and scaled to provide a smooth presentation when
displayed.
Below is an example of Elastography. The Elastography color map/bar appears, this image
appears in dual image mode, and Elastography imaging parameters appear on the right side
of the screen as E.
Elastography can be activated via the User defined key on the Control Panel or on the touch
panel.
Elasto is only available on Linear and Convex probes.

Figure 6-30 Elastography Example

1. Color Map
2. Color Bar

Activating Elastography

Table 6-20 Elastography Parameters Description

Parameter Description

Axial Smoothing Controls the smoothness of the elastography image in the axial direction. A
higher value means a smoother image.

Lateral Smoothing Controls the smoothness of the elastography image in the lateral direction. A
higher value means a smoother image.

Window Controls the RF data segment size for the motion tracking. A higher value of
Window gives a better signal to noise ratio (SNR) at the cost of axial resolution.
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Parameter Description

Map Controls the elastography maps. Six different maps are available with various
contrast and color schemes, including a gray scale map.

Frame Average Controls the persistence of the elastography images.

Frequency Controls the transmit frequency.

Soft Compress Individually controls the image enhancement for the softer than average tissues.

Hard Compress Individually controls the image enhancement for the harder than average tissues.

Scale Controls the time interval between consecutive firings. A lower value dictates a
higher sensitivity to weak manual motion.

Transparency High values bring out the tissue behind the elastography data. You adjust via the
Color Gain control; this imaging parameter appears as a “T” on the right-hand
portion of the display.

Biopsy Kit Biopsy Kit.

Sample Vol Controls the transmit pulse length. A higher value means longer transmit pulse
which gives better SNR but reduces axial resolution.

Frame Reject Controls how many frames get rejected due to low quality vertical motion. A
higher value means more frames get rejected. A rejected frame has a completely
transparent ROI with the B-Mode background showing through.

Noise Reject Controls how many frames get rejected due to lateral and elevational motion. A
higher value means more frames get rejected. A rejected frame has a completely
transparent ROI with the B-Mode background showing through.

Line Density Optimizes B-Mode frame rate or spatial resolution for the best possible image.

How to Use

The Elastography image is achieved by pulsating the probe while you are scanning the
anatomy of interest. Here are some criteria to use:
Handheld elasticity imaging can be very dynamic as the size of distortion depends on the
movement of the hand-held probe. To maintain stable and consistent displayed strains, pay
attention to the Quality graph. Two forms of feedback are provided. In either form, an ideal
manual compression is indicated by a high value feedback. In addition, apply the following
post-processing controls: Smoothing, Window, Scaling, and Frame Averaging.
Elastography displays harder tissue in blue and softer tissue in red. To enhance Blue
area, increase Hard Compress; to enhance Red area, increase Soft Compress. To enhance
elastography contrast, reselect the Color Map.
If you need more resolution, increase Smoothing, increase Frequency, reduce Sample
Volume, or reduce Window.
If you need a smoother image, increase Window, Axial Smoothing, Lateral Smoothing, and
Sample Volume.
If the images seem too flashy, decrease Frame Reject to 1.0 and Noise Reject to have
consistent imaging throughout.
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Additional Notes for Elastography

NOTE
Elasticity Index is not available in the United States.

Definition. Elasticity index (E) is defined as the value from 0.0 to 6.0. This index shows the
color distribution within the measured circle (ROI) relative to the whole ROI box. A higher
value means “higher stiffness” and “blue color is dominant”.

Figure 6-31 Elastography Quantification Definitions

Elasto Raw Data has two data sets of index and color for each pixel. Therefore, this index is
not affected by the color appearance change (color map and hard/soft compression). Index
detects smaller strain difference of hard region by a assigning wider dynamic range for a
smaller strain.
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2D Measurement. Measures the elasticity index of a single ROI and calculates the ratio
between two ROIs. You can label two different regions. You can also set the ROI on a
reference screen (B mode) with dual screen.

Figure 6-32 2D Measurements

HINTS

• This is a relative quantification tool based on freehand manual palpation technology. It
cannot show the stiffness by the kPa (kilopascal).

• There is no compatibility among manufacturers regarding the value. It depends on their
strain imaging technology and definition of the value.

• Colors indicate degree of stiffness and do not directly correlate to a specific tissue type.
Interpretation of what the tissues are and how to apply these ratios clinically is at the
discretion of the user.

• Elastography physics dictates that cystic structures will be displayed with a three-layer
pattern. This three-layer pattern will start with blue on the ultrasound system factory
default map (which corresponds to hard), then progresses to green and then to red
(which corresponds to soft). The posterior displacement of elastography patterns also
may cause the B-Mode cyst to consist primarily of blue with the green to red being
posterior to the B-Mode cyst. You need to be aware of the three-layer pattern of a cyst in
elastography. Utilizing elastography quantification and setting the ROI in the blue portion
of the three-layer pattern on the cyst and then setting the ROI in the “normal” tissue may
cause you to misinterpret the elastography quantification ratio as the cyst to be hard as
compared to the “normal” tissue.
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Contrast Imaging (Option)

NOTE
Please be advised that Contrast imaging MAY NOT BE available on your system. Contrast
agents for radiology use are not yet available.

CAUTION
Contrast Imaging is not available in USA.

WARNING
Appropriate training

Only physicians or echo technicians who have received appropriate training can use the
Contrast applications.

WARNING

Please use appropriate contrast agent.
Misdiagnosis based on image artifacts.
Misdiagnosis in ultrasound contrast images may be caused by several artifacts, most
importantly:
Motion artifacts: gives rise to signals independently of contrast presence. This may be
caused by patient movement; including respiration, or by probe movement influenced by the
operator.
Regional drop outs: caused by unintentional destruction of the contrast agent, too low
concentration of contrast agent, poor acoustic penetration due to rib/lung shadows or system
failing to detect the contrast agent due to erroneous settings induced by the operator.
Tissue harmonics: gives contrast-like signals independently of the presence of contrast
agent.

CAUTION
Cardiac rhythm disturbances during perfusion studies using gas ultrasound contrast agents
have been observed in the diagnostic range of Mechanical Index (MI) values and that, for
details, to see the specific package insert for the contrast agent being used.

WARNING
Read and follow contrast agent instructions provided by the manufacturer.

NOTE
The ultrasound system is designed for compatibility with commercially available ultrasound
contrast agents. Because the availability of these agents is subject to government regulation
and approval, product features intended for use with these agents may not be commercially
marketed nor made available before the contrast agent is cleared for use. Contrast-related
product features are enabled only on systems for delivery to an authorized country or region
of use.

By adjusting the acoustic output, you can enhance either contrast harmonics or stimulated
acoustic emission (SAE).
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Benefits
Injected contrast agents re-emit incident acoustic energy at a harmonic frequency much more
efficiently than the surrounding tissue. Blood containing the contrast agent stands out brightly
against a dark background of normal tissue.

Clinical Use
Possible clinical uses are to detect and characterize tumors of the liver, kidney, and pancreas
and to enhance flow signals in the determination of stenosis or thrombus.

Affect on other controls
The default acoustic output adjusts for contrast imaging and the Power Output key provides
more subtle gradations for use while in contrast imaging. When you exit Contrast Imaging,
the system returns the acoustic output to its original setting. When you reactivate Contrast
Imaging, the system enters the default Contrast Mode.
Most system controls are available (Depth, Zoom, Colorize, etc.). However, some controls
are not available (Anatomical M Mode and Rejection).
Controls adjusted while in Contrast Imaging retain these values when you exit Contrast
Imaging (except for post-processing controls).

Bioeffect
Activating Contrast Imaging may change the TI and/or MI. Observe the output display for
possible effects.

Feature Availability
3D is available; Multi Image and LOGIQView are not available.

Probe
Contrast is available on 4C-RS and C1-5-RS probes in abdomen and pediatric applications,
L3-12-RS probe in vascular / Peripheral Vascular and Small Parts applications and IC9-RS
probe on gynecology and urology applications.

Mode

Reference Mode
Reference (Ref) Mode is to image the anatomical reference, not the contrast enhancement.

Contrast Mode
There are several contrast imaging techniques. Note that the appropriate imaging technique
may vary by agent and application. In other words, the imaging technique is not dedicated for
the agent and vice versa.

Parameters

You can be preset almost controls in the Utility --> Imaging --> CON or Ref Tab.
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Single View/Dual View

Description
Single View displays the active Contrast image only.
Dual View displays the active Contrast image and the reference image simultaneously.

Visualization

Description
Define the display technique.

Values

• Contrast. Displays the contrast-enhanced image.
• Tissue. Displays the tissue image.
• Hybrid Contrast. Displays the contrast-enhanced image and the tissue image using

Hybrid Map.

Visualization/Map Indication

Visualization/Map Indication

Figure 6-33 Imaging parameter

1. Gray/Colorize Map for current visualization.
2. Visualization: C=Contrast, T=Tissue, HC=Hybrid Contrast

Hybrid Map
Select the hybrid map for the Hybrid Contrast visualization in the Dual/Hybrid Display.

Gray Map
You can select a map for the contrast image and reference tissue image independently.
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Adjusting
Press Gray Map and select the map in each tab.

Contrast Color
Select the color map for the Contrast mode image.

Adjusting
Press Colorize and select the map.

Contrast only
Only transmit and receive the acoustic power signal for the contrast-enhanced image.

Adjusting
Press Contrast Only.

Frequency
Select frequency type for each contrast technique.

Adjusting
Frequency can be preset in the Utility -> Imaging -> CON.

• Frequency (AM): Res, Gen, Pen

Sonazoid
If you use Sonazoid for Contrast agent, you have to check Sonazoid in Utility > Imaging >
CON.

Target MI
Target MI Control provides the automated adjustment of the acoustic output to keep the
specified target MI value to reduce the unexpected results on the contrast exam.
Target MI control can be preset in the Utility > Imaging > CON and Ref.

Accumulation
Accumulation enhances the flow in an image.
If Accumulation is turned off, then Frame Averaging is used; if Accumulation value is set, then
Accumulation is used.

Availability
Available in Contrast, Color Flow, PDI, and B-Flow.

Benefit
Accumulation detects the maximum signal and holds it for the level specified.

Max (Maximum) Enhance
Sets the acoustic output to its maximum setting (100%)
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Values
On/Off. When you deactivate Max Enhance, the acoustic output is returned to its previous
setting. Max Enhance is deactivated by the system when you turn it off, change probes, or
change the contrast technique.

Benefits
This control provides quick transition to High MI imaging. This allows the user a quick one-
button push to destroy the agent. Useful when the user is interested in the bubble wash-in
characteristics of the anatomy being scanned.

Trigger
The Contrast Trigger scans images at set intervals, delaying imaging according to the time
delay that you specify.

Adjusting
On/Off. Press Trigger assigned rotary.

Time Delay
The Contrast Trigger scans images at set intervals, delaying imaging according to the time
delay that you specify.
Rotate Time Delay assigned rotary.

Adjusting
Set the default seconds of Time Delay in Utility > Imaging > Con.

Flash
Description

This feature provides a way to expose the higher acoustic power for a specified time duration
by pressing a control once.

Adjusting

Select Flash on the Touch Panel.

NOTE
Set the frame numbers to scanned with the higher acoustic power in Utility > Imaging >
Con > Flash Frames. The frame numbers defined by Flash Frames are applied to both the
contrast imaging modes.

• If you select Flash once in the Con menus, the system scans with 100% acoustic output
burst pulses for the specified number of frames. The acoustic output then reverts to the
original settings.

• When Max Enhance is ON for the contrast imaging modes, the system keeps Max
Enhance = ON with no acoustic output change when Flash is selected in the Con menu.

Contrast Clock (Timer)
You can use the Contrast Clock by activating it at the time of injection and deactivating it at
the end of the exam.
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Two timers can be displayed on the bottom-left corner in image area and info area for several
injection.

NOTE
You can also configure the system to perform a countdown for the contrast injection with the
Utility > System > System Imaging > Countdown Time for Contrast preset.

Adjusting

1. Press Contrast Clock 1 to start/stop the T1 timer.
2. Press Contrast Clock 2 to start/stop the T2 timer.

Display
There are two areas on the screen where the Contrast Clock displays: on the image and on
the lower, left-hand portion of the display. The timer on the image freezes when you freeze
the image (the timer updates when you unfreeze the image). However, the timer located on
the lower, left-hand portion of the display continues to display over a freeze, probe change,
mode change, multi image, and zoom.
The timer also appears on CINE Loops and archived images.

Benefits
The Contrast Clock measures the time since injection.
You can save the data of contrast clock to an external file by using Export Traces of TIC.

1. Press Freeze. Scroll with the Trackball to show Cine tab.
2. Press TIC Analysis on the Touch Panel to enter TIC application.
3. Put a ROI on the image.
4. Press Export Traces. Type the file name and store it to the storage device.

Relationship with other controls

• L + R Simultaneous Display (L: Tissue, R: Active Visualization)

• Accumulation/Cine Capture

- Applied on the right side image only.
- You cannot compare On and Off image using L + R.

• SRI-HD

- Applied on both side image.
• Frame Average

- Applied on both side image.

• TIC

• Measured on active visualization, except “Hybrid Contrast”.
• “Hybrid Contrast” is disabled and measured on “Contrast” visualization.

• Easy 3D
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• Build volume data from active visualization, except “Hybrid Contrast”.
• Hybrid map is disabled and forces “Contrast” visualization.

• Archive

• The raw data size increases between two to three times the size compared to the
previous raw data. It takes a longer period of time to save as Cine.

Time Intensity Curve (TIC) Analysis

The basic TIC process works as follows

1. Scan the patient after injecting the contrast agent.
2. Watch the agent flow through the anatomy of interest.
3. When the desired contrast effect has been visualized, freeze the image and select a

range of images for analysis.
4. Position an ROI (region of interest) on one of those images where the contrast effect is

visible.
5. The system then calculates the mean pixel intensity within that ROI for all frames in the

user designated loop and plots the resulting data as a function of time.

You can also choose to fit this data to one of several mathematical functions. The
fundamental idea is that the contrast effect flowing through the organ of interest can be
modeled mathematically, and details of the wash in and washout of the agent can be gleaned
by analyzing the numerical parameters of the mathematical model.

Activating TIC

1. Scan the patient in Contrast mode or select a desired cine loop from the stored images.
NOTE
Images from the current scan session (already in CINE) or from a saved image loop can
be used for TIC analysis.

NOTE
TIC analysis is only available if the user has selected an image loop. If the user has
selected a saved still image (just one frame), TIC analysis is not available.

2. Press Freeze. Move the Trackball
NOTE
The TIC package is only available when the system is in FREEZE mode.

3. TIC Analysis displays on the Cine Touch Panel.
NOTE
Subsequent TIC processing is done on the images stored in CINE memory.
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4. Select TIC Analysis. The TIC Analysis screen and Touch Panel displays. To toggle the
trackball function between QA and Scroll, press Scan Area key.

Figure 6-34 TIC Touch Panel

Table 6-21 TIC Touch Panel Description

Parameter Description

Max Gradient Between the CINE Start and End frame, displays the time and gradient
that becomes the maximum gradient.

Accumulation Enhances the flow in an image.

Disable Frame The current frame is excluded from the CINE Loop display.

Enable All Frames Re-enables disabled frames.

Horizontal Sweep Allows you to increase/decrease the time interval over which to plot the
TIC curve.

Smoothing Smooths the trace displayed by applying a filter over a defined time
window. Both the filter type and time window are user-selectable. The
type of filter available depends on the analysis signal displayed.

Delete Sample Area Removes selected sample area from the CINE Loop window and
accompanying trace in the Analysis window. The Trackball marker must
be pointed at an anchored sample area.

Export Trace Saves trace data in ASCII format, readable in spreadsheet programs. If
present, trace data for physiological traces are also exported.

Curve Fitting Toggles between Wash-In, Wash-Out, and Off.

Set Sample Area Shape Enables resizing of a selected sample area by setting height, width, and
tilt angle. The Trackball marker must be pointed at an anchored sample
area.
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NOTE
The CINE Touch Panel is available to use when in TIC Analysis mode. CINE Touch Panel
controls retain their traditional functions. While the CINE Touch Panel is on the top level, the
Trackball and other imaging controls perform as they usually do in standard CINE mode.

Exiting TIC Analysis
There are several methods to exit TIC Analysis.

• Select Exit TIC Analysis on the TIC Touch Panel.
• Press Freeze to unfreeze and resume scanning.

TIC Analysis Screen Description

Figure 6-35 TIC Analysis Screen

Table 6-22 QAnalysis Screen Description

1. Contrast Cineloop Window
Sample Area: Indicates sampling position of the intensity (contrast) trace. The sample area is
color-coded: the first sample area is yellow, the second green, etc.
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2. Displays time-intensity curve.

• Y axis: Intensity scale (logarithmic) (db) or linear acoustic units (AU).
• X axis: Time(s) or Dt(s), elapsed time from previous frame.
• ECG (where available -- not shown), Frame Marker: displays ECG trace (where available),

the current frame marker and the start and stop markers for the cineloop.
• Time at cursor position and velocity at cursor position.
• Intensity (dB or AU) at cursor position.
• Intensity (dB or AU) at frame marker position (color coded)

3. Sample Area Tools.

• Pencil Icon: Creates a sample area based on freehand drawing.
• Shape Icon: Creates a sample area with a pre-defined circular/ellipse shape.

System Menu
The System menu on the monitor display can be used instead of the Touch Panel.

Analysis Window System Menu

Position the cursor over the analysis window and press the System Menu rotary. The
Analysis Window system menu displays at the cursor position.

NOTE
The system menu is dependent on mode.

Figure 6-36 Analysis Window System Menu - example
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ROI System Menu

Position the cursor on the ROI and press the System Menu rotary. The ROI system menu
displays at the cursor position.

Figure 6-37 ROI System Menu

Frame Marker System Menu

Position the cursor on the Frame Marker in the Analysis Window and press the System
Menu rotary. The Frame Marker system menu displays at the cursor position.

Figure 6-38 Frame Marker System Menu

Selecting TIC Analysis Image Range
A range of frames is selected for the TIC analysis in Cine mode (before accessing TIC
Analysis). Only the frames in this range are used for the TIC analysis.
If a range is not selected prior to accessing the TIC Analysis, the system uses the default
Cine start and end frames as the default TIC start and stop frames.

1. The first frame in the analysis series is selected by adjusting the Start Frame control to
the desired frame
OR
using the Trackball or the Frame by Frame control to select the desired first frame and
then selecting the Start Frame control.

2. The last frame in the analysis series is selected by adjusting the CINE End Frame
control to the desired frame
OR
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using the Trackball or the Frame by Frame control to select the desired last frame and
then selecting the End Frame control.

Generating a Trace
Up to eight traces can be generated.

About the sample area

The sample area can be in three different states:

• Free sample area: freely moving sample area (QA cursor) before anchoring.
NOTE
The free sample area disappears when the QA cursor is moved over a static anchored
frame.

• Static sample area: the free sample area is anchored by pressing Set.
• Dynamic anchored sample area: the sample area is anchored in two or more frames

(see Manual tracking below). In these particular frames, the sample area is displayed
with an anchor. The sample area moves smoothly between the anchored positions when
playing/scrolling the cineloop.

Trace from a pre-defined sample area

1. Press the Scan Area on the control panel to select QA function for trackball.
2. If necessary, select the sample area Ellipse ROI button (shape icon on the monitor

display).
3. Move the cursor to one of the Cineloop windows using the Trackball.

The cursor is changed to a sample area (white circle). A preview of the trace is displayed
in the Analysis window.

4. Press Set to anchor the sample area.

In this frame, the sample area is marked with an anchor. If the cineloop has more than
one heart cycle, a sample area will also be anchored in the corresponding frame in the
next heart cycle.
The trace is updated accordingly in the Analysis window.

Trace from freehand sample area

1. Select the Freehand ROI button (pencil icon on the monitor display).
2. Move the cursor to one of the Cineloop windows using the Trackball.
3. Trace the outline of the desired ROI by moving the caliper with the Trackball.
4. Press Set to anchor the sample area.

The sample area is automatically closed and the trace is updated accordingly in the
Analysis window.

Manual tracking of the sample area (dynamic anchored sample area)
The sample area can be moved within the loop to ensure that data in the trace is generated
from the same anatomical location during the cyclic motion of the heart.

Chapter 6

Versana Premier/Versana Premier Lotus - User Manual 419
5928218-1EN Rev. 6



1. Place a sample area over a region of interest. Note the anatomical location of the sample
area.

2. Scroll to a new frame using the Trackball.
3. Press the Scan Area on the control panel to select QA function for trackball.
4. Move the cursor to the sample area using the Trackball.
5. Press Set. The sample area is unanchored.
6. Drag the sample area to the corresponding anatomical location in the new frame.

When the sample area is anchored in more than one frame, linear interpolation is
performed so that the sample area is smoothly moved between the anchored positions in
the selected frames when running the cineloop.

NOTE
In the original frame and this particular frame the sample area is marked with an anchor.

7. Press the Scan Area on the control panel to select Scroll function for trackball.
8. Using the Trackball, scroll through the cineloop and control that the sample area follows

the moving anatomical structure.
9. Add anchored sample areas in several frames to obtain a more accurate displacement of

the sample area.

Moving a dynamic anchored sample area

1. Freeze the image.
2. Press the Scan Area on the control panel to select Scroll function for trackball.
3. Using the Trackball, browse through the cineloop to display one of the frames where the

sample area was anchored.
NOTE
In these frames, the sample area is marked with an anchor.

4. Press the Scan Area on the control panel to select QA function for trackball.
5. Move the cursor to the sample area using the Trackball.
6. Press Set. The sample area is unanchored.
7. Drag the sample area to a new location.
8. Press Set to anchor the sample area to the new location.

If you want to move the sample area to the same depth, select Move (same depth) from
the System Menu.

Zooming in the Analysis window
To zoom:

1. In the Analysis window, press and hold down the Set key while dragging the cursor to
define the zooming area.

2. Release the Set key.

To unzoom:

Advanced Features

420 Versana Premier/Versana Premier Lotus - User Manual
5928218-1EN Rev. 6



1. Press the Cursor key in the Analysis window. The system menu displays.
2. Select Unzoom.

NOTE
Shown only in zoom mode.

Delete a trace
The user can delete all traces at once or one at a time.

1. If necessary, press the Scan Area on the control panel to select QA function for
trackball.

2. Move the cursor over one of the sample area. Confirm that cursor is changed to hand
icon.

3. Press the Delete Sample Area on the touch panel.
4. Select Current Sample or Delete all as necessary.

Disabling/Enabling the frame
Frame disabling excludes the actual frame from the cineloop display. Frame disabling is
available only with contrast data.

Disabling the frame from the frame marker

To disable One Frame :

1. Use the Trackball to move the cursor to the frame maker to disable.
2. Press Set to disable the frame.
3. The frame marker is changed from green to red to indicate the frame has been disabled.

NOTE
The disabled frame is no longer displayed in the reference window when scrolling
through CINE memory.

Disabling multi-frames from the frame marker

1. Use the Trackball to move the cursor to the first frame maker to disable.
2. Press and hold down Set
3. Move the cursor with the Trackball to the last frame to be disabled and release Set.

The marker is turn red and the data from that frame is removed from the trace and any
subsequent trace processing.

Disabling a frame from the cineloop window

1. Use the Trackball to move the cursor to the cineloop window.
2. Press the System Menu rotary. The system menu displays.
3. Select Disable frame.

The current frame is disabled and the corresponding frame marker displays red.
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Disabling ECG triggered frame (where available)

In a multi-cycle acquisition, the user may deselect all frames in all heart cycles but a selected
one. This function can be used for example to select a particular systolic frame for each heart
cycle.

1. Scroll through the cineloop to identify the cardiac phase to analyze or identify the cardiac
phase on the ECG trace (where available).

2. Position the cursor on the ECG trace (where available) and press System Menu rotary.
The system menu displays.

3. Select ECG triggering (where available).

All frames in all heart cycles are disabled except for the selected and corresponding
frames in the other heart cycles.

To enable the frames

To re-enable all deleted frames :

1. Position the cursor on the Frame Marker line and press the System Menu rotary. The
system menu is displayed at the cursor position.

2. Select Enable all frames.
3. All disabled frames are re-enabled.

Figure 6-39 Frame markers

4. Analysis Window
5. Frame markers axis
6. Enabled frame (Green)
7. Disabled frame (Red)
8. ECG (where available)
9. Current frame

Manipulating the Sample Area
Up to eight ROIs can be saved on the reference image, with the corresponding eight
traces plotted simultaneously on the graph. Each ROI display has a different color, and its
corresponding trace data is plotted using that same color.
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Once eight ROIs have been saved, the system does not automatically generate an active
ROI when the cursor is positioned over the displayed reference image.
The saved ROIs can be a mixture of elliptical and freehand ROIs.
When the user repositions an ROI, the old trace data is erased from the plot and the trace
data for the new position replotted.
If the ROI position on the last frame of the selected image range is moved, the corresponding
ROIs on all frames are repositioned to match the last frame.
The user shall also have the capability of setting separate ROI positions on different frames
of the contrast images, and the system shall linearly interpolate the ROI positions for the
frames in between the selected frames.

Setting the default sample area shape

1. Select Set sample area shape. The Information Box displays.
Figure 6-40 Sample Area Information Box

2. Select Height, Width and Tilt angle.
3. Select Set as default. The current ROI size is set as the default for subsequent Ellipse

ROIs.

Reshaping a Sample Area

To reshape the sample area:

1. Position the cursor on the ROI to reshape and press the System Menu rotary.
2. The ROI system menu displays. Select Set sample area shape.
3. Adjust Height, Width and Tilt angle.
4. Press OK. The selected ROI size changes.

Labeling a Sample Area

The sample area label is used to identify data associated with the sample area when
exporting.

1. Position the cursor on the ROI to label and press the System Menu rotary.
2. The ROI system menu displays. Select Label sample area. The Label Dialog box

displays.
3. Enter a name for the sample area.
4. Select OK.
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Sample Area Shapes

There are two different methods for determining the shapes of the sample area.

Ellipse ROI

1. Select the ellipse icon (shape icon on the monitor display).
2. When the trackball positions the image display cursor over the reference image(s), an

elliptical ROI is automatically generated and displays on the reference image(s).
3. The average intensity value inside the ellipse is calculated for every image in the image

analysis range and plotted in the image display area.
4. The last generated or selected ellipse is considered the active ROI, and its trace plot

automatically updates as the user repositions it on the reference image. Old traces are
erased.

5. When scanning with an elliptical ROI, press Set to fix the ROI position and freeze
its corresponding trace on the plot. A new active ROI is generated whose position is
manipulated by the trackball and whose time-intensity curve traces will be plotted as
before, while the previous ROI and trace remain fixed at the points they were saved at.

NOTE
Elliptical ROIs can be positioned in any manner that keeps their center within the image
boundaries. In the case that part of the ROI is outside the image boundary, only data from
within the image boundary is used for calculating the mean intensity value.

NOTE
You can change the size of the Ellipse ROI by adjusting the Ellipse control.

Freehand ROI

1. Select Freehand icon (pencil icon on the monitor display).
Use the Trackball to position the caliper on the reference image at the start point. Press
Set to fix the start point.

2. Trace the outline of the desired ROI by moving the caliper with the Trackball.
3. When a suitable ROI has been drawn, press Set a second time.

The system automatically links the start point to the end point by drawing a straight line
between them. The caliper is then free for repositioning for another freehand ROI.

NOTE
You cannot go outside the image boundary when drawing a freehand ROI.

Copy, move and paste a Sample Area

To copy and paste the ROI,

1. Move the cursor over the ROI and press the System Menu rotary. The system menu
displays.

2. Select Copy sample area.
3. Move the cursor to the desired location for the copied ROI and press the System Menu

Key. The system menu displays.
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4. Select Paste sample area.

To copy and move the ROI,

1. Move the cursor over the ROI and press the System Menu rotary. The system menu
displays.

2. Select Copy & move. Or if you want to move to the same depth as the original ROI,
select Copy & move (same depth).

3. Move the copied ROI using the Trackball. Press Set to fix the position.

Deleting a Sample Area

Sample ROIs and their corresponding traces can be deleted using Delete Sample Area.

1. Select Delete Sample Area; a pull-down menu displays.
2. Select Current sample to delete the currently active ROI.

Select Delete all to delete all currently set ROIs and all of their traces.

NOTE
The corresponding traces for the deleted ROIs are erased from the plot.

NOTE
Deleting an ROI causes the ROIs to be deleted from all frames in the analysis loop.

TIC Plot Control
The following controls are user configurable presets which are configurable via the Utility
Menu or through the pull-down menu in TIC Analysis mode. When using the pull-down menu:

1. Position the cursor over the analysis window and press the System Menu rotary. The
system menu displays at the cursor position.

2. Select the appropriate parameter.

Vertical Unit

When analyzing the contrast data, the Y-axis can be set to display either logarithmic scale
(dB) or linear, acoustic units (AU) for both tissue intensity (2D) or Angio intensity data.
To toggle between dB and acoustical display units for the Y-axis.

• dB—The traditional log compressed B-mode data is used to calculate the time-intensity
curve values.
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• Acoustic—The system reverse the log compression function to provide un-log
compressed data for the TIC analysis.

Figure 6-41 Vertical Unit Pop-up menu

Vertical auto-scaling

The system can be configured to display the full unit range or a range according to the
maximum and minimum values of the displayed trace(s) (auto-scaling function). In addition,
the auto-scaling function can be set to be live update (updates while the sample area is
moved) or delayed (updated when the sample area is anchored).

• Delayed—The system automatically rescale the vertical axis of the trace graph only
when a new ROI is saved, to account for changing input dynamic range.

• On—The system automatically rescale the vertical axis of the trace graph every time the
currently selected (active) ROI is moved.

• Off—Disable any automatic scaling of the vertical axis. There is user-defined system
defaults on the system preset page for the fixed vertical scale to be used for the plot.

Figure 6-42 Vertical Autoscale Pop-up menu
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Line Style

• Solid—Setting the results in a plotted trace that does not display small boxes at the data
points

• Squares—Setting the results in a plot where small squares are displayed at each data
point, and the squares are linked together by lines.

Figure 6-43 Line style Pop-up menu

Horizontal Sweep

Horizontal Sweep allows you to increase or decrease the time interval over which to plot the
TIC curve.
The default is the user selected image range. If the user has not yet selected a first and last
frame, the first and last default frames from the displayed CINE loop are used.

Smoothing

The system can smooth the traces displayed by applying a filter over a defined time window.
The type of filter available is depending on the analysis signal displayed.

1. Select Smoothing.

OR

Position the cursor over the analysis window and press the System Menu rotary. The
System menu is displayed at the cursor position. Select Smoothing.

NOTE
When smoothing is turned on, it applies to all traces in the plot window.

2. The smoothing filter list displays. Select the appropriate parameter.
NOTE
If ‘dt’ is selected for Horizontal Scale, you cannot use Smoothing.
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Trace Measurement
Gradient

Gradient is displayed on the screen instead of Intensity (db or AU). The gradient calculates
from 7 points (includes previous and next frames).

Figure 6-44 Gradient

Show graph (Gradient plot)

1. Gradient Plot displays on the TIC system menu.
Figure 6-45 System Menu

2. Select the parameter.

• Off: A graph plots TIC.
• Gradient: Two graphs plot TIC and TIC gradient.

- Unit of Y-axis is dB or AU in case of intensity.
- The unit is d(dB)/dt or d(AU)/dt in case of the intensity gradient.
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- Gradient values for the current frame are displayed in the upper right corner of the
graph.

Figure 6-46 Gradient

• Gradient Derivative: Two graphs plot TIC and TIC gradient derivative.

- The Y-axis units is d2(dB)/dt2 or d2(AU)/dts in case of the intensity gradient derivative.
- Gradient derivative values for the current frame are displayed in the upper right corner
of the graph.

Figure 6-47 Gradient derivative
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• All: Three graphs plot TIC, TIC gradient and TIC gradient derivative.

Figure 6-48 All Gradient

Max Gradient
Displays the time and gradient that becomes the maximum gradient between the CINE start
and end frame.

Figure 6-49 Max Gradient

Curve Fit
Curve fitting analysis: for research studies of perfusion rates using contrast agents.

1. Select Curve Fit.
OR
Position the cursor over the analysis window and press the System Menu key. The
system menu displays at the cursor position. Select Curve Fit.
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2. The Curve Fit selection list displays.

Figure 6-50 Curve Fit Selection List

• Off—Remove the fitted curves from the plot and the fit parameters from the display.
• Wash-in—Used to find and estimate the local perfusion rate using the contrast agent.

Exponential wash-in is described by the function:
Y(t) = A(1-exp(-kt))+B, where:

• A (dB or AU) is the intensity from the contrast agent.
• B (dB or AU) is the intensity at time t=0 (defined as the time of the left marker). This

corresponds to the tissue (baseline) signal if no contrast is present at the selected
starting point.

A + B = contrast + tissue = plateau level.
• k (1/s) is a time constant.

• Wash-out—Used to find and estimate a local wash-out rate. Exponential wash-out is
described by the function:
Y(t) = Aexp(-kt)+B, where :

• A (dB or AU) is the intensity from the contrast agent.
• B (dB or AU) is the intensity from the tissue = baseline signal.

A + B is the initial intensity level.
• k (1/s) is a time constant.

• Gamma variate
Y(t) = Atcexp(-kt)+B
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Parameters of Gamma curve fitting

Figure 6-51 Gamma Curve

• tc: Increasing function (C>0) for “Wash-in”.

For larger C, the intensity increases quickly before the peak.
• exp(-kt): Decreasing function (k>0) for “Wash-out”.

For larger k, the intensity decreases quickly after the peak.
• B: Intercept intensity at t=0.
• The peak intensity of the curve is affected by all parameters.

Larger A, larger B, larger C, and smaller k make larger peak. The peak time is calculated
by C/k.

• MSE: Mean Square Error

If the MSE is small, the difference of actual data and the fitted curve is small.

Set Start/End Frame for Curve Fit per ROI position

1. Generate TIC and perform a Curve Fit.
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In this state, the Curve Fit graph is drawn from Cine Start Frame to Cine End Frame for
all the ROIs.

Figure 6-52 Curve Fit screen

a Cine Start Frame
b Cine End Frame

2. Select the Start Frame as with Cine or use the trackball to select Start Frame and press
Set with setting Scroll function to trackball by toggle Scan Area.

3. Set QA function to trackball by toggle Scan Area, move the arrow pointer on the ROI
(hand cursor appears) and press System Menu. The system menu appears.

4. Select Set curve fit start frame from the menu.
5. Select the End Frame as with Cine or use the trackball to select End Frame and press

Set with setting Scroll function to trackball by toggle Scan Area.
6. Set QA function to trackball by toggle Scan Area, move the arrow pointer on the ROI

(hand cursor appears) and press System Menu. The system menu appears.
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7. Select Set curve fit end frame from the menu. The ROI colored line displays.

Figure 6-53 New Start Frame and End Frame (Example)

a Start Frame
b End Frame

8. Repeat the above procedures as necessary.

The system retains the start/end frame per ROI while TIC is active. Once the TIC menu
is closed, the settings are lost.

Display/Hide Calculation Values
You can specify Time to Peak, Area under the curve, Curve gradient, and Arrival time values
for Wash-in, Wash-out, and Gamma Variate curve fitting values.
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1. Select Curve Fitting Parameters on the Touch Panel. The Curve Fitting Parameters
dialog appears.

Figure 6-54 Curve Fitting Parameters Dialog

2. Select a maximum of 5 parameters to display for each curve fitting.

• Save as default: saves as a system preset.
• Save: saves as temporary.
• Cancel

NOTE
If you select more than 5 parameters and select “Save” or “Save as default,” you
will be prompted the message that “More than 5 parameters selected”.
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3. The selected parameter displays below the image with the curve fitting active.

Figure 6-55 TIC image with all selected parameters

Exporting Traces (Saving the Trace Data)
You can save the trace data to an external file.

1. Select Export Traces on the Touch Panel to save the trace data.
OR
Position the cursor to the Analysis window and press the System Menu rotary. The
system menu displays. Select Export traces.

2. The following window displays.

Figure 6-56 Export Trace Window

• Location: Select Location which to save.
• Filename: Enter the filename. (Only Text)
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3. Select OK to save the data and return to the TIC Analysis screen.

• All displayed ROI traces are saved in the exported file.
• The fit parameters are included in the trace file if the user has done a curve fit.

All plot data (intensity, gradient and gradient derivative) are exported to a text file by “Export
Trace”.

Table 6-23 Example of exported file

Time(s): Trace 1: Trace 1 dGrad.: Trace 1 dGrad.

0.00000 -3.97995e+000 -2.15924e+001 8.05159e+001

0.03121 -5.14631e+000 -1.64719e+001 1.74256e+001

0.06242 -5.75798e+000 -1.27675e+001 -7.78004e+001

0.09362 -6.02222e+000 -1.27675e+001 -1.93426e+002

0.12483 -6.11224e+000 -1.44515e+001 -4.17252e+002

NOTE
The Smoothed trace is the one saved if the user has applied a smoothing filter.

NOTE
Only data from the user selected image range is included in the exported trace file.

NOTE
Data for disabled frames are not be included in the exported trace file.

NOTE
No trace results are saved in the standard image database.

NOTE
Trace results are not shown on the Worksheet.

Annotating the TIC Data
The user can annotate both the reference image and the trace plot displays. Use Comment
key to type the annotation. See Chapter 6 for reference.

Printing TIC Data
Press the appropriate print key in the TIC mode.
The system capture a single still frame which consists of the plot, the reference image and
user annotation.
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Needle Recognition (Option)

Needle recognition functionality is available with linear probes (12L-RS, L6-12-RS, 9L-RS,
L3-12-RS, L4-20t-RS), convex probes (4C-RS, C1-5-RS) and bi-plane probe (E7C8L-RS).

Below illustration b illustrates the position between the needle and probe. Needle recognition
can only enhance in-plane needles. The needle angle is defined as the angle between the
needle and probe surface.

Figure 6-57 Enhanced area and Needle Angle

Illustration a Illustration b

1 Enhanced area
2 Needle guide line
3 Unenhanced area

1 Needle
2 Probe
3 Needle angle

NOTE
Needle Recognition is only available in B/CF/PDI.

NOTE
The parameters for adjusting can be set in Utility > System > B. To set the desired
parameters in the Touch Panel for each button.

Adjusting

• Activating Needle Recognition:
Press user defined Needle key on the control panel to activate Needle Recognition.

• Adjusting steer direction:
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Needle key cycles through Off/Left or Off/Right depending on the setting in Utility >
Imaging > B tab. If the system is set for Off/Left/Right, press Needle key again after
activating the Needle Recognition in order to change the steering angle from left to right.

• Adjusting the needle recognition beam angle:
Adjust Beam Angle by rotating the Touch Panel control. Max available angles are up
to 50 degrees on 12L-RS, 9L-RS, L3-12-RS and L4-20t-RS, 45 degrees on 4C-RS,
C1-5-RS and 30 degrees on L6-12-RS, 20 degrees on E7C8L-RS.
Adjust the needle recognition steering angle to form the needle and the beam angle as
perpendicular as possible to get the best needle enhancement.

• Adjusting Needle Gain:

Adjust Needle Gain by rotating the Touch Panel control. Available Needle Gain ranges
from 0 to 100 in the increment of 5.

NOTE
Increasing the Needle Gain enhances the needle visibility while decreasing the Needle
Gain decreases artifacts and noise. Adjust the Needle Gain to balance the needle
enhancement versus level of artifacts/noise.

• Adjusting Needle Thickness:

Adjust Needle Thickness by pressing the Touch Panel control to change the
appearance of needle thickness between thick and thin.

NOTE
"Thick" option displays thicker and more prominent appearance of needle while "Thin"
option displays thinner but more realistic needle appearance.
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NOTE
The beam divergence and effects of beam steering with a transducer may prevent a
segment of the needle shaft from showing in the image if the needle angle is too steep.

Figure 6-58 Example of needle that is too steep

1 Needle shaft
2 Un-enhanced needle shaft
3 Needle tip
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NOTE
For best results please insert the needle at perpendicular to the dotted guide line (Figure
13-83), or at a needle angle that is slightly less than the Beam Angle.

Figure 6-59 Example of needle that is perpendicular to the guide line

Figure 6-60 Example of needle angle that is slightly less than the beam angle
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HINTS

To help verify the location and trajectory of the needle tip, please use needle movement
and / or fluid injection.
Make sure the needle is always in the ultrasound plane by slightly moving or tilting the probe
to get the best needle enhancement during the needle procedure.
Switch needle On/Off can help to identify artifacts and other not interesting structures.
Needle Recognition values (including enable/disable, Needle Direction, Beam Angle and
Needle Gain, etc.) are returned to factory or user preset value when you change: Exam
Category, Exam Calcs, or New Patient.

Preset
Needle Directions - preset via Utility > Imaging > B Tab.
Beam Angle - preset via Utility > Imaging > B Tab.
Needle Gain - preset via Utility > Imaging > B Tab.
Needle Thickness - preset via Utility > Imaging > B Tab.
Interactive Needle line - preset via Utility > Imaging > B Tab.

Benefits
Provides better biopsy needle visualization than normal B-Mode with steered beam angle and
post processing.

Bioeffects
Activating angle Needle Recognition may change the TI and/or MI. Observe the output
display for possible effect.
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Breast Care

Breast Care provides a protocol of breast scanning which helps user to scan breast by 4
Quadrants or 12 O’clock and axillary fossa consistently. User can use ‘P1’ key to follow the
scanning steps that allows user to focus on performing the exam rather than on controlling
the system and can help user to increase consistency while reducing keystrokes. The system
automatically invokes the correct modes, advances to the next step in the exam. After
finishing whole scanning steps, report will be generated.
Breast Care does not perform automatic breast lesion detection or classification. The user is
required to detect and diagnose any breast tissue abnormality, as well as verify any outputs
of Breast Scanning, Breast Lesion M&A, BI-RADS® classification.
Breast care is divided into 3 steps: prepare the patient information, scanning and report.

Prepare the patient information and scanning

Before Perform the scan, user can set up modes, PW, Elasto which can be included in
scanning steps and 4 Quadrants or 12 O’clock, Review Previous Report options in Utility >
System > General > Breast Care.
Example of 4 quadrants scanning steps:

1. User selects the appropriate transducer for breast imaging and select breast preset.
2. Configure Breast Care as a User Configurable key. Press the configured key to start.

Figure 6-61 Breast Care User Configurable key

3. The Breast Care protocol appears on the left side of the display.
Breast scanning is divided into 4 areas: Right Breast, Right Axillary Fossa, Left Breast,
Left Axillary Fossa.

4. Users have the choice to follow the sequential evaluation of the respective anatomy,
and instructions for which trackball controls are displayed if the user selects to manually
categorize a segment as negative or positive for findings.
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The system will visually display purple for a segment if negative selected by user.
Positive segment will display yellow if selected by user.
User can manually mark the lesion in the positive area with bright circles b via the button
a refer to step 5.
If a segment is marked positive by the user, the system will return to that segment for
further measurement and color Doppler, refer to steps 6-12.

Figure 6-62 Breast scan screen1

Figure 6-63 Lesion marker

5. Press P1 key, the screen is split in to dual screen, the frozen longitudinal plane scan
image is placed on the left side.

6. The live image is on the right side and the user performs transverse plane scan.
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Press P1 key, perform measurements.

Figure 6-64 Breast scan screen 2

The pie chart is used to display the breast scan area and result:

Figure 6-65 Pie Chart in Breast Care

a.The current scanned area: the outline is highlighted.
b.Dark blue area: Negative area, there is no finding/lesion with breast anatomy.
c.Yellow area: Positive area, there is a finding/lesion with breast anatomy, probable

pathology.
d.Nipple
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Breast Productivity Package

There are two features related to Breast:

• Breast Measure Assistant - this contains the auto contour feature and auto Height and
Length. It also has measurements related to Breast (distance to nipple, ratio)

• Breast Productivity - this includes lesion measurement folders, summary, etc.

This section covers both the Breast M&A Package and Breast Measure Assistant (Auto
Contour) features.

Breast Lesion M&A

Breast Lesion M&A allows you to document up to 30 breast lesions for each breast. Lesion
Height/Width/Length, Distance to Nipple, and A/B Ratio are available. Distance to Nipple
allows you to enter the value. This is not a calculated measurement.
The Measure Assistant Breast (Auto Contour) feature can also be used to automatically
detect and outline the breast lesion.
Worksheet and Summary Worksheets show all the documented right/left breast lesions.
From the Small Parts Model, select the Breast Application. Next, select the Right/Left Lesion
(Select Rt Side/Lt Side below the Touch Panel).
Table 6-24 Breast Lesion M&A Touch Panel

Preset Parameter Description

Position Specify the position of the lesion: Clock position 1-12 O’clock, Areolar,
SubAreolar, Axillary, or “-” (default).

Segment Specify A, B, C, None, or “-” (default).

Return Press to return to the previous Touch Panel.

Lesion # Indicates which lesion you are viewing (Lesion # of Total Number of
Lesions). Press the left/right arrow to move from lesion to lesion.

L Lesion Length

H Lesion Height

W Lesion Width

Distance to Nipple Used to manually enter the distance the lesion is from the nipple.

Auto Contour (HxL) Press to activate the Auto Contour feature, using the height and length.

Auto Contour (HxW) Press to activate the Auto Contour feature, using the height and width.

Rt or Lt A/B Ratio Right or Left Lesion A/B Ratio, measured by Area or Diameter.

Composition Specify the composition of the lesion: None (-), Solid, Cystic, or Complex.

Delete Lesion Press to delete this lesion.
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BI-RADS (ACR)

BI-RADS® (Breast Imaging-Reporting and Data System) is a risk assessment and quality
assurance tool developed by American College of Radiology that provides a widely accepted
lexicon and reporting schema for imaging of the breast.
Breast imaging studies are assigned one of seven assessment categories from ACR BI-
RADS® Atlas 5th edition quick reference ultrasound section (https://www.acr.org/Clinical-
Resources/Reporting-and-Data-Systems/Bi-Rads#Ultrasound) by Mendelson EB, Bohm-
Velez M, Berg WA, et al. ACR BI-RADS® Ultrasound. In: ACR BI-RADS® Atlas, Breast
Imaging Reporting and Data System. Reston, VA, American College of Radiology; 2013.

Copyright Notice/Permission
Copyright © 1992, 1993, 1995, 1998, 2003, 2013 American College of Radiology. All rights
reserved.
No part of this document may be reproduced or transmitted in any form or by any means,
electronic or mechanical, including photocopy, recording, or any information storage and
retrieval system, without the prior express written consent of the American College of
Radiology.
The ACR logo is a registered trademark and service mark of the American College of
Radiology. BI-RADS® is a registered trademark of the American College of Radiology.

Disclaimer
The American College of Radiology (ACR) Brest Imaging Reporting and Data System
Atlas (BI-RADS® Atlas) is the product of a collaborative effort among members of various
committees of the American College of Radiology. BI-RADS® suggests a standardized
method for breast imaging reporting. This system is not meant to dictate individual case
management decisions.
All referring physicians and radiologists should be aware of the benefits and limitations of
the application of imaging techniques. Imaging techniques classified as investigational by the
FDA have not been considered in developing the BI-RADS® Atlas; however, study of new
equipment and applications should be encouraged. The ultimate decision regarding breast
imaging procedures and treatment must be made by the referring physician and radiologist in
light of all the circumstances presented in an individual examination.

Warranty
Warranty limitations:

1. ACR BI-RADS® is provided on an “as is” basis, without warranties of any kind, either
express or implied, including, but not limited to, warranties of title, or implied warranties
of merchantability or fitness for a particular purpose;

2. The use of BI-RADS® is at your own risk;
3. Access to ACR BI-RADS® may be interrupted and may not be error free;
4. Neither the American College of Radiology nor anyone else involved in creating,

producing or delivering ACR BI-RADS® contained therein, shall be liable for any direct or
indirect, incidental, special, consequential or punitive damages arising out of your use or
inability to use ACR BI-RADS®.
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To activate BI-RADS® on the system:

1. When the operator would like to assess the lesion in breast, frozen image or recall a still
image with the lesion.

2. Press Measure and selects Rt Lesion or Lt Lesion in Measure Menu.
3. The operator measures L*H*W* manually or select Auto Contour(HxL)/(HxW). (L: length;

H: Height; W: width)
NOTE
BI-RADS assessment can only be performed after completion of lesion measurement.

4. Selects BI-RADS® (ACR) on Touch Panel. Then BI-RADS® (ACR) assessment form
appears. The operator selects the assessment descriptor in the assessment form.

5. Enter the characterization for the assessment description.

Figure 6-66 BI-RADS® (ACR) Menu
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NOTE
At any time, the operator can click the icon at the right corner of BI-RADS (ACR) form,
the information window from the BI-RADS (ACR) appears. To close the BI-RADS (ACR)
information window, the operator clicks the icon again.

Figure 6-67 Summarized User Prompt Window

6. The operator selects BI-RADS® assessment score.
NOTE
The determine definitive diagnosis depends on FNA (fine needle aspiration).

7. Repeat steps 1- 6 to complete multiple descriptor assessments.
8. After the completion of the assessment, operator can press the Report key to review all

the measurements and BI-RADS® assessment in report and worksheet.
Table 6-25 BI-RADS® Assessment Categories

Category Assessment

Category 0 Incomplete - Need additional imaging evaluation

Category 1 Negative

Category 2 Benign

Category 3 Probably benign

Category 4 Suspicious:

• Category 4A: low suspicion for malignancy
• Category 4B: moderate suspicion for malignancy
• Category 4C: high suspicion for malignancy

Category 5 Highly suggestive of malignancy

Category 6 Known biopsy-proven malignancy

9. The operator can select Exit to exit to worksheet and back to scanning page to do
scanning or more lesions' BI-RADS® assessment.
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Worksheet and Summary Worksheets

Worksheets and Summary Worksheets are provided for all documented Breast Lesions.

To move to the next page, rotate the Page Change rotary beneath the Touch Panel.

NOTE
Only defined features are displayed on the Summary Report. To display the undefined
features, select Show Undefined Features at the bottom of the Summary Worksheet.

Breast Measure Assistant (Auto Contour)

You can request that the system trace/outline the border of a breast lesion using Measure
Assistant Breast (Auto Contour). You do this by setting the Region of Interest (ROI) around
the lesion; the system can then measure the lesion by drawing the contour around it.
The system can store up to 30 breast lesions. The system tracks these by numbering the
lesions consecutively.
To automatically detect the breast lesion on the display,

1. Press Measure.
2. Press Auto Contour (HxW) on the Touch Panel.
3. Place the Cursor in the center of the lesion and press Set. Size the ROI around the

lesion. Use the Trackball to resize the ROI.

• To increase the size of the circle, move the Trackball down and to the right.
• To decrease the size of the circle, move the Trackball up and to the left.

NOTE
Include the entire lesion, even if additional surrounding tissue is included.

4. Press Set on the Trackball. A trace appears around the lesion.
5. Size the trace via the Trackball.
6. Press Set. The contour around the breast lesion is generated.

NOTE
Multiple breast lesion traces may be generated by the system.

7. Inspect the generated contour for accuracy. If edits are necessary, execute steps 8-10 to
edit the contour prior to accepting the measurement. Otherwise, skip to step 11.

8. To cycle through the generated contours, use the Select Contours rotary on the Touch
Panel.

9. To edit the selected contour, move the Trackball to appropriately size the edit region and
then press Set on the Trackball.

10. The blue portion of the contour can be edited by moving the Trackball to the portion of
the contour you want to edit.
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NOTE
The Caliper closest to the cursor enables editing.

NOTE
To limit the horizontal/vertical editing capabilities, you can set a preset via Utility >
Measure > Advanced > Small Parts > Restrict Breast Contour Caliper Edit.

11. After you have completed your edits, press Done on the bottom Set Key or press Print
to accept the measurement.
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Thyroid Productivity Package

A Thyroid Productivity Package is available.
The Thyroid Productivity Package is only available when the Thyroid Productivity Option is
activated.
Table 6-26 Thyroid/Parathyroid/Lymph Node Touch Panel

Preset Parameter Description

Side Specify the side: Right, Left, Isthmus.

Worksheet/Summary Select to view the Worksheet/Summary Worksheet.

Add#1, Add#2, etc. Cycles through the available lesions, or adds a new lesion/node/nodule,
etc.

Rt/Lt Thyroid
Rt/Lt Parathyroid
Rt/Lt Lymph Node
Rt/Lt Nodule

When measuring the Left/Right Thyroid/Parathyroid/Lymph Node/Nodule,
these folders highlight on the Touch Panel.
Length, Height, and Width are available for all thyroid measurements.
The Cortical Thickness measurement is available for the Lymph Node.
Show Features is available for all thyroid measurements.

Location Parathyroid: Specify Upper Gland or Lower Gland
Lymph Node: Supraclavicular fossa, Lower cervical, Middle cervical,
Upper cervical, Parotid, Submandibular, Submental, Posterior triangle
Nodule -- Use Up/Down Toggle to adjust.

• Location A: Upper, Lower, Mid, None
• Location B: Lateral, Medial, Mid, None

Isthmus Lymph Node
Isthmus Nodule

When measuring the Isthmus Lymph Node/Nodule, these folders
highlight on the Touch Panel.
Length, Height, and Width are available for all isthmus measurements.
The Cortical Thickness measurement is available for the Lymph Node.
Show Features is available all isthmus measurements.

Show Features - Overall
Thyroid

Press to activate the Show Features notations. To add notations for each
feature, position the trackball to the right of each feature and press Set.
This brings up the available notations. Move the Trackball to highlight a
notation and press Set to select a notation. The notation will then appear
next to the feature and on the Summary Worksheet.
Below is a list of each Feature with its possible notations by
measurement type:

• Overall Thyroid (Top Level Touch Panel)

Resected: Totally, Partially, None (-)
Appearance: Within normal limits, Abnormal, Symmetric, Asymmetric
R>L, Asymmetric L>R, None (-)
Comment
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Preset Parameter Description

Show Features - Lt/Rt
Thyroid

Press to activate the Show Features notations. To add notations for each
feature, position the trackball to the right of each feature and press Set.
This brings up the available notations. Move the Trackball to highlight a
notation and press Set to select a notation. The notation will then appear
next to the feature and on the Summary Worksheet.
Below is a list of each Feature with its possible notations by
measurement type:

• Lt/Rt Thyroid

Resected: Totally, Partially, None (-)
Echogenicity: Homogeneous; Coarse; Heterogeneous; Hashimoto,
Classic; Hashimoto, Probable; None (-)
Vascularity: Normal, Increased, Decreased, None (-)
Size: Normal, Enlarged, Small, None (-)
Comment
Isthmus Comment
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Preset Parameter Description

Show Features - Lt/Rt
Parathyroid / Lymph
Node / Nodule

Press to activate the Show Features notations. To add notations for each
feature, position the trackball to the right of each feature and press Set.
This brings up the available notations. Move the Trackball to highlight a
notation and press Set to select a notation. The notation will then appear
next to the feature and on the Summary Worksheet.
Below is a list of each Feature with its possible notations by
measurement type:

• Lt/Rt Parathyroid -- Upper/Lower Gland

Visibility: Visualized, Not Visualized, None (-)
Comment

• Lt/Rt Lymph Node

Appearance: Within normal limits, Suspicious, Pathologic, None (-)
Composition: Cystic, Complex, Solid, None (-)
Vascularity: Normal, Increased hilar, Increased non-hilar, None (-)
Comment

• Lt/Rt Nodule

Shape: Round, Oval, Irregular, Lobulated, None (-)
Margin: Well Defined, Well Defined with halo, Well Defined with
partial halo, Well Defined with complete halo, Poorly defined,
Irregular, None (-)
Composition: Solid, Cystic, Mixed, Complex, Heterogeneous, None
(-)
Vascularity: Normal, Increased, Decreased, Central Vasc
(Avascular, Hypovascular, Isovascular, Hypervascular, Severely
Hypervascular), None (-)
Calcification: No Calcification, Coarse central, Coarse rim, Punctate
scattered, Punctate clumped, Colloid, Mixed, None(-)
Comment
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Preset Parameter Description

Show Features - Isthmus Press to activate the Show Features notations. To add notations for each
feature, position the trackball to the right of each feature and press Set.
This brings up the available notations. Move the Trackball to highlight a
notation and press Set to select a notation. The notation will then appear
next to the feature.
Below is a list of each Feature with its possible notations by
measurement type:

• Isthmus Lymph Node

Appearance: Within normal limits, Pathologic, None (-)
Composition: Cystic, Complex, Solid, None (-)
Vascularity: Normal, Increased, None (-)
Comment

• Isthmus Nodule

Shape: Round, Oval, Irregular, Lobulated, None (-)
Margin: Well Defined, Well Defined with halo, Well Defined with
partial halo, Poorly defined, Irregular, None (-)
Composition: Solid, Cystic, Mixed, Complex, Heterogeneous, None
(-)
Vascularity: Normal, Increased, Central Vasc (Avascular,
Hypovascular, Isovascular, Hypervascular, Severely Hypervascular),
None (-)
Calcification: Coarse central, Coarse rim, Punctuate scattered,
Punctuate clumped, Colloid, Mixed, None (-)
Comment

Return Press to return to the previous Touch Panel.

H Height

W Width

L Length

Isthmus AP Used to measure the Isthmus height distance.

Cortical Thickness Cortical thickness of the lymph node.

Delete Press to delete this anatomy.

TI-RADS (ACR)

The ACR (American College of Radiology) TI-RADS (Thyroid Imaging, Reporting and Data
System) is designed to help the physician in the assessment and systematic documentation
of Thyroid nodules based on the peer reviewed published literature, ACR Thyroid Imaging,
Reporting and Data System (TI-RADS): White Paper of the ACR TI-RADS Committee by
Franklin N. Tessler, MD, CM, Jenny K. Hoang, MBBS, William D. Middleton, MD, Edward G.
Grant, MD, Michael D. Beland, MD, Lincoln L. Berland, MD, Sharlene A. Teefey, MD, John
J. Cronan, MD, Ulrike M. Hamper, MD, Terry S. Desser, MD, Mary C. Frates, MD, Lynwood

Chapter 6

Versana Premier/Versana Premier Lotus - User Manual 455
5928218-1EN Rev. 6



W. Hammers, DO, A. Thomas Stavros, MD, Jill E. Langer, MD, Carl C. Reading, MD, Leslie
M. Scoutt, MD, A. Thomas Stavros, MD published on Journal of the American College of
Radiology Volume 14, Issue 5, May 2017, Pages 587-595.

The ACR TI-RADS uses standard terminology to document the features of the nodules.
Points are given for all the ultrasound features in a nodule, with more suspicious features
being awarded additional points. When assessing a nodule, the user selects one feature from
each of the first four categories and all the features that apply from the final category and
sums the points. The point total determines the nodule’s ACR TI-RADS level, which ranges
from TR1 (benign) to TR5 (high suspicion). No recommended action is provided by the
system to the user. In the ACR TI-RADS publication, recommendations for FNA or ultrasound
follow-up are based on a nodule’s ACR TI-RADS level and its maximum diameter.

TI-RADS (ACR) is Thyroid Imaging Reporting and Data System (from ACR). ACR TI-RADS
could provide guidance regarding management of thyroid nodules on the basis of their
ultrasound appearance.

NOTE
TI-RADS is a registered trademark of ACR and all rights reserved by ACR.

To activate TI-RADS on the system:

1. The operator selects the appropriate probe and Thyroid preset.
2. The operator selects Nodule in Measure Menu.

Figure 6-68 Select Nodule

3. The operator measures Nodule L*H*W* manually or Auto Contour(HxL)/(HxW).
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4. The operator selects TI-RADS(ACR) on Touch Panel. Then TI-RADS(ACR) menu
appears. The operator selects each category for the Nodule. All points will be summed
up automatically.

Figure 6-69 TI-RADS(ACR) Menu

5. The operator clicks  icon at the right corner of TI-RADS(ACR) menu, a user prompt
window will appear. The window has two display modes.

• Place the cursor on the icon, the window will display a summarized introduction for
ACR TI-RADS.

Figure 6-70 Summarized User Prompt Window
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• Move the cursor to the category, the window will display a detailed introduction for
the selected category.

Figure 6-71 Detailed User Prompt Window

The operator clicks  icon again to exit the user prompt window.

6. The operator marks TI-RADS Level TRx manually.
NOTE
The determine definitive diagnosis depends on FNA (fine needle aspiration).

7. After the completion, the operator presses Report key to check all the measurements
and TI-RADS in the Worksheet.

Worksheet and Summary Worksheets

Worksheets and Summary Worksheets are provided for all documented Thyroid anatomies.

To move to the next page, rotate the Page Change rotary beneath the Touch Panel.

NOTE
Only defined features are displayed on the Summary Report. To display the undefined
features, select Show Undefined Features at the bottom of the Summary Worksheet.

NOTE
To exit back to the previous measurement screen, press Set on Exit button.

NOTE
To exit back to the scan screen, press Worksheet/Summary on the Touch Panel.
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Measure Assistant Thyroid (Auto Contour)

You can request that the system trace/outline the border of a nodule using Measure Assistant
Thyroid (Auto Contour). You do this by setting the Region of Interest (ROI) around the
nodule; the system can then measure the nodule by drawing the contour around it.
To automatically detect the nodule on the display,

1. Press Measure.
2. Press Auto Contour (HxL) or Auto Contour (HxW) .
3. Place the Cursor in the center of the nodule and press Set. Size the ROI around the

nodule. Use the Trackball to resize the ROI.

• To increase the size of the circle, move the Trackball down or right.
• To decrease the size of the circle, move the Trackball up or left.

NOTE
Include the entire nodule, even if additional surrounding tissue is included.

4. Press Set. A trace appears around the nodule.
5. Size the trace via the Trackball.
6. Press Set. The contour around the nodule is generated.

NOTE
Multiple nodule traces may be generated by the system.

7. Inspect the generated contour for accuracy. If edits are necessary, execute steps 8-10 to
edit the contour prior to accepting the measurement. Otherwise, skip to step 11.

8. To cycle through the generated contours, press Cursor Select.
9. To edit the selected contour, move the Trackball to appropriately size the edit region and

then press Set.
10. The blue portion of the contour can be edited by moving the Trackball to the portion of

the contour you want to edit.
NOTE
The Caliper closest to the cursor enables editing.

11. After you have completed your edits, press P1 to accept the measurement.
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Scan Assistant

Scan Assistant Manager

Scan Assistant provides an automated exam script that moves you through an exam step-
by-step. This allows you to focus on performing the exam rather than on controlling the
system and can help you to increase consistency while reducing keystrokes. The system
automatically invokes the correct mode and imaging parameters, advances to the next step
in an exam, annotates the image, initiates measurements, and assigns the measurements to
the worksheet/report.

Availability
The following additional imaging parameters and preferences are available for use in a Scan
Assistant program: CW Doppler, Dual on Freeze, Depth, Color Scale, PW Doppler Scale, PW
Sample Volume size, and Flow Model Selection.
You can initiate one or more manual Doppler measurements/calculations.
Body Patterns are available for use during a Scan Assistant program. You can turn a Body
Pattern on/off, select a particular Body Pattern graphic, and specify the position of the probe
mark on the Body Pattern graphic.
The footswitch can be used with Scan Assistant. You can map Pause/Resume, Previous
Step, and Next Step to the footswitch.
The “Always Use Doppler Cursor” preset, available on the Utility --> System --> General
page, allows all PW Doppler steps to start with full screen 2D image plus mode cursor. You
can specify the Store Order in Scan Assistant to set the Reading Order for the radiologist.
The Learn Probe attribute can be set to learn and change the probe for the user in the middle
of the exam.

Scan Assistant Definitions
Scan Assistant definitions:

• Scan Assistant Manager. Available via the Utility -> Scan Assistant page to import/
export Programs created via the Scan Assistant Creator and to assign Programs to a
user/exam category.

• Import. Used to load Programs created via the Scan Assistant Creator on to the
ultrasound system.

• Export. Used to move Programs from one ultrasound system to another ultrasound
system.

• Scan Assistant Creator. Used to create Scan Assistant Programs.
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Scan Assistant Description

Figure 6-72 Scan Assistant Display Description

1. Program name.
2. Completed steps/out of total number of steps, and step description area.
3. Program step status (Complete/Incomplete), step number, step name. A checkmark

indicates that this step has been completed. You can also manually check the box to
bypass this step.

4. This column indicates that the action moves the Program to the next step.
5. Active step.
6. This column indicates the mode or when a measurement needs to be made.
7. Edit (Pencil Icon).
8. Stop. Stop also allows the program to be stopped, restarted, or a new program selected.
9. Pause/Resume.

Setting up Scan Assistant
To set up Scan Assistant,

1. Import the Scan Assistant Program created using the Scan Assistant Creator or exported
from another ultrasound system program.

a. Insert the media with the saved Program from the Scan Assistant Creator or exported
program from another ultrasound system.
b. Press Utility > Scan Assistant.
c. Select Import from the Scan Assistant Manager page.
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d. In the Source field at the top of the Import Programs pop-up, select the media that the
Program is stored on.

Figure 6-73 Import Programs

e. Select the Program(s) to be imported. If a folder is selected, all programs in the folder
will be imported.
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f. Select Import. The Program(s) you selected are stored to the ultrasound system.
Select Exit. Then you can add it to the exam category and user.

Figure 6-74 Import Completed

2. Assign the imported Program to the exam category and user. Under Program Selections
on the right-hand side of the Scan Assistant Manager page, specify the Exam Category
and User for this Program. You can select All Users, or a specific user. If you specify
All Users, all users will have the ability to use this Program while in the specified exam
category, unless the user has his/her own list defined.
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3. Select the imported Program from Available Programs > Custom Programs on the
left-hand side of the page. Then press the right arrow button to move the imported
Program to the exam category and user selected above.

Figure 6-75 Add Program

You can access the Scan Assistant Creator to edit the exam’s program from the imaging
display via the Creator Icon located at the bottom of the Scan Assistant Program monitor on
the display. You can activate the Scan Assistant Creator from the image screen, make edits,
and then run Scan Assistant to test your changes.

NOTE
If you edit the program after you have already stored several images, and your edits change
the number of program steps, you are prompted to Restart or Continue the Scan Assistant
program.

NOTE
If you edit the program after you have already completed several steps, the check marked
steps will remained checked, even if you insert a new step in between the currently checked
steps. If this is not correct, you can edit the check marks or restart the program.

Using Scan Assistant
After you have set up Scan Assistant, the Program is active when you exit the Patient menu.
The Program is located on the left-hand side of the display and as you can see in the
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example below, the annotation for the first step has been automatically noted on the image,
ready for you to scan the specified anatomy.

Figure 6-76 Scan Assistant Display

1. Follow the steps indicated in the Program: image/measure the appropriate anatomy.
2. Perform the indicated trigger to move to the next step in the Program.

NOTE
The footswitch can be used with Scan Assistant. You can map Pause/Resume, Previous
Step, and Next Step to the footswitch.

3. To pause or unpause Scan Assistant, press the pause button on the display.
4. To stop or restart a Program, press the Stop icon at the bottom of the Scan Assistant

Program. A dialog pops up. This dialog lets you restart the current Program, start another
Program, or stop Scan Assistant.

5. To skip a step or move to a certain step, press the up/down arrows on the keyboard or
select the step you want to move to using the Trackball and Set keys.
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Activating the Scan Assistant Creator

To activate the Scan Assistant Creator on the ultrasound system, press the Creator key.

Figure 6-77 Scan Assistant Manager

Exporting Scan Assistant Programs

Exporting Scan Assistant Programs allows them to be imported to another Versana Premier/
Versana Premier Lotus or to be edited offline with the Scan Assistant Creator tool.
Follow below steps to export a Program.

1. Insert the media to save the program.
2. Press Utility > Scan Assistant.
3. Select Export from the Scan Assistant Manager page.
4. In the Source field at the top of the Export Programs pop-up, select the media that the

Program is to be stored on.
5. Specify the Program Directory using the drop-down menu if the desired Program

Directory already exists on the media. If not, or if you want to export the Program to
a new Program Directory, type a new Program Directory name in the field.

6. Select the Program(s) to be exported. If a folder is selected, all programs in the folder will
be exported.
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7. Select Export. The Program(s) you selected are stored to the media. You can now
import it to a new ultrasound system.

Figure 6-78 Export Program(s)
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My Trainer

My Trainer provides a quick guide to operate the system.
Follow below steps to access My Trainer:

• Press Alt + H to enter My Trainer.

OR

• Press Assistant key on the control panel, then select My Trainer.

Figure 6-79 Enter My Trainer by Assistant key

There are five sections in My Trainer. The five sections are displayed on the left side of the
My Trainer interface.

Figure 6-80 Sections Display

1. Getting Started: Supply Mains Switch, Probe Connection.
2. System Setting: Facility name set up, Date time set up, Enable options check, Language

setting, User configuration, User preset.
3. Peripheral Connection: Back panel ports, Wire Connectivity, Wireless Connectivity,

Connect to a printer, DICOM worklist setting, DICOM Image storage, Back-up/restore
the animal information, software version.

4. Maintenance: Trackball, Contact GE HealthCare service, Connect to Insite, Log export,
Air Filter Replacement.

5. New Feature: Latest new features.

Advanced Features

468 Versana Premier/Versana Premier Lotus - User Manual
5928218-1EN Rev. 6



My Trainer User Interface
The interface of the My Trainer includes below information:

Figure 6-81 Interface Illustration

1. The product name of the system.
2. Sections. Select the button to expand the section to show the list of subsections.
3. Subsections.
4. The highlighted subsection shows this subsection is currently opened and displayed on

the right side.
5. Exit. Press this button to exit this interface
6. The left number shows the current page of the subsection. The right number shows the

total pages of the subsection.
7. Illustration with graphic.
8. Text instruction about how to operate.
9. Step Description.
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Follow-up Tool

The Follow-up tool is intended to perform serial scans on a patient, and compare the images
of a previous ultrasound exam to the current exam.
Follow-up tool can select up to 4 historical data for comparison.
When performing a follow-up exam, the system automatically reloads the scanning
parameters including ROI for QAnalysis from previous exam, and allows for side by side
scanning for image comparison. This allows the physician to use consistent scanning
parameters and Region of Interest (ROI) from exam to exam on the same patient and may
assist in assessing a patient condition over time.

Follow-up tool configuration

• Follow-up tool is available in B / B (CHI) / CF/ PDI mode.
• In order to utilize the follow-up tool, images should be saved in Raw DICOM format.

To configure image format as Raw DICOM:
Enter Utility > Connectivity > Button to set the Print button for this format. Raw Dicom
should be selected in the Format field.

Figure 6-82 Set Image format
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• The Customer can configure the Follow Up Button in Utility > System > User
Configurable Key.

Figure 6-83 Follow Up Tool Configuration

• The Customer can configure the Follow Up Tool settings in Utility > System > System
Imaging > Follow Up Tool.

Figure 6-84 Follow Up Tool Setting

1. Comparison Image Side: select the comparison image displayed position. The
Choices are: Right and Left. The Factory Default value is Left.

2. Comparison Date: Choose the date display condition of images which are used for
comparison. The choices are: All Dates, Different Dates, None.

All Dates - The date is always displayed on the comparison image.
Different Dates - The date only displays when the date of the comparison image is
different from the active exam date.
None - No Comparison image date is displayed.

3. Show label on Clipboard: choose when to show the comment label for the image on
clipboard. The Choices are: Always, Follow up tool and Off.

4. Auto Copy QA Measurement:

Check the box, QAnalysis measurement is copied automatically from comparison
image to the current scanning image.
Uncheck the box, QAnalysis measurement is not copied automatically from
comparison image to the current scanning image.
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The factory default is that the box is unchecked.

Follow-up Tool Workflow

The First Exam

1. Press Patient to enter the Patient page.
2. Create a New Patient, and create a new exam for the patient. Select Scan to enter

scanning mode.
3. Press Probe to select the application and preset.
4. Scanning with B mode and adjust the scanning parameters.
5. Press Freeze.

NOTE
Comments and body mark can be added, and will be stored with the images.

6. Activate CF or PDI mode and adjust the scanning parameters. Here CF mode is used for
example.

7. Press Freeze. Press the Print key to save the image.
NOTE
Comments and body mark can be added, and will be stored with the images.

8. Press Measure to activate measurement and select measurement from measurement
folder.

9. Select measurement folder and select a measurement item.
NOTE
Follow-up Tool only available for the measurement items under MSK -> Knee -> Fusion.

10. Draw only one ROI and the result is displayed in result window.

Select Rt (Right) or Lt (Left) for the patient’s right and left side.
Select Prox (Proximal), Mid (Middle) or Dist (Distal) if the vessel has a location.

11. Press the Print key which is assigned to save the image with measurement.

The Follow-up Exam
NOTE
Before starting Follow-up exam, define a key from User Defined Key for activating/
deactivating Fusion via Utility > System > User Configurable Key.

NOTE
Before starting Follow-up exam, set the Fusion values via Utility > Imaging > B/HAR mode
page.

1. Enter Patient page, and select the patient from the Patient View list.
2. There are different methods to activate Follow up exam.
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NOTE
Be sure to activate the same probe used for the initial exam.

• To access Follow up exam:
a Select the Exam.
b Select Image History or Active Images.
c Select one image, then select Compare.
NOTE
Only one image is selected at a time so Compare can be activated. If more than
one image is selected, Compare can not be activated.

• In scanning mode, select the Follow up exam icon, the Follow up exam is activated.

Figure 6-85 Follow up exam icon

OR
Press Follow Up key on the control panel to activate Follow up exam.

3. The system enter scanning mode with Follow-up exam. The screen reverts to split
screen.

Click the Follow-up icon to deactivate or activate the Follow-up exam.
As factory default setting, the live image is displayed on the right side of the screen and
the selected comparison image is on the left.
The user can configure the display position in Utility > System Imaging > Follow Up
Tool > Comparison Image Side.

4. Select a B mode image on the clipboard to do follow up and the body mark and the
comments which are added in the selected image will be transferred to the current
scanning image.

5. Press the key assigned for Fusion to turn on Fusion. The overlay will appear on the
active image. Align the bony landmarks or fascial planes with overlay to find the same
scanning position from comparative study.
NOTE
You can assigned a key from key User Defined Key to turn on/off Fusion via Utility >
System > User Configurable Key.
Move the probe until the scanning position gets to the mark.

6. Select the assigned key again to deactivate Fusion.
NOTE
Fusion should be turned off before saving the image, otherwise the mark will remain on
the image which is frozen and saved.
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NOTE
For additional follow-up, select the appropriate clipboard image for comparison.

7. Press Freeze. Press the Print key to save image. An image with split screens will be
stored in the exam report.

8. Select one image of Color Flow Mode on the clipboard to do follow up. Color Flow Mode
is used for example here.

The color window automatically appears on the same position and in the same size with
the comparison image.
The scanning parameters is reloaded from the comparison image to the current image.

9. Select Fusion from the assigned Function key. When Fusion is activated with image that
has been saved in Color, the color disappears automatically from color window. The
color bar and color window will remain.

10. After the scanning position is located, press the key assigned for Fusion to turn off
Fusion. When the Fusion is turned off, color appears automatically in color window.
During this operation, the user does not need to press Color key to activate color.

11. Press Freeze.
Select the desired frame by using Frame By Frame control on the touch panel.

12. Press Measure. The measurement method, measurement item and ROI will be
transferred automatically from comparison image to the current scanning image.
NOTE
Be sure Auto Copy QA Measurement (Dual Screen) has been checked in the Follow
Up Tool portion in Utility > System > System Imaging. This is not available through
factory default.

NOTE
If Auto Copy QA Measurement (Dual Screen) is not selected, the QAnalysis
measurement will not be copied automatically from comparison image to the current
scanning image. The user can perform the measurement with new measurement
method, measurement item and ROI on the current image.

The result window displays the measurement result of comparison image and the
current image.

13. Press the Print key to save the image and measurement.

The image with split screens and measurement result for current image and comparison
image is stored.

Worksheet

To view a worksheet, press the Report key on the Touch Panel.

Report

To view the report, press Report on the Touch Panel.
Select Whizz Report on the Touch Panel to enter report. Select the image and click the +
icon, the image will display in the Images section.
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The measurement result window with measurement data of current image and comparison
image is kept on the image and displays.
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QAnalysis (Option)

Quantitative Analysis (QAnalysis) is available for the image loop acquired in the following
modes: Color Flow Mode, Power Doppler Mode, Tissue Velocity Mode, Strain and Strain
Rate. The difference of QAnalysis operations is small among different modes.

Activating QAnalysis

1. Scan the patient in CF/PDI/TVI mode or select a desired cine loop in CF/PDI/TVI mode
from the stored images.
NOTE
Images from the current scan session acquired (already in CINE) or from a saved image
loop can be used for QAnalysis.

NOTE
QAnalysis is only available if the user has selected an image loop. If the user has
selected a saved still image (just one frame), QAnalysis is not available.

2. Press Freeze. Then move the trackball to enter CINE mode.
NOTE
QAnalysis is only available when the system is in CINE mode.

3. Select QAnalysis to activate Quantitative Analysis function. To toggle the trackball
function between QA and Scroll, press the Set key.
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QAnalysis Screen Description

Figure 6-86 TVI mode QAnalysis Example

Table 6-27 QAnalysis Screen Description

1. TVI Cineloop Window
Sample Area: Indicates sampling position of the velocity. The sample area is color-coded: the
first sample area is yellow, the second green, etc.

2. B Cineloop Window
Sample Area: Indicates sampling position of the velocity. The sample area is color-coded: the
first sample area is yellow, the second green, etc.

3. Analysis Window.

• Y axis: Velocity scale (cm/s)
• X axis: Time(s)
• Time at cursor position.
• Velocity at Cursor position.
• Velocity at frame marker position (Color coded)

4. Sample Area

5. Time at cursor position and velocity at cursor position. Position the pointer cursor over the
analysis window.
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6. Sample Area Tools.

• Pencil Icon: Creates a sample area based on freehand drawing.
• Shape Icon: Creates a sample area with a pre-defined circular/ellipse shape.

Figure 6-87 CF Mode QAnalysis Example

Selecting QAnalysis Image Range

A range of frames is selected for the QAnalysis in Cine mode (before accessing QAnalysis).
Only the frames in this range are used for the QAnalysis.
If a range is not selected prior to accessing the QAnalysis, the system uses the default Cine
start and end frames as the default start and stop frames.

1. The first frame in the analysis series is selected by adjusting the Start Frame control to
the desired frame
OR
using the Trackball or the Frame by Frame control to select the desired first frame and
then selecting the Start Frame control.

2. The last frame in the analysis series is selected by adjusting the CINE Last Frame
control to the desired frame
OR
using the Trackball or the Frame by Frame control to select the desired last frame and
then selecting the Last Frame control.
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Generating a Trace

Trace from a pre-defined sample area

1. Select the sample area Ellipse ROI button (shape icon on the monitor display).
2. Move the cursor to one of the Cineloop windows using the Trackball.
3. Press Set to anchor the sample area.

In this frame, the sample area is marked with an anchor. If the cineloop has more than
one heart cycle, a sample area will also be anchored in the corresponding frame in the
next heart cycle.
The trace is updated accordingly in the Analysis window.

Trace from freehand sample area

1. Select the Freehand ROI button (pencil icon on the monitor display).
2. Move the cursor to one of the Cineloop windows using the Trackball.
3. Trace the outline of the desired ROI by moving the caliper with the Trackball.
4. Press Set to anchor the sample area.

The sample area is automatically closed and the trace is updated accordingly in the
Analysis window.

Manual tracking of the sample area (dynamic anchored sample area)

1. Place a sample area over a region of interest. Note the anatomical location of the sample
area.

2. Scroll to a new frame using the Trackball.
3. Press Scan Area key until the QA trackball assignment is selected.
4. Move the cursor to the sample area using the Trackball.
5. Press Set. The sample area is unanchored.
6. Drag the sample area to the corresponding anatomical location in the new frame.

When the sample area is anchored in more than one frame, linear interpolation is
performed so that the sample area is smoothly moved between the anchored positions in
the selected frames when running the cineloop.

7. Press Scan Area key until the scroll trackball assignment is selected.
8. Using the Trackball, scroll through the cineloop and control that the sample area follows

the moving anatomical structure.
9. Add anchored sample areas in several frames to obtain a more accurate displacement of

the sample area.

Moving a dynamic anchored sample area

1. Press Scan Area key until the scroll trackball assignment is selected.
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2. Using the Trackball, browse thought the cineloop to display one of the frames where the
sample area was anchored.
NOTE
In these frames, the sample area is marked with an anchor.

3. Press the Scan Area key until the QA trackball assignment is selected.
4. Move the cursor to the sample area using the Trackball.
5. Press Set. The sample area is unanchored.
6. Drag the sample area to a new location.
7. Press Set to anchor the sample area to the new location.

Delete a trace

The user can delete all traces at once or one at a time.

1. Move the cursor over one of the sample area. Confirm that cursor is changed to hand
icon.

2. Select Delete Sample Area.
3. Select Current Sample or Delete all as necessary.

Manipulating the Sample Area

Up to eight ROIs can be saved on the reference image, with the corresponding eight
traces plotted simultaneously on the graph. Each ROI display has a different color, and its
corresponding trace data is plotted using that same color.
Once eight ROIs have been saved, the system does not automatically generate an active
ROI when the cursor is positioned over the displayed reference image.
The saved ROIs can be a mixture of elliptical and freehand ROIs.
When the user repositions an ROI, the old trace data is erased from the plot and the trace
data for the new position replotted.
If the ROI position on the last frame of the selected image range is moved, the corresponding
ROIs on all frames are repositioned to match the last frame.
The user shall also have the capability of setting separate ROI positions on different frames
of the contrast images, and the system shall linearly interpolate the ROI positions for the
frames in between the selected frames.
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Setting the default sample area shape

1. Position the cursor on the ROI on Cineloop windows, a white circle appears.

Figure 6-88 Sample Area Information Box

2. Select Set sample area shape on the System menu. The Information Box displays.

Figure 6-89 Sample Area Information Box

3. Select Height, Width and Tilt angle.
4. Select Set as default. The current ROI size is set as the default for subsequent Ellipse

ROIs.

Reshaping a Sample Area
To reshape the sample area:

1. Position the cursor on the ROI to reshape and press Set key.
2. The ROI system menu displays. Select Set sample area shape.
3. Adjust Height, Width and Tilt angle.
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4. Press OK. The selected ROI size changes.

Sample Area Shapes
There are two different methods for determining the shapes of the sample area.

Ellipse ROI

1. Select the ellipse icon (shape icon on the monitor display).
2. When the trackball positions the image display cursor over the reference image(s), an

elliptical ROI is automatically generated and displays on the reference image(s).
3. The average velocity value inside the ellipse is calculated for every image in the image

analysis range and plotted in the image display area.
4. The last generated or selected ellipse is considered the active ROI, and its trace plot

automatically updates as the user repositions it on the reference image. Old traces are
erased.

5. When scanning with an elliptical ROI, press Set to fix the ROI position and freeze
its corresponding trace on the plot. A new active ROI is generated whose position is
manipulated by the trackball and whose velocity curve traces will be plotted as before,
while the previous ROI and trace remain fixed at the points they were saved at.
NOTE
Elliptical ROIs can be positioned in any manner that keeps their center within the image
boundaries. In the case that part of the ROI is outside the image boundary, only data
from within the image boundary is used for calculating the mean velocity value.

NOTE
You can change the size of the Ellipse ROI by adjusting the Ellipse control.

Freehand ROI

1. Select Freehand icon (pencil icon on the monitor display).

Use the Trackball to position the caliper on the reference image at the start point. Press
Set to fix the start point.

2. Trace the outline of the desired ROI by moving the caliper with the Trackball.
3. When a suitable ROI has been drawn, release the Set key.

The caliper is then free for repositioning for another freehand ROI.

NOTE
You cannot go outside the image boundary when drawing a freehand ROI.

Deleting a Sample Area
Sample ROIs and their corresponding traces can be deleted using Delete Sample Area.

1. Select System Menu; a pull-down menu displays.
2. Select Delete Sample Area to delete the currently active ROI.

Select Delete all Sample Area to delete all currently set ROIs and all of their traces.
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NOTE
The corresponding traces for the deleted ROIs are erased from the plot.

NOTE
Deleting an ROI causes the ROIs to be deleted from all frames in the analysis loop.

Disabling/Enabling the frame

NOTE
Disabling/Enabling the frame is available when enter QAnalysis from CF and PDI mode.

Frame disabling excludes the actual frame from the cineloop display. Frame disabling is
available only with contrast data.

Disabling the frame from the frame marker
To disable One Frame:

1. Use the Trackball to move the cursor to the frame maker to disable.
2. Press Set to disable the frame.
3. The frame marker is changed from green to red to indicate the frame has been disabled.

NOTE
The disabled frame is no longer displayed in the reference window when scrolling
through CINE memory.

Disabling multi-frames from the frame marker

1. Use the trackball to move the cursor to the first frame maker to disable.
2. Press and hold down Set .
3. Move the cursor with the Trackball to the last frame to be disabled and release Set.

The marker is turn red and the data from that frame is removed from the trace and any
subsequent trace processing.

Disabling a frame from the cineloop window

1. Use the trackball to move the cursor to the cineloop window.
2. Select Disable frame.

The current frame is disabled and the corresponding frame marker displays red.

To enable the frames
To re-enable all deleted frames:
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1. Position the cursor on the Frame Marker line.
2. Select Enable all frames.
3. All disabled frames are re-enabled.

Smoothing

NOTE
Smoothing is not available when entering QAnalysis from CF/PDI mode.

The system can smooth the traces displayed by applying a filter over a defined time window.
The type of filter available is depending on the analysis signal displayed.

1. Select Smoothing.
NOTE
When smoothing is turned on, it applies to all traces in the plot window.

2. The smoothing filter list displays. Select the appropriate parameter.

Horizontal Sweep

Horizontal Sweep allows you to increase or decrease the time interval over which to plot the
analysis curve.
The Horizontal Sweep control can range from TBD on the short side to the time interval
between the user selected first and last frame. The default is the user selected image range.
If the user has not yet selected a first and last frame, the first and last default frames from the
displayed CINE loop are used.

Drift Compensation

NOTE
Drift Compensation is only available when entering QAnalysis from TVI mode.

Drift Compensation compensates drifting of Tissue Tracking curves by either resetting the
curve to zero at the tracking start point (cycle resetting) or by linear compensation throughout
the cycle (linear compensation).

NOTE
When Displacement is chosen by Analysis Signal, Drift Compensation is active.
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Statistics

Select Statistics to enable/disable display of statistics of the frame or loop. The statistics are
shown only when the loop is stopped.

• Ratio: Ratio of Color (Power) Doppler pixel over total ROI area.
• Area (mm2): The size of ROI.
• Max Ratio/ Time of Max Ratio: Maximum Ratio of Color (Power) Doppler pixels in each

ROI, and which frame that occurs in.
• Min Ratio/Time of Min Ratio: Minimum Ratio of Color (Power) Doppler pixels in each

ROI, and which frame that occurs in.

Trace Measurements

Max Gradient
Displays the time and gradient that becomes the maximum gradient between the CINE start
and end frame.

Figure 6-90 Max Gradient

Exporting Traces (Saving the Trace Data)

You can save the trace data to an external file.

1. Select Export Traces on the touch panel to save the trace data.
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2. The following window displays.

Figure 6-91 Export Trace Window

• Location: Select Location which to save.
• Filename: Enter the filename. (Only Text)

3. Select OK to save the data and return to the QAnalysis screen.

• All displayed ROI traces are saved in the exported file.

All plot data (intensity, gradient and gradient derivative) are exported to a text file by “Export
Trace”.

Table 6-28 Example of exported file

Time(s): Trace 1: Trace 1 dGrad.: Trace 1 dGrad.

0.00000 -3.97995e+000 -2.15924e+001 8.05159e+001

0.03121 -5.14631e+000 -1.64719e+001 1.74256e+001

0.06242 -5.75798e+000 -1.27675e+001 -7.78004e+001

0.09362 -6.02222e+000 -1.27675e+001 -1.93426e+002

0.12483 -6.11224e+000 -1.44515e+001 -4.17252e+002

NOTE
The Smoothed trace is the one saved if the user has applied a smoothing filter.

NOTE
Only data from the user selected image range is included in the exported trace file.

NOTE
No trace results are saved in the standard image database.
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Annotating the QAnalysis Data

The user can annotate both the reference image and the trace plot displays. Use Comment
key to type the annotation. See Chapter 6 for reference.

Exiting QAnalysis

There are several methods to exit QAnalysis.

• Select Exit QAnalysis.
• Press Freeze to unfreeze and resume scanning.
• Press any other button that returns the system to real-time scanning.
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Whizz Label (Not applicable for China)

The right upper quadrant (RUQ) is an anatomical area where a patient presents with sign
or symptoms suggesting clinicians to take look or investigate. Ultrasound is a non-invasive
imaging method frequently used to image this anatomical region.

Whizz Label is a software technology utilizing Artificial Intelligence (AI) during ultrasound
acquisition to automatically detect the liver, gallbladder, and/or right kidney during an
ultrasound exam.

This technology is useful for clinicians that need to label or annotate ultrasound images for
documentation purposes similar to manual annotation of ultrasound images today.

NOTE
Whizz Label should not be used for pediatric abdomen scanning. It is only supported for
Adult abdomen scans.

NOTE
Algorithm cannot detect proper anatomy when probe movement is too fast or unstable.
Algorithm will not identify labels if the image quality is not deemed acceptable, e.g. shadows,
excessive or very little gain. In addition, presence of pathologies or missing parts of the
kidney capsule may impact auto label performance.

NOTE
Whizz Label is only available for the RUQ organs. Accuracy of figures is specified in the
context of right upper quadrant images and it is not applicable to the scanning of other parts
of the body.

NOTE
To use Whizz Label, the right upper quadrant organs are expected to be imaged as follows:

• Liver - in epigastric right midclavicular line or right intercostal windows using longitudinal
(sagittal), transverse views and/or oblique views.

• Gallbladder - scanned from subcostal or right intercostal approach.
• Right Kidney - scanned in epigastric/subcostal or right intercostal windows using

longitudinal (sagittal), transverse, and/or oblique views.

The tool has not been tested when scan is performed from other scan windows. Specifically,
the algorithm will not perform as expected when scanning the abdomen RUQ from a
subxiphoid window

Advanced Features

488 Versana Premier/Versana Premier Lotus - User Manual
5928218-1EN Rev. 6



NOTE
Whizz Label needs to see large portion of the organ to be accurate, as per the size
requirements shown in the table below.
Table 6-29 Accuracy of Whizz Label

Organ Accuracy

Liver 90% Accuracy when > 32cm2 size section of the liver is visualized on the image
scan area.

Gallbladder 80% Accuracy when > 8cm2 of the longitudinal view of gallbladder detected.

Right Kidney 90% Accuracy when > 16cm2 size section of the right kidney is visualized inferior to
liver in longitudinal or transverse view(s).

Using Whizz Label

User can start Whizz Label to label liver, gallbladder and/or right kidney in frozen image.
Whizz Label supports multi-language but can only be used in the Abdomen preset with
specific probes in B/CHI/CF/PDI mode. Refer to Table 5-8 Probe modes of operation and
Features on page 330 for detail information.

Whizz Label (Freeze)
To use Whizz Label on a Frozen Frame:

1. Select Whizz Label on Touch Panel. Once image is frozen, system will label liver,
gallbladder or right kidney as seen on the frozen image automatically.

Figure 6-92 Whizz Label while Freezing

Chapter 6

Versana Premier/Versana Premier Lotus - User Manual 489
5928218-1EN Rev. 6



2. If you are satisfied with the labels, press P1 to save. A confirmation window may display
if you configured in Utility > System > System Imaging > Need confirmation before
storing image under Whizz Label.
You can also activate Comment to modify or move the labels as needed.

Figure 6-93 Whizz Label confirmation

Whizz Label (Live)
To use Whizz Label in Scan Coach while scanning, user needs to enable the function in
Utility > System > System Imaging > Enable Whizz Label in Scan Coach.

NOTE
When storing a cine loop in Scan Coach, auto generated labels & protocol label will not be
stored.

1. Once Whizz Label in Live mode is set to ON in the configuration, organ labels are
automatically displayed during scanning when in the relevant protocol step (for Liver,
Right Kidney or Gallbladder). When the user Freezes a scan, the labels will be shown
only for the last frame.

Figure 6-94 Whizz Label while Scanning

2. If user is satisfied with the labels, user can press P1 to store the frozen image. The
system will show a message window to ask user to confirm correctness of labeling
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before image storage. Whizz Label will be turned off when saving the image. System will
resume Whizz Label after storing

User can configure whether to display the confirmation window in Utility > System >
System Imaging > Need confirmation before storing image under Whizz Label.
You can also activate Comment to modify the labels as needed.

Figure 6-95 Whizz Label confirmation

3. If you switch modes during scanning or turn on crossbeam, system will turn off Whizz
Label and remove the labels.

If you enter comment or body pattern during scanning, system will turn off Whizz Label
but keep the labels, user can also modify the labels kept on the image.
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Advanced urology procedures

E7C8L-RS probe can be attached to a stepper to be used for urological procedures including
transperineal needle guidance, transperineal grid biopsy and prostate brachytherapy.

ERB7/ERB Biopsy Attachment for E7C8L-RS

ERB7/ERB Biopsy attachment can been installed on the E7C8L-RS probe to assist you in
conducting biopsy procedures. Using this attachment allows a biopsy position to be selected
along the guide line while monitoring the Linear and Convex images in real-time.

ERB7/ERB Biopsy Attachment User Instruction
For ERB7/ERB Biopsy Attachment user instruction, please refer to Common Reusable
Biopsy Attachment User Manual for more information.

Please pay attention to the alignment tips below:

Figure 6-96 Probe/Attachment Alignment

a Do not install the guide attachment out of the scale of the probe.
b Align the scale of the probe and guide attachment.
NOTE
Attachment position can be adjusted based on patient size or distance to anatomy.

For proper setup recommendation for E7C8L-RS grid biopsy, please visit CIVCO website:
https://www.civco.com/catalog/ for User Instruction.

NOTE
Make sure probe and grid are attached correctly and tightly on the stepper.

A typical exam consists of:
The needle placement guide should match with the electronic needle placement grid
displayed on the Ultrasound system monitor. Grid is optional for stack of coins
measurements. When used with the stepper volume calculation option, a “stack-of-coins”
method can be used to calculate the volume of the prostate gland.

• Placing the patient in the supine or dorsal lithotomy position.
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• Carefully inserting a properly prepared E7C8L-RS probe and orienting it to scan the
prostate at the base position.

• Position the mechanical stepping device and secure the E7C8L-RS probe to the stepper.
• Make as many stepper volume measurements as necessary to calculate the volume of

the prostate.
• Retract the probe (utilizing the stepper device) the necessary step between each

incremental slice of the gland.
• Once the entire gland has been evaluated detach the probe from the mechanical stepper

and carefully remove it from the patient.

Biopsy Guideline Type Preset Selection

A preset, provided in Biopsy Kit on touch panel, is available for choosing the Biopsy
Guideline type.
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NOTE
Changing the needle guide type may be duplicated by programming a User Define key.
When the User Define key is pressed, the programmed needle guide type will be changed
with single key operation.

Figure 6-97 Setting the Biopsy Guideline Type for E7C8L-RS (-C: Convex Transducer)

Figure 6-98 Setting the Biopsy Guideline Type for E7C8L-RS (-L: Linear Transducer)
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E7C8L-RS Grid Biopsy Accessories

WARNING
The grid is single use only. Please choose the specific grid for your clinical usage.

The E7C8L-RS biopsy guide line accuracy absolute error shall be ≤ ±1.5mm, needle
guidance accuracy for grid shall be not larger than 1.8mm when using stabilizer/stepper for
procedure.
The table below lists the accessories included in E7C8L-RS MPWs Stepper Grid Biopsy.
Table 6-30 E7C8L-RS Grid Biopsy Accessories - MPWs Stepper

Multi-Purpose Workstation Stepper Grid Biopsy
Accessory

CIVCO Part No. Graphic

Multi-Purpose Workstation Stepper 642-510

Multi-Purpose Workstation Stepper - Cradle Only kit 642-509

Sterile Grid
(Disposable - one time use only)

610-905 (17GA)

610-906 (18GA)

Multi-Purpose Workstation with adjustable floor stand 610-974

The table below lists the accessories included in E7C8L-RS Classic Stepper Grid Biopsy.
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Table 6-31 E7C8L-RS Grid Biopsy Accessories - Classic Stepper

Classic Stepper Grid Biopsy Accessory CIVCO Part No. Graphic

Classic Stepper 642-512

Classic Cradle Only kit 642-511

Sterile Grid
(Disposable - one time use only)

610-905 (17GA)

610-906 (18GA)

Micro-Touch adjustable dual-sided table mount 610-911

Micro-Touch transportation stand (dual-sided
table mount)

610-911S

The table below lists the accessories included in E7C8L-RS EX3 Stepper Grid Biopsy.
Table 6-32 E7C8L-RS Grid Biopsy Accessories - EX3 Stepper

EX3 Stepper Grid Biopsy Accessory CIVCO Part No. Graphic

EX3 Stepper 642-514
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EX3 Stepper Grid Biopsy Accessory CIVCO Part No. Graphic

EX3 Cradle Only kit 642-513

Sterile Grid
(Disposable - one time use only)

610-905 (17GA)

610-906 (18GA)

Micro-Touch adjustable dual-sided table mount 610-911

Micro-Touch transportation stand (dual-sided
table mount)

610-911S

Calibration Procedure

For installing the E7C8L-RS probe on the Grid Biopsy guideline, please visit CIVCO website:
https://www.civco.com/catalog/ for User Instruction.

NOTE
Follow cleaning and disinfecting process for probe, steppers and reusable accessories
properly to avoid disease transmission between patients.

WARNING
The biopsy location/position must be calibrated prior to performing the actual biopsy to
compensate dimensional errors on kit and probe.

WARNING
Please do grid calibration step by step and check the accuracy before grid biopsy
examination.
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Depth Calibration

1. Submerge the probe and E7C8L-RS Grid Biopsy in 47°C (116.6 °F) water.

Figure 6-99 E7C8L-RS Grid Biopsy in water

2. Insert the 18 gauge needle into G11 of the grid biopsy.
NOTE
Please make sure choosing the correct needle according to the grid used with grid
biopsy kit.

3. Using the right/left knob of the grid biopsy bracket, adjust the location of the needle
image corresponding to the location of the grid.

Figure 6-100 Needle Image
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Center & Symmetry Calibration

1. Insert two needles on the E7C8L-RS grid biopsy guide in the following locations: B6 and
L6.

Figure 6-101 Center Calibration I

1. Relocate the probe on the bracket to adjust the center as shown below. Once it is
completed, tighten the knob to fix the location.

2. User can also use Alt + F7 Key and adjust the center by the Left/Right/Up/Down key on
the alphanumeric keyboard. The grid displayed on the monitor will appear red indicating
it is adjustable. Once position is set, use Alt+F7 again to accept.

3. Repeat the process until the location of the needle exactly coincides with the guide mark.

Figure 6-102 Needle Image
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Stepper Volume Measurement

Stepper volume (STVOL) is the method used to calculate the volume of an organ using
urology software, a transaxial probe and a mechanical stepping device that moves the probe
in fixed increments.
The volumes between the slices are assumed to be segments of a paraboloid of revolution,
where the volume between any slice n and n+1 is (An+An+1)d/2.
The sum of the volumes between slices is:
V=d [ ([A1+A2]/2) + ([A2+A3]/2) + .... + ([(An-1)+An]/2)]
Therefore, the total volume of the organ is calculated as:
V=d [ (5/6)A1+A2+A3+....+(5/6)An]
d: stepper volume increment;
V: stepper volume;
A: area.
Calculation method: Ellipse, Trace, Caliper, Circle, Spline.

Figure 6-103 Stepper Volume Measurement

Stepper volume (STVOL) is the method used to calculate the volume of an organ using the
urology software.
To perform a stepper volume (STVOL) measurement:

1. Perform the scan in the appropriate scan plane (Convex plane).
2. Press Freeze > Measure.
3. Select the STVOL folder on the Touch Panel, an active caliper displays.
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4. Perform a STVOL area measurement. For the detail of area measurement, please refer
to Circumference Measurement (Open Trace) on page 97.

5. The system displays the STVOL area and calculated STVOL in the Results Window.

Figure 6-104 STVOL Area Measurement

6. Press Freeze to unfreeze the image.

Repeat steps 1, 2, 5 and 6. To finish the Stepper Volume measurement, select STVOL
Done.
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WARNING
Do not freeze the image during a procedure, including biopsy procedure.

Figure 6-105 STVOL Done

NOTE
The maximum number of stepper volume slices is 50.

7. If it is required to perform the STVOL measurement again, repeat steps 1 through 7.

The relative error accuracy for B mode stepper volume measurement is <= 30%.

To view the stepper volume worksheet, press Worksheet on Touch Panel.

Figure 6-106 STVOL Worksheet
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Strain Imaging

Strain calculates and color-codes the extent of tissue deformation (lengthening or shortening)
relative to the original size over a given time interval, typically the systole. Users perform an
assessment of myocardial function based on color-coded images.
Strain is calculated using the following standard formula to produce a color map to show the
approximate values. The purpose of this tool is not to provide the exact strain or strain rate
value.

Figure 6-107 Standard formula for Strain
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Strain is dimensionless index of change in length. It defined as a measure of the amount
of local deformation of an object caused by an applied force. It displays the percent of
deformation [%].

Figure 6-108 The Strain mode screen

1. Strain color bar
2. Strain start and end markers
3. Strain start and end from detected QRS and Strain sample size
4. Parameter window

Figure 6-109 The Strain Touch panel
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Using Strain

Connect and configure ECG before using Strain.

1. From TVI mode, press Strain on the Touch Panel.
2. Adjust Strain Start close to the R-peak.
3. Adjust Strain End to end systole, typically near the T-wave.
4. Use the trackball key to adjust the size and position of ROI frame over the area to be

examined.

NOTE
User can select a desired cine loop in Strain mode from the stored images and enter
QAnalysis from the Touch Panel

Optimizing Strain

• From an optimized Strain rate display adjust strain tracking to pick out the systolic phase.
• The main use of Strain is to map negative systolic deformation. This means that Strain

start and Strain end should be adjusted to pick out the systolic phase of the cardiac
cycle: Adjust Strain start close to the R-Peak. Adjust Strain end to end systole, typically
near the T-wave.

• The maximum deformation that is color-coded can be adjusted using the Strain scale
control. If set too low, most of the wall will show the color indicating maximum
deformation. If set too high, the maximum deformation color is never reached.

• Strain provides information only in the beam direction. The apical view typically provides
the best window since the beams are then approximately aligned to the longitudinal
direction of the myocardium (except near the apex).

• Low strain values may be masked out with a different color using the SI Reject control.
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Strain rate

Strain rate calculates and color-codes the deformation per system time i.e. the speed at
which the tissue deformation occurs. Users assess myocardial function based on strain rate
color-coded images.
Strain rate is calculated as the spatial gradient of velocity data.
Strain rate is dimensionless index of change in length. It defined as a measure of the
amount of local deformation of an object caused by an applied force. It displays the speed of
deformation [1/sec].

Figure 6-110 The Strain rate mode screen

1. Strain rate color bar
2. Strain length and Strain rate reject
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3. Parameter window

Figure 6-111 The Strain rate Touch panel

Using Strain rate

1. From TVI Mode, press Strain Rate.
2. Use the trackball key to adjust the size and position of ROI frame over the area to be

examined.
3. Use the trackball to adjust the dimension of the ROI.

NOTE
User can select a desired cine loop in Strain Rate mode from the stored images and enter
QAnalysis from the Touch Panel

Optimizing Strain rate

• To reduce quantification noise (variance), the Nyquist limit should be as low as possible,
without creating aliasing. To reduce the Nyquist limit, reduce the scale while in TVI.

• To check for aliasing, freeze the loop and apply velocity trace (Press Freeze and Q-
Analysis), see `Quantitative analysis').

• Strain rate provides information only in the beam direction. The apical view typically
provides the best window since the beams are then approximately aligned to the
longitudinal direction of the myocardium (except near the apex).

• There is a trade-off between noise and spatial resolution controlled by the Strain length
control. To minimize noise the Strain length should be maximized.

• The maximum Strain rate that is color-coded can be adjusted using the SRI scale
control. If set too low, most of the wall will show the color indicating maximum Strain
rate. If set too high, the maximum Strain rate color is never reached.

• Low strain rates may be masked out with a green color using the SRI Reject control.
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Using 4D

WARNING

Please take extra care on the volume probe surface temperature before and during scanning
to avoid heat injury.
When using volume probe for 4D acquiring, end the 4D acquiring once the current exam is
complete, or freeze the 4D image when the machine is not in use.
DO NOT keep volume probe working in 4D acquiring mode for a long time, or the probe
surface temperature will exceed the normal value.

4D provides continuous, high volume acquisition of 3D images. 4D adds the dimension of
“movement” to a 3D image by providing continuous, real-time displays. With 4D, you can
apply rendering techniques to smooth out the appearance of an anatomical structure, for
example, a baby’s spine.
You can perform the following types of volume acquisitions within the 4D feature:
Table 6-33 4D Package Options

4D Type Description Acquisition Mode

4D Designed for continuous volume acquisition of a 3D image. B, 4D

Static 3D Designed for single volume acquisition of a 3D image. B, 3D

Features supported with 4D

The following features are supported with 4D:

• Most B-Mode controls
• Annotations
• High Detection Speckle Reduction Imaging (SRI-HD)
• Measurements and Calculations

The following post-processing controls are available with 4D:

• CINE
• Zoom

4D Principles of Operation

The acquisition of volume starts with a 2D image using special probes designed for
performing 3D sweeps and 4D scans. The volume box defines the region of interest to be
used for the volume sweep.
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Volume sweep refers to the range of the sweep of the 2D image to be transformed into a
rendered, 3D or 4D image. Static 3D acquisition involves a single volume sweep. 4D involves
multiple, continuous volume sweeps.

Figure 6-112 Volume Sweep

1 Central 2D Scan
2 Start 2D Scan
3 Range of VOI Sweep
When initiating a volume sweep, the angle of the volume can be adjusted.

Interactive 3D Rendering
Interactive 3D rendering allows visualization of certain structures, helping to view and analyze
different sections of the volume.

Region of Interest (ROI)/Render Box
The Region of Interest (ROI) - also referred to as the Render Box in rendering - contains the
section of the volume you want to render. Therefore, objects that are not inside of the box are
not included in the render process and are cut out (this is important in surface mode to allow
a free line of sight). This may or might not be the entire Volume of Interest (VOI).
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The view direction of the ROI can be adjusted.

Figure 6-113 Render View Directions

1 Up/Down
2 Left/Right
3 Front/Back
4 Down/Up
5 Right/Left
6 Back/Front

Render View

In Render view, only the rendered image displays - no reference images.

Advanced Features

510 Versana Premier/Versana Premier Lotus - User Manual
5928218-1EN Rev. 6



Image Orientation
Orientation of Image in Sectional view.

Figure 6-114 Quad Render Visualization Mode

1 Longitudinal
2 Transverse
3 Coronal

Principle of Sectional Planes
Sectional planes represent three different planes of the same 3D volume. There are three
separate planes, A (Longitudinal), B, (Transverse) and C (Coronal).

Figure 6-115 Illustration of Sectional Planes

The presentation of three orthogonal sectional planes is different from the conventional
patient orientation in 2D sonography.

NOTE
Whenever the usual, longitudinal section of the patient to display in field A is selected, the
conventional orientation for longitudinal and transverse sections is valid.
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Reference Images
Reference images are the individual image displays within the corresponding sectional plane.
Reference image A represents the longitudinal view; reference image B the transverse view,
and reference image C represents the coronal view.

Figure 6-116 Monitor Display of Reference Images in Sectional View

1. Reference Image A (Longitudinal)
2. Reference Image B (Transverse)
3. Reference Image C (Coronal)

Orientation Help
When you view a 4D image on the display, it’s sometimes difficult to recognize the
orientation. To help, the system displays a three-dimensional drawing to illustrate the
orientation. This drawing displays ONLY in sectional view.

Figure 6-117 Reference Image A
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For Reference image A, the transducer plane migrates from the FRONT to the REAR through
the volume body.

Figure 6-118 Reference Image B

For Reference image B, the transducer plane migrates from the LEFT to the RIGHT through
the volume body.

Figure 6-119 Reference Image C

For Reference image C, the transducer plane migrates from the TOP to the BOTTOM
through the volume body.
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Examples of Probe Orientation with Reference Planes

Figure 6-120 Abdominal Probe Orientation

1 Image Plane A
2 Image Plane B
3 Image Plane C
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4D Operational Controls

Control Panel Overview
When entering 3D/4D mode, the behavior of some of the Control Panel buttons changes. For
example, in 3D/4D mode, the PW-Mode, CF-Mode and M-Mode buttons are used (along with
Depth) to manipulate the Volume of Interest (VOI).

Figure 6-121 Control Panel Buttons

1. M key, M-Mode key used to rotate about the X axis.
2. PW key, PW-Mode key used to rotate about the Y axis.
3. CF Key, CF-Mode key used to rotate about the Z axis.
4. 3D/4D key.
5. Trackball, used to move the VOI. Also, the keys surrounding the Trackball map to

additional functionality, as shown on the monitor display.
6. Freeze key, used to freeze a 4D image.

4D Monitor Display
Imaging parameters are displayed in the upper right-hand portion of the display. The 4D
specific parameters are Quality (Q), Volume Angle (A) and Volume Rate (VR). The Status
Bar contains instructions on the tasks you can perform at each stage of the 4D imaging
process. Remember to take a look at the Status Bar as needed.
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4D Touch Panel Overview
Most 4D Touch Panel screens contain some similar controls. Refer to the table below for
descriptions of these controls. Controls that are unique to or that contain slightly different
functionality are described in the respective sections.
Table 6-34 Common 4D Touch Panel Controls

Preset Parameter Description

Tile The display can be divided into 1, 2, or 4 windows for Render view
(Render = On) and 1 or 4 windows for Sectional view (Render = Off).

Reset Curve Resets the three-point curve to a straight line.

Direction Adjusts the view direction of the ROI.

Visualization Sectional, Render, VCI, or Tomographic Ultrasound Imaging (TUI).
Render view displays one rendered image, or reference image(s) and
rendered image.

Focus Position Adjusts the focal position.

Volume Angle Sets the range of the volume sweep.

Quality Balances speed with line density. Max combines the highest density with
the slowest speed; Low combines the lowest density with the highest
speed.

4D Presets

Real-Time 4D/Static 3D Presets

1. When entering 3D/4D mode, select the Preset tab.
2. Select one of the preset settings for data acquisition and display. Presets are defined in

the preset file and differ by application.
Table 6-35 Common 4D Touch Panel Controls

Preset Parameter Description

Over Write Overwrite the application preset file with the changes you just made.

Create New Create a new user application preset file based upon the current
exam category and application.

User Used to define new user presets for a given application.

Static 3D Presets

1. When entering 3D/4D mode, select Static 3D, then the Preset tab.
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2. Select one of the preset settings for data acquisition and display. Presets are defined in
the preset file and differ by application.

Performing a 4D Scan

Visualizations
4D provides two types of views for displaying and working with images: Sectional, Render,
and Tomographic Ultrasound Imaging (TUI).

Sectional View

Sectional view contains one display for each sectional plane.

Figure 6-122 Monitor Display in Sectional View

1. Sectional Image A
2. Sectional Image B
3. Sectional Image C

Render View

The ultrasound system continuously displays the 4D rendered image.
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NOTE
When the tile selection is single, only the rendered 4D image appears. When the tile
selection is quad, the sectional images are located in 3 quadrants with the rendered 4D
image in the fourth.

Figure 6-123 Quad Tile Render View

Orientation Help
When viewing a 4D image on the display monitor, it’s sometimes difficult to recognize
the orientation. To help, the system displays a three-dimensional drawing to illustrate the
orientation. This drawing displays ONLY in sectional view.

Figure 6-124 Orientation Help Graphic
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Acquiring and Rendering a 4D VOI
Starting with a 2D Image

To create a 4D image, start with an optimized 2D image. The 2D image serves as the
mid-line for the resulting 4D image.

1. Connect the appropriate 4D-compatible probe, leaving the probes in their respective
holders.
NOTE
If the appropriate 4D probe is not connected, the original 3D Touch Panel appears.

2. Obtain a 2D image. Optimize the image as usual.

Entering 3D/4D Mode

In 3D/4D mode, the type of scan to perform is chosen: 4D or Static 3D.

1. Press 3D/4D to enter 3D/4D mode. The first time 3D/4D is pressed, the system is in B
Pre mode.

NOTE
The location of the number of focal zones might change when entering 3D/4D mode, since the
number of zones is pre-determined by the default ROI.

The default acquisition mode varies by application. In the OB application, the default acquisition
mode is Real-Time 4D. For all other applications, Static 3D is the default acquisition mode. When
entering pre-mode, an ROI graphic may appear on the monitor display that defines the initial ROI
(Region of Interest) of the volume.

Figure 6-125 ROI Graphic

2. Press the Preset tab. Select one of the preset settings for data acquisition and display.
Presets are defined in the preset file and differ by application.

Acquiring a 4D Volume of Interest (VOI)
To create a 4D image, you start with an optimized 2D image. The 2D image serves as the
mid-line for the resulting 4D image.
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During 4D image acquisition:

• Frame Averaging is disabled.
• You cannot change the transmit frequency.
• To change the position of the focal zone, adjust the depth of the VOI.
• You cannot change the number of focal zones.

Follow below steps to acquiring a 4D Volume of Interest (VOI).

1. Connect the appropriate 4D probe, leaving the probe in the respective holder.
NOTE
GE HealthCare recommends not to connect 4D straight handle probe to the center
probe port. It will prevent user to open the drawer.

2. Select the appropriate 4D probe from the probe indicator.
3. Obtain a 2D image. Optimize the image as usual.
4. Press 3D/4D to enter 3D/4D mode. An ROI graphic appears. 4D is selected.
5. Define the Volume of Interest (VOI) to be scanned. Press Pos Size until Pos is

highlighted, then move the Trackball to position the VOI. Then press Pos Size until
the Size is highlighted, then move Trackball to re-size the VOI. Only the area defined
within the VOI is rendered.

6. Adjust the volume angle. This defines the range of the volume sweep. A small sweep
angle results in a lower number of slices with a high volume rate.

7. Set Render on to begin 4D acquisition, press Start key. You DO NOT have to hold the
probe steady during data acquisition.

During data acquisition, you can manipulate the VOI to see different views of the image.
To rotate the VOI left or right, use the PW/Y control. To rotate the VOI forward or
backward, use the CF/Z control. To rotate the VOI in a circular motion, use the M/X
rotary control.

To return to 3D/4D pre-mode, press Pre Mode.

NOTE
If the volume size is too large, the message "Volume Size Too Big - Quality Degraded"
displays in the status bar. The system changes the quality automatically to below the
upper limit and displays the proper Quality value in the information window.

8. To complete the acquisition, press Freeze or Stop.
9. Store the image.

V-Live 2.0

V-Live 2.0 can be activated when performing static 3D and real-time 4D functions. The
lighting source used by the rendering can be positioned by the user around the rendered 3D
object on the sphere. By highlighting the side structure, a more realistic three-dimensional
image will be obtained.

Image rendering based on subsurface scattering technology is recognized as a mature
technology. Most of current surface reconstructions use frontal lighting on rendered objects,
which can cause images to look flat. Using the high-resolution volumetric imaging (V-Live
2.0) feature, lighting sources used for rendering can be positioned by the user around the
rendered 3D object on a sphere. By highlighting the side structures, the three-dimensional
image is significantly improved.
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You can activate V-Live 2.0 during live 4D scanning.

1. While scanning in 4D, select V-Live 2.0 on touch panel.
2. The flashlight icon displays on the screen. Press Light to continue. Move the trackball to

adjust the lighting direction for the scanning area.

Figure 6-126 V-Live 2.0 lighting sample

User can also activate V-Live 2.0 from Render tab after 3D/4D image acquisition.
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1. In 4D Render or Static 3D Render tab, select V-Live 2.0 from the drop-down menu of
Rend 1 Gray on touch panel.

Figure 6-127 V-Live 2.0 on Touch Panel

2. The flashlight icon displays on the screen. Press Light to continue. Move the trackball to
adjust the lighting direction for the scanning area.

NOTE
The lighting area can be adjusted 360 degree.

Sectional VOI Acquisition

Sectional view provides three separate views of the same image: Longitudinal (original
image), Transverse (elevational), and Coronal (horizontal).

1. In the 4D tab, Render defaults to On (Render mode). Change Render to Off for Sectional
view.

2. To select a reference image, use the Ref Image control on the Touch Panel. The
reference image selected contains the focus for control panel keys, allowing you to
manipulate or optimize that image.
Table 6-36 4D Data Acquisition Parameters

4D
Parameter Description

Restore
View

Resets all parameters back to the original values or chosen presets.

Tile Selections: Single, Quad. You can divide the display into 1 or 4 windows.
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4D
Parameter Description

Visualization Sectional, Render, or Tomographic Ultrasound Imaging (TUI). Render view
displays one rendered image, or reference image(s) and rendered image.

Orientation
Help

Displays a three-dimensional drawing to illustrate the orientation. Only displays in
sectional view.

Volume
Angle

Sets the range of the volume sweep.

Quality Selections: Max, Hi2, Hi1, Mid2, Mid1, Low. Used to balance speed with line
density. Max combines the highest density with the slowest speed. Low combines
the lowest density with the highest speed. BQ displays on the display.

Render VOI Acquisition

Rendering allows distinguishing of subtle anatomical detail. All areas of a VOI can be
rendered, or just certain regions of the VOI. The region defined for rendering is referred
to as the Render Box.

1. Define the area to be rendered. For example, with an image of an entire fetus, only the
fetal face may need to be rendered. Therefore, define the fetal face as the VOI.

2. Set Render to On.
Table 6-37 4D Data Acquisition Parameters - Render Mode

4D
Parameter

Description

Restore
View

Select to reset all parameters back to the original values or chosen presets.

Tile Selections: Single, Dual, Quad. You can divide the display into 1, 2, or 4 windows.

Visualization Sectional, Render, or Tomographic Ultrasound Imaging (TUI). Render view
displays one rendered image, or reference image(s) and rendered image.

3D Orient When selected, changes the orientation of the image on the monitor display.
Selections include: 0 degrees, 90 degrees, 180 degrees, and 270 degrees.

Volume
Angle

Sets the range of the volume sweep.

Quality Selections: Max, Hi2, Hi1, Mid2, Mid1, Low. Used to balance speed with line
density. Max combines the highest density with the slowest speed. Low combines
the lowest density with the highest speed.

Activate
Curve

Define a three-point curved surface for the render window using the Trackball.

Reset Curve Reset the three-point curve to a straight line.

Mix Selections: 0-100% in increments of 2. Allows you to mix a Rend Mode 1 mode
with a Rend Mode 2 mode. Always select two modes.

Chapter 6

Versana Premier/Versana Premier Lotus - User Manual 523
5928218-1EN Rev. 6



4D
Parameter

Description

Threshold Selections: 0-255. Sets a lower threshold below which weaker echoes are
removed.

3. Select the Render Setting tab.

The Render Setting tab allows selection and combining of gray-scale and color rendering
modes.

HINTS
When using Surface modes, adjust the Lower Threshold to recognize border structures
more clearly.

Table 6-38 4D (Data Acquisition) Render Parameters

4D
Parameter

Description

Direction The ROI determines the region that is rendered during 4D acquisition. The
direction in which this ROI is viewed can be changed. Selections: Up/Down, Down
Up, Left/Right, Right/Left, Front/Back, Back/Front.

Gray Map Displays the gray map selections on the display monitor. Select maps using the
Trackball.

Colorize Displays the tint map selections on the display monitor. Select maps using the
Trackball.

Render
Mode

Select Gray or Inversion. Selecting Inversion inverts the gray values of the
rendered image (e.g., image information that was black becomes white, and vice
versa).
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4D
Parameter

Description

Render 1 /
Render 2

Allows you to combine render mode values from render mode 1 and render mode
2. Select the render map combination from the upper-left portion of the monitor
display. Select map combinations using the Trackball.
Render Mode 1 Selections: Surface Smooth, Surface Texture, Transp Max, Transp
X-ray, Transp Min.
Surface Smooth - Surface displays in a smoothed texture mode, which means that
the gray values of the surface are identical with the gray values of the original 2D
scan.
Surface Texture - Surface displays in texture mode, which means that the gray
values of the surface are identical with the gray values of the original 2D scan.
Transp Max. - Displays the maximum intensity of gray values in the ROI. This is
helpful for viewing bony structures. Transp X-Ray - Displays all gray values in the
ROI. Trans Min. - Displays the minimum number of gray values in the ROI. This is
helpful for viewing vessels and hollow structures.
Render Mode 2 Selections: Surface Smooth, Light, Gradient Light, Transp Max,
Transp X-ray, Transp. Min.
Surface Smooth - Surface displays in a smoothed texture mode, which means that
the gray values of the surface are identical with the gray values of the original 2D
scan.
Light - Surface displays in light mode. Structures in the near field are brighter;
structures in the far field are darker. Gradient Light - Surface displays as if it
is illuminated from a spot light source. This is helpful if the displayed surface
is surrounded by hypoechoic structures (for example, liquids). Transp Max. -
Displays the maximum intensity of gray values in the ROI. This is helpful for
viewing bony structures. Transp X-ray - Displays all gray values in the ROI. Transp
Min. - Displays the minimum number of gray values in the ROI. This is helpful for
viewing vessels and hollow structures.

Adv. Rend Surface Smooth Plus - Surface displays in more smoothed mode.
Transparence Plus - Makes the image/information more transparent.

Transparenc
y

Selections: 20 to 250. Sets the transparency of the image. The higher the number,
the more transparent the gray scale information.

Manipulating the Volume of Interest (VOI)
The 3D/4D ROI is a tangible anatomical object that can be viewed and manipulated easily
using the Trackball and other control panel keys.
If the monitor display is in Sectional view, select the desired reference image before
manipulating the image.

Moving through the VOI
To move through the image to view a particular slice, press Shift.
This allows a displacement of the center of rotation along the intersection lines of the
sectional planes A, B, and C. The displacement of the center of rotation leads to the display
of parallel sectional images.

Zooming the Image
Rotate Zoom to zoom on the image.
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Moving the VOI Position
To move the position of the VOI, press Scan Area button on the control panel until Pos is
highlighted, then move the Trackball left, right, up and down, as needed.

Resizing the VOI
To re-size the VOI, press Top Right Key on the control panel until Size is highlighted, then
move the Trackball.

Stopping 4D Image Acquisition
To stop acquiring a 4D image, press Freeze/Stop.

4D VOI Post-Processing
When you press Freeze, the system menu may differ, depending on whether you are in
Render view or Sectional view.

Volume CINE

The system constantly stores CINE images to play back and review those images. CINE
is useful for focusing on images during the specific part of the heart cycle or to view short
segments of a scan session.
To activate CINE in 4D:

1. Press Freeze.
2. Select the VolCine tab.

Table 6-39 4D Cine Parameters

Preset
Parameter

Description

Loop Mode Selections include: One Way, BiDirectional (two-way). One Way - plays one loop
sequence forward. BiDirectional - plays the sequence forward and backward.

First Displays the first volume in the CINE loop.

Last Displays the last volume in the CINE loop.

Run/Stop Starts and stops the CINE loop.

Loop Speed Adjusts the CINE loop speed.

Volume by
Volume

Used to select an individual volume in the CINE loop.

3. If you were in Render visualization mode when you entered 4D CINE mode, you can also
press Pre Mode Key to return the Pre Mode.

If you were in Sectional visualization mode when you entered 4D CINE mode, you can
press Pre Mode key to return the Pre Mode.

4. To re-start real-time 4D acquisition, press Freeze.

Static 3D

A single sweep, single volume static 3D image can be created.
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Performing a Static 3D Scan

1. Connect the appropriate 4D probe, leaving the probe in the respective holder.
NOTE
GE HealthCare recommend not to connect 4D straight handle probe to the center probe
port. It will prevent user to open the drawer.

2. Select the appropriate 4D probe from the probe indicator.
3. Obtain a 2D image. Optimize the image as usual.
4. Press 3D/4D.
5. Press Static 3D. Set Render to On.
6. Define the Volume of Interest (VOI) to be scanned. Press Pos Size until Pos is

highlighted, then move the Trackball to position the VOI. Then press Pos Size until
the Size is highlighted, then move Trackball to re-size the VOI. Only the area defined
within the VOI is rendered.

7. Adjust the volume angle. This defines the range of the volume sweep. A small sweep
angle results in a lower number of slices with a high volume rate.

8. Make sure the probe is held steady. Press the Start key to start acquisition.
NOTE
During 3D acquisition, the CW, PW, M, and Depth control panel keys are not available.

NOTE
When the 3D acquisition begins, the Touch Panel appears blank for a brief moment.

9. Hold the probe steady until the system stops automatically. You will know the acquisition
has stopped when the system menu changes to display the Render Setting, 3D
Rotational Cine, and Scalpel tabs.

10. Store the image.

You can also activate V-Live 2.0 to use the light during Static 3D Scan. Refer to V-Live 2.0
on page 520 for detail information.

Static 3D Sectional View
Table 6-40 3D After Acquisition Parameters - Sectional View

Preset Parameter Description

Orientation Help Displays a 3-dimensional drawing to illustrate the orientation. Only
displays in sectional view.

Static 3D Render View
Table 6-41 3D After Acquisition Parameters - Render View - Page 1

Preset Parameter Description

Edit/Accept ROI Selections include Edit, Accept. Edit - Select to adjust the size of the
Region of Interest (ROI). Accept - accepts the active 3D image.
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Preset Parameter Description

3D Orient When selected, changes the orientation of the image on the monitor
display. Selections include: 0 degrees, 90 degrees, 180 degrees, and
270 degrees.

Scalpel

Scalpel allows editing/cutting sections of a 3D image. Scalpel is available only on a rendered
image.

1. Select Scalpel.
Table 6-42 Scalpel Parameters

Preset Parameter Description

Cut Mode Selections: Inside Contour, Outside Contour, Inside Box, Outside
Box, Eraser Big, Eraser Small. Inside Contour, Outside Contour -
Allows tracing the portion of the image to cut. Trace Outside removes
all portions of the image that fall outside the traced region. Trace
Inside removes all portions of the image that fall inside the traced
region. Inside Box, Outside Box - Displays a box used to define the
portion of the image to cut. Outside Box removes all portions of the
image that fall outside the box. Inside Box removes all portions of the
image that fall inside the box. Eraser Big, Eraser Small - Provides a
big and small eraser tool used to define the portion of the image to
cut by hand. Available only if Depth is Full.

Cut Depth Selections: Full, Define. Full -The entire depth of the selected region
will be cut. Define - Allows you to define the depth to cut using the
Depth control panel knob.

Undo Last Undoes the last cut only.

Redo Select to redo scalpel.

Undo All Undoes all cuts since you entered Scalpel mode.

Done Applies to User Defined Cut Depth when complete.

2. Select the cut mode.
3. Use the Trackball and Set key to define the portion of the image to cut. Press Set to

start, move the Trackball to define the region, then press Set again to cut the image.
The portion is removed.

To undo the last cut, select Undo Last.

To undo all cuts in the current session, select Undo All.

NOTE
With the cut image displayed, if you attempt to switch to the Static 3D tab to edit the
ROI, the following warning message appears: Scalpel changes will be lost. Do you want
to continue? [Yes/No].

3D Rotation CINE

3D Rotation CINE allows you to view the 3D image from various angles.

Advanced Features

528 Versana Premier/Versana Premier Lotus - User Manual
5928218-1EN Rev. 6



To activate rotation CINE in 3D:

1. Press Freeze.
2. Select the 3DRot Cine tab.

Table 6-43 3D Rotation Cine Parameters

Preset Parameter Description

Rotational Angle Sets the rotational angle of the 3D image over which the CINE loop is
played. Typical values are 30, 45, 60, 90, 180 and 360 degrees.

Step Angle Sets the step angle between individual frames in the CINE loop.

Rotation Axis Sets the axis about which the CINE loop is calculated. Selections X
and Y.

Loop Mode Selections include: One Way, BiDirectional (two-way). One Way -
plays one loop sequence forward. BiDirectional - plays the sequence
forward and backward.

First Displays the first volume in the CINE.

Last Displays the last volume in the CINE.

Run/Stop Starts and stops the CINE sequence.

Start Angle Used to select the starting angle in the CINE loop range. The default
Start Image is calculated from the rotational angle as: -1 X Rotational
angle / 2 If you adjust the Start Image, the Rotational Angle is re-set
to be the value of the adjusted Start Image.

End Angle Used to select the ending angle in the CINE loop range. The default
End Image is calculated from the rotational angle as: Rotational
angle / 2 If you adjust the End Image, the Rotational Angle is re-set to
be the value of the adjusted End Image.

Image by Image Used to select an individual image in the CINE loop.

VOCAL

Use VOCAL (Virtual Organ Computer-aided Analysis) to visualize and calculate the volume
of anatomical structures, such as a tumor lesion, cysts, and the prostate. VOCAL is available
after a Static 3D or Real-Time 4D acquisition.

1. Select Vocal. Specify the volume calculation method (Manual, Contour Detect,
SemiAuto Detect, or Sphere). Select the reference image you want to use to perform
the trace by selecting Ref Image A, B, or C. Press Start.

2. Trace the anatomy using the Trackball. Press Set to start and end the trace. You
must go across the dotted line for the trace to take effect (it turns yellow). The trace
is performed on each image slice, separated by the rotational step angle. Rotate the
Rot. Ref dial until you have completed the total of the required rotations (for example, if
you’ve selected 30 degrees, you need to complete six traces if you’ve selected Manual).
After you’ve completed the trace target, the Calc Volume button is active for you to
press. The calculated VOCAL image appears in the lower, right-hand corner of the
display. You are now in the edit state.
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NOTE
Trace not used for Sphere. For Sphere, set the Poles.

3. Edit as necessary. You can apply a shell, adjust its thickness, navigate through the
reference angles, or restart the VOCAL.

VOCAL Touch Panel states are described in the following tables.
Table 6-44 VOCAL Parameters on Setup Touch Panel

Parameter Description

Manual When you select the Manual method, you need to perform a manual
trace on each of the rotation angles.

Contour Detect When you select the Contour Detect method, you need to perform a
manual trace on each of the rotation angles.

SemiAuto Detect When you select the Semi Automatic Detect method, you need to
perform a trace on only two rotation angles. The system applies an
algorithm to define the traces.

Structure Structure is only available with the SemiAuto Detect method. Select
Hypo, Cystic, or Hyper/Iso.

Sphere Calculates the volume based on the pole settings.

Pole 1 Adjust the upper contour point (green arrow) of the structure.

Pole 2 Adjust the lower contour point (green arrow) of the structure.

Rotational Step Angle Specify the angular spacing between contour traces. Typical values
are 6, 9, 15, and 30 degrees. The number of planes varies by this
formula: 180 degrees / selected rotational step angle.

Ref Image Use this to select the image you want to use to perform the trace.

Start Press Start when you’re ready to perform the trace.

Rot.Ref #/# Back/Next Select Next/Back to move to the next image for contour definition in
the rotation step.

Table 6-45 VOCAL Calculate Volume Touch Panel

Parameter Description

Calc Volume Press Calc Volume to initiate the VOCAL image calculation.

Clear Press Clear to remove the trace from the image.

Restart Vocal Press Restart Vocal to return to the initial VOCAL state.

The Shell Modes allows you to construct a shell or contour “around” the structure of
interest, which enables you to distinguish between the contour of the targeted structure
and the contours the inside and outside of the structure.
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Table 6-46 VOCAL Parameters on Edit Touch Panel

Parameter Description

Shell Off Select Shell Off if you do not want a shell around the VOCAL image.

Inside Select Inside if you want a shell inside the volume.

Outside Select Outside if you want a shell outside the volume.

Symmetric Select Symmetric if you want half of the shell thickness inside and
half outside the volume’s perimeter.

Shell Thickness Adjust to vary the thickness of the shell.

Tomographic Ultrasound Imaging (TUI)

Tomographic Ultrasound Imaging (TUI) is a visualization mode which presents data as
parallel slices (planes) through the dataset. This method of visualization is consistent with
CT and MRI. The distance between the different planes can be adjusted.

1. Select TUI as the Visualization mode.
2. Start acquisition.
3. If in 4D, press R to end the acquisition. This step is not required in Static 3D.

The reference image and the number of specified slices appears. The reference image
always displays and indicates which slices you are currently viewing as solid lines.

Figure 6-128 TUI 3x3 Example

a. The TUI reference image that shows the slice position. This image is orthogonal to the
reference image.
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b. The number and green asterisk shows the position of each slice. A green asterisk
indicates the center image (A, B or C-plane).

c. Slice distance displays when the slices are in certain intervals.

d. A solid line indicates the slice appears on the monitor.

A dotted line indicates the slice did not appear on the monitor.

NOTE
TUI with Color is only available with Static 3D, not with 4D.

4. Adjust the number of slices and slice distance.

You can adjust the number of slices by using the Slices rotary. You can adjust the
distance between the slices using the Slice Distance rotary. Max value is 40mm.

• Select Display Format from 1x1, 1x2, 2x2 and 3x3.
• Change the center image via Ref. Image if needed (Reference image A, B or C).
• Move forward/backward through the slices via Prev./Next Slice.
• The following features are supported in TUI: Rotation (X/Y/Z), Trackball (Move the

position) and Gain.
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Whizz RenderLive

Whizz RenderLive helps to find the render start position to easily separate solid tissue in front
of the rendered object.

The Whizz RenderLive algorithm “looks” for the transition from solid tissue to liquids and
positions the “Render Start” into the liquid area visualized by the green render start line. The
render start line is not a straight line but a “free” trace for optimal adaptation to the rendered
object.

NOTE
The render start line can be positioned by pressing auto. It is possible to adjust the line trace
manually but not its sensitivity. For more flexibility/sensitivity, Whizz RenderLive has to be
activated.

Using Whizz RenderLive

1. Start the Render Visualization Mode.
2. Press the Whizz RenderLive knob.
3. To adjust the distance between the render start position and the render object, rotate the

Sensitivity control below the touch panel. A high value indicates a smaller distance.
NOTE
In the case that Whizz RenderLive is not used, the Render Start line can also be
modified manually. Press the trackball button Curv to activate Curved Render Start and
move the trackball to modify the line.
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NOTE
Whizz RenderLive is not available in Sectional or TUI Mode.

Figure 6-129 Whizz RenderLive example
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Whizz Follicle

Whizz Follicle helps detect low echogenic objects (e.g. follicles) in an organ (e.g. ovary) and
analyzes their shape and volume. From the calculated volume of the object, an average
diameter is calculated. All objects detected using whizz follicle will be listed according to
size. The calculation results are displayed in the bottom left corner, with the object numbers
color-coded to denote the object on the image. If the mouse cursor hovers over a specific
item on the list, the respective object in the image is highlighted (and vice versa). The color of
the object is bound to its position on the list.
On the acquired three-dimensional image data, low-echo object areas (such as follicles) in
organs (such as ovaries) are detected by manual cursor selection or manual measurement
of height and length, and the trace and number will be marked on the screen. The system
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calculates the volume and average diameter of the object based on the measurement results,
and display them in the Whizz Follicle table from largest to smallest based on the results.

Figure 6-130 Whizz Follicle Display Screen

Figure 6-131 Whizz Follicle Touch Panel

Table 6-47 Whizz Follicle Parameters on Touch Panel

Parameter Description

SemiAuto Each object is selected manually with the system cursor but traced /
measured automatically.

Manual Each object has to be selected and measured manually.
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Parameter Description

Angular The box has the shape of a rectangle.

Rounded The box has an elliptic shape with rounded corners.

Left Ovary Choose to measure Left Ovary with GYN application.

Right Ovary Choose to measure Right Ovary with GYN application.

Using Whizz Follicle

Manual

1. Create a 3D Static Volume of the desired organ.
2. Press the Volume Analysis in Static3D Render tab.
3. Select Whizz Follicle on the Touch Panel
4. Select Manual and adjust the ROI shape, if desired.
5. Start the measurement by selecting either Left Ovary or Right Ovary.
6. The green measurement cross appears on the monitor.
7. Perform measurements:

a. Position the start-point of the long diameter with the Trackball and press Set.
b. Position end-point of the long diameter with the Trackball and press Set.
c. Position the start-point of the short diameter with the Trackball and press Set.
d. Position end-point of the short diameter with the Trackball and press Set. The second
measurement displays.
e. To start the next measurement move the Trackball and repeat step 7.

8. Press AddToReport on the Touch Panel.
NOTE
A message will appear on the screen to indicate the report is added successfully.

9. User can press New Analysis and start a new analysis by repeating step 5 to step 8.

Semi Auto

1. Create a 3D Static Volume of the desired organ.
2. Press the Volume Analysis in Static3D Render tab.
3. Select Whizz Follicle on the Touch Panel
4. Select SemiAuto and adjust the ROI shape, if desired.
5. Start the measurement by selecting either Left Ovary or Right Ovary.
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6. Move the green arrow cursor to the middle of the desired area to measure and press
Add/Rem. trackball key. Then use trackball keys to add, remove, cut or merge the
desired area.

Figure 6-132 Whizz Follicle Trackball keys

Add/
Rem.

Position the system cursor over the detected object, then press Add/Rem. key
to add or remove objects manually.

Cut Position the system cursor over the detected object, then press Cut key and
use the trackball to trace the area you want to remove and press Cut key again
to cut the traced area.

Merge Position the system cursor over the detected object and press Merge key and
move the trackball to another object. Then press Merge key again to combine
these 2 objects.

7. Press AddToReport on the Touch Panel.
8. User can press New Analysis and start a new analysis by repeating step 4 to step 7.

User can also use the Add Manual key while SemiAuto is selected when objects are not
detected or wrongly measured.

1. Press Add Manual button.
2. The measurement cross appears.
3. Perform measurements:

a.Position the start-point of the long diameter with the Trackball and press Set.
b.Position end-point of the long diameter with the Trackball and press Set.
c.Position the start-point of the short diameter with the Trackball and press Set.
d.Position end-point of the short diameter with the Trackball and press Set. The second

measurement displays.
e.To start the next measurement move the Trackball and repeat step 3.

Whizz Follicle Report

1. Press Report on touch panel.
2. Select Whizz Follicle in Worksheet Tab.
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3. Press Whizz Report to generate report.

Figure 6-133 Whizz Follicle Worksheet and Report Touch Panel
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Whizz Note

Whizz Note allows the system to display folders and files from removable media. The user
can import and display useful clinical datasheet for reference during scanning.

1. Insert a removable media to the ultrasound system.
NOTE
Supported media includes USB, HDD, CD/DVD and Network Storage.

2. Press Assistant key on control panel.
3. Click Whizz Note on the touch panel.

Figure 6-134 Note on Touch Panel

4. A window displays on the screen. Select desired file, click Import to import files to Whizz
Note.
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NOTE
Whizz Note only supports importing files in bmp, png, jpg, jpeg, gif, icns or pdf format.
File sizes should be less than 2 Megabytes each.

Figure 6-135 Import files to Whizz Note
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5. The imported files will be listed in the Whizz Note window. User can select desired files
and click Show to open the file as a reference during operating the system. You can also
select  icon to import more files.

Figure 6-136 Show the file in Whizz Note

6. User can manipulate Whizz Note window while operating the system.

Figure 6-137 Whizz Note Main page
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Table 6-48 Controls on Whizz Note main page

No Control Description

1 Page control Select to display previous or next page.

2 Minimize/Maximize Select to maximize or minimize the window.

3 Close Select to close Whizz Note.

4 Size Move the cursor till it turns to an arrow, hold and drag
to change the size of the window.

7. To add more files, click the + icon on the right upper corner.
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VCO for customer

VCO for Customer allows a remote expert(s) who has (have) been authorized by the user to
connect to ultrasound system remotely. It enables remote imaging support, communication
and application training through the facility server and internet connection between the 2
components of the feature, DClient (Device Client) and EClient (Expert Client). DClient is
integrated in the software of the ultrasound device. EClient is a software application that can
be installed on a personal computer or mobile device.

WARNING
VCO for Customer is not intended for diagnostic use since GE HealthCare cannot validate
the shared image feed on the EClient side.

CAUTION
VCO for Customer is not available during biopsy procedure or cardiac application.

Outside Hospital version

Before using VCO for Customer (Outside Hospital version)
Before using VCO for Customer, please follow below steps to prepare both DClient and
EClient sides.

1. Make sure internet configuration for ultrasound system is completed before using VCO
for Customer.

2. Please connect USB2.0 drive-free camera and microphone through USB ports on
ultrasound system to share with video and audio during VCO for Customer session.

3. Enter https://jysx.gehealthcloud.cn into internet browser of local device with assigned
admin account information to create user account(s) for EClient expert(s).
NOTE
Admin account assigned by GE HealthCare can be used to create additional ultrasound
system (DClient) accounts as well as EClient accounts. Each expert needs a separate
account.

4. Share created account information (username and password) with each EClient
expert(s).

5. Inform EClient expert(s) to download and install EClient application on the device they
plan to use during the sharing session.

• For Windows devices, use internet browser to enter https://jysx.gehealthcloud.cn for
downloading and installing EClient application.

• For Android mobile devices, scan below barcode to download and install EClient
application.
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• For iOS mobile devices, visit App Store and search for  to
download and install EClient application.

6. You can start using VCO for Customer now.

Using VCO for Customer (Outside Hospital version) - DClient Side

1. Press Assistant key on the control panel, select VCO for Customer on the Touch
Panel.

Figure 6-138 Enter VCO For Customer
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2. Select Outside Hospital Version and Region in the pop up window, then press
Confirm to continue.

Figure 6-139 Select Outside Hospital version

NOTE
Please select appropriate region from the pop up window for the first time login the
Outside Hospital Version.

3. Input username and password on login page.
NOTE
Only authorized user can use VCO for Customer.

NOTE
User name and password can be assigned by the hospital administrator. If password is
lost, please contact administrator or GE HealthCare service to reset password.

NOTE
If connection error occurs, please check internet connection first. If internet connection is
good, please check if server address is correct.
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4. Press Login to enter VCO for Customer. User can select desired scenario to start
real-time assistant, training education, quality control and/or offline communication.

Figure 6-140 Outside Hospital version scenario

NOTE
When server connection is not good, there will be a caution message says server
connection is poor.

Below table lists the description for the scenario on home page.
Table 6-49 VCO for Customer home page on ultrasound system

Scenario Description

Real-time Assistant • DClient user requests to the remote expert to help provide support/
guidance during imaging.

• DClient user shares the ultrasound scan screen and can have a
live conversation. The video camera can be placed in position to
allow the EClient user to see imaging actions like probe position of
the DClient user.

• EClient user guides user of DClient with imaging operation through
live discussion.
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Scenario Description

Quality Control • DClient user enters quality control mode.
• EClient user(quality control center) selects device(s) for the quality

assessment to be performed on.
• EClient user views multiple scan screens of clients device

simultaneously.
• EClient user can request live discussion during the quality

assessment.

Training Education • DClient user can invite EClient to training session.
• DClient user shares ultrasound scan screen and positions external

video camera to allow EClient to view live scanning.
• DClient user and EClient users can communicate live through

Video and Audio.

Offline
Communication • DClient user sends JPG or wmv images to EClient for

communication.
• EClient user can view images and send text message between

expert clients.

GE Online • DClient user and EClient user can test the connection or start
online training.

• DClient user can consult application issue during using the feature.

Real-time Assistant
To use Real-time Assistant:

1. Select Real-time Assistant on home page.
WARNING
You are about to activate remote sharing function. Please pay attention to the protection
of patient information to avoid leakage

2. Select expert(s) from Experts List and press Enter Room to start Real-time Assistant.
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NOTE
Experts list is generated automatically after user account(s) are created in step 4
of section "Before using VCO for Customer".

Figure 6-141 Experts List

CAUTION
Please stop sharing when VCO is running at non-scanning window to prevent any
potential PHI (Patient Health Information) disclosure.

Main user interface controls in Real-time Assistant scenario are illustrated as below:
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Table 6-50 User Interface controls in Real-time Assistant

Icon No. Icon Name Description

1 Audio Enable/disable audio output.

2 Video Enable/disable video output.

3 Share Enable/disable screen sharing.

4 Setting Change the setting for image and other configuration.

5 Exit End meeting and exit VCO for customer.

6 Hide Minimize the main control menu to the top of the
screen.

7 Local Video Window on DClient side.

8 Remote Video Window on EClient side.

9 Members Online members list. User can mute all other users on
the list in this window.

10 Sharing area Screen sharing area.

Training Education
DClient user can invite EClient user to training session or share ultrasound scan screen and
position external video camera to allow EClient user to view live scanning.
DClient user and EClient expert can communicate live through Video and Audio. The remote
training classroom can support up to 300 users online at the same time.

1. Select Training Education on home page.
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2. Select expert(s) from Experts List and press Enter Room to start Training Education.

Main user interface in Training Education scenario is the same as Real-time Assistant, refer
to Real-time Assistant on page 548 for detail information.

Quality Control
Select Quality Control on home page to enter Quality Control mode.
An expert can see and communicate with multiple devices in Quality Control mode. For
the detail information of user interface in Quality Control scenario, please refer to Real-time
Assistant on page 548 for more information.

Figure 6-142 Quality Control key

User can also press the key a on the quality control page to request Quality Control from
EClient expert.

Offline Communication
When the EClient expert is not available for real-time assistant, user can send images/cine
loops for offline communication.
Follow below steps for offline communication:

1. Complete the exam and exit VCO for Customer.
2. For traditional workflow, select the exam and click Active Image. For simplified workflow,

select the exam and click Image Review.
3. For traditional workflow, select the images/cine loops needs to be sent, then click

`SaveAs' Images. For simplified workflow, select the images/cine loops needs to be
sent, then click Send To.

4. For traditional workflow, select Transfer to VCO For Customer under the drop-down
menu of Save in archive. For simplified workflow, select VCO For Customer in the
pop-up window.

Chapter 6

Versana Premier/Versana Premier Lotus - User Manual 551
5928218-1EN Rev. 6



5. For traditional workflow, click Save. For simplified workflow, click Send. Then the system
will transfer the selected images/cine loops without PHI and turn on VCO for Customer
automatically.
CAUTION
The patient information should be hidden when using VCO for Customer to transfer
images from DClient (Device Client) to EClient (Expert Client).

Figure 6-143 Send Image/Cine loops under Traditional Workflow

Figure 6-144 Send Image/Cine loops under Simplified Workflow

6. Input username and password to login VCO for Customer.
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7. Select expert from Experts List(a) and select files need to sent under Files(b), then click
Send to send files offline.

NOTE
User can send maximum 5 files in each offline communication message.

Figure 6-145 Send Offline Communication

8. Click X on the right upper corner to exit offline communication.

Inside Hospital version

Before using VCO for Customer (Inside Hospital version)
Before using VCO for Customer, please follow below steps to prepare both DClient and
EClient sides.

NOTE
Please make sure connecting to the intranet for the system internet configuration.

1. Make sure internet configuration for ultrasound system is completed before using VCO
for Customer.
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2. Please connect USB2.0 drive-free camera and microphone through USB ports on
ultrasound system to share with video and audio during VCO for Customer session.

3. Configure VCO for Customer to an ultrasound system User-Defined key in Utility >
User Configurable Key > User Defined Key.

4. You can start using VCO for Customer now.

Using VCO for Customer (Inside Hospital Version) - DClient Side

1. Press Assistant key on the control panel, select VCO for Customer on the Touch
Panel.

Figure 6-146 Enter VCO For Customer

2. Select Inside Hospital Version, press Confirm to continue.

Figure 6-147 Select Inside Hospital version

3. Input username and password on login page.
NOTE
Only authorized user can use VCO for Customer.
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NOTE
User name and password can be assigned by the hospital administrator. If password is
lost, please contact administrator to reset password.

NOTE
If connection error occurs, please check internet connection first. If internet connection is
good, please check if server address is correct.

4. Press Login to enter VCO for Customer.
Below table lists the description for the scenario on home page.
Table 6-51 VCO for Customer (Inside Hospital Version) home page on ultrasound
system

Scenario Description

Real-time
Assistant • DClient user requests to the remote expert to help provide

support/guidance during imaging.
• DClient user shares the ultrasound scan screen and can have

a live conversation. The video camera can be placed in position
to allow the EClient user to see imaging actions like probe
position of the DClient user.

• EClient user guides user of DClient with imaging operation
through live discussion.

5. Select Real-time Assistant to continue.

Figure 6-148 Inside Hospital version scenario

WARNING
You are about to activate remote sharing function. Please pay attention to the protection
of patient information to avoid leakage

NOTE
When server connection is not good, there will be a caution message says server
connection is poor.
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6. Select expert(s) from Experts List, the selected experts will be displayed on the right
column. Press Confirm to enter the device connecting page.

Figure 6-149 Select Experts

CAUTION
Please stop sharing when VCO is running at non-scanning window to prevent any
potential PHI (Patient Health Information) disclosure.

7. On the device connection page, make sure that the camera, microphone, speaker, and
network equipment are connected, click the Enter Session button to enter the meeting.
User can set the camera and microphone to be turned on/off.

8. Main user interface controls in Real-time Assistant scenario of Inside Hospital Version
are illustrated as below:

Figure 6-150 User Interface for Inside Hospital Version
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Table 6-52 User Interface controls in Real-time Assistant

Icon No. Icon Name Description

1 Microphone Enable/disable audio output.

2 Video Enable/disable video output.

3 Screen Share Enable/disable screen sharing.

4 Setting Change the setting for image and other
configuration.

5 End
Conversation

Exit real-time assistant.

6 Close
Application

Exit the application.

7 Hide Hide the menu.

8 Local Video Window on DClient side.

9 Remote Video Window on EClient side.

10 Members Online members list.

11 Sharing area Screen sharing area.

Using VCO for Customer - EClient Side

Before using VCO for Customer on EClient side, scan the barcode below to get the
supplementary instruction.

Figure 6-151 Barcode for downloading supplementary instruction

For detail information on using VCO for Customer on EClient side, please read and follow the
supplementary instruction downloaded.
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Digital Expert Connect

Digital Expert Connect is intended to facilitate remote non-diagnostic image viewing and
review, consultation, guidance, support, and education in real time between ultrasound users
and remote users. This device is intended for use by healthcare professionals in a clinical
support setting on compatible workstations and mobile devices.

NOTE
This tool is not for clinical diagnostics purposes.

Refer to the Digital Expert Connect User Manual for information on setting up and using
Digital Expert Connect.

NOTE
Digital Expert Connect is not available in all regions.
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Intensity Ratio

Intensity Ratio(IR) is a generic measurement to calculate the ratio of two intensity (Echo
Level, displays EL_dB) measurements. The formula is, Intensity Ratio = Intensity A/ Intensity
B.

Purpose

Intensity Ratio is intended to calculate the intensity ratio of two sample areas on a frozen
B-mode image.

Probes and presets

Intensity Ratio is available through specific probes and presets. Refer to Table 5-8 Probe
modes of operation and Features on page 330 for detail information.

Scan Mode

Intensity Ratio is only available on 2D B-mode.

Activation

1. Obtain a frozen B-mode image.
2. Press Measure on control panel, select a category on Touch Panel.
3. Select Cardiac Generic in Cardiology category or Generic in other categories, then

press Intensity Ratio to enter the page.

IR Calculation

IR can be activated from generic measurement menu on a frozen image. Sample area can be
drawn freehand by trace or circle. User shall select the format before using Intensity Ratio.
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Select Double Trace or Double Circle on Intensity Ratio main page directly.

Figure 6-152 Select ROI format on Touch Panel

Draw the sample area by trace if Double Trace is selected.

Figure 6-153 ROIs drawn by trace

Draw the sample area by circle if Double Circle is selected.
Follow below steps to adjust the ROI for Double Circle：
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1. Rotate Set Sample Area Shape knob.

Figure 6-154 Intensity Ratio Sub Menu

2. Adjust the Height, Width and Tilt angle for Double Circle ROI. Click OK to start
drawing.

Figure 6-155 Adjust Double Circle ROI
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Use trackball and Set key to draw by Double Circle.

Figure 6-156 ROIs drawn by circle

Display Intensity A and B values and IR in measurement window after performing.

IR Calculation with Follow Up Tool

IR measurement can be activated/calculated when entering Follow Up tool.

1. Select Auto Copy QA Measurement from Utility > System > System Imaging >
Follow Up Tool.

2. Obtain two ROIs, save it as Raw DICOM image, press Follow Up button, select the
RawDICOM image, click Freeze button, press Measure, then the samples area (two
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ROIs) of intensity 1 and intensity 2 shall be copied to side by side Raw DICOM image
comparison from a patient's previous exam to the patient's current active exam.

Figure 6-157 IR Calculation with Follow Up Tool

Worksheet and Report

IR calculation can be transferred to worksheet and report. Press Report > Whizz Report to
display the IR calculations and report.

NOTE
Measurements taken during the active exam are transferred to the current exam's
Worksheet only; previous exam measurement information is not included on active
worksheets.
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US LI-RADS (ACR)

The Ultrasound Liver Imaging Reporting And Data System (US LI-RADS® v2017) is:

• A standardized system for imaging technique, interpretation, reporting, and data
collection for screening or surveillance ultrasound exams in patients at risk for
developing HCC.

• Supported and endorsed by the American College of Radiology (ACR).
• Developed by a consortium of diagnostic radiologists and hepatologists with expertise

in hepatobiliary ultrasound, with input from and approval by the LI-RADS Steering
Committee.

US LI-RADS US requires two types of assessments, both pertaining to the whole liver rather
than specific nodules or other observations:

• US category
• US visualization score

US Category

The US Category summarizes the main results and helps determine the most appropriate
follow-up. These scores are possible:

• US-1 Negative
• US-2 Subthreshold
• US-3 Positive

Table 6-53 US Category Details

Category Concept Definition

US-1 Negative No US evidence of HCC No observation OR Only definitely
benign observation(s)

US-2
Subthreshold

Observation(s) detected that may
warrant short-term US surveillance

Observation(s) < 10mm in diameter,
not definitely benign

US-3 Positive Observation(s) detected that
may warrant multiphase contrast-
enhanced imaging

Observation(s) >= 10mm diameter,
not definitely benign OR New
thrombus in vein

US Visualization Score

The US Visualization Score reflects technical or other factors that may affect liver
visualization or nodule detection. This information helps to communicate the expected level
of sensitivity of the screening exam for HCC detection in an individual patient. Data on
visualization scores may be used for quality assurance and to inform future refinements
of LI-RADS and LI-RADS-related management guidelines. Three visualization scores are
possible:
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• A. No or minimal limitations
• B. Moderate limitations
• C. Severe limitations

Table 6-54 US Visualization Score Details

Score Concept Examples

A. No or
minimal
limitations

Limitations if any are
unlikely to meaningfully affect
sensitivity

Liver homogeneous or minimally
heterogeneous.
Minimal beam attenuation or shadowing.
Liver visualized in near entirety.

B. Moderate
limitations

Limitations may obscure
small masses

Liver moderately heterogeneous
Moderate beam attenuation or shadowing
Some portions of liver or diaphragm not
visualized

C. Severe
limitations

Limitations significantly lower
sensitivity for focal liver
lesions

Liver severely heterogeneous
Severe beam attenuation or shadowing
Majority (>50%) of liver not visualized
Majority (>50%) of diaphragm not visualized

User Requirement

Probes and Presets
LI-RADS(ACR) is only offered in Abdomen application using ABD or ABD_PEN presets.

Activation
There are two entrance to activate LI-RADS(ACR). Operator can use Measure button to
activate:
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1. Press Measure, select Abdomen category, press LI-RADS(ACR) on the Touch Panel to
activate LI-RADS(ACR).

Figure 6-158 LI-RADS on Touch Panel

2. Select US category and US visualization score, input comments in Comment box.

Figure 6-159 Using LI-RADS

NOTE
The character limit for comment is 512 characters.
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NOTE
Click the icon in the upper right corner of the LI-RADS(ACR) menu. A window will appear
with reference information. Click the icon again to close the window.

Operator can also activate LI-RADS(ACR) by pressing Report on the Touch Panel.

1. Press Report, click LI-RADS(ACR) to activate LI-RADS(ACR).
2. Select US category and US visualization score, input comments in Comment box.

NOTE
There is no reference information when using Report button to activate LI-RADS.

LI-DARS(ACR) Report
After completion, press Report > LI-RADS(ACR) > Whizz Report to display the report, this
applies to both system configurations.

US LI-RADS® Management
The table summarizes the suggested follow-up for patients based on the US LI-RADS®

Category. Note that the US Visualization Score is not used to determine follow up.
Table 6-55 US LI-RADS Management

Category Follow Up Action

US-1 Negative Repeat surveillance US in 6 mo

US-2 Subthreshold Repeat surveillance US in 3-6 moa,b

US-3 Positive Further characterization with multiphase contrast-enhanced imagingc

Footnotes:
a. For observations < 10mm in size (US-2 Subthreshold), follow-up in 3-6 months is
suggested. If observation does not show growth over a 2-year period, observation can be
benign and study can be categorized as US-1 Negative.
b. This is concordant with 2010 AASLD recommendations.
c. Multiphase imaging may include multiphase contrast-enhanced CT, MR, or CEUS.
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Whizz Report

The ultrasound system enables the generation of patient reports based on the examination
performed and the analyses that were made during the exam. The reports are generated
using the data stored in the system with pre-selected template.
You may edit a report while performing the exam; customize, delete, or add measurements;
and save changes until you use the Store command. Once Stored, the reports are read-only.
It is recommended that the data be saved often, and then carefully reviewed before the report
is Stored. Use the worksheet to facilitate the review and adjust data before storing a report.
The final report can be printed on a standard printer.
This ultrasound system allows users to create their own report template by a separate tool
called Whizz Report Editor on users' personal computer.
The template can be saved into an USB and imported to the ultrasound system.

Creating a report

Reports summarize the data obtained in the examination. They can contain data, images,
and cine loops.
The ultrasound system retrieves the patient information from the archive which is then used
to generate the report. Once generated, the report can be viewed, images can be added,
and the patient's personal data can be modified. The examination data itself CANNOT be
changed.

Activating the Report

1. Select Report > Whizz Report on the Touch Panel.
2. Default report for the current application displays on the monitor.

The information entered during the examination is automatically filled in the appropriate
fields (e.g. demographic, diagnosis, comments).

3. Use cursor to select images on the clipboard and add to the Images column.
4. Use report button controls on touch panel for more further action.

Table 6-56 Report Button Controls

Button Description

Worksheet Accesses Worksheet Page

Graph Accesses OB Graph page (applies only to OB).

Anatomical Page Accesses Anatomical Survey page (applies only to OB).

Template Selects templates from the list of selected applications.

Store Stores the report page into Archive as CHM file.
NOTE: CHM is a compressed HTML help file.

Save As Exports the report page to storage media as PDF format.
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Button Description

Print Prints out the report to the default printer.

Retrieve Retrieves the report page from Archive.
Stored Date/Time is appended to the name of stored
report.

Print Preview Preview the report before printing.

Add Bull's Eye Add Bull's Eye graph in report. (applies only to Cardiac).

Exit Exit to scanning page.

Delete Delete the report.

Selecting another template

You can select another template for the current patient:

1. Select Report > Whizz Report > Template on the Touch Panel.
2. A list of available templates and exam categories displays.
3. Select the desired template using the Trackball and press Set key.

The selected template displays on the monitor.

NOTE
If you select another exam category, the template list of the selected category displays.
Select the desired template.

4. Select the desired template name and press Set.
5. The report changes to the selected template.

Factory Templates

The system has factory templates for each application. You can also create your own
templates with Whizz Report Editor on a personal computer and import to the ultrasound
system. You need to save revised/new templates with unique names.
A template may include one or more of the following:

• Measurements
• Worksheet or Vessel Summary Images
• Anatomical Surveys or Biophysical Profiles
• Anatomical Graphics
• Graphs
• Images areas
• Score Boxes

User-defined report templates can be added from the Utility > Reports menu. Refer to
Import Report Template to Ultrasound System on page 580 for detail information.
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Whizz Report Editor

Whizz Report Editor is a software application installed on user's personal computer. You can
use it to design and create your own customized template from a blank template page, or you
can use an existing template (factory or user-defined) and save the changes.

Installation and Operating environment
Whizz Report Editor only supports running on Win10 and above operating systems.
User can export the Whizz Report Editor from the ultrasound system to install on your own
computer.

1. Press Utility > Whizz Report on the Touch Panel.
2. Click Export Whizz Report Editor icon on the monitor.

Figure 6-160 Export Whizz Report Editor

3. Select the removable media to save the Whizz Report Editor application.
4. Connect the removable media to your local computor with Win 10 and above opertating

system and double click the application to install.

Design or edit a report template

1. Double click the Whizz Report Editor application to open the tool on your personal
computer.
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2. The main page displays as below.

Figure 6-161 Whizz Report Editor main page

Table 6-57 Whizz Report Editor main page

No Name Description

a Components Lists all the components user may need for the report.

b Tool Bar List the tools for editing the main page of the template.

c Components
Editor

Use to edit the details of each selected component.

d Template Template preview for current design status.

Whizz Report Components
There are 4 categories of components for users to choose. User can choose general
components under General and select special components from OB, Carotid and Cardiac
for specific application.
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To add a component in the template, you can click and hold the cursor to drag the desired
component to the report template.

Figure 6-162 Drag components to template
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Table 6-58 Whizz Report Components

Category Component Description

General Headers This is the header of the report.

Images This is a box displays the images from the test.

Conclusion It's a input box to input conclusion in text format.

Patient Information This is a box displays patient information.

Measurement This is a box displays measurements.

Referral Reason It's a input box to input referral reason in text format.

Diagnosis It's a input box to input diagnosis in text format.

Signature It's a box to show Signature, user can write text in
blank area.

Anatomical Survey This is a box to show anatomical survey result.

Biophysical Profile This is a box to show Biophysical Profile result.

Line Use to insert a line between two components.

Measurements CV This is a box displays measurements CV.

Footers This is the footer of report template, Operator and
Perf. Physician can be changed to other patient
information elements.

Ratios Measurements This is a box displays Ratios Measurements.

Text Field This is a Text input box, maximum number of this
components is 20 in a report template.

Fixed Text This is a Fixed Text box, and user can edit text in
designer tool, maximum number of this components
is 20 in a report template.

OB OB Graphs This is a box displays OB Graphs.
User can check or uncheck OB Graphs in
worksheet->Graph.

OB Calculations This is a box to show calculations text. System will
insert calculation measurements data to the table
automatically.

Growth Bar Graph This is a box displays Growth Bar Graph.
User can select fetus.

OB Measurements This is a box displays OB Measurements.

Carotid Carotid Measurements This is a box displays carotid measurements,
In middle, this is a carotid image, and in left
and right, there are some measurements, include
measurement title and measurements data.
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Category Component Description

Cardiac Bull Eye Wall Motion
Score Box

Displays two cardiac images and every area can be
paint by different color.

Cut Planes Wall Displays two rows and per row has five cardiac
images, and every area can be paint by different
color.

Score Table This is a list to show Score and color of Score .

Tool Bar
On the top of the Whizz Report Editor main page, there is a tool bar.

Figure 6-163 Whizz Report Editor Tool Bar

Table 6-59 Whizz Report Editor Tool Bar

No Tool Name Description

1 Report Templates Click to select report template from Default Templates or My
Templates.

2 Report Display
Ratio

Use drop-down menu to select report display ratio. Available
ratio: 25%, 50%, 75%, 100%, 125% and 150%.

3 Undo/Redo Click to Undo or Redo previous / next steps.

4 Move Click on the icon, the icon will turn to blue and the cursor shape
will change. You can move the template by click and hold the
cursor.
NOTE: Press the icon again to disable the movement.

5 Zoom Out/
Zoom In

Click to zoom out / zoom in the template.

6 Page Margin Click to select template page margin from Normal, Narrow or
Wide.

7 Template Name Click the tab to input the template name. Default text is Default
Template Name.

8 Export Html Click to export current template in Html format.

9 Save as Save current template as a new template.

10 Save Save the template.

Whizz Report Component Configuration
On the right side of Whizz Report Editor main page, there is a component configuration
column. You can configure the display for each component.
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Private Options

Private Options is different for each component. Once user select a component in the
template, all the configurable elements will be displayed under Private Options.

NOTE
Some components doesn't have configurable elements. Please skip if the Private Options
drop-down menu is empty.

Headers Configuration
Header configuration allows user to edit report logo and hospital information.

Figure 6-164 Headers Configuration

1. Logo - Select desired logo for the report template.
2. Delete - Delete selected logo.
3. Import - Import new graphic for logo.
4. Hospital Info - Check the box and type text in the tab to show Hospital name, Address

and Phone on the template.
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Images Configuration
Use can select the Grid to adjust the display of template images.

Figure 6-165 Images Configuration

Patient Information Configuration
This section allows user to configure patient information

Figure 6-166 Patient Information Configuration

'

1. Show Title - Enable or disable the component title.
2. Table - Select the design of the columns showing in the components.
3. Info filter - Check to select the information that displays under Patient Information.
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Conclusion Configuration
Use can enable and disable the Summary in the component.

Figure 6-167 Conclusion Configuration

1. Show Title - Enable or disable the component title.
2. Summary - Display or hide Summary in the component.

Line Configuration
Use can change the Stroke Width of Line in the template.

Figure 6-168 Line Configuration

Measurement CV Configuration
Use can check to select desired Vascular Measurements.

Figure 6-169 Vascular Measurement Configuration
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Footer Configuration
Use can check to select the information to display on footer.

Figure 6-170 Footer Configuration

Bull Eye Wall Motion Score Box Configuration
Use can select the Grid to adjust the display of template images.

Figure 6-171 Bull Eye Wall Motion Score Box Configuration

Container Options

Container Options allow users to customize the Padding, Stroke and Font for each
component.

Figure 6-172 Container Options

1. Padding - Use to adjust the padding for the component.
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2. Stroke - Use to adjust color, style and width for the component.
3. Font - Use to adjust color, size and style of the fonts in the component.

NOTE
Component title is not adjustable.

Report Template Preview
This section displays current editing template. User can preview during editing. You can
move the components up and down or adjust the size of each component.
User can use the cursor to click and hold on the components to drag the component to move
the component up and down.

Figure 6-173 Move the component up and down

User can move the cursor to the right bottom of each component till the cursor turns to arrow,
click and hold to resize the component.

Figure 6-174 Resize the component

Export Report Template
User can export your own templated designed by Whizz Report Editor and import to
ultrasound system.
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To export your own template from Whizz Report Editor:

• Click the Export icon in the tool bar of Whizz Report Editor to save the current editing
template to a removable media.

Figure 6-175 Export current template as Html Document

• Click Report Templates icon in the tool bar of Whizz Report Editor, then select and
save desired template from My Templates > Export.

Figure 6-176 Export Html Documents from My Templates

Import Report Template to Ultrasound System

User can import your own templated designed by Whizz Report Editor to ultrasound system.
To import a new template from Whizz Report Editor:

1. Save and export your own template to a removable media. Refer to Export Report
Template on page 579 for exporting details.

2. Connect the removable media to ultrasound system.
3. Press Utility > Whizz Report on Touch Panel.
4. Click Import to open the removable media.
5. Select the template from the removable media and click Import to complete.

Once the import is completed, a templates successfully imported information window will
pop out.
Click OK to continue.
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6. Select the desired template from Available Templates > My templates, then click

to move the template under Section.

Figure 6-177 Import report template

a: Set Default - Once the imported template is selected, there Set Default icon displays.
User can click to set imported template as default.
b: Up and Down icon - Use these buttons to move the selected template up and down.
c: Reset: Reset to original settings.

7. Press Report > Whizz Report > Template on the Touch Panel to change the template
by Trackball and Cursor key.

Figure 6-178 Change the report template
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Scan Coach

Scan Coach Manager

Before performing Scan Coach function on the system, please read and accept the
Statement, Disclaimer and Limitation of liability described as below:

Statement
• Scan Coach IS NOT MEANT TO REPLACE TRAINING, OR TUTORIALS/HANDS-ON.

IT IS MERELY A REFRESHER TOOL OF ALREADY RECEIVED EDUCATION AND
TRAINING.

• Scan Coach IS AN ON -DEMAND REFRESHER AND REMINDER TOOL WHICH
DISPLAYS INFORMATION IN THE FORM OF DICOM IMAGES, ANIMATIONS AND
VOICE COMMENT; THE PROVIDED REFERENCE MATERIAL MAY HELP USER IN
ACQUIRING ULTRASOUND IMAGES.

• Scan Coach DOES NOT PROVIDE A DIAGNOSIS, BUT DOES PROVIDE REFERENCE
MATERIAL FOR SOME TYPES OF ACQUISITIONS.

• Scan Coach IS MEANT TO PROVIDE REFERENCE MATERIAL FOR ACQUISITION,
BUT IT IS NOT INTENDED TO IDENTIFY DIAGNOSTIC IMAGE QUALITY. ACTUAL
IMAGES, INCLUDING IMAGE QUALITY, OF THE DEVICE MAY VARY VERSUS THE
PROVIDED REFERENCE MATERIAL.

Disclaimer
Scan Coach AND THE CONTENT AVAILABLE THROUGH IT ARE PROVIDED ON AN
"AS IS" AND "AS AVAILABLE" BASIS. YOU EXPRESSLY AGREE THAT USE OF Scan
Coach AND/OR ITS CONTENT IS AT YOUR SOLE RISK. TO THE FULLEST EXTENT
PERMISSIBLE PURSUANT TO APPLICABLE LAW, GE AND ITS AFFILIATES DISCLAIM
ALL WARRANTIES OF ANY KIND, WHETHER EXPRESS OR IMPLIED, INCLUDING
WITHOUT LIMITATION ANY WARRANTY OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE OR NON-INFRINGEMENT. YOU EXPRESSLY AGREE THAT
USE OF Scan Coach, INCLUDING ALL CONTENT, IS AT YOUR SOLE RISK.
ANY RESPONSIBILTY FOR IMAGE ACQUISITION, IMAGE INTERPRETATION,
IDENTIFICATION OF ANATOMICAL PARTS, ANATOMICAL MEASUREMENTS AND
CLINICAL DIAGNOSIS LIES WITH YOU, THE ULTRASOUND USER.
TO THE FULLEST EXTENT PERMISSIBLE PURSUANT TO APPLICABLE LAW, GE AND
ITS AFFILIATES DISCLAIM ALL LIABILTY AND RESPONSIBILITY FOR ANY DAMAGES
SUFFERED BY A USER, OR PATIENT OF A USER INCLUDING, BUT NOT LIMITED TO,
DAMAGES ARISING OUT OF LOSS OR INACCURACY OF CONTENT OF Scan Coach.
IT IS THE RESPONSIBILTY OF YOU, THE ULTRASOUND USER, TO UNDERTAKE
ALL NECESSARY AND CUSTOMARY TRAINING, AND TO MEET ALL OTHER
REQUIREMENTS OF APPLICABLE LAWS AND REGULATIONS, BEFORE USING THE
ULTRASOUND DEVICE.

Limitation of Liability
UNDER NO CIRCUMSTANCES, INCLUDING, WITHOUT LIMITATION, NEGLIGENCE,
SHALL GE OR ITS PARENTS, SUBSIDIARIES, AFFILIATES, OFFICERS, DIRECTORS,
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EMPLOYEES, AGENTS, OR SUPPLIERS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES ARISING FROM OR IN
CONNECTION WITH THE USE OF OR THE INABILITY TO USE Scan Coach.

Introduction
Scan Coach is based on Scan Assistant, it displays information which helps user acquire the
right scan plane. The reference image indicates how the scan plane image for a given step
should look like. The probe/beam anime image shows the corresponding probe placement,
or beam formation for getting the correct scan plane. The schema anime shows the key
anatomical structures to be visualized in two dimensional mode.
Scan Coach can be used as an on-demand refresher/reminder tool in live scanning.

Scan Coach Description

Figure 6-179 Scan Coach Display Description

1. Program step number and step name.
NOTE
The user is also able to select the program step by pressing the Up/Down key on the AN
keyboard.

2. List View - Select this icon to display program list.
3. Image View - Select this icon to activate Animation and Reference image.
4. Both View - Select this icon to display both view of Scan Coach.
5. Select this icon to activate Scan Coach Edit page.
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6. Animation of probe position.
7. Two dimensional schema of the current scan plane.
8. Voice Comment list.
9. Recorder for voice comment.

Setting up Scan Coach
Go to Utility > Scan Coach > Scan Coach Manager to create, import/export and manage
the Scan Coach programs.

Using Scan Coach with Voice Comment

1. Go to Utility > Scan Coach > Scan Coach Manager, select the protocol from the left
column, move it to the Program Selections column. Then select Exit to the Scanning
page.

Figure 6-180 Select Scan Coach Protocol

2. Press Assistant key on the control panel and then select Scan Coach on the Touch
Panel to activate the Scan Coach function. The Scan Coach addendum displays. Select
Acknowledge to continue.
Or select Cancel not to start Scan Coach.
Check the box before Don't show next time and the Scan Coach addendum will not
display next time.

3. Select the protocol from the pull-down menu, and then select Start.
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NOTE
If there is only one program in the current application, the system will display the Scan
Coach screen directly. This step is only available when there are two or more programs.

4. Select program, for example, LIVER LENGTH, then select Image View icon to review
the reference image and the probe position and schema.
It displays reference image, probe position, voice comment and schema to guide the
user acquire the right scan plane.

Figure 6-181 Using Scan Coach 2

a. live scan image
b. reference image
c. probe position
d. two dimensional schema of the current scan plane
e. voice comment

5. You can also press the List View icon to return to the program step list and select
another program.

Using Voice Comment

Voice Comment is a quick method to record comments while Scan Coach.
To use the voice comment:

1. Connect the microphone to ultrasound system.
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2. Record the voice comments and save to Voice Comment list.

Figure 6-182 Voice Comment Recorder

a. Click to start recording.
b. Click to play the recorded comment.
c. Click to stop recording.
NOTE
The maximum recording time is 2 minutes. Once the recording time reaches 2 minutes,
the recording will be stopped automatically.

d. Input the file name.
e. Click to save the Voice Comment.

3. All the recorded voice comments will be saved to the Voice Comment list.
NOTE
User can save maximum 5 voice comments, for more comments, please delete the
existing comments to release space.

4. Play the voice comments.

Figure 6-183 Voice Comment List
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a. Click to switch from playing each comments continuously on the list or playing
selected comments only.
b. Click to delete the voice comment.
c. Click to play the voice comment.

Edit Scan Coach Protocol

1. To edit Scan Coach protocols, go to Utility > Scan Coach > Scan Coach Manager and
select Creator.

Or Select the icon  in the program list. Then select  and the system will
lead to the Scan Coach Edit page.

2. The Scan Coach Creator is used to build customized programs that can be imported
onto the Versana Premier/Versana Premier Lotus. Select Scan Coach on the tool bar to
display the Scan Coach edit page.

Figure 6-184 Scan Coach Creator

3. Select the Scan Plane. Select Browse to upload the reference image.

Figure 6-185 Select Scan Plane
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4. Select Upload to upload the reference image from the folder called "Reference Images"
of the corresponding application. Then select Close after the upload is complete.

Figure 6-186 Upload Reference Image

NOTE
The reference image only supports *.dcm file.

The reference image can also be uploaded from external USB stick/HDD/CD/DVD.
Select the correct directory from the pull-down menu, and then select the appropriate
image to upload.

5. Upload Probe Position Image and Schema Image from the folder called "Other Images"
of the corresponding application, or from the external devices.

NOTE
A protocol can be created without uploading the reference image, but the protocol without
reference image do not display in Utility > Scan Coach > Scan Coach Manager. It can be
found via Utility > Scan Coach > Scan Coach Manager > Custom Programs.

Activating the Scan Coach Creator

To activate the Scan Coach Creator on the Versana Premier/Versana Premier Lotus, press
Utility > Scan Coach > Scan Coach Manager and select Creator.
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Scan Coach Creator

The Scan Coach Creator is used to build customized Programs that can be imported onto
this ultrasound system. These Programs automate many of the steps normally performed
manually by the user, thereby reducing the number of user actions and the amount of time to
perform an exam.

Figure 6-187 Tool Layout Overview

1. Menu and Tool Bars
2. Scan Coach Button
3. Steps
4. Scan Coach Attributes
5. Rule Checking

NOTE
Scan Coach Button is not available for Scan Assistant, only for Scan Coach.

The Scan Coach Creator tool can be used both on the scanner and as an off scanner tool.
Where there are differences in behavior, this user's guide uses the term `on scanner' to
indicate when the tool is running on the scanner and `off scanner' to indicate when the tool is
running off the scanner.

Chapter 6

Versana Premier/Versana Premier Lotus - User Manual 589
5928218-1EN Rev. 6



File Handling
When using Scan Coach Creator off the scanner, it is very important to organize the
programs in a way that will make it easy to import the programs onto the scanner. Each
Program is a computer file. While these computer files can be copied, pasted and deleted like
any other computer file, the Program files are only viewable using the Scan Coach Creator.

Off-Scanner Directory Structure

The Scan Coach Creator organizes the Programs in a directory structure that allows easy
importing into the Versana Premier/Versana Premier Lotus. In order to be imported, all
Programs must be stored in a LOGIQ_SCAN_COACH Programs Directory. Within this
directory, one or more user-specified directories are created. Within each of these user-
specified directories are the category directories (VAS, ABD, etc.) that hold the actual
Programs.
The dialog in the figure below allows the user to specify the location of the
LOGIQ_SCAN_COACH directory (root directory) and to either select an existing User
Program Directory or create a new one.
The Directory Structure dialog can be accessed via the File menu and File Toolbar.

File Extensions

Factory defined Programs have an .ep (exam Program) extension while user-defined
Programs have an .uep (user exam Program) extension. Both factory and user-defined
Programs can be read into the Scan Coach Creator, but only user-defined Programs are
created. If a factory Program is read into the Scan Coach Creator and then edited, it is saved
as a user-defined Program.
Upon installation of the Scan Coach Creator, files with a .ep or .uep extension are
automatically associated with the Scan Coach Creator.

Exporting Programs from Ultrasound System

Factory or user-defined Programs on the ultrasound system are easily exported for editing
with the Scan Coach Creator.
On the ultrasound system:

1. Insert a USB storage device (or CD/DVD).
2. Select Utility > Scan Coach.
3. Select Export.
4. Select the media type and specify a directory. If a directory is specified that already

exists, the Export adds the Programs along with any existing Programs. If the names of
Programs are the same, use the resulting dialog to decide how to continue.

5. Select the Program to be exported and export them.

Importing Programs to Ultrasound System

Programs created with the Scan Coach Creator are easily imported to the Versana Premier/
Versana Premier Lotus.
Copy the complete LOGIQ_SCAN_COACH directory from the system to a USB device
(or CD/DVD). The LOGIQ_SCAN_COACH directory needs to be at the top level (not in a
subdirectory) on the USB device (or CD/DVD).
Example of Directory structure:
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LOGIQ_SCAN_COACH
MyUserNameDirectory
ABD
CARD
GYN
OB
VAS
On the Versana Premier/Versana Premier Lotus:

1. Insert the USB device (or CD/DVD).
2. Select Utility > Scan Coach.
3. Select Import.
4. Select the media type.
5. Select the Programs to be imported and import them. If you attempt to import Programs

that already exist with the same name, use the resulting dialog to decide how to
continue.

Creating New Programs

A new Program is created by selecting File > New, by clicking on the New document icon in
the Toolbar, or by using the keyboard shortcut Ctrl+N.

1. Before creating a New Program, select Single Step in the Toolbar.

Figure 6-188 File Toolbar

2. Proceed to add/update your settings for the Step: Step Name, Instructions, etc.
3. Once finished, highlight the finished Step.

Figure 6-189 Highlight Step to Copy
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4. Select Edit > Copy.

Figure 6-190 Edit -> Copy

5. In the Toolbar along the left, select Insert Step Before Selected or Insert Step After
Selected.

Figure 6-191 Insert Step

6. Highlight the copied step and proceed to edit accordingly.
7. Proceed to follow the same procedure to add more steps to your Program.
8. When you are done, select Check to verify your Steps.
9. The results are listed as to whether the Scan Coach Rule Check Passed or if any

Issues were detected. Issues found when running the check do not mean the Program is
unusable.

NOTE
The rule check may report an unequal number of left and right steps. This may or may not
be the expected result. If a change is made in response to the rule check results, a new rule
check can be run to see if the issue has been resolved.

Views
A Program is made up of a series of steps. Each step is made up of various step attributes.
The step and step attribute data can be viewed in many ways using the Scan Coach Creator.
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The different ways to look at the data are called Views. The view of choice is selected from
the View Selection Menu or the View Toolbar Menu.

Figure 6-192 View Selection Menu and View Toolbar Menu

Single Step Views

There are two Single Step views: Basic and All. The Basic view shows the most common
attributes of the selected step. The All view shows all of the attributes of a given step.
For both views, the step names are shown on the left with the active step highlighted. The
step attributes appear on the right and are separated into four groupings:
General attributes at the top
Imaging and Comment attributes on the left
Measure attributes on the right.

Figure 6-193 Basic Single Step View

1. Steps
2. Step Attributes
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Scan Coach Features
Scan Coach allows the user to program the steps in an exam and to program certain
attributes for each step. The attributes are what give the Scan Coach Program behavior.
The tables below provide the names of all attributes along with a description of how each one
is interpreted by the Scan Coach feature.

General Attributes
Table 6-60 General Attributes

Attribute
Name

Selections Description First Step
Default

Other Steps
Default

Store Order (Not
Applicable)

Button used to enable the
Store Order Definition dialog
so that the Store Order can
be set

Advance On Store Advance to the next step and
go live after Print / Image
Store (e.g. P1 key). This can
be a single image store or a
loop store.

Print Same as
previous step

Store &
Unfreeze

Advance to the next step after
Print / Image Store (e.g. P1
key) and unfreeze. This can
be a single image store or a
loop store.

User
Selection

Advance to next step only
after next step is manually
selected (e.g. down arrow)

Instructions [Any Text] User notes displayed in the
Scan Coach Navigation menu
when the step is active

Blank Same as
previous step

Optional Optional
(checked)

An optional step is given a
check mark during Program
execution even if no image is
acquired

Mandatory Same as
previous step

Mandatory
(unchecked)

A mandatory step is given a
check mark only if an image
is acquired for the step

Learn Probe On (checked) Learn and change the probe
for the user

Off Off

Off
(unchecked)

No probe change
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Comment Attributes
Table 6-61 Comment Attributes

Attribute
Name

Selections Description First Step
Default

Other Steps
Default

Comment 1,
Comment 2

[Any Text] User annotation associated
with the step. When editing
in a Multi Step View, use
Alt+Enter to create a new
line.

Same as Step
Name
attribute

Same as Step
Name
attribute
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Attribute
Name

Selections Description First Step
Default

Other Steps
Default

Location 1,
Location 2

Top Left Annotation is placed in the
top left corner of the image
area

Location 1:
Bottom Center

Same as
previous step

Middle Left Annotation is placed in the
middle left side of the image
area

Bottom Left Annotation is placed in the
bottom left corner of the
image area

Location 2:
Dual Right:
Bottom Center

Top Center Annotation is placed in the
top center of the image area

Bottom Center Annotation is placed in the
bottom center of the image
area

Top Right Annotation is placed in the
top right corner of the image
area

Mid Right Annotation is placed in the
middle right side of the image
area

Bottom Right Annotation is placed in the
bottom right corner of the
image area

Dual Left:
Bottom Center

Annotation is placed on the
bottom center of the left
image in dual screen

Dual Left: Top
Left

Annotation is placed on the
top left of the left image in
dual screen

Dual Left:
Bottom Right

Annotation is placed on the
bottom right of the left image
in dual screen

Dual Right:
Bottom Center

Annotation is placed on the
bottom center of the right
image in dual screen

Dual Right:
Top Left

Annotation is placed on the
top left of the right image in
dual screen

Dual Right:
Bottom Right

Annotation is placed on the
bottom right of the right image
in dual screen
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Attribute
Name

Selections Description First Step
Default

Other Steps
Default

BP1, 2 Blank Body Pattern not specified.
Scan Coach does not set
Body Pattern.

Blank Same as
previous step

Body pattern
graphics with
or without
probe position

Selected Body Pattern with or
without probe position will be
set.

Blank Same as
previous step

BP Specify (Not
applicable)

Button used to enable the
Body Pattern Selection dialog
so that the Body Pattern
graphic can be selected and
probe position can be set

BP Clear (Not
applicable)

Clears BP1, BP2 defined for
the step

BP Probe On (checked) BP Probe mark will be set by
Scan Coach

Off Same as
previous step

Off
(unchecked)

Probe mark not specified.
Scan Coach does not set
Probe mark.

Imaging Mode Attributes
The probe and application associated with a program is not configurable. Instead, the
scanner remembers the last probe and application used for a given Scan Coach program
and automatically selects them the next time the program is started.
Table 6-62 Imaging Mode Attributes

Attribute
Name

Selections Description First Step
Default

Other Steps
Default

Color Mode On (checked) Color Doppler is on Off Same as
previous step

Off
(unchecked)

Color Doppler is off

PW Doppler
Mode

On (checked) PW Doppler is on. If PW
Doppler is not on and the new
activated step indicates that
Doppler should be on, the
Mode Cursor is displayed or,
if the Mode Cursor is already
displayed, then PW Doppler
is turned on.

Off Same as
previous step

Off
(unchecked)

PW Doppler is off

Chapter 6

Versana Premier/Versana Premier Lotus - User Manual 597
5928218-1EN Rev. 6



Attribute
Name

Selections Description First Step
Default

Other Steps
Default

M Mode On (checked) M-Mode is on Off Same as
previous step

Off
(unchecked)

M-mode is off

CW Mode On (checked) CW Mode is on Off Same as
previous step

Off
(unchecked)

CW Mode is off

Dual Off Dual screen not in use Off Same as
previous step

Left Active Dual screen is active and the
left image is the active image.

Right Active Dual screen is active and
the right image is the active
image.

DualView
(simul)

DualView is active (both left
and right images are live)

Dual on
Freeze

DualView is active on freeze

3D On (checked) 3D on Off Same as
previous step

Off
(unchecked)

3D off

LOGIQView On (checked) LOGIQView on Off Same as
previous step

Off
(unchecked)

LOGIQView off

Imaging Preference Attributes
Imaging Preferences work slightly different than other attributes. For example, if an abdomen
Program has 20 steps and all steps have the Harmonics attribute set to Default, then Scan
Coach will not affect the harmonics setting. Now, assume that steps 10-12 are gallbladder
steps and that the harmonics attribute has been set to on for these steps. When transitioning
into this group of steps (step 9 to step 10, e.g.), harmonics will be turned on (or remain on
if it was previously on). If harmonics is then manually turned off in step 10 then Scan Coach
will not turn it back on when advancing to step 11. In other words, a group of consecutive
steps with the same Imaging Preference are treated as a group by Scan Coach and not as
individual steps.
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Table 6-63 Imaging Preference Attributes

Attribute
Name

Selections Description First Step
Default

Other Steps
Default

Harmonics Off Harmonics off Default Same as
previous step

On Harmonics on

Default Harmonics not specified.
Scan Coach does not set
Harmonics on or off.

Virtual
Convex

Off Virtual Convex off Default Same as
previous step

On Virtual Convex on

Default Virtual Convex not specified.
Scan Coach does not set
Virtual Convex on or off.

CrossXBeam Off CrossXBeam off Default Same as
previous step

On CrossXBeam on

Default CrossXBeam not specified.
Scan Coach does not set
CrossXBeam on or off.

PDI Off PDI off Default Same as
previous step

On PDI on

Default PDI not specified. Scan
Coach does not set PDI on or
off.

Color/Doppler
Steer

Left Color/Doppler steered to the
left

Center Same as
previous step

Center Color/Doppler not steered

Right Color/Doppler steered to the
right
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Measurement Attributes
Table 6-64 Measure Attributes

Attribute
Name

Selections Description First Step
Default

Other Steps
Default

B/M Measure
Trigger

Measure Key Initiate "Measure 1" attribute
when the Measure key is
manually selected.

None None

Freeze Key Initiate "Measure 1" attribute
when the image is frozen.

Store Image Initiate "Measure 1" attribute
when the Measure key is
manually selected or the
image is stored. This is used
to store / print an image
and then measure on it
and then store it again.
Therefore, the Advance On
Print attribute is ignored on
the first store / print when the
Measure Trigger attribute is
set to Image Store.

None Measurements are not
triggered by Scan Coach.
The "Measure 1" attribute is
ignored.

Side Rt The side measurement
qualifier is set to Right side of
the body

Rt Derived from
Step Name
attribute if
possible.
Otherwise,
same as
previous step

Lt The side measurement
qualifier is set to Right side of
the body

None The side measurement
qualifier is not used (neither
Right nor Left)
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Attribute
Name

Selections Description First Step
Default

Other Steps
Default

Fetus A The fetus measurement
qualifier is set to Fetus A

A Same as
previous step

B The fetus measurement
qualifier is set to Fetus B

C The fetus measurement
qualifier is set to Fetus C

D The fetus measurement
qualifier is set to Fetus D

Location Prox The location measurement
qualifier is set to Proximal

Prox Same as
previous step

Mid The location measurement
qualifier is set to Middle

Dist The location measurement
qualifier is set to Distal

None The location measurement
qualifier is not used

Measure 1 Various 2D or
M-mode
measurement
s

Specifies the first 2D or M-
mode measurement to be
initiated. The point at which
the measurement is initiated
is based upon the Measure
Trigger attribute. See Section
6 for more information.

Blank Blank

Measure 2 Various 2D or
M-mode
measurement
s

Specifies the second 2D
or M-mode measurement
to be initiated after the
measurement associated with
the Measure 1 attribute is
completed. See Section 6 for
more information

Blank Blank

Measure 3 Various 2D or
M-mode
measurement
s

Specifies the second 2D
or M-mode measurement
to be initiated after the
measurement associated with
the Measure 2 attribute is
completed. See Section 6 for
more information.

Blank Blank

Dop Vessel
Assign

Various
Doppler
measurement
Vessel folders

Specifies the Vessel folder
to assign auto calcs to. The
assignment happens when
the image is stored / printed
(P1 key, e.g.). See Section 6
for more information.

Blank Blank
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Attribute
Name

Selections Description First Step
Default

Other Steps
Default

Auto Calcs Default Auto Calcs state not
specified. Scan Coach does
not set Auto Calcs state.

Default Same as
previous step

Off Auto Calcs state set to Off

Frozen Auto Calcs state set to
Frozen

Live Auto Calcs state set to Live

Auto Calc
Params

Various Auto
Calc
parameters

Specifies the auto calc
parameters to be used.

Default Same as
previous step

Default Auto Calc parameters are
not specified. Scan Coach
does not set the Auto Calc
parameters.

Auto Calc
Specify

[Not
Applicable]

Button used to enable
the Auto Calcs Parameter
Selection dialog so that the
Auto Calc Params attribute
can be set

[Not
Applicable]

[Not
Applicable]

Auto Calc
Default

[Not
Applicable]

Button used to set the Auto
Calcs Params attribute to
Default.

[Not
Applicable]

[Not
Applicable]

Double Print On (checked) If an Image Store / Print (P1
key, e.g.) is performed on
an image with measurements,
the image is stored / printed
two times, once with the
measurements and once
without.

Off Same as
previous step

Off
(unchecked)

No special Store / Print
behavior.
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Attribute
Name

Selections Description First Step
Default

Other Steps
Default

Double Print On (checked) If an Image Store / Print
(P1 key, e.g.) is performed
on an image with color,
the image is stored / printed
two times, once with color
and once without. If double
print on color and double
print on measurements are
both configured to be on,
the image is stored / printed
two times, once with the
measurements and once
without.

Off
(unchecked)

No special Store / Print
behavior.

View
Worksheet

On (checked) The worksheet is turned on Off Off

Off
(unchecked)

The worksheet is not turned
on
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manipulating the volume of interest 525
operational controls 515
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requesting a catalog 250

ALARA (as low as reasonably achievable),
bioeffects 260
Allergic reactions to latex-containing medical
devices 269
Alpha Hip, pediatric measurement 142
area measurements

ellipse 97
spline 98
trace 97, 98

Auto Vascular Calculation, see also Manual
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setting up calculation parameters 130
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B
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Echo Level 100
B-Mode measurements, general 96
B-Mode measurements, generic
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B-Mode measurements, mode
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circumference and area (spline trace) 98
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biological hazards 264
Bladder Volume 135
BluetoothSave 168

C
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urology 134
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Check System Date and Time 46
CINE loop

previewing only 163
storing and previewing 162
storing without previewing 163

circumference measurements
ellipse 97
spline 98
trace 97, 98

Connectivity Functions 186
contacts

clinical questions 250
Internet 250
service questions 250

contraindications 14
Control panel adjustment 29
Curved Anatomical M-Mode 82

D
Danger icon, defined 260
Database Protection Mechanism 48
dD Ratio, pediatric measurement 143
Disposal 205
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general 96
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TAMAX and TAMEAN 102
time interval 104
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E
E7C8L-RS Operation 316
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ECG Operation 385
ECG Patient preparation 386
Echo level measurements 100
Elastography 404
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Elastography, 2D measurement 406
electrical hazard 264
electromagnetic compatibility (EMC) 270
ellipse measurement, general 97
EMC (electromagnetic compatibility) 270
Endometrium thickness (Endo), GYN exam
118
equipment safety 264
exam

OB 109
explosion hazard 264
Export Report Template 579

F
Federal law (USA), requirements 15
Fetal growth curve graph

multiple fetus 115
Fetal trending

multiple fetuses 115
Fetus

entering number of 114
Fetus Compare

multiple fetus 115
Follicle measurements, GYN exam 118

G
Gel Warmer (Option) 26
General imaging

changing presets 155
GYN exam

endometrium thickness 118
follicle measurements 118
ovaries measurements 118
uterus measurements 119

Gynecology exam 117

H
hazards, safety symbols 260
hazards, types

biological 264
electrical 263, 264
explosion 264
mechanical 263
smoke and fire 264

Hip Dysplasia, pediatric measurement 141

I
Imaging Insights 187
Imaging presets, changing

General 155
Import Report Template 580
Indicator Light 30
information, requesting 250

L
Loading the Software 222
Log Off 47

M
M-Mode

CAMM 82
M-Mode measurements, mode

time interval 101
tissue depth 101

M-Mode, general measurements 100
Manual Vascular Calculation 133
Multiple fetuses 114

fetal trending 115
identifying 115
on OB worksheet 116

My Trainer 468

N
Noisy ECG Signal 388

O
OB

graph 113
identifying multiple fetuses 115

OB exam
preparing 109

OB graphs
patient data 114
viewing 113

OB mulitgestational 114
OB worksheet

multiple fetuses 116
Optimizing M Color Flow 86
Orientation Help, 3D/4D imaging 518
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P
Patient data

OB graphs 114
patient safety 262
pediatric measurements, types

alpha HIP 142
dD ratio 143
hip dysplasia 141

Phantoms 234
Physical A/N keyboard 30
prescription device, caution 15
Preset Program menu

Acoustic Output
Fetal Exposure 109
Prudent Use 109

probe orientation, 3D.4D imaging 514
Prostate Volume 136
prudent use 260

Q
QAnalysis 476

Drift Compensation 484
Exit 487
generating a trace 479
manipulating the sample area 480
Select Image Range 478
smoothing 484

QAPlot Control
horizontal sweep 484

Quality Assurance
baselines 234
frequency of tests 233
periodic checks 235
phantoms 234
record keeping 241
system setup 235
test descriptions 236
typical tests 233

R
Record keeping 241
reference images, 3D/4D 512
Renal Volume 135
Render view, 3D/4D imaging 517
Report Templates 569
Reporting 262

S
safety

electromagnetic compatibility (EMC) 270
equipment 264
hazards 260, 264
patient 262

electrical hazards 263
mechanical hazards 263
patient identification 262

personnel 264
precaution icons, defined 260
precaution levels, defined 260

Scalpel, 3D/4D imaging 528
Scan Assistant

Availability 460
Definitions 460
Description 461
Setting Up 461
Using 464

Scan Coach Creator 588
Scan Coach Manager 582
Scan Coach Protocol 587
Scan Coach with Voice Comment 585
Sectional view, 3D/4D imaging 517
service, requesting 250
Setting up Scan Coach 584
Small Parts 108
Static 3D imaging 526

T
TAMAX and TAMEAN, Doppler mode

measurement
manual trace 102

TI and MI Display Accuracy 283
TIC analysis

activating 414
curve fitting 430
exiting 416
generating a trace 419
manipulating the sample area 422
smoothing 427

TIC Plot Control
horizontal sweep 427
line style 427
overview 425
vertical auto scaling 426

Time interval
Doppler mode measurement 104
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Time interval ()
M-Mode measurement 101

Tissue depth, M-Mode measurement 101
Trace measurement, general 97, 98
TVI

Quantitative Analysis 476

U
urology measurements

pelvic floor 138
Using Whizz Follicle 537
Uterus measurements 119

V
Velocity, Doppler measurement 102
Volume measurement, B-Mode generic
measurement 104

W
Warning icon, defined 260
Whizz Report 568
Whizz Report Editor 570
Whizz Report Tool Bar 574
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